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CHAPTER 1

Introduction

The Video Multiprocessing Gateway (VMG) from RGB Networks delivers the industry's highest 
density digital video solution for multi-screen audio/video transcoding, grooming, statistical 
multiplexing, transrating, and digital program insertion (DPI). Based on a flexible, scalable, and 
modular platform, the VMG expedites deployments of advanced video services and simplifies 
operation and management, while reducing operational and capital costs.

Receiving input through its Gigabit Ethernet (GigE) interfaces, this advanced product can 
simultaneously support standard definition (SD) and high definition (HD) program services. One 
chassis can simultaneously perform digital ad insertion, program substitution, switching, and 
grooming, and real time transcoding. 

The VMG is fully MPEG-2 and H.264 compliant and interoperable with leading cable and telecom 
industry equipment. 

The Video Multiprocessing Gateway from RGB makes configuration more intuitive and simple by 
providing the VMG Element Manager, an easy-to-use Java-based graphical user interface (GUI) 
accessible through a standard Web browser 

Document Organization

The chapters in this document are arranged to provide the reader with a logical progression of the tasks 
involved in configuration and usage of the VMG. 

This guide is organized as follows:

• Chapter 1, Introduction – (this chapter) describes the contents and conventions used in the VMG 
Software User Guide.

• Chapter 2, Overview – provides information about the features and capabilities of the VMG.

• Chapter 3, VMG Element Manager – provides an overview of the Java-based VMG Element 
Manager.

• Chapter 4, System Configuration – describes VMG setup and configuration.

• Chapter 5, Bulk Configuration – contains information about how to access and use the Bulk 
Configuration Tool from the VMG Element Manager. 

• Chapter 6, System Maintenance – describes VMG system maintenance.

• Chapter 7, System Alarms and Events – discusses the methods used to monitor the health of the 
VMG.

• Chapter 8, Video Processing Overview – describes interfaces, transport streams, programs and 
grooming, transrating, transcoding, and program redundancy.

• Chapter 9, Input Transport Streams – describes input transport stream configuration and 
management.

• Chapter 10, Single Video Transport Streams – describes standard output transport stream 
configuration and management.
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• Chapter 11, Transcoded+PIP Transport Streams – describes transcoded+PIP output transport 
stream configuration and management.

• Chapter 12, MBR Transport Streams – describes MBR output transport stream configuration and 
management.

• Chapter 13, Advanced Grooming Applications – describes program redundancy and elementary 
stream management/PID management.

• Chapter 14, Module Redundancy – provides details of the Network Processor Module (NPM), 
Video Processor Module (VPM), and Transcoding Module (TCM) software related redundancy 
features. 

• Chapter 15, Digital Program Insertion (DPI) and Program Substitution – describes the VMG’s 
digital program insertion features. 

• Chapter 16, Monitoring – describes how to use the VMG performance monitoring tools at the 
VMG Element Manager. 

• Chapter 17, Troubleshooting – describes VMG troubleshooting procedures and Customer Support 
contact information.

• Appendix A, Configuration Reference – provides lists of bitrates and resolutions, to reference for 
configuration purposes. 

• Appendix B, VMG Alarms and Events –  provides a list of VMG alarms and events, their 
categories, and severity levels.

• The glossary and index are available, for quick reference. 

Document Audience

This guide is intended for system administrators and operators who are responsible for configuration 
and maintenance of the VMG and for processing network broadcasts. Users of this guide should be 
familiar with general video and networking terminology, and should be accustomed to basic network 
software configuration.

Most importantly, the user must be familiar with the basics and principles of broadcast network 
processing.

Related Documentation

• Video Multiprocessing Gateway, Element Manager User Guide.

• Video Multiprocessing Gateway, VMG-6: Hardware Setup Guide.

• Video Multiprocessing Gateway, VMG-8: Hardware Setup Guide.

• Video Multiprocessing Gateway, VMG-14: Hardware Setup Guide.

• Video Multiprocessing Gateway, VMG-14+ Hardware Setup Guide.

• Video Multiprocessing Gateway Software Upgrade Guide.

• Video Multiprocessing Gateway Software Release Notes.
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Document Conventions

Table 1 provides an easy way to recognize information of particular importance in this manual.

Graphics

In some cases the images shown in this manual may differ slightly from what appears on screen and on 
the actual product. 

All efforts have been made to ensure that the latest images are used. In all cases, the functionality 
described is current at the time of writing. 

Table 1. Document Conventions

When 
you see: It means:

Note: This points out information that may not be part of the text but provide tips and other 
helpful advice.

Caution: This provides an alert to an action that may have undesirable consequences if the 
instructions are not followed correctly. Cautions also indicate that failure to follow guidelines could 
cause damage to equipment or loss of data.

Warning! This shows that failure to take the necessary precautions or to follow guidelines could 
cause harm to equipment and personnel.

Navigation tip: follow the path alongside the pointer to navigate to a specific option. 

Clicking any blue link takes you to the item to which the link refers.



VMG Element Manager User Guide 4

CHAPTER 2

Overview

The Video Multiprocessing Gateway (VMG) from RGB Networks is the industry’s first high density, 
carrier class platform that delivers advanced standard definition (SD) and high definition (HD) 
MPEG-2 and H.264 video processing, including advanced ad insertion and transcoding solutions. The 
VMG platform enables video service operators to deploy the next generation of video services. 

In This Chapter:

• “VMG Architecture,” next.

• “High-Availability and Redundancy” on page 7.

• “Software Features and Capabilities” on page 7.

Figure 1. RGB Video Multiprocessing Gateway Systems

VMG 8

VMG 14
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VMG Architecture

RGB’s VMG architecture combines the VMG hardware and Element Manager software described in 
this section. 

Hardware Architecture

The RGB Video Multiprocessing Gateway product line delivers advanced video and audio processing 
solutions on a modular carrier-class platform that is designed to scale to the telco and cable service 
provider video processing and ad insertion requirements. The VMG product line consists of the VMG-
14, VMG-8, and VMG-6 products that offer cable and telco operators more flexibility in deploying the 
next generation of video processing applications in terms of size and density requirements. The three 
platforms have identical system functionality by virtue of running the same software and sharing the 
same hardware modules: Network Processing Modules (NPM), Video Processing Modules (VPM), 
Transcoding Modules (TCM), and Application Media Processors (AMP). The key differences between 
the three platforms are as follows:

• The VMG-14 can accommodate up to twelve application slots for AMPs, VPMs, and/or TCMs.

• The VMG-8 can accommodate up to six application slots.

• The VMG-6 can accommodate up to four application slots.

Note: The VPM is not supported in Release 3.1.x. Please refer to the associated Release Notes for 
additional information. 

For more information on the VMG hardware platform, please refer to “Related Documentation” on 
page 2.

Additionally, the simplified architecture of the VMG provides full processing scalability designed to 
grow with your environment. Just as the high density of the VMG is an ideal solution in a centralized 
environment, its scalability also offers an equally compelling solution for distributed video processing 
environments where density requirements vary. Figure 2 shows how the VMG fits within the network 
architecture.

Figure 2. Centralized and Distributed Network Architecture



VMG Element Manager User Guide 6

Release 3.1.3 VMG Architecture

Software Architecture

The VMG Element Manager is a Java Web Start-based user interface that supports Microsoft 
Windows™, Unix, and Apple™ operating systems. The VMG Element Manager communicates with 
the VMG using the XML-RPC protocol and provides automatic chassis status updates, such as the 
current chassis view, and chassis alarms and events. Multiple VMG Element Manager user interfaces 
are supported for managing a single VMG. 

The VMG Element Manager user interface is divided into three layers: 

• XML-RPC Client: handles communication with the XML-RPC server running on the VMG.

• User Interface Model: defines the Application Programming Interface (API) used to access the 
VMG data objects and configuration logic.

• User Interface Screens (or Widgets): provides the windows that are displayed to operators using 
the VMG Element Manager GUI.

Figure 3 shows the VMG Element Manager interface architecture model.

Figure 3. VMG Element Manager Interface Architecture Model

VMG System

VMG Element Manager

XML-RPC Server

XML-RPC Client

SNMP Agent

SNMP Client

User Interface Model

User Interface 
Screens

NMS NTP ServerSyslog Server

Syslog NTP Client

Syslog Client
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High-Availability and Redundancy

High availability and redundancy refer to the duplication of critical components within a system in 
order to prevent downtime in the event a primary component fails.

The VMG redundancy implementation guarantees high availability of services provided by the VMG 
platform. It is designed with the goal of a high availability of carrier-class service through both 
hardware and software implementations, including chassis redundancy, NPM and AMP 1:1 
redundancy, and N+M redundancy for the VPM and TCM cards. Refer to Chapter 14, “Module 
Redundancy” for more information.

Software Features and Capabilities

Key VMG system software features and capabilities are listed in Table 2.

Table 2. System Software Features and Capabilities  

General
MPEG-2 and H.264 video program distribution through MPEG-2TS / UDP / IP / GigE, or 
through MPEG-2TS / RTP / UDP / IP / GigE with or without Pro-MPEG COP3r2 FEC 
coding.

Input/Output

• MPEG-2 input and output transport stream (TS) unicast and multicast.

• DVB SI input and output transport stream support.

• Support for:

- H.264 SD / HD or MPEG-2 SD / HD video programs.

- Mixed Mode: Multiple programs types (MPEG-2 or H.264) to be carried by one 
output transport stream.

- Up to eight GigE interfaces and one of two 10 GigE interfaces per NPM.

- Mirroring all output on one GigE interface (port) to another GigE interface.

Stream 
Processing

• Support for input transport stream network de-jittering.

• Program grooming with different combinations of input programs.

• MPEG-2: TS statistical multiplexing for MPEG-2 and H.264 video content, and video 
program digital ad insertion based on SCTE 30 and SCTE 35.

• H.264: Video program digital ad insertion with constraints per SCTE 128 and DVS714r3. 
Picture in Picture (PIP) support, including program substitution and DPI.

• Input and Output PID management.

• Bandwidth utilization monitoring and analysis.

• PSI generation, PSIP and DVB-SI data parsing, re-construction, and pass-through.

• FEC decoding and encoding on input and output streams.
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Video 
Processing

• MPEG-2 video stream transrating with manageable video quality and best bandwidth 
efficiency.

• Support on each VPM for:

- Grooming and statistical multiplexing for SD or HD video program streams (MPEG-2 
and H.264).

- Simultaneous transrating for MPEG-2 SD or HD video program streams.

- Simultaneous digital program insertion (DPI) splicing for SD or HD video program 
streams (MPEG-2 and H.264).

• Support on each TCM for:

- Transcoding of input programs from MPEG-2 to output of H.264 Single Program 
Transport Stream (SPTS).

- Transcoding of input programs from H.264 to output of MPEG-2 Single Program 
Transport Stream (SPTS).

- CBR rate conversion of MPEG-2 to MPEG-2 and H.264 to H.264 output TSs.

• Input and output support for:

- MPEG-2 single program transport streams (SPTSs) and multiprogram transport 
streams (MPTSs).

- Constant bitrate (CBR) or variable bitrate (VBR) of MPEG-2 and H.264 video 
streams.

• Support for Active Format Description (AFD)-based aspect ratio conversion and 
forwarding.

• Support for high density transcoding: SD to SD and SD to PIP.

Audio 
Processing

Audio transcoding support for the following codecs: HE-AACv1, HE-AACv2, AAC-LC, 
MPEG-1 LII, MPEG-2 LII, AC-3, and E-AC-3 (Dolby Digital Plus).

Control 
Interface

• Web browser-based GUI for system configuration, control, and management. Also, 
FTP-based software upgrade via the GUI, and database backup and FTP-based restore 
via the GUI.

• Support for:

- Drag-and-drop grooming using the VMG Element Manager.

- Remote Authentication Dial In User Service (RADIUS) and Terminal Access

- License keys for all VMG features, with options to add licenses.

- SNMP v2: MIBs available for download from the VMG Element Manager home 
page.

• Controller Access Control System Plus (TACACS+) for administrative access control.

• Management of local accounts and interaction with one or more AAA servers.

• Multi-tiers of password protection within the VMG Element Manager interface for 
different user access levels.

Redundancy

• Design for high availability of carrier-class service, service level and card redundancy.

• Support for four (in the VMG-6), six (in the VMG-8), or 12 (in the VMG-14) application 
modules (TCM, VPM, AMP) with in-chassis module redundancy support.

• Up to two Network Processor Modules (NPMs) configured in 1:1 redundancy for video 
over IP network routing, switching, and filtering.

• Up to two Application Media Processors (AMPs), each mated to an NPM and configured 
in 1:1 redundancy, for audio transcoding.

• Support for both input-level program redundancy.

• Support for output GigE interface redundancy. 

Table 2. System Software Features and Capabilities  (Continued)
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Multi-Bitrate Video and Audio Transcoding for Adaptive Streaming Applications

Adaptive streaming and “over the top” video delivery technologies now represent a key option 
available to video service providers to leverage IP networks to the home and to make content available 
on PC and mobile devices such as Apple's iPad.

The VMG represents a key component in an adaptive streaming architecture in that it allows for real-
time audio transcoding (through the AMP module) and video transcoding (through the TCM module). 
The TCM allows a multi-profile transcode operation where an HD or SD input received over MPTS or 
SPTS can be configured to an H.264 output complying with PC/mobile device video requirements. 
Requirements include the definition of a “group” of output profiles, all of which are synchronized with 
aligned IDR frames.

VMG input and output protocol format is typically MPEG-2 transport stream, and the output is 
typically received by a downstream “fragmenter” device, such as RGB's AMS Packager, for protocol 
conversion and possible encryption for secure content to be made available to the appropriate 
receiving device.

Key VMG features for multi-bitrate transcoding

• Video transcoding from HD or SD inputs and up to 48 H.264 all-progressive outputs per TCM 
module with varying resolutions and encoding parameters.

• Audio transcoding from MPEG-1 LII, MPEG-2 LII, AAC-LC, HE-AACv1, HE-AACv2, or Dolby 
AC-3 or E-AC-3 (Dolby Digital Plus), to MPEG-1 LII, MPEG-2 LII, AAC-LC, HE-AACv1, HE-
AACv2, or Dolby AC-3 or E-AC-3 (Dolby Digital Plus).

MPEG-2 and H.264 Grooming and PSIP

Grooming refers to the process of grouping specific programs and services into different levels for 
end-users (e.g., creating customized channel lineups based on the available input programs). 
Grooming must be done to prevent potential conflicts with any current packet identifiers (PIDs) and 
Program and System Information Protocol (PSIP) data. PSIP data is comprised of a set of descriptive 
tables, associated with digital television (DTV) transport streams, that provide program guide 
information about the broadcasters services and programming. The VMG preserves incoming PSIP 
data and only reads the information to check for conflicts. If conflicts are found, the user is alerted.

VMG Grooming and PSIP features

• Allows selection of any GigE input SPTS or MPTS program to combine with one or more 
programs from any other input to create an MPTS multiplex on any output port.

• Supports Main and High profile H.264 encoded video for grooming, statistical multiplexing, and 
DPI.

• Allows drag-and-drop grooming through the VMG Element Manager.

• Dynamic service grooming supported, with scheduling of start time, end time, and day of the 
week.

• Synchronization of input and output program names.

• PSIP based on the ATSC A/65 standard supported.

Refer to Chapter 10, “Single Video Transport Streams” and Chapter 11, “Transcoded+PIP Transport 
Streams” for more information.
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MPEG-2 and H.264 Multiplexing

Multiplexing is used to combine multiple data sources such as video, audio, and data, into a single 
source. This is normally done to transmit multiple video programs over a single bandwidth-limited 
carrier medium, such as fiber or coax, to end-users. Multiplexing several variable bitrate streams 
together into a fixed sized transport stream bandwidth is called statistical multiplexing and helps to 
increase the overall efficiency of a multi-channel digital transmission.

VMG multiplexing features

• Support for transport stream-level multiplexing CBR or VBR programs from SPTS and MPTS 
input transport streams to an MPTS output stream.

• Support for de-multiplexing multiple MPTSs into smaller SPTSs or MPTSs.

• PID re-mapping/PID-aliasing to prevent PID conflicts in the MPEG-2 output transport stream.

• Allows program stream creation with up to thirty-two PIDs: only one can be video, the rest a mix 
of audio and data.

• MPEG-2 transport stream timing accuracy: PCR correction with tolerance within ±500ns.

• Generation and insertion of new PSI tables (PAT and PMT).

• PSI insertion repetition rate is MPEG-2 system specification compliant: the VPM default is 67ms 
and not programmable.

Note: The VPM is not supported in Release 3.1.x. Please refer to the associated Release Notes for 
additional information

Refer to Chapter 8, “Video Processing Overview” through Chapter 13, “Advanced Grooming 
Applications” for more information.

MPEG-2 Transrating

Transrating, or rate shaping, is the process of changing the bitrate of a video stream for the purposes of 
improving bandwidth and system efficiency. This includes converting variable bitrate (VBR) to 
constant bitrate streams (CBR), as well as transrating the streams. The use of transrating removes the 
need for additional decoders and encoders in order to change the bitrate of a video stream.

This function is processed by the VPM to provide VTR services. 

Note: The VPM is not supported in Release 3.1.x. Please refer to the associated Release Notes for 
additional information

VMG Transrating features

• Supports processing of any MPEG-2 SPTS or MPTS inputs over IP (Unicast/Multicast).

• Supports NTSC and PAL video formats:

- Supports MP@ML and MP@HL MPEG-2 profiles.

- SD resolutions: 720x480/576, 704x480/576, 544x480/576, 528x480/576, 352x480/576.

- HD resolutions: 1080ix1920, 1080ix1440, 1080ix1280, 720px1280.

- Frame rates: 23.976 or 24Hz, 25 or 29.97 or 30Hz, 50 or 59.94 or 60Hz.

- Aspect ratios: 4:3 and 16:9.
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- 3:2 reverse pull down.

• Dynamic bitrate conversion and adaptation of MPEG-2 video streams:

- CBR to VBR.

- VBR rate clamped output.

- VBR to VBR.

• Provides multiple QoS setting levels for each output program that is to be rate shaped:

- Rate shaping QoS levels range from -8 to +8 with step sizes of 1.

- +8 is for minimum relative rate reduction.

- -8 is for maximum relative rate reduction.

• Configuration of transrating output video bitrates through GUI.

• Ability to disable transrating on any output program through GUI. 

• VPM required.

Note: The VPM is not supported in Release 3.1.x. Please refer to the associated Release Notes for 
additional information

Refer to Chapter 10, “Single Video Transport Streams” for more information.

Transcoding

The VMG’s high capacity transcoding capabilities enable operators to deliver MPEG-2 or MPEG-4/
H.264 SD or HD content from various sources to suit the type of “last mile” distribution network to the 
home, targeting broadcast-quality delivery to set top boxes or integrated digital tuner TV's. Typical 
applications include transcoding H.264 signals into MPEG-2 for existing MPEG-2 set top boxes, or 
transcoding MPEG-2 feeds into H.264 for IPTV or next-generation QAM delivery networks. IPTV 
applications also require a picture in picture (PIP) version of the full resolution (SD or HD) video 
stream. That stream is typically used for electronic program guides, multi-screen mosaic, and related 
set top box applications. The VMG is capable of generating a PIP stream alongside a full screen 
transcode, compliant with such popular middleware systems as Microsoft's Mediaroom.

This function is processed by the TCM to provide PIP, VTX, and VTX+PIP services. 

TCM transcoding features

• Transcoding of MPEG-2 to H.264 SPTS, in HD or SD.

• Transcoding of H.264 to MPEG-2 SPTS, in HD or SD.

• Transcoding of MPEG-2 to MPEG-2, in HD or SD.

• Transcoding of H.264 to H.264, in HD or SD.

• Integrated HD to SD downconversion.

• H.264 PIP generation, with SD or HD inputs in either MPEG-2 or H.264 formats.

• TCM required.

Refer to Chapter 10, “Single Video Transport Streams” and Chapter 11, “Transcoded+PIP Transport 
Streams” for more information.
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MPEG-2 and H.264 Digital Program Insertion (DPI)

Digital program insertion (DPI) is the digital splicing of one digital program into one or more other 
digital programs. DPI is used to seamlessly insert digital content, such as locally specific programs and 
advertisements, into national or regional programs before they are delivered to end-viewers. This 
generally involves MPEG-2 or H.264 video stream splicing to accomplish the substitution, and is 
based on SCTE 30 and SCTE 35 standards for communication, with an ad server and reading cue 
messages embedded in the transport stream.

Note: For correct DPI splicing and ad insertion, the VMG must be configured to use an NTP server 
that is accurate to ±15ms.

VMG DPI features

• H.264 ad insertion based on an MPEG-2 transport stream.

• Support for multiple ad zones per VMG.

• Support for both SD and HD formats for H.264 DPI.

• Supports splicing that is seamless:

- Follows DVS714 for video network feeds and video ad streams.

- Follows SCTE 128 for video systems and transport constraints.

• Supports back-to-back ads.

• Supports SCTE 30 to SCTE 35 mapping.

• Cue forwarding enable/disable.

• Support network and ad stream language matching.

• Support for MPEG-1 LII, AC-3, AAC audio formats and meta data.

• Complies with SCTE 30 and SCTE 35 standards for communication with ad servers and ad 
insertion.

• Simultaneous ad insertions for SD or HD programs.

• Supports rate shaping for SD or HD channels for MPEG-2 video streams only.

• Support for SCTE 30 keep-alive and priority messages.

Refer to Chapter 15, “Digital Program Insertion (DPI) and Program Substitution” for more 
information.

MPEG-2 and H.264 Program Substitution 

Program substitution is a form of digital program insertion (DPI) that offers the ability to switch from 
one program to another program based on a schedule instead of between a program and an 
advertisement based on cue tones. Long format content, which is typically 30 to 60 minute 
programming segments, differs from short format content which is used for regional spot 
advertisements. Program substitution is particularly important for some operators in meeting national 
programming content rules which often limit the amount of international programming that is allowed. 
This generally involves MPEG-2 or H.264 video stream splicing to accomplish the substitution, and is 
based on the SCTE 30 standard for communication, with a scheduling server. 
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VMG Program Substitution features

• Similar to DPI except involves long form MPEG-2 and H.264 content instead of short form video 
streams. 

• Program Substitution based on the scheduled information via SCTE 30 on a schedule or on 
demand basis. 

• Integrates with third party scheduling system based on SCTE 30 messaging. 

• Integration with an external Program Substitution scheduling server for schedule based program 
substitution.

• VPM required.

Note: The VPM is not supported in Release 3.1.x. Please refer to the associated Release Notes for 
additional information

Refer to Chapter 15, “Digital Program Insertion (DPI) and Program Substitution” for more 
information.

Forward Error Correction (FEC) Coding

Due to video’s inherent low tolerance for transmission errors, delivering high quality IPTV video 
services over IP transport networks to digital set-top box decoders can be challenging, the access 
portion of the transport network being the main source for transmission related errors. These errors 
result in packet loss and perceptible degradation of video quality such as macro blocking, artifacts, and 
frame freezes from decoder under flows, the results even less desirable when viewing video in High 
Definition, where anything less than pristine quality is unacceptable from a subscriber perspective. 

The VMG provides a simple, standards-based solution to video degradation seen as a result of 
transmission error packet loss. By implementing Real Time Protocol (RTP) in conjunction with Pro- 
MPEG CoP#3 FEC, the VMG can recover from packet errors on processed incoming broadcast video 
streams as well as supporting packet recovery to downstream devices. 

FEC coding features and parameters

• Supports FEC generation and error correction on RTP encapsulated video packets.

- Decodes and corrects FEC packets on input transport streams.

- Generates FEC packets on output streams.

• Based on the Pro-MPEG CoP#3 standard. 

• Supports RTP packet recovery on detection of packet loss on input video streams. 

- Uses two dimensional computed checksum received from the low bit rate channel.

- Addition of four net filters and four UDP ports assigned for each FEC-enabled input transport 
stream. 

• Supports RTP encapsulated video delivery in output video streams. 

- Generates two dimensional checksum on a set of RTP packets and sent over a separate out of 
band low bit rate UDP connection.

- Addition of three netfilters and four UDP ports assigned for each FEC-encoded output 
transport stream.

- Matrix dimension where L = width and range is between 1 and 20. 

- Matrix dimension where D = height and range is between 4 and 20. 
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- L x D is less than or equal to 100.

• VPM required.

Note: The VPM is not supported in Release 3.1.x. Please refer to the associated Release Notes for 
additional information

Refer to Chapter 9, “Input Transport Streams” and Chapter 10, “Single Video Transport Streams” for 
more information.

Program Redundancy

The VMG supports input-level program redundancy. At the detection of a missing program, the VMG 
automatically switches to a redundant or backup program. 

In a program redundancy configuration, a switch to backup occurs when:

• Missing MPTS/SPTS streams are identified by checking the PAT.

• Missing program streams are identified by checking the PMT.

You can assign a backup program for every input program, and any input program can be assigned to 
back up a running primary program. The backup program can be another program on the same GigE 
port or it can be on a different GigE port in the same chassis.

Program redundancy also supports programs using DPI; the DPI program will default to the primary 
program when a backup is triggered. 

Refer to Chapter 13, “Advanced Grooming Applications” for more information.

Port Mirroring

The VMG supports replicating (mirroring) all traffic sent out on one odd-numbered GigE port (the 
source port) to the next higher even-numbered GigE port (the mirrored-to port). The port mirroring 
functionality can serve one of two purposes:

• Capturing traffic sent out on a port for analysis by mirroring the traffic to another port.

• Support for downstream device redundancy where the outputs from a VMG are replicated across 
two different paths, thus allowing for greater network resiliency in the event that a downstream 
device goes out of service.

The source port can carry both input and output traffic; however, only the output traffic is mirrored. 
The output transport streams can be sent to a different IP address (for redundant output) on the 
mirrored-to port.

Software Serviceability

Software serviceability refers to the ability to perform software maintenance, such as upgrades, on the 
VMG with the least amount of hassle and down time.
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VMG software serviceability features

• Remote upgrade of software using FTP.

• Support for graceful shutdown of VMG.

• Full IP interface support on management IP address.

Refer to Chapter 6, “System Maintenance” for more information.

Database Backup and Restore

The VMG Element Manager provides the ability to backup all configurations stored in the VMG 
database and the ability to restore a backup up configuration to a current system. 

Backup / Restore functionality includes: 

• Remote HTTP backup using the VMG Element Manager. 

• Remote restore of current system configuration using FTP. 

• Forward configuration database compatibility for software upgrade. 

Refer to Chapter 6, “System Maintenance” for more information.

Monitoring and Management

The VMG provides multiple monitoring and management tools accessible through the VMG Element 
Manager. The features listed below encompass security, asset management, system configuration, 
system management, system monitoring, and system diagnostics. Alarms and events allow operators to 
monitor the health of the VMG system and to be notified when their assistance is required. Alarms 
monitor and notify operators when any hardware, software, MPEG stream anomalies, or defects are 
caused by the VMG. Events are used to log issues that occur within the VMG system, and may be used 
to provide historical event information. Operator assistance may or may not be necessary depending on 
the severity of the alarm or event.
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VMG monitoring and management features

• RADIUS and TACACS+ support for user authentication and access control.

• Three login profile levels for user accounts: Administrator, Operator, and User.

• Embedded GUI application for configuration and management supported via XML/RPC over 
HTTP.

• Allows setting International Time Zones through the VMG Element Manager.

• Display of audio language code during grooming.

• Basic event reporting using the VMG Element Manager.

• Popup window display for accessing configuration or activity details.

• Display of input and output bandwidth for each service.

• Display of input and output error statistics for each groomed elementary stream.

• Support for International variations of Daylight Savings Time (DST).

• Initialization of system software upgrade from the VMG Element Manager.

• Platform asset management information: software version, hardware serial numbers, and card 
characteristics and capabilities.

• Monitoring of port link faults and bitrate via the VMG Element Manager.

• Four severity levels for generated alarms: Critical, Major, Minor, and Info.

• Maintains a log for alarm triggered events.

• User sortable event log.

• Uses standard Syslog for logging service and system events.

• Full management capability via SNMP.

Refer to Chapter 4, “System Configuration” and Chapter 7, “System Alarms and Events” for more 
information.

Licensing

Licensing is used to enable certain-value added aspects of the VMG. The VMG supports the licensing 
options listed and described in “License Management” on page 99.
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VMG Element Manager

This chapter provides information about the VMG Element Manager which is used to configure and 
monitor the VMG system.

In This Chapter:

• “VMG Element Manager Overview,” next.

• “Obtaining Java Runtime Environment” on page 18.

• “Launching the VMG Element Manager” on page 18.

• “VMG Element Manager GUI” on page 22.

• “Chassis Tab” on page 25.

• “Grooming tab” on page 35.

• “Monitor tab” on page 35.

• “Alarms & Events tab” on page 35.

• “VMG Element Manager Software Version” on page 35.

• “Quick Keys” on page 36

• “Clearing the Java Web Start Cache” on page 37.

VMG Element Manager Overview

The VMG Element Manager is a Java-based GUI available using a standard web browser. This easy-
to-use interface offers a variety of features that simplify the setup and operation of the VMG. These 
features include: 

• An embedded GUI application for configuration and management via XML/RPC over HTTP.

• Program level drag-and-drop grooming.

• PID Management.

• Input program redundancy.

• Output port mirroring.

• Simultaneous bitrate analysis of input and output transport streams and programs.

• Viewing of alarm and event logs.

• Module redundancy configurations.

• Full configuration of system functions and Gigabit Ethernet ports.

About the VMG IP Address

There are two types of IP addresses employed by the VMG: physical (used by each NPM installed in 
the VMG) and virtual (used by the system as a whole, also referred to as the Management Interface). 
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The active NPM’s physical IP address must be used to access the VMG until a virtual IP address has 
been configured. 

To find out how to perform initial VMG configuration, refer to the VMG-6, VMG-8, or VMG-14 
Hardware Setup Guide.Once the virtual IP address is configured on the VMG, this address will be used 
for subsequent access to the VMG (the management interface).

Obtaining Java Runtime Environment 

The VMG Element Manager requires that the PC on which it is running have Java™ Runtime 
Environment (JRE) v1.6 or higher. If your PC does not have the correct JRE installed, it is available 
free from the RGB Customer Portal (see below).

Obtaining JRE from the RGB Customer Portal

To obtain installation instructions and the latest version of JRE that is compatible with the 
VMG Element Manager, log in to RGB’s Customer Portal and search for Download Java Runtime 
Environment.

Launching the VMG Element Manager

The VMG Element Manager is pre-installed on the VMG at the factory. This section describes how to 
set up a session with the VMG and the VMG Element Manager, then log in to the VMG Element 
Manager for management of the VMG. 

Accessing the VMG Element Manager

1. Open a web browser from the management workstation and enter the IP address of the VMG in the 
browser’s address field to display the VMG Element Manager home page (Figure 4).

Figure 4. VMG Home Page

The VMG Element Manager home page allows you to launch the GUI and also contains options 
you can use for troubleshooting, MIB access, database backup, and configuration backup.
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2. At the VMG Element Manager home page, click Launch VMG Element Manager. 

The system now queries for action to take with the index.jnlp file (Figure 5). 

3. At the Opening index.jnlp screen, use the Open with option and click OK to download the 
application. 

The Java WebStart screen now reports download activity (if the Web Start cache does not already 
contain the correct version).

Figure 5. Open index.jnlp and download 

4. At the Java Warning Security screen (Figure 6), click Run to start the VMG Element Manager. 

Figure 6. Java warning
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Logging in to the VMG Element Manager

As dependent on the type of login required—as either local login, or login via AAA server—you can 
either type or enter the user ID and password (Figure 7) after launching the VMG Element Manager.

1. At the IP Address or Host Name: field, enter the IP address of the VMG to manage, or use that 
already provided in this field. 

Note: If required, you can change the VMG target to be managed, by specifying the VMG IP address 
or Host Name during log in. When doing this, you can avoid inconsistent VMG behavior if you 
ensure that the VMGs are running the same software versions. 
For example, if you launch Element Manager with (VMG) 10.32.96.215 at the web browser, 
then change the IP address to (VMG) 192.168.1.12 at the Log In dialog, these VMGs must be 
running identical software versions. 

Figure 7. VMG Element Manager login 

Note: Prior to initial configuration of the VMG, the default IP address of the NPM is set to 10.1.1.1 
with a subnet mask of 255.255.255.0. However, prior to launching the VMG Element Manager, 
the IP address should have already been changed to an appropriate address for your specific 
network. For detailed information on initial configuration of the VMG, please see the VMG-6, 
VMG-8, or VMG-14 Hardware Setup Guides.

2. At the User: field, select the user account from the drop-down list, or type the user name if using a 
AAA server for authentication.

3. At the Password: field, type the password (Table 3)

Note: Passwords are case sensitive. 
To change a local user account password, refer to “Local Tab” on page 56. 
To change an AAA server password, refer to the AAA server documentation.

Table 3. VMG Element Manager Default Login Reference

User Password

Administrator Admin

Operator Operator

User User

Local log in AAA server log in 
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4. Click Log in.

The VMG Element Manager opens to reveal the graphical representation of the VMG chassis and 
current slot assignments, a tabular display of associated system information, and various status 
indicators (Figure 8). 

Figure 8. VMG Element Manager Chassis tab (VMG-14)

Additionally, management and control options are provided in the Element Manager menu, tab pages, 
and pop up menus throughout the Element Manager GUI, as described in “VMG Element Manager 
GUI” on page 22.
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VMG Element Manager GUI

The VMG Element Manager provides a convenient, intuitive method for management of a VMG. In 
addition to numerous tools built into the interface for configuration of services, status of the VMG 
system is always evident via various reporting functions. 

The VMG Element Manager GUI hierarchy consists of two main branches: tabs and menus (Figure 9). 
The menus and tabs reside in the GUI screen with various other functions, as described in the 
following topics:

Figure 9. Hierarchy of VMG Element Manager Menus and Tabs

• “VMG Element Manager Window” on page 23. • “Chassis Tab” on page 25.

• “VMG Element Manager Menu” on page 23. • “Grooming tab” on page 35.

• “VMG Element Manager Tabs” on page 24. • “Monitor tab” on page 35.

• “VMG Element Manager Toolbar Icons” on 
page 24.

• “Alarms & Events tab” on page 35.

• “VMG Element Manager Status Bar” on page 25.
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VMG Element Manager Window

The VMG Element Manager provides the GUI components shown in Figure 10. The menus, icons, 
tabs, and colors built into the GUI assist in locating the configuration functions and determining status 
of the VMG. 

Figure 10. VMG Element Manager window components

Note that the identity of the VMG and the currently logged in user is always in view at the top bar of 
the window. Status of the connection between the VMG and the VMG Element Manager is always on 
display at the bottom bar, alongside the overall status of the VMG system. 

VMG Element Manager Menu

Use the VMG Element Manager menu to perform configuration and maintenance tasks (Table 4). 

VMG Element 
Manager Menu

Toolbar Icons

Tab page

Tabs

Connectivity 
Status

Alarm Status


Syslog Status

System or Card Information

Table 4. VMG Element Manager Menus 

Menu Use

File Exit the VMG Element Manager.

View Refresh the currently active window.

Configuration Configure global options, Gigabit Ethernet ports, and user authentication. Access bulk 
configuration components. 
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VMG Element Manager Tabs

Use the VMG Element Manager tabs to perform monitoring and grooming (Table 5). 

VMG Element Manager Toolbar Icons

Use theVMG Element Manager toolbar icons (Table 6) for quick access to commonly used functions.

Maintenance Upgrade software, manage licenses, restore database information, reboot the system, 
shutdown the system, and perform NPM redundancy switching.

Help Display the Element Manager About dialog.

Table 4. VMG Element Manager Menus (Continued)

Menu Use

Table 5. VMG Element Manager Window Tabs 

Tab Use

Chassis Provides a quick overview of the VMG system state. Clicking a card or port provides 

specific information for that item. Clicking any other part of the VMG displays system 

information about the VMG.

Grooming Create and map programming.

Monitor Monitor bitrates in real-time.

Alarms & Events View alarms and events.

Table 6. VMG Element Manager Toolbar Icons 

Icon Name Use

Global Configuration Opens the global configuration dialog. 

Equivalent to Configuration -> Global. (See also “Global Configuration” 
on page 41). 

Refresh Current 
Window

Refreshes the current view. 

Equivalent to View -> Refresh.

About Opens the VMG About dialog. 

Equivalent to Help -> About.
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VMG Element Manager Status Bar

The status bar at the bottom of the VMG Element Manager always remains in view to report status 
information about the VMG. Color coding (Table 6) indicates the current, highest-level severity of the 
situation reported for connectivity, events, or the syslog portion of the bar. 

Connectivity

Status of connectivity to the VMG is reported at the left portion of the status bar, where you can view 
the currently connected IP address of the VMG, and current status of connectivity between the VMG 
and the VMG Element Manager as either green (good) or red (error). 

Events

Status of most critical event reported by the VMG is displayed as a text string and color code (Table 7) 
in the middle section of the status bar. Refer to Appendix B, VMG Alarms and Events, on page314 for 
information about messages you may see in the status bar. 

Syslog

Status of trace logging from the VMG is reported at the right portion of the status bar. Current status is 
color-coded as either green or red (Table 8).

Chassis Tab

The VMG Element Manager automatically detects the chassis hardware and provides a graphical 
display of the product components, current status, and general system information (Figure 8). 

Except for setting the administrative state of a card, information on the Chassis tab screen is displayed 
for informational purposes only. 

• When moving the cursor over a port on the screen, the name of the port is displayed, indicating 
that details about that port are viewable. 

Table 7. VMG Element Manager System Status

Color Meaning

Green Informational alert or event.

Yellow Minor alert or event may require operator action.

Pink Major alert or event requires operator action.

Red Critical error has occurred and operator intervention is needed.

Table 8. VMG Element Manager Syslog Status

Color Meaning

Green The trace logs reported to syslog are enabled at normal logging levels. 

Red The trace logs reported to syslog are enabled at increased logging levels, and may 
result in VMG performance issues. 
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• Clicking with the left mouse button displays the information about the selected Gigabit Ethernet 
port. 

• All active ports appear green on the screen.

Chassis Tab Menus

At the Chassis tab page, you can access popup menu options from the components displayed in the 
VMG chassis. These menus allow access to module details, administrative settings, and reset 
functions. 

Right-click on a component in the Chassis tab page to view applicable options (Table 9) from the 
popup menu.

Table 9. VMG Chassis Popup Menus 

Component Options

Chassis View System Information (see also “VMG System Information” on page 27).

NPM View System Information, View Slot Properties, Configure GigE Ports. 

AMP View System Information, View Slot Properties. 

TCM View System Information, View Slot Properties, Set Card Admin State, Reset Card (see 
also “Card Information” on page 31).VPM

GigE port View System INformation, View Slot Properties, Configure Gige Ports (see also “Port 
Information” on page 33).
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VMG System Information

To access the comprehensive VMG chassis System Information table, make sure the Chassis tab 
(Figure 11) is in view: 

If the System Information panel is not already in view, right-click anywhere on the chassis and select 
View System Information from the popup menu.

Figure 11. VMG Element Manager—Accessing System Information

The chassis system information is displayed in the table alongside the chassis graphic, and described in 
the following topics:

• “Management IP,” next. 

• “Chassis” on page 28.

• “Chassis FRU” on page 28.

• “NPM Redundancy” on page 29.

• “VPM Redundancy” on page 29.

• “TCM Redundancy” on page 30.

• “AMP Redundancy” on page 30.

Right-click on the chassis to access the View System 
Information option. 
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Management IP

The Management IP information for the managed VMG consists of properties listed in (Table 10).

Chassis

The chassis information for the managed VMG consists of properties listed in (Table 11).

Chassis FRU

The chassis FRUs for the managed VMG consists of properties listed in (Table 12).

Table 10. Chassis Tab - System Information  - Management IP

Property Value

IP Address Virtual IP address of the system. 

• If this hasn’t been configured in the Global Configuration -> Management Interface tab, 
this field will be empty.

MAC Address MAC address of the system.

Subnet Mask Subnet mask of the system. 

• If this hasn’t been configured in the Global Configuration -> Management Interface tab, 
this field will be: empty.

Gateway The IP address of the gateway. 

• If this hasn’t been configured in the Global Configuration -> Management Interface tab, 
this field will be: 0.0.0.0 

Table 11. Chassis Tab - System Information - Chassis  

Property Value

System Type The chassis type (e.g., 14-slot).

Note: Double click the ellipses (...) to retrieve the serial number of the chassis.

System Time The current system time.

System Up Time Amount of time that the chassis has been powered on.

Active Software 
Version

Version of the software currently running on the system.

Loaded Software 
Version

Specifies the latest downloaded version of the software currently residing on the system 
disk. This version will become the active version at the next system reboot.

Reset Reason The reason for the last system reset. Used for troubleshooting purposes when reporting 
to customer support. 

Alarm LED Displays the color of the highest alarm currently active in the system.

Table 12. Chassis Tab - System Information - Chassis FRU

Property Value

Fan n Indicates if fan is present in the system. 

Power n Indicates if power module is present in the system.

System 
Controller n

Indicates if system controller is present in the system. 

SAP Indicates if shelf alarm panel is present in the system. SAP is displayed only for VMG-6 
and VMG-14 systems; not applicable for VMG-8. 
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NPM Redundancy

Current NPM redundancy configuration and state information for the managed VMG consists of 
properties listed in (Table 13).

See also Chapter 14, “Module Redundancy,” for more information about NPM redundancy. 

VPM Redundancy

Note: The VPM is not supported in Release 3.1.x. Please refer to the associated Release Notes for 
additional information. 

Current VPM redundancy configuration and state information for the managed VMG consists of 
properties listed in (Table 14):
.

See also Chapter 14, “Module Redundancy,” for more information about VPM redundancy. 

Table 13. Chassis Tab - System Information - NPM Redundancy

Property Value

Slot n (NPM) Shows if there is an NPM installed in slot 7 or 8 of the VMG-14 chassis or slot 1 or 2 of the 

VMG-6 or VMG-8 chassis, and its current redundancy state. 

• If one NPM, choices are: Not Redundant or N/A (empty slot). 

• If two NPMs, choices are: Active, Standby, or Disabled. 

Redundancy 
State 

Shows Redundancy state: 

• If one NPM, or the standby NPM has failed, value is: Not Redundant. 

• If two NPMs are fully operational, choices are: Fully Redundant or Not Redundant.

Table 14. Chassis Tab - System Information - VPM Redundancy  

Property Value

Grooming Group 
1

Provides color coded and text redundancy status information on available bandwidth for 
all cards in grooming group 1 (the 8x1 GigE ports). Color codes are:

• Green: Less than 70% capacity utilized.

• Yellow: Greater than 70% capacity utilized.

• Orange: Greater than 90% capacity utilized.

• Red: Card is at 100% capacity; no more streams will be allocated to this card.

Hover over a color block to view percent of utilization.

Grooming Group 
2

Provides color coded and text redundancy status information on available bandwidth for 
all cards in grooming group 2 (either 10 GigE1 or 10 GigE2). Color codes are:

• Green – Less than 70% capacity utilized.

• Yellow – Greater than 70% capacity utilized.

• Orange – Greater than 90% capacity utilized.

• Red – Greater than 100% capacity utilized; some output TSs are currently unassigned. 

Hover over a color block to view percent of utilization.
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TCM Redundancy

Current TCM redundancy configuration and state information for the managed VMG consists of 
properties listed in (Table 15)

See also Chapter 14, “Module Redundancy,” for more information about TCM redundancy. 

AMP Redundancy

Current AMP redundancy configuration and state information for the managed VMG consists of 
properties listed in (Table 16).

See also Chapter 14, “Module Redundancy,” for more information about AMP redundancy. 

Table 15. Chassis Tab - System Information 

Property Value

Grooming Group 
1

Provides color coded and text redundancy status information on available bandwidth for 
all cards in grooming group 1 (the 8x1 GigE ports). Color codes are:

• Green: Less than 70% capacity utilized.

• Yellow: Greater than 70% capacity utilized.

• Orange: Greater than 90% capacity utilized.

• Red: Card is at 100% capacity; no more streams will be allocated to this card.

Hover over a color block to view percent of utilization.

Grooming Group 
2

Provides color coded and text redundancy status information on available bandwidth for 
all cards in grooming group 2 (either 10 GigE1 or 10 GigE2). Color codes are:

• Green – Less than 70% capacity utilized.

• Yellow – Greater than 70% capacity utilized.

• Orange – Greater than 90% capacity utilized.

• Red – Greater than 100% capacity utilized; some output TSs are currently unassigned. 

Hover over a color block to view percent of utilization.

Table 16. Chassis Tab - System Information - AMP Redundancy

Property Value

Slot n (AMP) Shows if there is an AMP installed in slot 6 or 9 of the VMG-14 chassis or slot 3 or 4 of the 

VMG-6 or VMG-8 chassis, and its current redundancy state. 

• Choices are: Active, Standby, Disabled, or N/A (empty slot). 

Redundancy 
State 

Shows Redundancy state: 

• If one AMP, or the standby AMP has failed, value is: Not Redundant. 

• If two AMPs are fully operational, choices are: Fully Redundant or Not Redundant.
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Card Information

To access information about a specific module in the VMG chassis, bring up the Card Information 
tab:

Hover over the card in the display, and right-click to present the popup menu -> select View Slot 
Properties to present the Card Information tab (Figure 12 and Table 17). The following example 
demonstrates the Card Information tab presented when invoking the popup from the AMP in slot 3. 

Figure 12. VMG Element Manager—Accessing Slot Information

Table 17. Chassis Tab - Card Information 

Section Field Description

Slot 
Information

Slot Number The VMG slot location where the selected card is installed.

Card Type The card type (NPM, AMP, VPM, or TCM) or Blank if no card 
present.

Present Indicates if a card is present in the slot. Yes or No.

Note: See also “Additional Information (...)” on page 33.

Failure Reason The reason for card failure, if a failure has occurred. Used for 
troubleshooting purposes when reporting to customer support. 

Status
Operational State Up or Down. Specifies if the card is functioning (Up) or not (Down).

Admin State Up or Down. Indicates the administrative state of the card.

Version For NPM

For AMP

For TCM

For VPM

Software version, hardware version, and driver version.

Software version, hardware version, and driver version.

Hardware version, and driver version.

Hardware version, and driver version.

Right-click on a slot to access the 
View Slot Properties option. 
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LEDs
(NPM only)

Fault LED Displays the current color/state of the Fault LED for the selected 
card:

• White - Card operation state is down.

• Gray - Card operation admin state is down.

• Green – Normal operation.

• Red – A fault has occurred.

Backup LED Displays the current color/state of the Backup LED for the selected 
card:

• White - Card operation state is down.

• Gray - Card operation admin state is down.

• Green – Card is currently active (in operation).

• Red – Card is currently in standby mode.

Redundancy
(VPM & TCM 
only)

Redundancy Status 
(Grooming Group1)

Indicates the color-coded redundancy capability of the grooming 
group for selected card. Color codes are:

• Green – Grooming group is available for redundancy failover.

• Red – Grooming group is not available for redundancy failover.

Redundancy Status 
(Grooming Group2)

Indicates the color-coded redundancy capability of the grooming 
group for selected card. Color codes are:

• Green – Grooming group is available for redundancy failover.

• Red – Grooming group is not available for redundancy failover.

Table 17. Chassis Tab - Card Information (Continued)

Section Field Description
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Port Information

To access information about a specific NPM GigE port, go to the Port Information tab (Table 17):

Hover over the GigE port of an NPM in the graphic -> right-click and select View Port Properties 
from the popup menu.

Additional Information (...) 

At the System Information tab screen, you can obtain additional information from any topic listed 
alongside an ellipsis. This tab screen provides the option to view tabular details about System Type, 
the fans, the system controller, and SAP in a dialog associated with your selection. For any selection, 
the dialog presents the manufacturer name, part name, part number, manufacturer date, hardware 
revision number, and serial number. 

At the ellipsis ( ... ) use one of the following methods to present the detail dialog:
   - Double-click to go directly to the detail dialog (Figure 13).
or
   -Right-click and select Detail from the popup menu. 

Table 18. Chassis Tab - Port Information 

Section Field Description

Port

Slot Number The VMG slot location of the NPM card where the selected port is 
located.

Port Number The selected GigE port number on the NPM card. The port 
numbers are as follows:

• GigE 1 to GigE 8 – The 1 GigE interfaces.

• 10 GigE 1 – The 10 GigE 1 interface. 

• 10 GigE 2 – The 10 GigE 2 interface. 

Port The name of the selected Gigabit Ethernet port.

IP Address IP address assigned to the port.

MAC Address MAC address of the port.

Subnet Mask Subnet mask of the port.

Gateway The IP address of the gateway.

Status
Admin State Up or Down. Indicates the administrative state of the port.

Operational State Up or Down. Specifies if the port is functioning (Up) or not (Down).
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Figure 13. Chassis tab - Additional Information (...) 
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Grooming tab

The Grooming tab page provides access to tools for managing transport streams and programs and is 
described in the following sections:

• Chapter 8, “Video Processing Overview”

• Chapter 10, “Single Video Transport Streams”

• Chapter 11, “Transcoded+PIP Transport Streams” 

Monitor tab

The Monitor tab allows real-time bitrate monitoring and display of error statistics on input-output 
audio and video elementary streams. Refer to Chapter 16, “Monitoring” for more information.

Alarms & Events tab

The Alarms & Events tab provides information about the current state of the system and is viewable 
at any time. Refer to Chapter 7, “System Alarms and Events” for more information.

VMG Element Manager Software Version

To view the current version of the VMG Element Manager, go to the RGB Networks About dialog 
(Figure 14):

From VMG Element Manager main menu -> Help -> About.

Figure 14. VMG Element Manager About Dialog

Software Version (including build) number 
currently running on the VMG. 
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Quick Keys

The VMG Element Manager contains numerous shortcuts you can use to navigate quickly from the 
main menu, and to adjust views. 

Table 19. VMG Element Manager Quick Keys  

Primary 
Key(s) Key Combinations and Actions

Esc Close all dialog windows at once.

Tab In dialogs, navigate to next editable field.

Alt f Display the File option from the VMG Element Manager main menu. 

• Alt f, Alt e = Log off the current user session and dismiss the VMG Element Manager screen. 

Alt v Display the View options from the VMG Element Manager main menu. 

• Alt v, Alt r = Refresh the current view of the VMG Element Manager screen.

Alt c Display the Configuration options from the VMG Element Manager main menu. 

• Alt c, Alt b = Go to the Bulk Configuration dialog.

• Alt c, Alt g= Go to the Global Configuration tab panel. 

• Alt c, Alt p = Go to the Configure GigE Ports screen.

• Alt c, Alt u = Go to the User Authentication tab panel. 

• Alt c, Alt t = Go to the Trap Configuration dialog.

Alt m Display the Maintenance options from the VMG Element Manager main menu. 

• Alt m, Alt u = Go to the Upgrade Software dialog.

• Alt m, Alt l = Go to the License Manager dialog.

• Alt m, Alt d = Go to the Restore DB Configuration dialog.

• Alt m, Alt r = Go to the Reboot dialog.

• Alt m, Alt s = Go to the System Shutdown confirmation query.

• Alt m, Alt n = Go to the NPM Switchover confirmation query. 

• Alt m, Alt p = Go to the Regroom confirmation query. 

• Alt m, Alt t = Go to the Set Up Time Offset Table (TOT) dialog.

Alt h Display the Help option from the VMG Element Manager main menu.

• Alt h, Alt a = Go to the VMG Element Manager About dialog.
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Clearing the Java Web Start Cache

If you need to downgrade your VMG Element Manager software, be sure to clear the Java web start 
cache, as described in this section. 

Go to the Java Control Panel to get started:

From Windows -> Control Panel, double-click on the Java icon, 
or 
Select Start -> Control Panel -> Java to present the Java Control Panel (Figure 15).

Figure 15. Java Control Panel screen

5. Click the Settings... button in the Temporary Internet Files section. The Temporary Files 
Settings screen (Figure 16) is now presented. 

Figure 16. Temporary Files Settings screen

6. Click the Delete Files... button. The Delete Temporary Files confirmation screen (Figure 17) is 
now presented. 
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Figure 17. Delete Temporary Files screen

7. Ensure that the Applications and Applets option is selected, and click the OK button to clear the 
cache.

Be sure to select 
Applications and Applets
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CHAPTER 4

System Configuration

This chapter describes the tools that are available from the configuration menu of the VMG Element 
Manager. Configuration of global settings, user authentication, and Gigabit Ethernet ports can be 
performed here.

Note: Release 2.5.1 introduced the new Bulk Configuration function from the VMG Element 
Manager main menu. Currently, only MBR-TS configuration is supported via use of the bulk 
configuration tools. 

In This Chapter:

• “Bulk Configuration,” next.

• “Global Configuration” on page 41.

• “User Authentication Configuration” on page 53.

• “SNMP Traps and Trap Configuration” on page 60.

• “Gigabit Ethernet Port Configuration” on page 63.

Bulk Configuration

The bulk configuration function allows the Element Manager Administrator to set up a complete set of 
MBR-TS parameters into a convenient spreadsheet format. Following entry of the settings, the 
spreadsheet can be applied to a VMG to either replace or append the current MBR-TS configuration. 
You can also use the Bulk Configuration screen to clear the current MBR-TS configuration on the 
VMG. 

Note: The Bulk Configuration function is available only to users logged on to the VMG Element 
Manager as Administrator. This function is not available at Operator or User privilege levels. 

To get started with the bulk configuration tools, the administrator must access the Bulk Configuration 
screen to get the spreadsheet components:. 

From the VMG Element Manager, select Configuration -> Bulk Configuration to present the Bulk 
Configuration screen (Figure 18 and Table 20). 

See Chapter 5, Bulk Configuration on Page 72 to find out how to use the VMG Bulk Configuration 
Tools. 
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Figure 18. Bulk Configuration screen

Use this field to specify
the bulk configuration
software program tool
.exe)

Use this field to specify
the bulk configuration
spreadsheet package
(.xls)

Table 20. VMG-8 components  

Field Description

File Provides graceful exit from the Bulk Configuration screen. 

System Provides the Download Bulk Configuration Software option. 

Option Drop-down selector to select one of the following options:

Note: In the current release, bulk configuration applies only to 
MBR.

• Replace current TS database with new TS configuration

The bulk configuration tool clears all transport streams and configures the 
transport stream based on the configuration file read from the VMG-8. 
The system needs to be out of service when using this option.

• Append new configuration to existing TS database

The bulk configuration appends the transport streams based on the bulk 
configuration file. The system can remain in service when using this 
option.

• Clear the TS database

The bulk configuration clears all current transport streams. The system 
needs to be out of service when using this option. 

• Save current TS database to new Configuration File

Retains the existing configuration file under a new configuration file name. 

Application File The location of the application file. 

Default path: c:\vmgConfigTool_MTS\config_vmg.exe

Source Configuration File The location of the Excel (.xls) configuration source file. Refer to the VMG 
Bulk Configuration Tool Administrator’s Guide for complete details about the 
configuration files (spreadsheets). 

Target IP Address IP address of the VMG on which the bulk configuration will be deployed. 
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Global Configuration

Use the Global Configuration screen to view and configure settings that are applicable to the VMG 
chassis. 

From the VMG Element Manager, select Configuration -> Global 
or

Click the Global Configuration icon at the VMG Element Manager toolbar to present the Global 
Configuration screen. 

The tab pages available in the Global Configuration screen are described in the following sections:

• “System Tab,”  next.

• “Management Interface Tab” on page 44.

• “Grooming Group tab” on page 46.

• “Redundancy Switch Tab” on page 49.

• “Transcoder Tab” on page 50.

• “Dolby Tab” on page 51.

System Tab

Use the System tab to set and configure network timing protocol (NTP) servers, system time, and 
syslog settings. 

From the VMG Element Manager main menu, select Configuration -> Global -> System to present 
the System Tab (Figure 19 and Table 21). 

Status Messages Status message display area, which populates with INFO and/or ERROR 
messages after you press the Execute button. Messages continue to display 
until completion of the configuration at the VMG. 

Execute Use the settings in this screen to begin sending the spreadsheet 
configuration to the VMG system. Prior to upload, the system will query for 
Administrator password. 

Table 20. VMG-8 components  (Continued)

Field Description
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Figure 19. Global Configuration - System tab

Table 21. Global Configuration - System Settings

Category/
Section Field Description Default

NTP NTP Address 1
...
NTP Address 5

Type the IP address(es) of the NTP server(s) to use for 
time synchronization. Up to five NTP servers can be 
specified.

Blank 

Status View current status of NTP server, as either Active or 
Inactive. 

Read-only 

System Time Time Zone Drop-down selector, to define the local time zone relative 
to UTC (GMT) time.

From NTP 

System Time Drop-down panel, to define the system time (see also 
Figure 21).

From NTP 

Syslog Server Syslog IP 
Address

Type the IP address of the syslog server. Blank 

Syslog Port Type the port number to be used at the syslog server. 514 

System Event 
 Max Count 
(50...10000)

Type the maximum number of events, in the range 50-
10,000, to be displayed in the Element Manager > Alarms 
& Events > Event History screen.

500
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About NTP

NTP provides the mechanisms to synchronize and coordinate time distribution over a computer 
network using a reference clock. NTP uses a hierarchical configuration of synchronized time servers, 
in a distributed subnet, to deliver reference time to requesting clients using local routing algorithms. 
NTP is used to provide accurate timestamps for system log messages and program splicing.

Note: NTP server connectivity must be tested to ensure proper system time synchronization and 
system operation. 

When configuring NTP, up to five systems on the network can be specified as authoritative time 
sources/servers. It is important to select reliable and reachable local NTP servers in order to maintain 
clock accuracy and synchronization.

An NTP server is required for splicing when performing digital program insertion (DPI). If not using 
NTP, the Time Zone (Figure 19) and System Time (Figure 21) fields must be manually set, using the 
drop down options from the System tab page.

Figure 20. System Time Zone Configuration

Select a time zone from
the drop-down selector.
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Figure 21. System Time Configuration

About VMG Syslogs

The VMG generates system log messages (syslog messages) that record alarms and events occurring 
in the system. Each syslog message contains a time stamp of when the event occurred, a description of 
the event, and the severity of the event. Refer to Chapter 7, “System Alarms and Events” and 
Appendix B, “VMG Alarms and Events” for more information on alarms and events.

Note: The syslog also contains debug messages intended for internal RGB use that are not 
documented in this user guide. 

Management Interface Tab

The VMG chassis allows for two separately addressed NPMs to be installed to provide network 
connection redundancy. Configuring a virtual IP address for the VMG system means that 
IP connectivity to the VMG remains unchanged regardless of which NPM is active. 

When configuring the VMG for the first time, the physical IP address of the NPM must first be set 
through Telnet access or GUI to the VMG or serial console access (see Chapter 4, “Initial 
Configuration,” of the VMG Hardware Setup Guide for more information). Once the physical 
IP addresses have been set for both NPMs (the active NPM and the backup NPM if you are 
configuring NPM redundancy for your system), you can then point your browser to the physical 
IP address configured for the active NPM in order to configure theVMG’s Virtual IP address. 

Use the Management Interface tab to configure a single global Virtual IP address for the VMG 
system and to edit the physical IP address of the active NPM card. 

Select month, year,
and day, or click Today
to set the current 

date. 

Select values to set 
system hour, minute,
second; AM or PM.
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From the VMG Element Manager main menu, select Configuration -> Global -> Management 
Interface to present the Management Interface tab (Figure 22 and Table 22). 

Figure 22. Global Configuration - Management Interface tab 

Table 22. Global Configuration - Management Interface Settings

Section Field Description Default

Mac Address View the MAC address of the active NPM. Read-only

Virtual IP Address IP Address Type the virtual IP address of the VMG that 
the installed NPM(s) will use for management 
traffic. 

Blank 

Subnet Mask Type the subnet mask of the VMG’s virtual 
IP address. 

Blank 

Gateway for Active 
NPM Physical and 
Virtual

Gateway Type the IP address of the default router for 
the system.

Blank

Active NPM 
Physical IP Address

IP Address View the physical IP address of the active 
NPM card.

Auto-
populated 
based on 
config

Subnet Mask View the subnet mask of the active NPM card. Auto-
populated 
based on 
config
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Management IP Address Configuration Guidelines

The following guidelines must be considered when configuring or editing the Virtual IP Address or 
the NPM Physical IP Address sections.

Note: The 10.0.1x and 10.0.2x subnets are reserved for VMG internal use only and cannot be used 
for the management interface. 

• To edit the Active NPM Physical IP Address section, there can be no Virtual IP Address 
information configured. If a virtual IP Address has already been configured, you will need to 
delete the address, apply the changes, and re-login to the VMG Element Manager before being able 
to modify the Active NPM Physical Address section.

• When changes to either the Virtual IP Address or Subnet Mask have been applied, the 
VMG Element Manager will close and you will have to re-login using the new IP configuration.

• When changes to either the Active NPM Physical IP Address or Subnet Mask have been 
applied, the VMG Element Manager will close and you will have to re-login using the new 
IP configuration.

• The Active NPM Physical Address and Subnet Mask fields cannot be blank.

• The Virtual IP Address configuration cannot be changed at the same time as the Active NPM 
Physical IP Address configuration, and vice versa. 

Grooming Group tab

Use the Grooming Group tab to enable GigE grooming groups, which is necessary to retain 
connectivity with certain ad servers after an NPM switchover. 

You can enable or disable one of the grouping categories displayed in the Grooming Group tab page, 
using the following considerations:

• The VMG must be rebooted whenever a group is enabled or disabled. 

• Only one group may be selected: the groups cannot be enabled / disabled at once. 

See also “Configuration Guidelines for Grooming Groups” on page 47 for additional information. 

Note: You must set up and enable all desired grooming groups before configuring and grooming any 
program. Disabling of the 10 GigE 1 or 10 GigE 2 grooming group will remove all grooming 
for the port.

From the VMG Element Manager main menu, select Configuration -> Global -> Grooming Group 
to present the Grooming Group tab (Figure 23 and Table 23). 
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Figure 23. Global Configuration - Grooming Group tab.

Configuration Guidelines for Grooming Groups

The VMG recognizes three groupings for the NPM Gigabit Ethernet ports (Figure 24), which can be 
combined as shown in Table 24:

Note: For conceptual purposes only, the groupings are identified in this section as Group A, Group 
B, and Group C. 

• Group A — the eight 1GigE ports (labeled SFP 01 to SFP 08) 

• Group B — the 10GigE 1 port (labeled XFP2)

• Group C — the 10GigE 2 port (labeled XFP1)

Your groupings will be displayed at the highest level of the trees contained within the input and output 
columns of the Grooming tab page. Groups displayed in the Grooming tab page are ready for service 
configurations. 

Table 23. Global Configuration - Grooming Group Settings

Field Description Default

Grooming Group 
Enable

Enable (check) or disable (un-check) one of the following 
groups:

• 8X1 1GigE

• 10GigE 1

• 10GigE 2 



8X1 1GigE = checked 

10GigE 1 = un-checked 

10GigE 2 = un-checked 
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Figure 24. NPM Port Grouping

Video processing considerations. The NPM provides video processing capabilities based on the 
groups configured. Video processing for grooming input and output transport streams cannot span 
across the two groups. For example, an input transport stream from Group A must be associated with 
an output transport stream in Group A; it cannot use an output transport stream in Group B or Group C. 

General considerations about grooming groups.  

• When a grooming group is enabled or disabled, the VMG must be rebooted.

• 10GigE 1 and 10GigE 2 cannot be enabled together at any time.

• Only two grooming groups can exist on the VMG at any time.

• A grooming group cannot be disabled if settings are in place at the Configure GigE Ports 
screen (Figure 40) for any port in that group.

• If only one grooming group is being used on the VMG (e.g., Ports 1-8 in Group A, or only the 
10GigE 2 group), consider disabling all unused groups to maximize bandwidth allocation for 
the used groups. 

Note: The VMG supports transcoding only on the Group A grooming group. 

Table 24. Valid Grooming Group Combinations 

Enabled Grooming Groups Validity 

Group A + Group B Valid

Group A + Group C Valid

Group A alone Valid

Group B alone Valid

Group C alone Valid

Group A + B + C Invalid

Group B + C Invalid

Group B Group C Group A
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Redundancy Switch Tab

For operations as a redundant system, up to two NPMs can be installed in the VMG. During operations 
as a redundant system, one of the NPMs processes requests in active mode, and the other NPM resides 
in standby mode. If the active NPM encounters a failure condition, the standby NPM automatically 
‘switches over’ to become the active NPM. This is the default and recommended behavior and setting.

This setting is controlled at the Redundancy Switch tab page (Figure 25), from which NPM 
redundancy can be further managed by applying one of the predefined link state determinants.

Note: The Redundancy Switch setting should only be enabled when performing system maintenance, 
such as for a system upgrades. It is not recommended for use during normal operations 
because it forces the system into a non-redundant configuration.

Use the Redundancy Switch tab page to modify switchover of the NPMs in the VMG. 

From the VMG Element Manager main menu, select Configuration -> Global -> Redundancy 
Switch to present the Redundancy Switch tab page (Figure 25). 

Figure 25. Global Configuration - Redundancy Switch tab

1. At the Redundancy Switch tab page, define the NPM switchover behavior:

- To allow NPM redundancy, click Enabled. 

- To inhibit NPM redundancy, click Disabled. 

- Select one of the link state determinant options for the switchover.

2. Click Apply to commit the settings. 

Note: This setting has no effect on a system that deploys only one NPM. 
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Transcoder Tab

Use the Transcoder tab page to globally adjust quality of video elementary stream output. This is done 
by enabling or disabling Smooth Video Bitrate and/or Hypothetical Reference Decoding. The 
Transcoder tab page also provides the option to define global implementation of an Encoder 
Boundary Point (EBP) for elementary streams. 

An EBP refers to metadata (data about data) that is inserted—at segment and/or fragment 
boundaries— to audio or video elementary streams intended for use in adaptive streaming 
applications. 

• EBPs may be used by downstream equipment, such as packagers (if they support EBP) to assist in 
the creation of discrete sections of de-codable content from the continuous streams. 

• EBPs may also be added at cue-induced boundaries to facilitate the insertion of ads or other 
alternate content. 

From the VMG Element Manager main menu, select Configuration -> Global -> Transcoder to 
present the Transcoder tab page (Figure 26 and Table 25). 

Figure 26. Global Configuration - Transcoder tab

1. At the Global Configuration Transcoder tab page, select enable or disable, as required.

2. Click Apply to use your settings. 
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Note: Changes that are applied to the VMG’s Global Transcode configuration result in automatic 
reboot of the VMG and interruption to services.

Dolby Tab

Use the Dolby Advanced Decoder Parameters tab page to set global AC-3 and E-AC-3(Dolby 
Digital Plus) decode parameters, which will be applicable to the entire VMG system where input 
streams are AC-3 or E-AC-3 (Dolby Digital Plus) types. The settings can be modified at any time but 
will take effect only on new sessions subsequent to your entries in the tab page. 

From the VMG Element Manager main menu, select Configuration -> Global -> Dolby to present the 
Dolby Advanced Decoder Parameters tab page (Figure 27 and Table 26). 

Note: Changes that are applied to the VMG’s Global Dolby configuration result in automatic reboot 
of the VMG and interruption to services.

Table 25. Transcode—Transcoder Configuration Options  

Field Description Default

Smooth Video 
Bitrate 

Enable or disable smoothing on all output video elementary streams. 
When enabled, neutral packets are inserted into the video layer when 
the encoder buffer model overflows. The insertion of the zero bytes 
forces the video output to use up allocated video bandwidth. 

In most cases, this option will smooth the output. However, if there is a 
large gap between video ES bitrate and transport stream bitrate, the 
video output may still be bursty.

Disabled

HDR Parameter 
Insertion 

Enable or disable inclusion of HDR parameters in the video 
elementary stream. 

Disabled

Encoder 
Boundary Point 
(EBP) 

Enable or disable employment of Encoder Boundary Points in MBR 
output streams. 

When enabled: 

• An EBP fragment marker will be inserted in every IDR. 

• An EBP fragment and segment marker will be inserted at every cue-
induced boundary.

Disabled

EBP Segment 
Length

Value, in the range 0 to 30, to define the number of segments allowed 
between Instantaneous Decoding Refresh (IDR) fragment markers.

Click Enabled at Encoder Boundary Point to activate this EBP 
Segment Length field. 

0 (none)



VMG Element Manager User Guide 52

Release 3.1.3 Global Configuration

Figure 27. Global Configuration - Dolby

1. At the Global Configuration Dolby tab page, set parameters to control compression, input 
validations, and stereo output.

2. Click Apply to use your settings. 

- Any entry errors detected for dynamic ranges will result in yellow fills at those fields. 

To continue, you will need to re-enter values—following advice in the guide text beneath the 
field(s)—and click Apply again. 

- Upon successful data entry, an Information screen is presented (Figure 28). 
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Figure 28. Global Configuration - Dolby—Grooming Information

User Authentication Configuration

Use the VMG user authentication functions to view and configure settings that control user access to 
the VMG chassis. The VMG allows both local and remote user authentication. Remote user 
authentication is performed using an authentication, authorization, and accounting (AAA) server that 
supports RADIUS or TACACS+.

An AAA server handles requests for access to system resources. It provides a central location for 
policies to be configured, allowing maintenance of user profiles to be performed once for any number 
of clients. When a client wants to access a system resource, it must first gain permission from the AAA 
server.

Table 26. Dolby—Capabilities and Advanced Decoder Parameters 

Field Description Default

E-AC-3 (Dolby 
Digital Plus) 
decode capability

Enable (ON) or disable (OFF) E-AC-3 (Dolby Digital Plus) decoding. 

When enabled, AMP resource allocation for E-AC-3 (Dolby Digital 
Plus) input is expanded. 

OFF

Compression 
mode

Compression mode to be applied globally, as one of the following:

0 - Custom mode (no digital dialog normalization).

1 - Custom mode (digital dialog normalization).

2 - Line out mode.

3 - RF mode.

0

Dynamic range 
scale low

Value, in the range 0 to 1.0, to define low range scale by which to 
validate input. As appropriate for your locale, type a comma or a 
period symbol to designate the decimal point in your entry. 

1

Dynamic range 
scale high

Value, in the range 0 to 1.0, to define high range scale by which to 
validate input. As appropriate for your locale, type a comma or a 
period symbol to designate the decimal point in your entry (see also 
“Dolby Dynamic Range Scale Entry Guidelines” on page 312). 

0

Stereo output 
downmix mode

Stereo output downmix mode to be applied globally, as one of the 
following:

0 - Automatically detect stereo mode.

1 - 2/0 Dolby Surround compatible (Lt, Rt).

2 - 2/0 Stereo (Lo, Ro).

1 - 2/20
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The VMG provides a local user fallback authentication method enabling users to log in when an AAA 
server is not available. However, for security and account management reasons, it is recommended to 
use AAA. All passwords configured for AAA—both remote and local— are encrypted.

The following workflow (Figure 29) describes the behavior of the authentication process when a user 
attempts to login in to the VMG.

Figure 29. VMG User Authentication Workflow
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Accessing User Authentication Tools

From the VMG Element Manager main menu, select Configuration -> User Authentication to 
present the User Authentication screen. The tabs available in the User Authentication screen are 
described in the following sections:

• “Global Tab,”  next.

• “Local Tab” on page 56.

• “Servers Tab” on page 57.

Global Tab

Use the Global tab to configure global AAA options for the VMG system. 

From the VMG Element Manager main menu, select Configuration -> User Authentication -> 
Global to present the Global tab (Figure 30 and Table 27).

Figure 30. User Authentication - Global tab. 

Table 27. User Authentication - AAA Global Configuration settings  

Field Description Default

Enable Check to enable authentication using a specified AAA server. When 
checked, configuration fields are displayed in the User 
Authentication screen. 

Un-check to use local user authentication.

Un-checked 

Number of 
Retries

Value, in the range 0 to 2, to define the number of times the system 
will try connecting to a remote server before trying another server in 
the list. 

0

Timeout (Sec) Value, in the range 1 to 4, to define the amount of time (in seconds) to 
wait for a response from the remote server.

2

Disabled Enabled



VMG Element Manager User Guide 56

Release 3.1.3 User Authentication Configuration

Local Tab

The User Authentication Local tab permits the VMG Element Manager Administrator to configure 
local user account passwords, for access to the VMG. 

From the VMG Element Manager main menu, select Configuration -> User Authentication -> Local 
to present the Local tab (Figure 31). 

Figure 31. User Authentication - Local tab

Setting the User Role and Password

At the User Authentication screen, click Change Password to reveal the password configuration 
fields (Figure 32 and Table 28).

Figure 32. User Authentication - Role and Password Configuration 

Protocol Protocol to be used for server selection, as one of the following:

• No Preference – No protocol preference.

• Radius – Try all RADIUS servers before trying TACACS+ servers.

• TACACS+ – Try all TACACS+ servers before trying RADIUS 
servers.

Radius 

Remote Only Requires the VMG to use only remote authentication. If enabled and 
remote authentication fails or a connection to the AAA server is not 
established, local authentication is not performed and the user is not 
logged in.

Un-checked 

Table 27. User Authentication - AAA Global Configuration settings  (Continued)

Field Description Default
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Note: Local settings apply only if AAA is disabled, or if the AAA server is unreachable and Remote 
Only in the Global tab is not enabled.

Local User Accounts

The VMG provides three local user accounts (Table 29) with different levels of access to the VMG 
system. Each local user account has specific permissions. At the VMG Element Manager screens, the 
features not available to a specific account type are grayed-out and cannot be selected or modified.

Servers Tab

Use the Servers tab to set up and configure the AAA servers to be used by the VMG system. 

From the VMG Element Manager main menu, select Configuration -> User Authentication -> 
Servers to present the Servers tab (Figure 33).

Figure 33. User Authentication - Servers tab

Table 28. User Authentication - Local settings 

Field Description Default

User User account name for which to change the password, as 
either Administrator, Operator, or User.

Administrator 

Old Password The old password for the specified local user account. Blank 

New Password The new password for the specified local user account. Local 
passwords are saved as encrypted data in the VMG 
configuration database. 

Blank 

Retype New Password Confirmation of the new password for the specified local user 
account.

Blank 

Table 29. Local User Accounts 

User Description Default Password

User Read-only access account. No changes to the configuration are 
allowed.

User

Operator Read and write access are allowed for all configuration operations 
except changing passwords. This is the normal login user account.

Operator

Administrator Full access to the VMG system configuration is allowed. This is the 
only user account that is authorized to change passwords.

Admin
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The Servers tab lists the currently configured AAA servers that are to be used by the VMG system for 
user authentication. From here AAA servers can be provisioned, as described in the following 
sections:

• “Adding or Editing AAA servers,” next.

• “Reordering Server List” on page 59.

• “Deleting Servers” on page 60.

Adding or Editing AAA servers

Use the Add / Edit AAA Server screen to add new AAA servers or to edit existing AAA servers. The 
system allows up to eight AAA servers. 

From the VMG Element Manager main menu, select Configuration -> User Authentication -> 
Servers, to present the Servers tab, then click the Add button to present the Edit AAA Server screen 
(Figure 34 and Table 30).

Figure 34. Add/Edit AAA Server 

Table 30. User Authentication - Servers - Add/Edit AAA Server settings

Field Description Default

IP Address The IP address of the AAA server. Blank 

Port Value, in the range 0 - 65536, to define the port to use on the AAA 
server. Radius uses UDP ports. Tacacs+ uses TCP ports 

Radius: 1812

Protocol The authentication protocol to use when communicating with the 
AAA server, as either Radius or Tacacs+. 

Radius

Shared Secret Type the password, or passphrase to be used to authenticate with 
the AAA server.

Blank 

Retype Shared Secret Retype shared secret string, exactly as for previous field. Blank 

Enable Enable (check) or disable (un-check) associated AAA server. If a 
server is not enabled, it is not available to be selected by the 
VMG.

Un-checked
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Reordering Server List

Use the Edit AAA Server Order screen to modify the sequence to be used by the VMG when 
searching for AAA servers. 

From the VMG Element Manager main menu, select Configuration -> User Authentication -> 
Servers to present the Servers tab, then click the Set Order button to present the Edit AAA Server 
Order screen (Figure 35 and Table 31). 

Figure 35. Edit AAA Server Order
 

 

Note: The numbers used in these fields refer to the index numbers shown in the first column of the 
Configuration -> User Authentication -> Servers tab of the VMG Element Manager menu. 
See Figure 33 on page 57.

The order in which the system attempts to connect to an AAA server is based on the following 
conditions:

• The preferred authentication protocol specified in the Protocol field of the User Authentication -> 
Global tab.

• The current server order as shown in the Order column of the User Authentication -> Servers tab.

- If the preferred authentication protocol is set to Radius, all RADIUS servers will be tried first, 
followed by TACACS+ servers. 

- If set to TACACS+, all TACACS+ servers will be tried first, followed by RADIUS servers. 

- If no protocol preference was specified (the default), the servers will be tried based on the 
current server order.

For example, if four AAA servers have been added to the AAA server list (Table 32) and the specified 
protocol preference is Radius, the order in which the servers are tried is: A, D, B, C.

Table 31. User Authentication - Servers - Edit AAA Server Order settings

Field Description

Current Order Displays the current server order. The default server order is the order in 
which the AAA servers were added to the list. This field is read-only.

Change Order to The new server order to use. Separate each number with one space. 

Table 32. AAA Server List Example 

AAA Server
Current 
Server Order Protocol

A 1 RADIUS

B 2 TACACS+
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Deleting Servers

From the VMG Element Manager main menu, select Configuration -> User Authentication -> 
Servers to present the Servers tab. 

In the Servers tab, select the last AAA server to delete from the list, then click the Delete button. 

The Servers tab will only allow deletion of a server in last-to-first order. For example, if there are four 
servers in the order of 1, 2, 3, 4, the order in which the servers must be deleted is: 4, 3, 2, 1. 

Note: To delete a server whose order is not last, reorder the servers to change the desired deletion to 
the last number in that order. 

Note: The index number is not relevant to the order of server deletion; it is the order in which the 
servers are configured to prioritize which is relevant to deletion. 

SNMP Traps and Trap Configuration 

The VMG reports both alarms and events to the VMG Element Manager. 

• Each event is reported once and logged to the event history. 

• Each alarm can be reported twice—once when raised, and once when acknowledged. These 
occurrences are also reported in the event log. 

• Alarms are sent to the designated trap server(s) when they are raised and acknowledged. 

• Service impacting error events are sent to the designated trap server(s) when they are reported. 

The VMG reports alarms upon detection of various hardware and service-impacting errors. Service-
impacting errors may result in alarms associated with problems on the input stream (such as transport 
stream missing) or problems on the output stream (such as where grooming errors are detected). To 
reference the full list of alarms and associated criticalities, see Appendix B, VMG Alarms and Events – 
beginning on page 314. 

Traps and Error Counters

Input errors that are detected on the output elementary stream—DTS jump, PCR error, video 
underflow, and PCR reset—are reported to the trap server, and associated error counters are recorded 
on both the output and the input elementary streams. 

Traps are cleared when reporting no longer occurs about the error(s). And, if any error is repeated 
within the 60-second window, no new trap is generated. 

C 3 TACACS+

D 4 RADIUS

Table 32. AAA Server List Example (Continued)

AAA Server
Current 
Server Order Protocol
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Input errors that must be detected by the output video ES—CC error, Decoder error, packet loss, frame 
loss, packet drop, and TEI error—are the actual accumulated error occurrences detected on the output 
ES, and cannot be reset. 

• The output ES counters are the actual accumulated error occurrences, as detected on the output ES, 
and cannot be reset. 

• The counters on the input ES reveal the number of times that outputs reported each error. 

You can set up, generate, and view dynamic reports of error counts by using the VMG Element 
Manager monitoring tools, as described in “Viewing Elementary Stream Traffic Details” on page 293. 

Note: It is helpful to use the VMG Element Manager monitoring tools to examine causes of stream 
alarms, to set up various types of counters for generation of performance statistics. See also 
Chapter 16, “Monitoring,” beginning on page page 291, for more information. 

The VMG Element Manager provides trap configuration tools that you can use to set up SNMPv1 or 
SNMPv2c trap client destinations. This section describes how to add or remove IP addresses use for 
VMG trap configurations, in the following topics:

• “Adding IP Addresses for Trap Configuration,” next. 

• “Deleting Trap Servers” on page 62.

Adding IP Addresses for Trap Configuration

You may enter several trap servers for the VMG. Each trap server is defined at the VMG Element 
Manager by an IP address, an SNMP version, and a community string entry. 

Use the Trap Configuration screen to set trap parameters: 

From the VMG Element Manager main menu, select Configuration -> Trap Configuration to present 
the Trap Configuration screen (Figure 36).

1. In the Trap Configuration screen, click Add to present the Configure Trap dialog (Figure 36 
and Table 33).

2. At the Configure Trap dialog, enter an IP address for a VMG, and the SNMP version and 
password (community string) to be used, then click Apply. 

Your configuration will now be displayed in the Trap Configuration screen (Figure 37).
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Figure 36. Trap Configuration - Add IP Address 



Figure 37. Trap Configuration screen, displaying designated trap servers.

Deleting Trap Servers

Use steps in this section to remove a specified trap server from the Trap Configuration screen. 

1. In the Trap Configuration screen select the trap server to be deleted, then click Delete. 

2. At the Delete Confirmation popup screen (Figure 38), click Yes.

Figure 38. Delete IP Confirmation popup

Table 33. Configure Trap Parameters

Field Description Default

IP Address Type the IP address (IPv4) of the trap server, in dotted decimal 
format.

Blank 

SNMP Version Set SNMP version as either v1, or v2. v1

Community String Set the password string to be exchanged (as cleartext) between 
the VMG and the designated trap server. 

public
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Gigabit Ethernet Port Configuration

Use the Configure GigE Ports screen, for either One-IP address mode or Three-IP address mode, to 
view and configure settings that control the NPM Gigabit Ethernet ports. 

Note: You can adjust the IP Address mode at any time. The system will prompt for confirmation of an 
adjustment between the IP address modes, and the change will result in momentary service 
interruption. 

To enable operations for GigE port pairs, use the Configure GigE Ports screen to assign either one 
address (when using One-IP address mode) or three addresses (when using Three-IP address mode). 
Using the Three-IP address mode is beneficial if you need to ensure the fastest NPM switchover 
possible on the VMG. 

Note: Beginning with VMG Release 3.0.3, GigE options for both One-IP and Three-IP address 
modes are supported. Refer to Table 34 for information about previous releases. 

Duplication and conflicts with IP addressing are not allowed and the system prevents these errors 
(during configuration) by issuing an error message upon detection of an attempt to apply faulty address 
settings. The following rules for assignment of subnets apply to any IP address mode:

• All the virtual and physical IP addresses of a GigE port must be in the same subnet. 

For example, virtual IP address of 1.2.3.1, physical IP addresses of 1.2.3.11 and 1.2.3.21 and a 
subnet mask of 255.255.255.0 (Figure 40).

• Each GigE port must have a unique subnetwork. 

For example, the addresses of GigE 1 might begin with 1.2.3 while the addresses of GigE 2 might 
begin with 1.2.4 (Figure 40).

• Each GigE port’s subnet must contain at least four IP addresses. 

For example, the subnet mask must not be 255.255.255.255 or 255.255.255.254. 

Table 34. IP Address Options and VMG Releases

VMG Release

GigE Address Modes

One-IP Three-IP

2.5.x (and previous) Yes No

3.0.0 No Yes

3.0.1 No Yes

3.0.2 No Yes

3.0.2p1 No Yes

3.0.3 Yes Yes

3.1.x Yes Yes
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One-IP Address Mode for GigE Ports

For One-IP address mode, each enabled port pair must be assigned a valid and unique IP address. Ports 
not enabled need not be assigned addresses. 

Each GigE port pairing on redundant NPMs is allocated a single IP address. This address floats with 
the active redundancy mode of both NPMs, and is assigned (in the Configure GigE Ports screen for 
One-IP address mode) to the GigE port of the active card only. Upon switchover, the VMG tears down 
this IP address from the previous active NPM GigE port then sets it up on the newly active NPM port. 

Use the Configure GigE Ports screen, in One-IP address mode, to assign IP addresses to NPM GigE 
ports. 

From the VMG Element Manager main menu, select Configuration -> Gige Ports to present the 
Configure GigE Ports screen (Figure 40 and Table 35). Ensure that the drop-down selector is set for 
One-IP. 
or
From the Chassis tab page, right-click on an NPM and select Configure GigE Ports from the popup 
menu. 

1. At the Configure GigE Ports screen for One-IP, set IP Address and Subnet Mask for GigE ports 
on the active NPM. 

2. Use guidelines from Table 35 to enter other GigE port information for the active NPM. 

3. Click Apply to save and use your GigE port configuration. 

Figure 39. Configure GigE Ports—One-IP 
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Three-IP Address Mode for GigE Ports

For Three-IP address mode, each enabled port pair must be configured with three valid and unique 
IP addresses: one virtual IP address, and two physical IP addresses:

• Virtual IP Address
This address floats with the active mode of the GigE port pair.

• Physical IP Address (for the lower-numbered NPM slot). 

- VMG-14: slot 7

- VMG -6 or VMG-8: slot 1

This address does not float with the active mode of the GigE port pair. 

• Physical IP Address (for the high-numbered NPM slot). 

- VMG-14: slot 8

- VMG-6 or VMG-8: slot 2

This address does not float with the active mode of the GigE port pair. 

Use the Configure GigE Ports screen, in Three-IP mode, to assign both virtual and physical network 
addresses to the NPM’s GigE ports. 

From the VMG Element Manager main menu, select Configuration -> Gige Ports to present the 
Configure GigE Ports screen (Figure 40 and Table 35). Ensure that the drop-down selector is set for 
Three-IP. 
or
From the Chassis tab page, right-click on an NPM and select Configure GigE Ports from the popup 
menu. 

Figure 40. Configure GigE Ports—Three-IP 

1. At the Configure GigE Ports screen for Three-IP, set Virtual IP Address, Physical IP 
Addresses for both NPM slots, and Subnet Mask for the administratively enabled GigE ports on 
the active NPM. 
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2. Use guidelines from Table 35 to enter other GigE port information for the active NPM. 

3. Click Apply to save and use your GigE port configuration. 

GigE IP Address Parameters

Use information from Table 35 for entries in the Configure GigE Ports screen.

Table 35. Gigabit Ethernet Port Configuration Fields 

Field Description Default

Mode Drop-down selector from which to define the IP Addressing mode to 
be used with the NPM(s), as either One-IP or Three-IP.

You can toggle between these modes at any time. The system will 
prompt for confirmation to proceed with a mode change, and 
momentary service interruption will occur with the change. 

Three-IP

Port The Gigabit Ethernet port numbers on the NPM. If the port is 
administratively enabled and operationally Up, the icon is green. 

Read-only 

Port Enabled Enable (check) or disable (un-check) a specified GigE port. Un-checked 

Input Link State 
Redundancy

Click to enable (check) or disable (un-check) input link state based 
redundancy for the GigE port. 

Un-checked

MAC Address View the physical MAC address of the port. 

An “(A)” next to the MAC address indicates the NPM’s physical 
MAC is the active MAC for the system. 

Read-only 

Name Type and alphanumeric string to define name for the GigE 
interface. The configured name will be displayed in the Grooming --
> Mapping tab page. 

Blank 

IP Address For One-IP mode: the valid, unique IP address for the port. Blank

Virtual IP Address For Three-IP mode: Type a network address for use as the virtual 
IP address for the GigE port. Each enabled GigE port must be 
configured with one virtual IP address, and two physical IP 
addresses. 

Blank

Physical IP 
Address (slot 1)

for Three-IP mode: Type the IP address of the GigE port associated 
with the NPM in VMG in the lowest-numbered slot. 

• For VMG-6 and VMG-8: Slot 1 in this screen is equivalent to slot 
1 at the system.

• For VMG-14: Slot 1 in this screen is equivalent to slot 7 at the 
system

Blank 

Physical IP 
Address (slot 2)

For Three-IP mode: Type the IP address of the GigE port 
associated with the NPM in VMG in the higher-numbered slot. 

• For VMG-6 and VMG-8: Slot 2 in this screen is equivalent to slot 
2 at the system.

• For VMG-14: Slot 2 in this screen is equivalent to slot 8 at the 
system

Blank

Subnet Mask The subnet mask for the interface. Blank 

Gateway The default router IP address for the port, if applicable. Blank 

Auto Negotiation Enable (check) or disable (un-check) auto negotiation on the GigE 
port. This option is applicable only for GigE 1-8. It is not applicable 
for 10GigE 1 or 10GigE 2.

Un-checked 
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Output Port Mirroring

The VMG supports replication (mirroring) of all traffic sent out on one GigE port (the source port) to 
another GigE port (the mirrored-to port). The port mirroring functionality can serve one of two 
purposes:

• Capture traffic sent out on a port for analysis, by mirroring the traffic to another port.

• Support for downstream device redundancy where the outputs from a VMG are replicated across 
two different paths, thus allowing for greater network resiliency in the event that a downstream 
device goes out of service.

The source port can carry both input and output traffic; however, only the output traffic is mirrored. 
Port mirroring can only be configured between the following port pairs:

• GigE 1 output can be mirrored to GigE 2.

• GigE 3 output can be mirrored to GigE 4.

• GigE 5 output can be mirrored to GigE 6.

• GigE 7 output can be mirrored to GigE 8 (unless the AMP Connection is enabled).

Configuring Output Port Mirroring

Use the Configure GigE Ports screen to set parameters for the output interfaces subject to port 
mirroring.

From the VMG Element Manager main menu, select Configuration -> GigE Ports to present 
the Configure GigE Ports screen (Figure 41).
1. Click the checkbox for the port you want to mirror output traffic to. The example in Figure 41 

demonstrates mirroring of output from GigE 5 to GigE 6.

Strict ARP Specifies whether or not an ARP response will be sent if the 
IP address in the request matches the IP address of the GigE port 
on which the request is received. Values are:

• Checked (enabled) – an ARP response will only be sent if ARP 
request IP matches the GigE port IP. (recommended)

• Un-checked (disabled) – an ARP response will be sent to any 
ARP request on any GigE port.

Note: To set Strict ARP, an IP address must first be configured for 
the GigE port.

Checked

Mirror Output To Check this box to mirror the port’s output to the designated port. 
See also “Output Port Mirroring” on page 67 for details.

Un-checked

AMP Connection Check this box to connect ports 7 and 8 to the paired AMP card. 
This connection is necessary to use MBR transport streams. See 
also “AMP Connection” on page 69 for details.

Un-checked

Table 35. Gigabit Ethernet Port Configuration Fields (Continued)

Field Description Default
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Figure 41. Configure GigE Ports - Output Port Mirroring

2. Click Apply to dismiss the screen and use your settings. 

Note: The Element Manager checks whether there are any input or output Transport Streams 
configured on the mirrored-to port. If there are, an error message appears directing you to 
first delete all transport streams from the mirrored-to port.

3. Verify your settings.

Go to the Grooming tab Mapping page (Figure 42). The Output mirrored to n message should be 
displayed alongside the source port. 

Note: You will not be able to configure any input or output transport streams on the mirrored-to port.

Figure 42. Grooming - Output Port Mirroring



VMG Element Manager User Guide 69

Release 3.1.3 Gigabit Ethernet Port Configuration

AMP Connection

To support audio transcoding, ports 7 and 8 are used to interconnect the NPM with its paired AMP for 
transporting data between them. 

• In the VMG-14, the NPM in slot 7 pairs with the AMP in slot 6, and the NPM in slot 8 pairs with 
the AMP in slot 9. 

• In the VMG-6 and VMG-8, the NPM in slot 1 pairs with the AMP in slot 3, and the NPM in slot 2 
pairs with the AMP in slot 4.) 

To interconnect an NMP to its paired AMP, you must first physically connect the NPM to the AMP. 
See any of the following documents for details: VMG-14 Hardware Setup Guide, VMG-8 Hardware 
Setup Guide, or VMG-6 Hardware Setup Guide, or the Application Media Processor (AMP) 
Installation Guide for VMG Systems. 

Following physical setup, you must then configure the AMP connection at the VMG Element Manager 
as described in this section. 

Configuring the AMP Connection

Use the Configure GigE Ports screen to set AMP connectivity for specific interfaces. 

Note: If you have Port Mirroring or any transport streams configured on ports 7 and 8, you must 
first disable Port Mirroring and/or delete these transport streams.

From the VMG Element Manager main menu, select Configuration -> GigE Ports to present 
the Configure GigE Ports screen (Figure 43).
1. Enable (check) the AMP Connection field, located above ports 7 and 8 (Figure 43).

Clicking AMP Connection results in display of a popup warning advising that the following events 
occur when enabling AMP connectivity:

- Port mirroring is disabled.

- IP address, subnet mask, and gateway are reset to the AMP factory defaults.

- Input and output transport streams cannot be configured at GigE 7 and GigE 8. 
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Figure 43. Configure GigE Ports - AMP Connection

2. Click Apply to dismiss this screen and use your settings. 

3. Verify your settings.

Look at the Grooming > Mapping tab: GigE 7 and GigE 8 should now displayed as having an 
AMP Connection (Figure 44). 

Note: You will not be able to configure transport streams on these ports while the AMP connection is 
enabled. 

Figure 44. Grooming - AMP Connection
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Grooming—Mapping Subtab View

In the GigE Ports menu, all GigE ports are displayed. However only the ports whose interfaces have 
been configured in the GigE Ports menu and whose grooming group have been enabled in the 
Grooming Group tab will be displayed in the VMG Element Manager Grooming -> Mapping page. 

Figure 45 demonstrates display of all configured GigE ports in the Grooming -> Mapping subtab.

Figure 45. Configured GigE Ports in Grooming -> Mapping Subtab 
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Bulk Configuration

This chapter describes how to access and use the VMG Bulk Configuration tool. 

Note: Release 2.5.1 introduced the new Bulk Configuration function from the VMG Element 
Manager main menu. Currently, only MBR-TS configuration is supported via use of the bulk 
configuration tools. 

Note: A bulk configuration is not a replacement for configurations you perform by using the various 
functions throughout the VMG Element Manager GUI. It is a software package accessible 
from the VMG Element Manager Configuration menu that allows you to configure MBR 
transport stream data from a set of .xls files on your PC, for upload to the VMG’s MBR 
database. 

Note: You must be logged in to the VMG Element Manager as Administrator to use the Bulk 
Configuration function. 

In This Chapter:

• “About Bulk Configuration,” next.

• “Bulk Configuration Tools” on page 73.

• “Bulk Configuration Spreadsheets” on page 74.

• “Downloading VMG Bulk Configuration Files” on page 84.

• “Using the Bulk Configuration Spreadsheets” on page 88.

• “Applying Spreadsheet Data to the VMG” on page 89.

• “Handling Errors” on page 90.

About Bulk Configuration

The goal of bulk configuration is to simplify the configuration of MBR groups in large systems. These 
MBR groups can be provisioned for one to eight transport streams each, to provide various 
combinations of resolution parameters and MBR group IDs. An added bonus is that each worksheet 
provides a human-readable record of the overall configuration.

You can access blank worksheet templates from the Bulk Configuration Tool and start building as 
many MBR.xls files as you may require for your various operations. The .xls file consists of four bulk 
configuration worksheets that are pre-populated with rows and columns for organization of the 
following entries:
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• Tests—for program grooming configuration. 

• MBRs—for MBR stream configuration.

• Program Redundancy—for program stream backup configuration.

• Audio Language—for language descriptor settings. 

The VMG is unaffected until you return to the Bulk Configuration Tool to select a deployment option. 
Configurations defined by the worksheet format become the MBR TS database when loaded to a VMG 
if the selected option either replaces or appends the existing VMG’s MBR configuration database. 
Other options from the Bulk Configuration Tool allow you to either clear the VMG’s MBR database, or 
save the VMG MBR database to an .xls file on your PC

Bulk Configuration Tools

Use the Bulk Configuration screen to obtain the bulk configuration’s spreadsheet (.xls) templates 
from the VMG, and to apply your configured spreadsheets to the VMG. 

From the VMG Element Manager, select Configuration -> Bulk Configuration to present the Bulk 
Configuration screen (Figure 46 and Table 36).

Note: When first launched, the Bulk Configuration screen displays the names of files in the 
Application File field and the Source Configuration File field. The files displayed in these 
fields are not available until you complete the tasks described in “Downloading VMG Bulk 
Configuration Files” on page 84.

Figure 46. Bulk Configuration screen

This field specifies the bulk 
configuration software program tool 
(.exe).

This field specifies the bulk 
configuration spreadsheet package. 
(.xls).

Table 36. VMG-8 components  

Field Description

File Provides graceful exit from the Bulk Configuration screen. 

System Provides the Download Bulk Configuration Software option. 
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Bulk Configuration Spreadsheets

The bulk configuration spreadsheets are the .xls files you edit prior to applying the consolidated 
configurations onto a VMG system. Your entries to the worksheets create various transport streams, 
each containing combinations of grooming and network settings that you can deploy from a single 
point of presence. 

The spreadsheet package is organized as described in the following topics:

• “Tests Tab” on page 75.

• “MBRs Tab” on page 78.

• “Audio Language Tab” on page 81.

• “Program Redundancy Tab” on page 82.

• “README Tab” on page 84.

Note: RGB Networks advises that you do not modify or rename the names of the tabs in your 
worksheets, nor the names of the column heads in the worksheets. 

Option Drop-down selector that contains the following options:

• Replace current TS database with new TS configuration

The bulk configuration tool clears all transport streams and configures the 
transport stream based on the configuration file read from the VMG-8. 
The system needs to be out of service when using this option.

• Append new configuration to existing TS database

The bulk configuration appends the transport streams based on the bulk 
configuration file. The system can remain in service when using this 
option.

• Clear the TS database

The bulk configuration clears all current transport streams. The system 
needs to be out of service when using this option. 

• Save current TS database to new Configuration File

Retains the existing configuration file under a new configuration file name. 

Application File The location of the application file. 

Default path: c:\vmgConfigTool_MTS\config_vmg.exe

Source Configuration File The location of the Excel (.xls) configuration source file. Refer to the VMG 
Bulk Configuration Tool Administrator’s Guide for complete details about the 
configuration files (spreadsheets). 

Target IP Address IP address of the VMG on which the bulk configuration will be deployed. 

Status Messages Status message display area, which populates with INFO and/or ERROR 
messages after you press the Execute button. Messages continue to display 
until completion of the configuration at the VMG. 

Execute Use the settings in this screen to begin sending the spreadsheet 
configuration to the VMG system. Prior to upload, the system will query for 
Administrator password. 

Table 36. VMG-8 components  (Continued)

Field Description



VMG Element Manager User Guide 75

Release 3.1.3 Bulk Configuration Spreadsheets

Tests Tab

The Tests tab (Figure 47 and Figure 48) contains columns in which to enter or select values to define 
program grooming for the transport streams associated with the .xls file.You use this sheet to set 
program names, networking parameters for input and output, and quality parameters for audio and 
video. You can also define which rows are to be included/excluded from configuration runs. 

The configuration reference for the Tests tab is provided in Table 37 on page 76.

Figure 47. Worksheet—Tests Tab (columns A to M)
) 
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Table 37. Tests Page Worksheet (Columns A to M)  

Column Description

A skip_test Value, as either 0 or 1, to indicate whether or not to skip testing that uses 
data on this row. 

0: do the test

1: skip the test. 

B testcase Test Case: value to define a number for the test. 

C mbr_group_id  Alphanumeric string to define a unique MBR group ID, which is the name of 
the video/audio file to be applied to an MBR program map. You can either 
enter an MBR Group ID, or use the existing one. 

D MultiTS ID  unique group ID for the MBR TS group.

E input_port Source GigE interface for use by the program. 

F input_mcast_ip Multicast IP address, in dotted decimal format, for input stream.

Address range: 224.0.0.1 - 239.255.255.255.

G input_source_ip Source IP address, in dotted decimal format. 

H input_mcast_port (optional) Value, in the range 1-65535, to define the port on which the 
incoming stream is to be transported. 

I input_ts_name Name of the input transport stream.

J input_program_number Value to set program number. 

K input_resolution_class Type of horizontal x vertical resolution to use for SD or HD programming. For 
the complete list of resolution values, see “Configuration Reference” on 
page 306.

L output_port Destination GigE interface for use by the transport stream.

M output_mcast_ip Multicast IP address, in dotted decimal format, for output stream.

Address range: 224.0.0.1 - 239.255.255.255.
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Figure 48. Worksheet—Tests Tab (columns N to AA)

Table 38. Test Page Worksheet (Columns N to AA)  

Column Description

N output_mcast_port UDP port number.

O redundant_output_ip IPv4 address for the redundant output port. 

P output_ts_name Alphanumeric string to define the name of the transport stream. 

Q output_program_number Value to define the program number, in the range 1-131072.

R output_program_name Alphanumeric string to define the name for the program.

S output_ts_bandwidth Value, in the range .01 Mbps to 5 Mbps, to define the bitrate of the output 
transport stream. 
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MBRs Tab

Use the MBRs tab (Figure 49) to enter your multi-bitrate transport stream settings. An MBR (multi-
bitrate) transport stream enables transcoding of a single input stream (HD or SD in either MPEG-2 or 
H.264 format) into (max) four H.264 SPTSs per grooming operation. All programs groomed to MBR 
TSs are transcoded to H.264 video. 

The configuration reference for the MBRs tab is provided in Table 39 on page 79. 

Note: See also “Configuration Reference” on page 306, for supported sampling and bit rates for 
channels.

T video_bitrate Value, in Mbps, to define maximum video bitrate allowable. The video 
bitrate is applied to video on the elementary stream. 

This value cannot exceed that defined for TS bandwidth. 

U video_resolution Values to set type of horizontal (H) resolution as high (yellow), medium 
(blue), or low (red) for each transcoded program. Use the drop-down 
selector to set resolution, in accordance with the following scheme:

For the complete list of resolution values, see “Configuration Reference” on 
page 306.

Default: 640x360

V aspect_ratio Entry to specify the ratio of the program width to the height, as either 
automatic, 4:3, or 16:9. 

W video_profile Video capability, as either high, main, or baseline.

High = Typically for HD TV applications. Allows 8x8 transform size. 

Main = Typically for SD TC broadcasts that use DVB-standard MPEG-4 
formats.

Baseline = typically for low-cost applications, such as video conferencing 
and mobile usages. 

X pmt_pid ID of the program map table (PMT), as a value in the range 48-8175. 
Default: 100.

Y video_pid Video PID. Default: 101.

Z audio_pids List of Audio PIDs, using format “Audio_ES_num:PID” and comma 
separator. For example:

• 1:102, 2:103 (Map to 1st Audio and configure PID Map to 2nd Audio and 
configure PID).
or

• 1:102 (Map to 1st Audio ES Stream).

AA data_pids List of Data PIDs using format “Data_ES_num:PID” and comma separator. 
For example: 

• 1:104, 2:105 (Map to 1st Data and configure PID Map to 2nd Data and 
configure PID).
or

• 1:104 (Map to 1st Data ES Stream).

Table 38. Test Page Worksheet (Columns N to AA)  (Continued)

Column Description
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Figure 49. Worksheet—MBRs Tab

Table 39. MBRs Page Worksheet Columns  

Column Description

A mbr_group_id Unique system-generated ID for the MBR group. 

B forward_cue Forward SCTE35 cue: Entry, as either Yes or No, to indicate whether or not 
to enable forwarding of SCTE 35 information on input streams. 

C gop_m Value to define the spacing of the P frames in the output. The higher the 
value, the lower the data rate:

• For H.264 HD or SD: 
Default: 4.
Acceptable Values: 1, 2, or 4.

D gop_n Value to define the number of frames in each GOP. The higher the value, the 
lower the data rate. 

• For MBRTS H.264 HD or SD:
Acceptable Values: 32, 60, or optimized.

E idr_interval Value to specify the interval between instantaneous decoder refresh (IDR) 
frames, or number of frames between random access points. 

Default: 160 frames.

Acceptable Values: 32, 64, 96, 128, 160, 192, 224, 256, 288, 320. 

F audio_codec Specify method to be used for decoding audio.

Default: AAC-LC

Acceptable Values: HE-AAC, HE-AACv2, AAC-LC, MPEG1L2, MPEG2LC, 
AC-3, and E-AC-3 (Dolby Digital Plus).

G audio_sampling_rate Value to define the number of audio samples per second. Higher values 
equal better sound quality. 

Default: 48 kHz.

Acceptable values: 8 kHz, 11.03 kHz, 12 kHz, 16, kHz, 22.05 kHz, 24 kHz, 
32 kHz, 44.1 kHz, 48 kHz. 

H audio_channels Type of channel to be used for the audio stream.

Default: stereo

Acceptable Values: mono, stereo, or 5.1 surround.

I audio_bitrate) Define bitrate for all audio streams within the MBR transport stream. Audio bit 
rate filters on the basis of the combined audio codec, channel, and sample 
rate settings. 

For acceptable values (kbps): refer to tables provided in “Configuration 
Reference” on page 306.
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J audio_gain Value to set the gain on an audio stream level. Audio Gain is applied to all 
audio streams within the MBR TS. If the input program has two or more audio 
PIDs, all audio outputs will have the same gain. 

Default: 0 (no gain)

Acceptable Values: -24 dB to +24 dB 

K audio_pass_through Enable or disable AC-3 input audio passthrough. 

• None: disable audio passthrough.

• AC-3: enable audio passthrough.

Default: None

L audio_start_pid Set value to define the starting PID value. The PID will be validated within all 
elementary streams. 

Default: blank

M dd_LFE For 5.1 surround configuration only: enable (On) or disable (Off) 3/2 mode. 

Off = non 3/2 mode.

On = 3/2 mode. 

N dd_bitstream Value to set one of the following options for the bitstream mode (AC-3 or E-
AC-3 (Dolby Digital Plus) only):

• 0 - main audio service: complete main (CM)

• 1 - main audio service: music and effects (ME)

• 2 - associated audio service: visually impaired (VI)

• 3 - associated audio service: hearing impaired (HI)

• 4 - associated audio service: dialogue (D)

• 5 - associated audio service: commentary (C)

• 6 - associated audio service: emergency (E)

• 7 - associated audio service: voice over (VO)

O dd_dialog_norm Set value to define dialog normalization, in the range 0 dB (passthrough) and 
-1 dB (loudest) to -31 dB (least loud). 

P dd_DRC_line Value to set one of the following options for the DRC line mode profile (AC-3 
or E-AC-3 (Dolby Digital Plus) only):

• 0 - No compression

• 1 - Film standard compression

• 2 - Film light compression

• 3 - Music standard compression

• 4 - Music light compression

• 5 - Speech compression

Q dd_DRC_RF Value to set one of the following options for the DRC RF mode profile (AC-3 
or E-AC-3 (Dolby Digital Plus) only):

• 0 - No compression

• 1 - Film standard compression

• 2 - Film light compression

• 3 - Music standard compression

• 4 - Music light compression

• 5 - Speech compression

R dd_DRC_line2 See description for column P (above).

S dd_DRC_RF2 See description for column Q (above).

Table 39. MBRs Page Worksheet Columns  (Continued)

Column Description
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Audio Language Tab

Figure 50. Worksheet—Audio Language Tab

T dd_surr_shift Enable (On) or disable (Off) 90-degree phase shift to surround channels. 

Default: Off

U dd_surr_atten Enable (On) or disable (Off) 3dB attenuation to surround channels. 

Default: Off

V input_table_processing Set type of table processing to apply to the input stream, as either DVB, 
ATSC, or SDT. 

W output_sdt Enable (yes) or disable (no) SDT passthrough or generate on the MBR 
transport stream.

X sdt_options Select pass-through or generate. 

Y sdt_service_name Type an alphanumeric string, up to 64 characters, to identify the SDT service 
for the transport stream. 

Table 39. MBRs Page Worksheet Columns  (Continued)

Column Description

Table 40. Audio Language Worksheet Columns  

Column Description

A skip_test Value, as either 0 or 1, to indicate whether or not to skip testing that uses 
data on this row. 

0: do the test

1: skip the test

B input_port Source GigE interface.

C input_mcast_ip Multicast IP address, in dotted decimal format, for input stream.

• Address range: 224.0.0.1 - 239.255.255.255.

D input_source_ip Source IP address, in dotted decimal format. 

E input_mcast_port (optional) Value, in the range 1-65535, to define the port on which the 
incoming stream is to be transported. 

F input_ts_name Name of the input transport stream.

G input_program_number Value to set program number. 
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Program Redundancy Tab

The VMG supports input-level program redundancy. At the detection of a missing program, the VMG 
automatically switches to a redundant or backup program.

In a program redundancy configuration, a switch to backup results when either of the following events 
occur:

• Missing MPTS/SPTS streams are identified by checking the PAT.

• Missing program streams are identified by checking the PMT.

You can assign a backup program for every input program, and any input program can be assigned to 
back up a running primary program. The backup program can be another program on the same GigE 
port or it can be on a different GigE port in the same chassis.

For bulk configuration, use the Program Redundancy tab (Figure 51) to apply settings for backup of 
streams. The configuration reference for the Program Redundancy tab is provided in Table 41 on 
page 83.

H audio_pid List of Audio PIDs, using format “Audio_ES_num:PID” and comma separator. 
For example:

• 1:102, 2:103 (Map to 1st Audio and configure PID Map to 2nd Audio and 
configure PID).
or

1:102 (Map to 1st Audio ES Stream).

I audio_lang_code String to set a language descriptor. See also “Language Descriptor Settings” 
on page 313. 

Table 40. Audio Language Worksheet Columns  (Continued)

Column Description
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Figure 51. Worksheet—Program Redundancy Tab

Table 41. Program Redundancy Page Worksheet Columns

Column Description

A skip_test Value, as either 0 or 1, to indicate whether or not to skip testing that uses data 
on this row. 

0: do the test.

1: skip the test. 

B Input_port Value, in the range 1-8, to specify the GigE input port number to be used. 

Recommended value: 1

C input_mcast_ip Input multicast IP address, in dotted decimal format. 

Address range: 224.0.0.1 - 239.255.255.255.

D Input_source _ip Optional cell in which to specify the IP address of the source where the port 
receives data. This value is used only for multicast (IGMPv3) transport 
streams. 

Address range: 0.0.0.0 - 239.255.255.254.

E input_mcast_port Value, in the range 0-65535, to define the UDP port on which the incoming 
stream is to be transported. 

F Input_ts_name Alphanumeric string to define the name of the primary input transport stream.

G Input_table_processing Type of table processing to apply to the input stream, as either ATSC, DVB, 
or SDT. 

H input_program_number Value to define the primary program number. 

I bkp_input_port Value, in the range 1-8, to specify the GigE backup input port number to be 
used. 

Recommended value: 1

J bkp_input_mcast_port Input multicast IP address for backup use, in dotted decimal format. 

Multicast address range: 224.0.0.1 - 239.255.255.255.

K bkp_input_source_ip Input IP address, for backup use, in dotted decimal format.

L bkp_input_mcast_port Value, in the range 0-65535, to define the UDP port on which the incoming 
stream is to be transported. 

M bkp_input_ts_name Alphanumeric string to define the name of the backup input transport stream.

N bkp_input_table_
processing

Type of backup table processing to apply to the input stream, as either ATSC, 
DVB, or SDT. 
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README Tab

The README tab contains tips and encoding values for use when configuring your worksheets. 
Information from this page is not read by the system during bulk configuration deployment. 

Downloading VMG Bulk Configuration Files

The bulk configuration files reside on the VMG as a tar package—vmgConfigTool—that you access 
via the VMG Element Manager’s Bulk Configuration window, for placement on your computer’s 
hard drive. This section describes how to get started with bulk configuration, in the following topics:

• “Accessing the Bulk Configuration Template Files” 

• “Understanding Bulk Configuration File Types” 

• “Managing VMG Bulk Configuration Template Files” 

Before you can access any bulk configuration tools, you must be logged in to the management 
interface as an Administrator user.

1. Access the VMG Bulk Configuration window:

From the VMG Element Manager main menu, select Configuration -> Bulk Configuration Tool 
to present the Bulk Configuration screen (Figure 52). 

O bkp_input_program_
number

Value to define the backup program number. 

P recovery_mode Define method of recovery from backup program to primary program, as 
either automatic or manual. 

0: automatic
Enable automatic fail-over option from primary to backup program and 
recovery operation from backup to primary, as based on PAT/PMT detection. 

1: manual 
Enable automatic fail-over operation from primary to backup program, as 
based on manual selection.

Table 41. Program Redundancy Page Worksheet Columns

Column Description
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Figure 52. Launching the Bulk Configuration window.

Accessing the Bulk Configuration Template Files

To get started, the bulk configuration files must be downloaded from the VMG to your computer to 
enable use of the transport stream settings, and to load the software (.exe file) necessary to perform the 
bulk configuration tasks from the VMG Element Manager. 

1. With the VMG Bulk Configuration window in view, choose System -> Download Bulk Config-
uration SW...(Figure 53). 

Figure 53. Bulk Configuration System Software Download command

The Save window (Figure 54) is now presented. 

2. At the Save window, perform the following tasks:

a. Click to highlight the c:directory. This will enable installation into c:\vmgConfigTool_MTS.
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b. Check to ensure that the Files of Type field contains vmgConfigTool.zip. 

c. Click Save and wait for the transfer process to complete. 

Figure 54. Pulling the VMG Bulk Configuration zip file into your workspace.

3. Go to the zip file that is now located on your hard drive and extract the files. Note that the 
vmgConfigTool_MTS folder consists of the file types similar to those shown in Figure 55.

Note: Due to Windows security, you cannot download the zip file to C drive. Therefore, you need to 
set up a subfolder on C for use with your Bulk Configuration source files. 

Figure 55. Locating VMG Bulk Configuration Files on your PC
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Understanding Bulk Configuration File Types

Files inclusive of the vmgConfig Tool directory are contained in the Library and the vmgConfig Tool 
folders. Within these folders are the various file types listed in the Table 42.

Note: The .xls file (labelled input_template_file) is the file you will use as the initial template for 
your bulk configurations.

Managing VMG Bulk Configuration Template Files

RGB recommends that you do not modify the input_template_file supplied with your 
vmgConfigTool software. To get started, open input_template_file.xls, and save the file as a different 
name. 

Note: RGB recommends that you do not modify the original input_template_file supplied with your 
vmgConfigTool software. 

You can save your worksheets to any folder or directory on your computer, as long as you are able to 
locate them with the browser from the VMG Bulk Configuration screen. 

Handling Template Updates

With upcoming new VMG databases, the newer .xls file templates are likely to contain additional 
columns. To reuse existing worksheet data, in a new template, use the following steps:

1. Rename and save the new .xls file template.

2. Cut data from columns in the existing (older) worksheet and paste it into the identically named 
columns at the new worksheet. 

3. In your new worksheets, and at the new empty columns, type in value required for your services. 

4. Save the .xls file. 

Table 42. vmgConfigTool directory files

File type Description

.xls The input template file that contains sample settings for transport stream bulk configuration. Use 
this file as your template to create additional bulk configurations for the VMG associated with the 
current login. 

library The library file for the config tool.

.pyd Various Python dynamic module files.

.dll The Python application DLL file. 
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Using the Bulk Configuration Spreadsheets

Caution: Before beginning any configurations, ensure that the macros are enabled in your Excel 
workspace. If you see Security Warning Macros have been disabled, click Options…and 
change the setting to enable the Macros.

1. Configure MBRs 

In your .xls files, bring the MBRs tab into view and set all parameters across the row for the MBR 
name. You can set up new MBR name(s), or use those already provided. 

You can set up as many as 54 video/audio MBR groups for programs groomed to MBR TSs, with up to 
eight profiles (outputs) each.

For information about the MBRs settings, refer to Table 39, “MBRs Page Worksheet Columns,” on 
page 79. This name will also be used in the Tests tab, as the MBR_Group_ID. 

2. Configure Tests

At the Tests tab, set the MBR name into the MBR_Group_ID column, using one to eight rows, and 
enter or select settings across the worksheet row, for each MBR group row. Use reference information 
provided in Table 37, “Tests Page Worksheet (Columns A to M),” on page 76 to tailor your entries. 

3. Configure Program Redundancy

At the Program Redundancy tab, set parameters for the input source and the backup source.

4. Check the Configuration

Caution: Check your entries against the following list to ensure minimal errors during the 
upcoming configuration run:

• All output program name entries are unique.

• All referenced mbr group_id(s) in the Tests sheet are also defined in the MBRs sheet 

• Resolution combination per MTS (Multi TS) is valid.

• Value to define the output video ES bit rate is less than that defined for the output TS bit rate.

• The TS bandwidth column contains a value in the range 0.1 to 5 Mbps.

• No more than four TSs are associated with each MTS group ID. 

• Excluded audios are done for all streams per MBR.

• Audio transcoding values are valid for codec, sampling rate, channel and bitrate.

• Input Resolution Class setting is identical for all streams within the same MBR.

• Selected output video resolution is valid for the selected input resolution class.
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Note: The number of audios in the Excel sheet drives the maximum of supported/needed audios. Up 
to two are allowed, but where two columns only are provided in the Excel sheet, the Bulk 
Configuration tool makes sure to honor that number instead.

5. Save the Configuration

This .xls file should now be ready for use by the Bulk Configuration tool. 

After completing your entries to a bulk configuration .xls files, return to the Bulk Configuration 
window to upload your configuration to the VMG. 

Applying Spreadsheet Data to the VMG

Use steps in this section to apply settings from a spreadsheet package to the VMG. 

1. Save the Current Running VMG Configuration

Before attempting to load any configuration to the VMG, use the Save Running Configuration 
(Figure 56) option at the VMG Element Manager splash screen to back up the database currently 
running on the VMG. 

Figure 56. Save Running Configuration 

2. Log in to VMG Element Manager and go to the Bulk Configuration screen.

From the VMG Element Manager main menu, select Configuration -> Bulk Configuration Tool 
to present the Bulk Configuration screen (Figure 52). 

3. At the drop-down Option field, select the type of configuration to be used (refer to Option in 
Table 36 on page 73).

4. At the Application file field, browse to select the vmgConfigTool to be used for this upload.

5. At the Source Configuration File field, browse to select the .xls file to be uploaded for this bulk 
configuration.

6. Double check to ensure that the target IP address matches that of the VMG for which this 
configuration is to be applied. 
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7. Click Execute to run the configuration. 

As dependent on which option you have selected, the system may query for confirmation of the 
selected action. 

In all cases, the system presents the Password Verification dialog box (Figure 57) prior to 
processing the .xls file configuration for the VMG. 

Use your VMG Element Manager password, then click OK to proceed. 

Figure 57. System queries prior to upload

8. Monitor the status messages now displayed in the Bulk Configuration window. Status messages 
are reported as either INFO or ERROR. 

Handling Errors

Errors read from the input .xls file are reported in the Status Messages field of the Bulk 
Configuration window. If the Excel file passes the initial sanity check, the combinations delivered to 
the VMG are valid and the configuration should run smoothly on the VMG. Conversely, if problems 
are detected with input stream configurations, these will be reported as errors in the Bulk 
Configuration window, and will require repair prior to another attempt at upload to the VMG. 

Note: Un checked configurations and/or issues that may require repair, which can result in errors, 
are listed in “4. Check the Configuration” on page 88. 

In the Status Messages field, each error message contains the cause of the error notification. Use this 
information as your guide if you need to return to the .xls files to correct any entries. 



VMG Element Manager User Guide 91

CHAPTER 6

System Maintenance

This chapter describes the VMG maintenance functions that are available from the VMG Element 
Manager home page and the System Maintenance menu. 

In This Chapter:

• “Database Backup and Restoration,” next. 

• “Software Upgrade” on page 94.

• “License Management” on page 99.

• “System Reboot” on page 103.

• “System Shutdown” on page 105.

• “NPM Redundancy Switch” on page 106.

• “Program Redundancy Switch to Primary” on page 106.

• “Time Offset Table (TOT)” on page 107.

Database Backup and Restoration

The VMG provides the ability to back up its running configuration to a local workstation via HTTP 
and restore the database to a VMG via FTP. This feature is useful when there is a wide deployment of 
VMGs sharing identical configurations or when you need to re-apply a saved configuration to the same 
VMG in the event of a system failure or database wipe. 

Note: To facilitate storage and retrieval of the VMG running configuration, be sure to assign an FTP 
server that is accessible by the VMG. 

Database Backup / Save Running Configuration 

RGB Networks recommends that the VMG running configuration be saved at least once per week to 
ensure the most up to date database in the event of a system failure. 

To save the running configuration:

1. Click the Save Running Configuration link at the VMG Element Manager home page 
(Figure 58). 
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Figure 58. VMG Home Page - Save Running Configuration Option

2. Wait for completion of the database tar process. Notifications similar to those shown in Figure 59, 
will display when files are compressed into binary format, and when the tarred database is 
completed. You can save the tarred files when you see the Click here to get dbbackup.tgz link. 

Figure 59. Tar the Running Config and Save Locally

3. Click on the Click here to get dbbackup.tgz link to present the Opening dbbackup.tgz screen.

4. Click Save File and OK to save the backup config file to the local workstation. 

Note: Note that the screen may not be identical to that shown in Figure 59, as dependent on the 
browser in use.



VMG Element Manager User Guide 93

Release 3.1.3 Database Backup and Restoration

Database Restoration

When restoring the database to the same VMG from which the database was saved, or restoring a 
database to a different VMG, the following guidelines must be considered: 

• The configuration database is not valid for an earlier version of software from which it was saved.

• A configuration database from one chassis type (VMG-6, VMG-8, or VMG-14) is not valid for a 
different chassis type. 

• When restoring a configuration database to a different VMG from which it was originally saved, 
new licenses will need to be installed on the restored VMG. Contact RGB Customer Support for 
more information. 

To restore a database to a VMG:

1. Make sure the backed up configuration file resides on an FTP server accessible by the VMG. 

2. Use the Restore DB Configuration screen to log into the FTP server and retrieve a specified file:

From the VMG Element Manager main menu, select Maintenance -> Restore DB Configuration to 
present the Restore DB Configuration screen (Figure 60 and Table 43). 

Figure 60. Restore DB Configuration

3. Click Restore. 

Table 43. Restore DB Configuration Fields 

Field  Description Default 

Host IP Address Type the IP address of the host server where the 
configuration database resides. this address must be 
associated with an FTP server, and it must be accessible 
to the VMG. 

Blank

Protocol Set FTP protocol for retrieval of the configuration 
database. Currently, FTP is the only protocol option.

FTP

User Name Type the login user name for the FTP server. Blank

Password Type the login password for the FTP server. Blank

Restore license file Restore (check) or do not restore (un-check) the license 
file with the database retrieval. 

Checked

Directory and File 
Name 

Type the absolute path where the configuration database 
is located on the FTP server. 

• Example: /ftproot/dbbackup.tgz 

Blank
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4. At the Restore DB Confirmation query (Figure 61), click Yes to confirm the restoration, or No to 
abort the operation. 

Figure 61. Restore DB Confirmation 

5. If Yes, watch for the successful restoration message (Figure 62), and click OK to dismiss the 
popup screen.

Figure 62. Restore DB Result.

6. Reboot the VMG to enable activation of the restored database. Refer to “System Reboot” on 
page 103

Software Upgrade

Use the VMG Element Manager software upgrade function to install the most current VMG software 
onto the VMG system and the AMP modules. Two software packages are provided with each new 
VMG release, which are tailored for use specifically with the VMG system modules, or the AMP 
modules:

• sw.tar

This software package contains the software for the NPM, TCM, and VPM and is to be used 
whenever you are upgrading the system to the most current VGM release.

• AmpBuild.xxxx.rgb

This software package contains the software for the AMP and is to be used only if AMPs are 
installed in the VMG. Where applicable, this upgrade should be performed after successful reboot 
of the VMG following a sw.tar upgrade.

Note: Refer also to the Video Multiprocessing Gateway Software Upgrade Guide for detailed 
upgrade procedures. This guide, which is provided with all new VMG releases, provides 
instructions for handling upgrades and downgrades over multiple VMG releases. 

This section contains information about VMG software upgrades, in the following topics:

• “Upgrade Sequences,” next.

• “Upgrade Steps” on page 95

• “The Software Upgrade Processes” on page 97.
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Upgrade Sequences

To upgrade to the current software release, the VMG must already be loaded with VMG software 
release 3.0.3. If the VMG is using a very early release, accomplishment of the 3.0.3 release 
requirement will require additional steps (Figure 44). 

Refer to the Video Multiprocessing Gateway Software Upgrade Guide for detailed upgrade procedures.

Upgrade Steps

Use steps in this section to upgrade the VMG or an AMP module to the latest software:

1. Contact RGB to acquire/download the upgrade package. 

2. Store the sw.tar file and/or the AmpBuild_xxxxx.rgb file on an FTP server accessible by the VMG. 

3. Use the Upgrade Software screen to load new software.

From the VMG Element Manager main menu, select Maintenance -> Software Upgrade (Figure 63 
and Table 45). 

4. Click Upgrade.

5. At the upgrade confirmation query, click Yes to confirm and proceed with the upgrade, or click No 
to abort the upgrade operation. 

- If Yes, the software upgrade procedure now begins by performing a validation check for image 
corruption and compatibility with the VMG system. 

- When the new image has been downloaded to the applicable module, the Upgrade Status 
field will return a value of Completed. 

6. After a system software upgrade completes, reboot the VMG to enable activation of the new 
software. 

Note that it is not necessary to reboot the system following an AMP upgrade. 

To perform a reboot, you can either check the Reboot chassis after successful software upgrade 
option from the Upgrade Software screen. See also “System Reboot” on page 103 for more 
details about the VMG Element Manager Reboot tools. 

Table 44. Release Sequences for Software Upgrades

Release Currently Running on 
the VMG

Number of Steps to Perform SW 
Upgrade Requirement

Pre 2.5.1 More than 2

Upgrade to 3.0.3 

2.5.1 2

2.5.2 2

2.5.3 2

3.0.x 2

3.0.3 (GA) 1

3.1.x 1
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Figure 63. Upgrade Software

Table 45. Software Upgrade Fields 

Field Description Default

Current Version Current version of software installed. Read-only 

Host IP Address Type the IP address of the host server where the configuration 
database resides. this address must be associated with an FTP server, 
and it must be accessible to the VMG. 

Blank 

Protocol Set FTP protocol for retrieval of the configuration database. FTP

User Name Type the login user name for the FTP server. Blank 

Password Type the login password for the FTP server. Blank 

Directory and File 
Name

Type the absolute path where the configuration database is located on 
the FTP server. Following are examples of path entries that refer to 
VMG and AMP locations.

• VMG image: /ftproot/sw.tar

• AMP one-file image: AmpBuild_4.7.5-15164.noarch.rgb

• AMP two-file image: AmpBuild_4.7.5-15188.noarch.001.rgb

Blank 

Upgrade Status View the current status of the software upgrade process once started:

• In Progress – The upgrade procedure is currently being performed.

• Completed – The upgrade procedure completed successfully.

• Failed – The upgrade procedure encountered an error.

Read-only 

Reboot chassis 
after successful 
software upgrade

Either reboot the chassis (check) or do not reboot the chassis (un-
check) after the software has been upgraded. 

Note that before the new software can take effect, the VMG requires a 
reboot. See also “System Reboot” on page 103 for additional 
information.

Un-checked
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The Software Upgrade Processes

The VMG performs many tasks during software upgrade sessions. This section illustrates the overall 
process as well as the processes for NPM and AMP upgrades, in the following topics:.

• “VMG System Upgrade Process” on page 97.

• “AMP Upgrade Process” on page 98.

VMG System Upgrade Process

Issuing an upgrade instruction to the VMG results in system processes shown in Figure 64. 

Figure 64. VMG Upgrade Process

Specify location of the upgrade software, 
the the directory and file name (sw.tar), and
User Name/password

Click 
Upgrade

New image loaded to 
active NPM, via FTP

Is there a 
redundant 

NPM?Yes

Standby NPM

Send 
Notification

New image loaded to 
standby NPM

Image installed on 
standby NPM

Image installed on 
active NPM

No

Software Upgrade screen should now 
display new NPM version (NPM1).
The software is not installed onto other 
modules until the VMG system is rebooted. 

Image installed on NPM 

Complete

Active NPM

Is Database 
Convertible?

Yes

Back up and Clean 
Database

NoConvert Database

Wait for 
Standby to 
complete 

installation

Complete

Software Upgrade screen should now display new  
version for both NPMs (NPM1, NPM2).
The software is not installed onto other modules 
until the VMG system is rebooted. 

Send 
Notification
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AMP Upgrade Process 
AMP Upgrade Process

Specify location of the upgrade software, the 
directory and file name (AmpBuild.xxxx .rgb), 
andv User Name/password

Click Upgrade

New image loaded to 
active NPM, via FTP

NPM: via ftp, put 1st AMP image file 
on NPM

1. NPM telnet to AMP
2. Load image onto AMP.

NPM: via ftp, put 2nd AMP image file 
on NPM

1. NPM telnet to AMP
2. Load image onto AMP.

NPM: via ftp, put 1st

AMP image file on NPM

1. NPM telnet to AMP
2. Load image onto AMP.

Redundant AMP?
Yes No

Redundant 
AMP?

Yes No

1. NPM telnet to AMPs.
2. Concatenate images..

1. NPM telnet to standby AMP.
2. Run self-extract image to install/restart.
3. Reboot the standby AMP

1. NPM telnet to AMP.
2. Run self-extract image to install /restart.

1. NPM telnet to active AMP.
2. Run self-extract image to install/restart.

Complete

Complete
Software Upgrade screen 
should now display new 
AMP version.

Software Upgrade screen 
should now display new 
AMP version for both AMPs.
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License Management

VMG License Key management is described in the following topics:

• “VMG License Types,” next. 

• “License Configuration” on page 101.

• “Acquiring License Keys” on page 102.

• “Entering License Keys” on page 103. 

VMG License Types

The VMG supports the license types listed and described in Table 46. Each license is issued on a per 
chassis basis, and will only work with the corresponding device. Bandwidth allocation for bandwidth-
based licenses corresponds to the bitrate configured for the transport stream. 

Note: This note applies to the Transrating License, DPI License, and Program Substitution 
License listed in the following table: The VPM is not supported in Release 3.1.x. Please 
refer to the associated Release Notes for additional information. 

Table 46. VMG License Types  

License Type Description

Base License Key Allows configuration of non-video related features, such as the chassis and 
interfaces. Enables grooming and multiplexing functions.

Transrating License 
(Bandwidth Based) Key

In combination with the Base license, allows creation and configuration of 
MPEG-2, ATSC, SCTE, or DVB transports with SPTS transrating and MPTS 
transrating/statistical multiplexing. This is a bandwidth-based license; 
creation of an output transport stream will be rejected if the bandwidth 
needed is not available. This license does not allow DPI functionality. 
Requires VPM.

DPI License (Bandwidth 
Based) Key

In combination with the Base license, allows creation of DPI supported 
output transport streams for MPEG-2 and H.264 in addition to SPTS 
transrating and MPTS transrating/statistical multiplexing. This a bandwidth 
based license; creation of an output transport stream will be rejected if the 
DPI bandwidth needed is not available. All programs associated with this 
output transport stream will be DPI capable. 

Requires VPM.

DPI License (Number Based) 
Key

In combination with the Base license, allows creation of DPI-supported 
output programs within an output transport stream as long as program-level 
DPI is enabled on the TS. Output programs not supporting DPI can also be 
created within the same output transport stream. For this license type, the 
creation of an output program supporting DPI will be rejected if the number of 
DPI sessions purchased has been exhausted. 

Requires VPM.
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Program Substitution License 
(Number Based) Key

In combination with the Base license, allows creation of program substitution 
supported MPEG-2 or MPEG-4 output programs. Output programs not 
supporting Program Substitution can also be created within the same output 
transport stream. A DPI bandwidth or number based license is not required 
for output programs employing Program Substitution. For this license type, 
the creation of an output program supporting Program Substitution will be 
rejected if the number of channel substituted sessions purchased has been 
exhausted. 

Requires VPM

MPEG-2 SD Transcoding 
License (Number Based) Key

In combination with the Base License, allows creation of SD MPEG-2 output 
programs through the Transcoding Module (TCM) when “Transcoding” is 
enabled in output transport streams. Input format can be either MPEG-2 or 
H.264, and must be of a supported SD or HD resolution. Transcoded output 
transport streams must be configured as SPTS. 

Requires TCM.

MPEG-2 HD Transcoding 
License (Number Based) Key

In combination with the Base License, allows creation of HD MPEG-2 output 
programs through the Transcoding Module (TCM) when “Transcoding” is 
enabled in output transport streams. Input format can be either MPEG-2 or 
H.264, and must be of a supported HD resolution. SPTS only is supported in 
Transcoded output transport streams. 

Requires TCM.

H264 SD Transcoding 
License (Number Based) Key

In combination with the Base License, allows creation of SD H.264 output 
programs through the Transcoding Module (TCM) when “Transcoding” is 
enabled in SPTS. Input format must be MPEG-2 or H.264 and of a supported 
SD or HD resolution. This license is also used to enable PIP or multi-bitrate 
stream outputs. 

Requires TCM.

H264 HD Transcoding 
License (Number Based) Key

In combination with the Base License, allows creation of HD H.264 output 
programs through the Transcoding Module (TCM) when “Transcoding” is 
enabled in SPTS. Input format must be MPEG-2 or H.264 and of a supported 
HD resolution. 

Requires TCM.

Table 46. VMG License Types  (Continued)

License Type Description
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License Configuration

Use the License Manager screen to establish licensing information for the VMG. 

From the VMG Element Manager main menu, select Maintenance -> License Manager to present the 
License Manager screen (Figure 65 and Table 47). 

Note: Display of decimal marks in the License Manager screen—as either comma or period 
separators—is dependent on standards for your locale. 

Figure 65. License Manager.

Table 47. License Manager Fields 

Field Description

Serial Number Displays the serial number of the VMG

Base License Key 
Transrating License (Bandwidth Based) Key
DPI License (Bandwidth Based) Key
DPI License (Number Based) Key
Program Substitution License (Number Based) Key
MPEG-2 SD Transcoding License (Number Based) Key
MPEG-2 HD Transcoding License (Number Based) Key
H264 SD Transcoding License (Number Based) Key
H264 HD Transcoding License (Number Based) Key

These fields display the currently installed license 
keys, if installed.
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Acquiring License Keys

To acquire the appropriate license keys, contact RGB Networks and submit the following information:

• The VMG chassis serial number.

• The type(s) of license(s) desired.

Note: The VMG chassis serial number is located at the top of the License Manager screen. 

Base License Indicates if the base license entered is valid and 
currently enabled.

Transrating Bandwidth License (Mbps)
DPI Bandwidth License (Mbps)
DPI Number License
Program Substitution Number License
MPEG-2 SD Transcoding Number License
MPEG-2 HD Transcoding Number License
H264 SD Transcoding Number License 
H264 HD Transcoding Number License

These fields display the respective number of 
purchased, used, and available licenses for each 
type:

• Purchased – The total number of licenses or 
bandwidth purchased. 

• Used – The number of purchased licenses or 
bandwidth currently in use. 

• Available – The number of purchased licenses 
or bandwidth currently available for use. 

• Enabled – Applies to Base License only. A 
Base License can only be enabled or disabled. 
No number or bandwidth licensing is 
associated with it. 

• Status – Indicates if the particular license is 
valid. Examples of an invalid license are: 

- Invalid serial number information due to 
erroneous configuration from one VMG to 
another. 

- Licensing capacity is less than allowable 
configuration for the VMG. 

- Missing or corrupt license file due to 
system malfunction. 

- When the Status field is un-checked, 
contact RGB Customer Support for 
additional assistance. 

New License Key Type The type of new license corresponding to the 
license key being entered in the New License Key 
field. Options are:

Base, Transrating Bandwidth, DPI Bandwidth, 
DPI Number, Program Substitution, MPEG-2 SD, 
MPEG-2 HD, H264 SD, and H264 HD.

New License Key The new license key to install.

Table 47. License Manager Fields (Continued)

Field Description
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Entering License Keys

Use the License Manager screen to set license keys:

From the VMG Element Manager main menu, select Maintenance -> License Manager. 

1. Select the appropriate license type from the New License Key Type drop down list.

2. Enter the corresponding license key in the New License Key field.

Note: To avoid key entry errors due to typos, copy the key from the email in which the key was 
provided, then paste it into the New License Key field. 

3. Click the Apply New License button to apply the license key.

4. Repeat steps 1- 3 for each additional license to be installed.

System Reboot

Caution: Performing a system reboot will interrupt all video services.

To reboot a VMG from Element Manager, use the Reboot screen: 

From the Element Manger, select Maintenance -> Reboot to present the Reboot screen (Figure 66)

1. At the Reboot screen, click to select the appropriate reboot condition and click Apply reboot to 
confirm.

Figure 66. Reboot Options popup screen

2. At the Password Verification screen (Figure 67) enter the Administrative password and click 
OK.

Figure 67. Password verification popup screen
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3. Depending upon which Reboot option was selected in the Reboot options popup screen, one of 
the following confirmation queries (Figure 68) is presented:

4. To apply the selected reboot, click OK on the confirmation query. 

Figure 68.Reboot Options

Reboot

• Preserve the current configuration.

• Preserve all licenses. 

Reboot with factory default configuration-retain licenses

• Reset the database to its factory default setting.

• Preserve licensing.

Reboot with factory default configuration-remove licenses

• Reset the database to its factory default settings.

• Remove all licenses. 
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System Shutdown

If power must be removed from the VMG chassis, as when moving the VMG chassis to a different 
rack, perform a system shutdown.

Use the System Shutdown screen to issue a system shutdown instruction to the VMG. 

Caution: Performing a system shutdown interrupts all video services and powers down the chassis. 
After the system is shut down, the VMG chassis must be manually powered on using the 
facility power switch.

From the Element Manger, select Maintenance -> System Shutdown to present the System 
Shutdown screen (Figure 69)

Figure 69. System Shutdown Confirmation

1. At the System Shutdown screen, click Yes. 

2. At the Password Verification screen (Figure 70), enter your password and click OK.

Figure 70. Password Verification
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NPM Redundancy Switch

In addition to the VMG initiating an NPM redundancy switch when certain failover conditions are met, 
the redundancy condition can be manually switched over by using the NPM Redundancy Switch. 
Activating the redundancy switch causes the standby NPM to become active and the currently active 
NPM to switch to standby after the system is rebooted. 

Caution: If you have AMP cards installed and configured, performing an NPM redundancy switch 
will cause a switchover to the standby AMP card as well.

Note: The NPM Switchover feature only applies if two NP\Ms are installed in the VMG chassis, the 
system is fully redundant, and the standby NPM has been online for at least three minutes. If 
the standby NPM has not been online for at least three minutes, the VMG Element Manager 
will not allow manual switchover.

Use the NPM Switchover screen to manually perform an NPM redundancy switch.

From the Element Manger, select Maintenance -> NPM Switchover to present the NPM Switchover 
screen (Figure 71).

Figure 71. NPM Switchover Confirmation

Either click Apply to proceed with the system switchover, or click Cancel to abort the switchover. 

Program Redundancy Switch to Primary

This operation requires that program redundancy be configured prior to attempting the switchover. See 
also “Program Redundancy” on page 253 for more information. Use the Regroom screen to 
implement a program switchover. 

From the Element Manger, select Maintenance -> Program Redundancy Switch to Primary to 
present the Regroom screen (Figure 72). 

Either click Apply to proceed with the program redundancy switchover, or click Cancel to abort this 
switchover. 

Figure 72. Regroom
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Time Offset Table (TOT)

The TOT conveys additional information about summer and winter time periods and gives the local 
time offset with respect to UTC for different countries or regions. If the TOT is locally generated, user 
interaction is required to define the country or region in which the receiver is operated.

The VMG supports the required DVB tables, including TOT. 

Use the Setup Time Offset Table (TOT) screen to set parameters for TOT. 

From the VMG Element Manager main menu, select Maintenance -> Setup Time Offset Table 
(TOT) to present the Setup Time Offset table (TOT) screen (Figure 73 and Table 48). 

Figure 73. Setup Time Offset Table (TOT)

Table 48. Tot Time Offset Settings  

Field Description Default

Country Code The three character country code. USA

Region ID The region identifier, with range 0 to 60. If there is only one time 
zone in the country, this value is zero. Otherwise, the timezones 
are numbered from 1 (most easterly) up to 60, (the most 
westerly).

0

DST Offset The Daylight Savings Time (DST) offset: (range is -2:00, -1:30, -
1:00, -0:30, 0, +0:30, +1:00, +1:30, +2:00). The value is 0: when 
DST is not applicable; otherwise the offset to be applied to 
current time when DST is in effect.

For instance, in the US, the local time offset when DST is not in 
effect is -8, and when DST is in effect, it is –7. So, the DST offset 
is +1. polarity is 1 as time is behind UTC.

00:00

The following fields will only be displayed if the DST offset is set to anything but 00:00.

Start Time: Day Indicates what day DST takes effect in the current year. Choices 
are: 1st, 2nd, 3rd or Last Sunday.

1st Sunday

End Time: Day Indicates what day DST ends in the current year.
Choices are: 1st, 2nd, 3rd or Last Sunday.

1st Sunday

Start Time: Month Indicates the month DST takes effect in the current year.
Choices are: January - December

Jan

End Time: Month Indicates the month DST ends in the current year
Choices are: January - December.

Jan

Start Time and End Time fields are 
displayed after you select a value in 
the DST Offset field. 
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Start Time: Hour Indicates the hour (military time) DST takes effect in the current 
year.
Choices are: 0-23.

0

End Time: Hour Indicates the hour (military time) DST ends in the current year.
Choices are: 0-23.

0

Start Time: Minute Indicates the minute DST takes effect in the current year.
Choices are 0-59.

0

End Time: Minute Indicates the minute DST ends in the current year.
Choices are: 0-59.

0

Table 48. Tot Time Offset Settings  (Continued)

Field Description Default
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System Alarms and Events

This chapter describes the use of the VMG Element Manager to monitor system health. The Alarms & 
Events tab on the VMG Element Manager screen provides system information and health status.

To view the complete list of VMG Alarms and Events, refer to Appendix B, “VMG Alarms and 
Events” on page 314.

In This Chapter:

• “Active Alarm,” next.

• “Event History” on page 111.

Active Alarm

For each alarm generated from the VMG, the time raised, acknowledged status, severity, category, 
type, and description are displayed in the Active Alarm tab page. The information on this screen can 
be sorted by clicking on the column headings. Clicking on the Apply button will retrieve the most 
recent alarms, if any.

Use the Active Alarm tab page to view the currently active alarms reported by the VMG (Figure 74 
and Table 49). 

At the VMG Element Manager, click Alarms & Events, then click Active Alarm. 

Figure 74. Active Alarm Tab Page

Table 49. Active Alarm Tab Page

Field Description

ID The identification number of the alarm. 

Raised Time The time the alarm occurred.
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Once an alarm has been triggered, it must be acknowledged to activate the alarm cutoff. 

Acknowledging Alarms

Current status of alarm acknowledgement is reported in the Ack column of the Alarm tab page as 
either Yes (acknowledged) or No (not acknowledged). 

Acknowledged alarms remain in the Active Alarm list until cleared. Once an alarm condition is 
resolved, the alarm is removed from the active list. For example, when a port is not functioning 
(“operationally down”) an alarm is added to the list. Later, after the port becomes operationally up, the 
alarm is cleared and removed from the list.

Use the Active Alarm tab page to acknowledge alarms:

1. Ensure that the alarm to be acknowledged has not already been acknowledged. The Ack column 
should report No. 

2. Click on the alarm in the Active Alarm list to highlight your selection. 

3. Right-click and choose Ack Alarm from the popup menu.

Note that the Ack column for the selected alarm row now reports Yes, and acknowledgement of an 
alarm is recorded in the Event History. 

Paging - Alarms

The paging option allows you to move quickly through the alarm displays, on a pagination basis. 
When enabled, you can choose to view the previous or next page of alarm reports, or jump to the first 
or last pages. 

Use the Active Alarm tab page to enable or disable the paging function for the displayed alarms. 

• Enable (check) or disable (un-check) Paging in the Filter Criteria section of the Active Alarm 
screen. 

- If paging is selected, four buttons are displayed for navigating the alarm log: First, Previous, 
Next, and Last (Figure 75).

- If paging is disabled, the First, Previous, Next, and Last.buttons are hidden from view. 

Ack Shows if the alarm has been acknowledged or not. Until an alarm is acknowledged, 
the central telco alarm/bell will be active.

Severity The severity of the alarm. One of Critical, Major, Minor, or Info.

Category The general category for the alarm. 

See Appendix B, “VMG Alarms and Events” for details.

Type The type of alarm that occurred.

Description A description of the alarm.

Table 49. Active Alarm Tab Page

Field Description
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Figure 75. Active Alarms List with Paging Enabled

Event History 

An entry is added to the event history table each time an event occurs. Some events result in alarms 
being raised or cleared. Acking an alarm adds an entry to the list. This provides a history of alarms on 
the system. For each event, the time stamp, severity, category, type, and description are displayed on 
the Event History tab page. 

• The information on this screen can be sorted by clicking on the column headings. 

• Clicking the Apply button will retrieve the latest events, if any.

Use the Event History tab page to view the current events reported by the VMG. 

At the VMG Element Manager, click Alarms & Events, then click Event History (Figure 76 and 
Table 50). 

Figure 76. Event History

Table 50. Alarms & Events - Event History Settings  

Field Description

ID The identification number of the event. 

Time Stamp The time the event occurred.
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Paging - Events

The paging option allows you to move quickly through the event log, on a pagination basis. When 
enabled, you can choose to view the previous or next page of event logs, or jump to the first or last 
pages. 

Use the Event History tab page to enable or disable the paging function for the displayed events. 

• Enable (check) or disable (un-check) Paging in the Filter Criteria section of the Event History 
screen. 

- If paging is selected, four buttons are displayed for navigating the alarm log: First, Previous, 
Next, and Last (Figure 77).

- If paging is disabled, the First, Previous, Next, and Last.buttons are hidden from view. 

Figure 77. Event History with Paging Enabled

Severity The severity of the event: Critical, Major, Minor, or Info.

Category The general category for the event. 

See Appendix B, “VMG Alarms and Events” for details.

Type The type of event that occurred.

Description A description of the event.

Table 50. Alarms & Events - Event History Settings  (Continued)

Field Description



VMG Element Manager User Guide 113

CHAPTER 8

Video Processing Overview

The VMG provides the capability to transmit and receive MPEG-2 and H.264 video program streams 
in either single- or multi-program MPEG-2 transport streams encapsulated with UDP / IP or RTP / 
UDP / IP using the IP transport network. The VMG provides advanced digital video services, such as 
transcoding, transrating, grooming, and statistical multiplexing, which are essential for video 
processing.

Note: System configuration must be completed before performing grooming tasks. Refer to Table 59, 
“Grooming Task Sequence Reference,” on page 124 and/or Chapter 4, “System 
Configuration” for more information.

This chapter introduces how to associate the VMG GigE interfaces to the transport streams and 
perform grooming operations at the VMG Element Manager. 

In This Chapter:

• “Interfaces,” next. 

• “Transport Streams” on page 115.

• “Programs” on page 118.

• “Table Processing” on page 119.

• “Grooming” on page 120.

• “Program Redundancy” on page 125.

• “Transrating” on page 125.

• “Transcoding” on page 126.

• “Bitrate Monitoring” on page 126.

• “Statistical Multiplexing” on page 127.

• “Forward Error Correction (FEC)” on page 127.



VMG Element Manager User Guide 114

Release 3.1.3 Interfaces

Interfaces

Interfaces refer to the Gigabit Ethernet (GigE) ports of the NPMs installed at the VMG. Each NPM 
provides eight bidirectional GigE ports that support small form-factor pluggable (SFP) optical or 
copper modules, and two 10GigE ports that support 10 Gigabit small form-factor pluggable (XFP) 
optical modules. The NPM also provides one RJ-45 10/100 Ethernet port for configuration and 
management, one RJ11 serial console port, and one RJ-45 DOCSIS Timing Interface (DTI).

Note: For updates on the latest SFPs and XFPs approved for use with RGB’s products, log in to 
RGB’s Customer Portal and search for either SFP, or XFP.

The VMG GigE interfaces comply with the following standards: 

• IEEE 802.3z, IEEE 802.3ab, IEEE 802.3ae.

• ITU-T G.692 - Optical interfaces for multichannel systems with optical amplifiers.

• RFC-768, RFC-791, RFC-792, RFC-793, RFC-826, RFC-1889.

After you configure the GigE interfaces, they are displayed at the Inputs and Outputs panels of the 
Grooming -> Mapping page as GigE icons (Figure 78). 

Figure 78. GigE Interfaces on the Grooming --> Mapping tab page

GigE interfaces: collapsed view 

This view displays the Ethernet 
grooming groups at the Inputs 
and Outputs panels. 

GigE interfaces: expanded view

This view provides the means by 
which you can manage operations 
on the individual GigE ports. 

However, before you can use a GigE 
interface, it must first be configured, 
using the Configure GigE Ports 
screen.

You can view and select options from 
any GigE interface on the Grooming 
Mapping tab page by right-clicking 
on the interface and selecting an 
option from the popup menu 
(Table 51). 
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Right-click on an input or output GigE icon to view and select options from the popup menu 
(Table 51). 

Transport Streams

A transport stream consists of a group of programs and the elementary streams (audio, video, data, 
etc.) associated with each program. The VMG carries MPEG-2 transport streams using UDP / IP (or, 
optionally, RTP / UDP / IP for real-time content). An MPEG-2 transport stream is split in groups of 
packets and mapped to the data portion of a UDP frame. The UDP header contains the 16-bit source 
UDP port number, 16-bit destination UDP port number, and UDP frame length and checksum. The 
UDP port is used to identify the source and destination applications for the message. In readiness for 
delivery, the UDP frame is encapsulated in an IP frame, which contains the IP addresses of the source 
and destination. 

Transport stream creation is dependent on the type of licenses installed at the VMG. Refer also to 
“License Management” on page 99 for details.

Using the menus from the GigE interfaces on the Grooming --> Mapping tab page, you create the 
transport streams for both input and output, as introduced in the following topics:

• “Input Transport Streams and the VMG,” next.

• “Output Transport Streams and the VMG” on page 116.

Input Transport Streams and the VMG

Input transport streams contain the source content that the VMG uses for video processing tasks. The 
type of content loaded into an input transport stream is the result of your configuration at the Create 
GigE Input Transport Stream dialog for a specific GigE interface. This configuration allows you to 
create single or multiple input transport streams, set table processing (for DVB, ATSC, or SDT), and 
define network parameters. 

After you set up the input streams, you can:

• View input transport stream content at the Inputs panel of the Grooming Mapping page 
(Figure 79), displayed beneath the interface when it is received by the interface. 

• Choose programs from the input stream to map with output transport streams. 

• Use menu options directly from a TS popup menu (Table 52 on page 118, Inputs column). 

Table 51. GigE Menu Options for Input and Output Ports

 Input Options Output Options

Create a Transport Stream Create MBR Transport Stream

Delete a Transport Stream Create AVTX + PIP Transport Stream

Create VTX + PIP Transport Stream

Create AVTX Transport Stream

Create VTX Transport Stream

Create PIP Transport Stream

Create VTR Transport Stream

Delete All Transport Streams
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Figure 79. Input Transport Streams

For details about managing input transport streams, refer to Chapter 9, “Input Transport Streams”.

Output Transport Streams and the VMG

Output transport streams contain the content being sent out from the VMG. For any GigE output 
interface, you can use the VMG Element Manager to create standard, transcoded+PIP, and/or MBR 
transport streams. 

After you set up the output streams, you can:

• View output transport stream content at the Outputs panel of the Grooming Mapping page 
(Figure 80), displayed beneath the interface when you groom to the transport stream.

• Use menu options directly from a output TS popup menu (Table 52 on page 118, Outputs columns) 
to manage the transport stream as well as the grooming. 

Figure 80. Output Transport Streams

Input Transport Streams

This view displays the various 
transport streams assigned to 
specific GigE interfaces. Each TS 
is identified by information as was 
configured with the Create GigE 
Input Transport Stream dialog.

Output Transport 
Streams

These transport streams 
are associated with 
specific GigE interfaces 
as a result of your 
selection for TS type. 
Content for each TS is 
the result of assigning 
an input program to the 
output TS. 
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Standard Output Transport Streams

Standard output transport streams are MPEG-2, ATSC, SCTE, or DVB streams that can contain 
transcoded or non-transcoded output programs. Single video transport streams are VTX (video 
transcoding), AVTX (audio and video transcoding), PIP (picture-in-picture), and VTR (video 
transrating). 

• Transcoded output programs can contain output video types of MPEG-2 (HD or SD) or H.264 
(HD, SD, or PIP). 

• Non-transcoded (transrated) streams support both transport stream-level and program-level digital 
program insertion (DPI). 

For information on creating standard output transport streams and associated program grooming, refer 
to Chapter 10, “Single Video Transport Streams”.

Transcoded+PIP Output Transport Streams

In contrast to standard output transport streams, a Transcoded+PIP transport stream enables 
transcoding of a single input stream (HD or SD in either MPEG-2 or H.264 format) into two H.264 
output streams: a full frame rate, broadcast-resolution main stream and a corresponding PIP stream. 
All programs groomed to Transcoded+PIP transport streams are transcoded to H.264 video. 

Transcoded+PIP TSs use the VMG’s resources more efficiently than standard OTSs and simplify the 
creation of programming that requires PIP output. 

You can create two types of Transcoded+PIP transport streams: 

• AVTX+PIP for audio transcoding and picture-in-picture.

• VTX+PIP for video transcoding and picture-in-picture.

For information on creating Transcoded+PIP transport streams and associated program grooming, 
refer to Chapter 11, “Transcoded+PIP Transport Streams”.

MBR Output Transport Streams

An MBR (multi-bitrate) transport stream enables transcoding of a single input stream (HD or SD in 
either MPEG-2 or H.264 format) into as many as four H.264 SPTSs per grooming operation. More 
than four profiles (outputs) can be configured by performing multiple groom operations reference the 
same group ID. All programs groomed to MBR TSs are transcoded to H.264 video. For each SPTS in 
an MBR TS, you can independently control the video bitrate, resolution, aspect ratio, profile, and GOP 
structure for a groomed program.

MBR TSs also perform transcoding on the input audio streams, enabling you to control the number of 
audio channels, sampling rate, and audio bitrate for the output programs. You can set up as many as 
108 video/audio MBR groups for programs groomed to MBR TSs with up to 8 profiles (outputs) each.

For information on creating MBR transport streams and associated program grooming, refer to 
Chapter 12, “MBR Transport Streams”.
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Right-click on an input or output transport stream to view and select options from the popup menu 
(Table 52).

Programs

Programs processed by the VMG are represented by Program icons at both the input and output 
sections of the grooming platform. 

Input Programs

Input programs are displayed at the VMG Element Manager as a result of being received in a particular 
transport stream via its GigE input interface. An input program consists of a group of individual 
elementary streams (audio, video, data, etc.), which are compliant with the table processing 
instructions you define in your configuration for the GigE Input Transport Stream. 

Once a program icon is in view at the input panel, you can use options directly from its popup menu 
(Table 53) Inputs columns) for management of the input program and to add elementary streams.

Output Programs

An output program consists of a group of individual elementary streams (audio, video, data, etc.) 
intended for transmission from the VMG. You set up and configure the output programs at the 
Outputs section of the grooming platform either by creating a new program directly from an output 
TS (AVTX, VTX, VTR, PIP), or by dragging an input program to a specific output TS. 

Once a program icon is in view at the output panel, you can use options directly from its popup menu 
(Table 53, Outputs columns) for management of the output program, streams, and grooming.

Right-click on an input or output program icon to view and select options from the popup menu 
(Table 53). 

Table 52. Transport Stream Menu Options for Input and Output  

INPUTS OUTPUTS

 Transport 
Stream Options

Standard Transport 
Stream Options

MBR, and Transcoded + PIP 
Stream Options

Modify Transport Stream Modify <TS type> Transport Stream Modify <TS type> Transport Stream

Delete Transport Stream Delete <TS type> Transport Stream Delete <TS type> Transport Stream

Create Ghost Program Create Program Modify <TS type> Grooming

Delete All Programs Delete <TS type> Grooming

Display Grooming Reset <TS type> Grooming

Bitrate Monitor View <TS type> Grooming Source

Reset Grooming

Table 53. Program Menu Options for Input and Output  

 Inputs Options Outputs Options

Modify Program Name Modify Program

Delete Program Delete Program
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Table Processing 

The VMG processes Service Definition Tables (SDTs) on non-DVB input transport streams (on the 
basis of your configuration for table processing on specific GigE interfaces), and enables generation of 
SDTs on MBR output transport streams (on the basis of your settings when creating or modifying the 
output transport streams). 

Table processing on an input TS is supported at the VMG for both DVB and non-DVB input. The 
stream content is managed by means of your configurations for table processing—for specific input 
transport streams on GigE interfaces—whereby you can opt for no table processing, or choose DVB, 
ATSC, or SDT (Table 54). More information about this configuration is provided in “Creating Input 
Transport Streams” on page 128. 

Following your configuration of an input transport stream, the associated table types are displayed in 
the VMG Element Manager grooming platform upon receipt of the incoming traffic. The tables, 
themselves, cannot be modified. 

Rollback Original Program Name Manage Elementary Streams

Config Program Redundancy View Grooming Source

Add Elementary Stream Modify Grooming

Table 53. Program Menu Options for Input and Output  (Continued)

 Inputs Options Outputs Options

Table 54. Table Processing—Input Transport Streams

Table Processing 
Option Input TS

None Streams classified as DVB, ATSC, or SDT will be ignored but only basic tables 
(PAT and PMT) will be processed on the input TS at the GigE interface. 

DVB (Digital Video 
Broadcast)

The GigE interface will classify the input TS as DVB, and will process only DVB 
tables in conjunction with PAT and PMT from the input transport stream. 

This setting cannot be combined with any other table processing option.

ATSC (Advanced 
Television Systems 
Committee)

The GigE interface will classify the input TS as ATSC, and will process only ATSC 
tables in conjunction with PAT and PMT from the input transport stream.

This setting cannot be combined with any other table processing option.

SDT (Service Descriptor 
Table)

Allows processing SDT tables on non-DVB input TS. When enabled, input stream 
types 0x80 are interpreted as SCTE-video; other DVB-SI tables (EIT, NIT, TDT, 
TOT) cannot be received on the input interface.

This setting cannot be combined with any other table processing option. 
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Grooming 

Grooming refers to the process of grouping (mapping) specific input programs and services from 
multiple sources into different packages, such as customized channel lineups for subscribers. The 
VMG allows selecting an elementary stream (e.g., video, audio, or data), a single-program transport 
stream (SPTS), or multi-program transport stream (MPTS) from one input, and grooming it with one 
or more streams from other inputs to create an MPTS multiplex.

Note: The VMG must be equipped with appropriate modules to enable service for particular 
transport streams. See Table 58 for more information. 

You can perform grooming tasks from a single window—the Grooming--> Mapping page—on the 
VMG Element Manager, to manage both input and output interfaces, programs, and a variety of 
transport streams. 

Drag-and-drop Grooming

The VMG Element Manager GUI provides drag-and-drop grooming capability for programs and 
elementary streams on an input program, to become part of an output program. 

Drag-and-drop grooming can be applied to create new program mappings, or you can replace an 
existing, already-groomed output transport stream (which is referred to as regrooming). Regrooming 
recreates the grooming configuration but associates it with a different input (source) program. A basic 
rule for regrooming is that the input program being used must contain an identical number of streams, 
stream types, and PMT order as does the targeted output program. 

As based on the output transport stream type, the VMG Element Manager supports two types of 
regrooming (Table 55):

Table 55. Regrooming

Output Transport Streams Description

VTX, VTX+PIP, PIP, VTR Regrooming rebuilds the grooming at the selected output TS, with the new 
input program, using the identical configuration on the output program, 
output elementary streams. 

See also “Regrooming—VTX, VTX+PIP, PIP” on page 195.

The same implementation is true for VTR, if not program substitution or DPI.

AVTX, AVTX+PIP, MBR Regrooming rebuilds all grooms for the output transport stream that shared 
the same audio profile ID, MBR group ID, to use the identical video 
configuration and audio configuration, and the identical MBR group ID or 
audio profile ID name. 

See also “Regrooming—AVTX, AVTX+PIP” on page 220.
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Resetting Grooming

The VMG Element Manager allows you to reset grooming of output transport streams. This function 
interrupts service while tearing down the current grooming to rebuild it with the identical configured 
parameters. For more information about the Reset Grooming function, see:

• “Resetting Grooming—AVTX, VTX, PIP” on page 195.

• “Resetting Grooming—AVTX+PIP or VTX+PIP” on page 220.

• “Resetting Grooming—MBR” on page 239.

How to Groom

Use the Grooming -> Mapping tab page (Figure 81) to view existing transport streams, program 
names, and elementary streams for each of the input and output interface ports of the VMG. 

At the VMG Element Manager, click the Grooming tab to present the Mapping tab page.

Figure 81. Mapping Components

The Mapping screen displays all the input and output components currently associated with each 
GigE interface at the VMG. The components are hierarchically organized (Table 56), and identifiable 
by icons and labels (Table 57). 

Table 56. Mapping Hierarchy for Grooming  

Object Description

GigE group Displayed at top of the input and output panels. The type of group displayed 
is the result of your configuration for the GigE grooming group (see 
“Grooming Group tab” on page 46). 

GigE1 through GigE 8 Individual GigE ports, as numbered on the installed NPM. The same GigE 
port is configured for both input streams and output streams at the Mapping 
page. 

Input and Output Mapping Panel, listing all GigE interfaces, 
including:
• Transport Streams
• Tables, and Programs
• Elementary Streams

GigE Groupings
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You can also use the Display Grooming option from a populated input program, to view and refresh 
program information in the Current Program Mapping screen. 

Grooming Icons

All configured interface ports are displayed in the Mapping tab page, which contains the inputs in the 
left panel, and the outputs in the right panel. If a port is enabled and functioning, it is displayed with a 
green icon. Each component type listed in the Mapping tab page is identifiable by its icon (Table 57) 
as well as its logical name. Icon colors provide a quick method of determining status of the GigE ports, 
certain transport streams, and the programs. 

TS Transport stream. 

• Input TS: After you create these, they will contain source content: a set of 
programs and PSIP/SI tables and programs, which are displayed under 
their associated transport stream. To find out how to create an input TS, 
see “Creating Input Transport Streams” on page 128. 

• Output TS: After you create these, they will contain the content to be 
delivered from the VMG. Each output TS is associated with a specific 
transcoding and/or transrating method. To find out how to create an output 
TS, see the section appropriate for the type of stream:

- “Creating Output Transport Streams” on page 139

- “Creating Transcoded+PIP Transport Streams” on page 201.

- “Creating MBR Transport Streams” on page 226.

Programs and Tables • Each program consists of audio, video, and PSIP/SI information.

Elementary Streams • Elementary streams appear under the program.

Table 56. Mapping Hierarchy for Grooming  (Continued)

Object Description

Table 57. Grooming -> Mapping Icons  

Icon Description

1 GigE or 10 GigE Interface. 

To start drilling down into the contents, either double-click on the icon or click the + box 
alongside the label. 

1 GigE or 10 GigE Port. Status is indicated as follows:

• Green and blue = port is administratively up. 

• Black and white = port is enabled but not administratively up. 

Input or Standard Output Transport Stream. 

Transcoded+PIP or MBR Transport Stream. Status is indicated as follows:

• Blue and dark blue = video processing is active. 

• Black and white = video processing is not active.

Input or Output Program. Status is indicated as follows:

• Red, green, and blue = video processing is active. 

• Black and white = video processing is inactive. 

Output Program that is DPI-enabled.
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Basic Grooming Requirements and Workflow

The VMG Element Manager contains numerous tools that you can use to set up a wide variety of 
stream configurations. The VMG can support various configurations if the correct VMG modules are 
installed at the system (Table 58). 

Note: The VPM is not supported in Release 3.1.x. Please refer to the associated Release Notes for 
additional information

Output Program that is Program Substituted. 

Error detected in program, such as a mismatch between the configurations and the actual 
stream type, video codec, or resolution. To view the reason for the program error, hover over this 
icon to prompt for the information popup. 

PAT, PMT, or CUE presence. 

Video channel presence. 

Audio channel presence. 

Table 57. Grooming -> Mapping Icons  (Continued)

Icon Description

Table 58. VMG Equipment and Streams  

Output 
Streams Description

VMG Equipment 
Requirement TS Type—Options

VTR Single video TS: 
Video Transrating

VPM, NPM MPEG-2, ATSC, SCTE, DVB

PIP Single video TS: 
Picture in Picture

TCM, NPM MPEG-2, ATSC, SCTE, DVB

VTX+PIP Transcoded+PIP TS:
Video Transcode with PIP 

TCM, NPM MPEG-2, DVB

VTX Single video TS: 
Video Transcode

TCM, NPM MPEG-2, ATSC, SCTE, DVB

MBR MBR TS: 
Video and Audio Transcoding

TCM, AMP, NPM MPEG-2

AVTX Single video TS: 
Video and Audio Transcoding

TCM, AMP, NPM MPEG-2, ATSC, SCTE, DVB

AVTX+PIP Transcoded+PIP TS:
Video and Audio Transcoding with PIP

TCM, AMP, NPM MPEG-2
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Typical Task Sequence 

The typical task sequence, for grooming input programs to output transport streams consists of steps 
listed in Table 59.

Table 59. Grooming Task Sequence Reference  

Steps and Options VMG Element Manager Access Location in Manual

1. Configure GigE 
interfaces

Main Menu, Configuration --> GigE Ports --> 
Configure GigE Ports screen.

“Gigabit Ethernet Port 
Configuration” on page 63.

2. Create Input 
Transport Stream

Grooming tab --> Mapping page, Inputs panel -
-> right click on GigE interface, select Create 
Transport Stream --> Create GigE Input 
Transport Stream screen.

“Creating Input Transport 
Streams” on page 128.

3. Create Output 
Transport Stream

Grooming tab --> Mapping page, Outputs 
panel --> right click on GigE interface, select 
Create <type> Transport Stream screen.

• “Creating Output Transport 
Streams” on page 139.

• “Creating MPEG-2 
Transcoded+PIP Transport 
Streams” on page 201.

• “Creating DVB 
Transcoded+PIP Transport 
Streams” on page 206.

4. Map Input Program 
to Output Transport 
Stream.

Grooming tab --> Mapping page, Inputs panel -
-> click-select a Program from an Input 
Transport Stream --> drag it to the Outputs 
panel and into a <type> TS --> <type> Program 
Mapping screen.

• VTR: “Grooming Non-
Transcoded Programs” on 
page 171.

• PIP: “Grooming Transcoded 
Programs” on page 175.

• VTX+PIP: “Grooming to 
VTX+PIP” on page 210.

• VTX: “Grooming Transcoded 
Programs” on page 175.

• MBR: “Grooming a Program 
to an MBR TS” on page 230.

• AVTX: “Grooming 
Transcoded Programs” on 
page 175.

• AVTX+PIP:“Grooming to 
AVTX+PIP” on page 209.
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Typical Maintenance Tasks

Typical grooming maintenance tasks are listed in Table 60.

Program Redundancy

The VMG supports per-input program redundancy. Program level standby is configurable using the 
VMG Element Manager. The VMG allows you to designate any input service from the same grooming 
group as a “standby program” with the exception of the same service. The VMG automatically returns 
to the primary program from the standby program when the primary program recovers from the 
interruption if auto-revert was initially selected; otherwise manual intervention is required for the 
switch back to the primary input.

The health of the standby program will be checked before failover, and the VMG will not perform the 
switch if the standby is degraded. 

When a grooming session is created (via static configuration or SCTE 30 message) it will inherit the 
program redundancy configuration from the corresponding input program. 

Transrating

Transrating, or rate shaping, is the process of changing the bitrate of a video stream for the purposes of 
improving bandwidth and system efficiency. This includes converting variable bitrate (VBR) streams 
to constant bitrate (CBR) streams (also known as “clamping”) as well as reducing VBR streams’ 
bitrate. The VMG supports MPEG-2 standard-definition (SD) and high-definition (HD) transrating.

The Bypass Transrating option in the VMG enables an operator to completely bypass the VMG 
transrating engine. This is desired when the incoming video programs into the VMG are already 
transrated and the operator doesn’t wish to make any further changes to the video bitrate or video 
quality, while taking advantage of other VMG features such as Ad Insertion, Program Substitution, etc.

Table 60. Grooming Management Tasks  

Steps and Options VMG Element Manager Access Location in Manual

1. Manage Output TS 
(options: Modify, 
Delete, Reset, 
Integrate)

Grooming tab --> Mapping page, Outputs 
panel --> right-click a Program for popup menu.

• “Managing Standard Output 
Streams and Programs” on 
page 184.

• “Managing Transcoded+PIP 
Transport Streams and 
Programs” on page 217.

• “Managing MBR Transport 
Streams and Programs” on 
page 238.

2. Manage Output 
Programs (options: 
Modify, Delete, 
Manage ESs, View 
Grooming Source, 
Display Grooming)

Grooming tab --> Mapping page, Outputs 
panel --> right-click Program for popup menu.

3. Manage Input 
Programs (options: 
Modify, Delete, 
Rollback, Config 
Redundancy, Add 
ES)

Grooming tab --> Mapping page, Inputs panel • “Modifying and Deleting 
Input Transport Streams and 
Programs” on page 133.

• Table 65, “Grooming - Input 
Program /Ghost Program 
Popup Menu,” on page 134.
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Transcoding

Transcoding is the direct compressed stream-to-compressed stream conversion of one type of video or 
audio stream into another in order to increase bandwidth capacity for video delivery of programs, or to 
enable a new generation of consumer decoding devices. Historically, transcoding was achieved using 
stand-alone decoders that brought the signal down to the SDI un-compressed format, followed by a 
stand-alone real-time encoder. That architecture suffered from network complexity and high capital 
costs. With the TCM, the VMG can provide the following video transcoding features: 

• Transcoding of MPEG-2 to H.264, in HD, SD, PIP, or multi-bitrate streams.

• Transcoding of H.264 to MPEG-2, in HD or SD.

• Transcoding of MPEG-2 to MPEG-2, in HD or SD.

• Transcoding of H.264 to H.264, in HD, SD, PIP, or multi-bitrate streams.

• Downconversion from HD to SD in any transcoding combination and aspect ratio.

• Flexibility in configuring video bit rate (in CBR).

• Ability to configure a variety of horizontal resolutions.

• Ability to configure Group of Picture (GOP) structure.

• Support for various pre-processing filters including MCTF noise reduction and Telecine.

• Closed captioning support.

With the AMP module, the VMG can provide the following audio transcoding features:

• Audio transcoding from MPEG-1 LII, MPEG-2 LII, AAC-LC, HE-AACv1, HE-AACv2, or Dolby 
AC-3, to MPEG-1 LII, MPEG-2 LII, AAC-LC, HE-AACv1, HE-AACv2, or Dolby AC-3.

• Mono, stereo, or 5.1 channel sources can be converted to mono or stereo during transcoding to 
MPEG-1 LII or MPEG-2 LII.

• Mono or 5.1 channel sources will be converted to stereo during transcoding to HE-AACv2.

• Mono, stereo, or 5.1 channel sources can be converted to mono, stereo, or 5.1 channel during 
transcoding to AAC-LC or HE-AACv1.

• Up to 300 stereo pairs can be transcoded by an AMP module.

Bitrate Monitoring

The VMG Element Manager provides real-time bitrate monitoring and display for both input and 
output streams. 

• Input bitrate monitoring is performed through sampling of the inputs, and monitoring of transport 
streams and ports. 

• Output bitrate monitoring provides output program bitrates as a percentage of total output 
bandwidth, which you can display as follows. 

- For single-video streams, you can access the bitrate monitor screen by clicking directly on an 
output —VTR, AVTX, PIP, VTR, or VTX. 

- For multi-video streams, the bitrate monitor is accessible by clicking on a TS listed beneath 
the transport type—VTX+PIP, MBR, or AVTX+PIP. 

See Chapter 16, Monitoring on Page 291 for more information about the VMG Element Manager 
monitoring tools. 
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Statistical Multiplexing

Multiplexing is used to combine multiple data sources, such as video, audio, and data into, a single 
source. This is normally done to transmit multiple video programs over a single bandwidth-limited 
carrier medium, such as fiber or coax, to end-users. Multiplexing several variable bitrate streams 
together into a fixed sized transport stream bandwidth is called statistical multiplexing and helps to 
increase the overall efficiency of a multi-channel digital transmission.

Forward Error Correction (FEC)

Forward Error Correction is a means of error control for video transmission in which redundant data, 
or error correction code, is added to the transmission. This allows for error detection and correction on 
incoming transport streams and ensures consistent delivery of high quality video on output transport 
streams. The VMG provides a simple, standards-based solution to video degradation seen as a result of 
transmission error packet loss. By using the Pro-MPEG CoP#3 standard, FEC generation and error 
correction is applied on RTP encapsulated video packets, thus enabling the VMG to provide high 
density video processing—including transrating, statistical multiplexing, and advertisement 
insertion—at the highest levels of video quality, which the subscriber has come to expect from IPTV 
services. 

The VMG performs error correction and detection on RTP encapsulated input video streams and 
generates FEC packets using the Pro-MPEG CoP#3 standard on output video streams.

For more information about VMG and FEC, see:

• “Forward Error Correction (FEC) Coding” on page 13.

• “Creating FEC-based Input Transport Streams” on page 130.

• FEC field descriptions in Table 61, “Create Input Transport Stream Fields,” on page 129 and 
Table 68, “Create Output Transport Stream - Parameters for AVTX, VTX, VTR, and PIP,” on 
page 145.
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Input Transport Streams

This chapter provides an overview about use of the VMG Element Manager to perform video 
processing, using settings you provide for input transport streams. 

Note: System configuration must be completed before performing grooming tasks. 
Refer to Chapter 4, “System Configuration” for more information.

Note: The VMG supports program redundancy and elementary stream/PID management. If you plan 
to implement any of these advanced applications, please review associated sections in Chapter 
13, “Advanced Grooming Applications” before attempting the input transport stream tasks 
described in this chapter.

In This Chapter:

• “Creating Input Transport Streams,” next.

• “Creating Ghost Programs” on page 132.

• “Modifying and Deleting Input Transport Streams and Programs” on page 133.

• “Configuring Program Languages” on page 136.

Creating Input Transport Streams

Use the Create GigE Input Transport Stream screen (Figure 82 and Table 61) to set parameters for 
specific input transport streams. You can also use this screen to access parameters for setup of multiple 
transport streams (see also “Creating Multiple Transport Streams” on page 130). 

The following steps insert a new transport stream (and table processing specification) into the Inputs 
panel, beneath a selected GigE interface. 

From the Inputs panel of the VMG Element Manager Grooming -> Mapping tab page, right-click on 
the input GigE interface -> select Create Transport Stream.

1. At the GigE Input Transport Stream screen, use guidelines from Table 61 to set parameters for 
the GigE input transport stream.

2. Click Apply.

3. Check the Mapping page display to ensure that the transport stream name is displayed under its 
GigE at the Input panel.
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Figure 82. Create Input Transport Stream 

 

Table 61. Create Input Transport Stream Fields 

Field Description Default

GigE Port View the selected port on which the input transport stream will be 
created. 

Read-only 

TS Name Type an alphanumeric string to set a name for the input transport 
stream. 

Maximum length = 32 characters. 

Blank

Table 
Processing

Enable (check) or disable (un-check) a specific table processing 
method for input transport streams on the GigE interface:

• DVB: check to process SI tables, in addition to PAT and PMT.

• ATSC: check to process PSIP tables, in addition to PAT and PMT.

• SDT: check to process SDT, in addition to PAT and PMT.

Only one option can be selected.

If no option is checked, only PAT and PMT streams will be processed 
on the interface. 

Un-checked

Multicast IP 
Address

Enable (check) or disable (un-check) multicasting on this interface. 

• If enabled, type a valid multicast address (in the range 224.0.0.0 
through 239.255.255.255) to define the address carrying the 
service. 

• If disabled, type a valid unicast address. 

For each multicast input transport stream defined, the VMG issues an 
Internet Group Management Protocol (IGMP) join to the IP address 
specified in its configuration. A multicast group must be successfully 
joined before video can be routed to the interface.

Multicast: Blank

Unicast: Defaults 
to IP Address of 
GigE port

Source IP (Optional, and only for multicast IGMPv3 streams) Type the IP 
address of the source where the port receives data.

Blank

UDP Port The UDP port on which the input stream transports. Blank
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Creating FEC-based Input Transport Streams

The following guidelines should be considered when creating FEC-based input transport streams: 

• Each FEC-based input transport stream will use an additional four (4) UDP ports, totalling five (5) 
UDP ports per FEC enabled stream. For example, if creating an FEC input transport stream with a 
multicast IP address of 239.1.1.1, which uses UDP port number 500, port numbers 500-504 will be 
used for the FEC based stream. 

• For the reason mentioned above, creating multiple transport streams using incrementing UDPs for 
an FEC-based stream is not allowed. 

Creating Multiple Transport Streams

You can create both input and output multiple transport streams. To create an input stream, use steps in 
this section. 

1. At the Create GigE Input Transport Stream screen, enter the TS name, IP address, and UDP 
port number. Click Multiple TS to display the Multiple IP and UDP screen (Figure 83).

2. At the Multiple IP and UDP screen, select one of the incremental options, enter values to define 
the multiple and excluded UDP ports, then click Apply. 

FEC Enable (check) or disable (un-check) FEC decoding on the input 
transport stream.

When enabled, an additional four UDP ports will be used when the 
stream is created, totalling five UDP ports per FEC enabled stream. 

Refer also to “Creating FEC-based Input Transport Streams” on 
page 130 for more information.

Un-checked

Multiple TS Access the Select Multiple IP and UDP screen to set parameters for 
multiple transport streams. 

Refer also to “Creating Multiple Transport Streams” on page 130 for 
more information.

See Table 62 on 
page 131

Table 61. Create Input Transport Stream Fields (Continued)

Field Description Default
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Figure 83. Select Multiple IP and UDP 

Table 62. Create Multiple Transport Streams (IP and UDP)

Field Description Default

Start IP Address View the starting IP address. This field is read-only. Based on IP address 
from stream creation 
dialog 

End IP Address View the ending IP address. This field is read-only and is 
updated to reflect the value entered in the Multiple 
Number and Multiple TS Type fields.

Incremented by the 
Multiple Number if 
applicable. 

Start UDP View the starting UDP port. This field is read-only. Based on UDP port 
number from stream 
creation dialog.

End UDP View the ending UDP port. This field is read-only and is 
updated to reflect the value entered in the Multiple 
Number and Multiple TS Type fields.

Incremented by the 
Multiple Number if 
applicable. 

Multiple TS Type Set sequential increment method, as one of the following:

• Increment IP Address – Increment only the IP 
addresses.

• Increment UDP – Increment only the UDP ports.

• Increment Both IP Address and UDP – Increment 

both the IP addresses and UDP ports.a

a. When Increment Both IP Address and UDP option is selected, the Excluded UDP Ports option is not available. 

Increment IP Address 

Multiple Number Type a value to define the number of transport streams to 
create (number of increments).

Blank 

Excluded UDP Ports Type values to define the UDP ports to be excluded from 
the sequential increments. This field is available only 
when Increment UDP is selected for the increment type.

Use comma delimiters to separate port numbers in your 
entry. 

Hidden 



VMG Element Manager User Guide 132

Release 3.1.3 Creating Ghost Programs

Creating Ghost Programs

Ghost programs are used to add one or more unreferenced packet identifiers (PIDs) to an input 
transport stream. Unreferenced PIDs are input elementary streams that are not referenced by PAT/PMT 
tables. Such streams are not detected by the VMG system and require manual configuration for input 
routing. This manual operation is referred to as “ghost program” configuration.

Use the Create Ghost Program screen to set identifiers for a ghost program.

From the Inputs panel of the VMG Element Manager Grooming -> Mapping subtab, right-click the 
transport stream -> Create Ghost Program -> Create Ghost Program screen (Figure 84 and 
Table 63)).

1. Set program name and number. 

2. Click Apply to dismiss the screen and commit your settings.

3. Check the Input panel of the Mapping tab (Figure 85) page to ensure your ghost program is 
listed. 

Figure 84. Create Ghost Program.

Table 63. Create Ghost Program Fields 

Field Description Default

Program Name Type alphanumeric string to set name of the ghost program.

Maximum length = 32 characters.

Blank

Program 
Number

Type numeric string, in the range 65535 to 131072, to set number of 
the ghost program.

Blank
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Figure 85. Ghost Program Input Stream on Mapping Page

Note: To use the ghost program to add an unreferenced PID as an elementary stream, refer to 
“Adding an Unreferenced PID as an Elementary Stream” on page 262.

Modifying and Deleting Input Transport Streams and Programs

Use the Grooming tab of the VMG Element Manager screen to modify a transport stream (Figure 86) 
or program configuration (Figure 87). 

Right-click the input transport stream or program, and select an option from the popup menu. 

Figure 86. Transport Stream - Menu Options

The options available from the popup menu differ depending on the item selected. For example, if an 
item can be deleted, the Delete option becomes available. 

• Table 64 describes options from the Inputs transport stream popup menu.

• Table 65 describes options from the Inputs program popup menu.
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. 

Figure 87. Input Program Menus

Modify Input Program

Use the Modify Input Program (Figure 88) screen to change the name of the selected input program. 

Note: To find out how to modify output program parameters, see “Modify Output Program” on 
page 197.

From the input panel of the Grooming Mapping tab pagen -> right-click on a program, then select 
Modify Program Name from the popup menu. 

Table 64. Grooming - Inputs Transport Stream Popup Menu 

Menu Item Description

Modify Transport Stream Access the transport stream modification screen.

Delete Transport Stream Remove a selected transport stream.

Create Ghost Program Access the Create Ghost Program screen.

Table 65. Grooming - Input Program /Ghost Program Popup Menu  

Menu Item Description

Modify Program / Ghost Program Name Go to the Modify Input Program dialog for an input program. 

Delete Program / Delete Ghost Program Applicable for Ghost Program Only: Deletes the ghost program.

Rollback Original Program Name When selectable, allows you to return to the original name of 
the input program as received on the input port.

Config Program Redundancy Applicable for Non-Ghost Programs Only: Opens the Input 
Program Redundancy Configuration screen.

Add Elementary Stream Applicable for Ghost Program only: Opens the Add Elementary 
Stream screen.

Manage Program Languages Go to the Audio Stream Languages dialog, if any ES in the 
program is set for a language. 

If ES language has not been modified, an Info dialog states that 
no language modifications were found. 

Menu from Input Program Menu from Ghost Program
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Figure 88. Modify Input Program

1. At the Program Name: field, type an alphanumeric string (maximum 32 characters) to set a name 
for the selected program.

2. Click Apply.

3. Check the input panel to ensure that the program name is now displayed alongside the program 
number. 

Delete All Input Transport Streams

Use steps in this section to delete all input transport streams configured on an interface:

1. From the Inputs panel, right click the interface and select the Delete All Transport Streams 
option from the popup menu (Figure 89).

Figure 89. Menu - Delete All Transport Streams

2. Select Yes when prompted by the Delete Confirmation screen.
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Delete Single Input Transport Stream

Note: If an input transport stream contains programs that are groomed to output transport streams, 
you cannot delete the input stream until you first delete all of the groomed programs.

To delete a single transport stream and all its associated programs from an interface:

1. From the Inputs panel of the Grooming -> Mapping screen, right-click the desired transport 
stream and select the Delete Transport Stream option from the popup menu (as shown in 
Figure 86).

2. Select Yes when prompted by the Delete Confirmation screen.

Delete Ghost Program

Note: Input programs learned through configuring an input transport stream cannot be deleted.

To delete a single ghost program in an input transport stream:

1. Right-click the ghost program and select the Delete Ghost Program option from the popup menu 
(as shown in Figure 87).

2. Select Yes when prompted by the Delete Confirmation screen.

Configuring Program Languages

The VMG Element Manager provides language control tools you can use to perform the following 
tasks:

• Modify the original language (english) for audio elementary stream(s) associated with an input 
Program.

• Reset the original language, either from the ES level or from the program level.

• View all languages currently configured to run within a program. 

Modifying Language Descriptors

The VMG provides ISO 639-compliant configuration for language coding on individual input audio 
elementary streams. 

Use the Modify Language Descriptor dialog (Figure 90 and Table 66) to view the current language, 
and/or to select the language to be associated with a specified audio elementary stream. 

At the VMG Element Manager, Grooming tab -> Mapping tab page, Inputs column -> right-click on 
an Audio ES, and select Modify Language Descriptor from the popup menu. 



VMG Element Manager User Guide 137

Release 3.1.3 Configuring Program Languages

Figure 90. Modify Language Descriptor

Note: The current implementation of the Language Descriptor function only allows you to add a 
descriptor to an input stream. If the input stream already carries a descriptor, it cannot be 
removed. 

1. With the Modify Language Descriptor dialog in view, click to check the New Language box. 
The dialog immediately expands to provide the drop-down selector, and presents an audio-
interrupt warning. 

2. Use the drop-down selector to define the language to be used on the elementary stream, then click 
Apply to commit the setting.. 

The setting will remain until it is either reset at the Modify Language Descriptor dialog or removed 
at the program level (as described in “Managing Program Languages” on page 138).

Table 66. Modify Language Descriptor

Menu Item Description

Original Language Three-letter country code that identifies the language descriptor originally 
provided in the VMG Element Manager software. 

New Language Click to check-mark and reveal the entry field for New Language. 

Languages you can choose are listed in Table 137 on page 313. 
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Managing Program Languages

All language descriptors modified for a program can be viewed or removed by means of the Manage 
Audio Stream Languages dialog (Figure 91). 

At the VMG Element Manager, Grooming tab -> Mapping tab page, Inputs column -> right-click on 
a Program, and select Manage Program Languages from the popup menu. 

Figure 91. Manage Program Languages

Configuration Prerequisite for Language Management

If a language has not been set for an audio ES within the selected program, an error message is 
presented (Figure 92). 

Figure 92. Language—Not Configured

Refer to “Modifying Language Descriptors” on page 136 to configure language associations for input 
audio elementary streams. 

Removing a Language Descriptor at the Program Level

1. Go to the Manage Audio Stream Languages dialog for a specific program.

1. At the dialog, click one or more check boxes at the Remove column. 

There are no other editable fields in this dialog.

2. Click the Apply button. 

All applicable audio elementary streams are returned to the Original Language setting(s).
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Single Video Transport Streams

This chapter describes the use of the VMG Element Manager Grooming -> Mapping tab page to 
manage the creation and grooming of standard single bitrate transport streams—AVTX, VTX, PIP, and 
VTR. 

Note: System configuration must be completed before performing grooming tasks. 
Refer to Chapter 4, “System Configuration” for more information.

Note: The VMG supports program redundancy and elementary stream/PID management. If you plan 
to implement any of these advanced applications, please familiarize yourself with their 
respective sections in Chapter 13, “Advanced Grooming Applications” before performing the 
procedures in this chapter.

In This Chapter:

• “Creating Output Transport Streams,” next.

• “Output Programs and Grooming” on page 157.

• “Managing Standard Output Streams and Programs” on page 184.

Creating Output Transport Streams

The VMG supports four types of single bitrate output streams: MPEG-2 and SCTE; ATSC and DVB, 
for which the VMG supports PSIP/SI table generation. 

• Processes for creating either an MPEG-2 or SCTE output stream are identical. 

See “Creating Single Video Output Transport Streams” on page 140.

• Processes for creating ATSC and DVB output streams and for generating PSIP tables are similar.

See “Creating ATSC and DVB Output Transport Streams” on page 151.
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Creating Single Video Output Transport Streams

Use steps in this section to create an MPEG-2 or SCTE output transport stream. 

1. Access the output transport stream menu:

From the Outputs panel of the Grooming -> Mapping -> tab page, right-click on a GigE interface 
and select a single video option—AVTX, VTX, PIP, or VTR—from the popup menu (Figure 93).

Figure 93. Create Output Transport Stream - GigE interface menu 

2. Set parameters into the Create Output Transport Stream screen associated with your selection 
(Table 67).  

Video transcoding parameters for use with these screens are described in Table 68 on page 145, and 
Table 69 on page 148. 

Table 67. Options for Creation of MPEG-2 and SCTE Output Transport Streams 

Menu Selection Description 

Create AVTX Transport Stream Access the Create Output AVTX Transport Stream screen (Figure 94) 
to set parameters for a standard output transport stream that enables 
both audio and video transcoding. 

See also “Create Output AVTX Transport Stream” on page 141.

Create VTX Transport Stream Access the Create VTX Transport Stream screen (Figure 95) to set 
parameters for standard output transport stream that enables video 
transcoding only.

See also “Create Output VTX Transport Stream” on page 142. 

Create PIP Transport Stream Access the Create PIP Transport Stream screen (Figure 96) to set 
parameters for standard transcoded PIP program output transport stream.

See also “Create Output PIP Transport Stream” on page 143. 

Create VTR Transport Stream Access the Create VTR Transport Stream screen (Figure 97) to set 
parameters for non-transcoding transrating output transport stream. 

See also “Create Output VTR Transport Stream” on page 144. 

Single bitrate output streams
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Create Output AVTX Transport Stream

Use the Create Output AVTX Transport Stream dialog (Figure 94) to set parameters for an 
AVTX TS at a selected GigE output port. 

Grooming -> Mapping -> Outputs -> right-click on a GigE interface -> select Create AVTX 
Transport Stream from the popup menu. 

Figure 94. Create Output AVTX Transport Stream - configuration

1. At the Create Output AVTX Transport Stream dialog, enter information to define the AVTX 
TS. Use guidelines from Table 68 for your entries. 

2. Click Apply Configuration to save and use the configuration. 

The new AVTX TS is now displayed at the Outputs panel of the Mapping tab page. 

This transport stream is now ready to accept program setup and/or mapping.

NOTE:
For HD Input 
Resolution, the Video 
Type and Video 
Standard fields are not 
displayed in this screen. 
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Create Output VTX Transport Stream

Use the Create Output VTX Transport Stream dialog (Figure 95) to set parameters for a VTX TS at 
a selected GigE output port. 

Grooming -> Mapping -> Outputs -> right-click on a GigE interface -> select Create VTX 
Transport Stream from the popup menu. 

Figure 95. Create Output VTX Transport Stream - configuration

1. At the Create Output VTX Transport Stream dialog, enter information to define the VTX TS. 
Use guidelines from Table 68 for your entries. 

2. Click Apply Configuration to save and use the configuration. 

The new VTX TS is now displayed at the Outputs panel of the Mapping tab page. 

This transport stream is now ready to accept program setup and/or mapping.

NOTE:
For HD Input 
Resolution, the Video 
Type and Video 
Standard fields are not 
displayed in this screen. 
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Create Output PIP Transport Stream

Use the Create Output PIP Transport Stream dialog (Figure 96) to set parameters for an PIP TS at a 
selected GigE output port. 

Grooming -> Mapping -> Outputs -> right-click on a GigE interface -> select Create PIP 
Transport Stream from the popup menu. 

Figure 96. Create Output PIP Transport Stream - configuration

1. At the Create Output PIP Transport Stream dialog, enter information to define the PIP TS. Use 
guidelines from Table 68 for your entries. 

2. Click Apply Configuration to save and use the configuration. 

The new PIP TS is now displayed at the Outputs panel of the Mapping tab page. 

This transport stream is now ready to accept program setup and/or mapping.

NOTE:
For HD Input 
Resolution, the Video 
Type and Video 
Standard fields are not 
displayed in this 
screen. 
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Create Output VTR Transport Stream

Use the Create Output VTR Transport Stream dialog (Figure 97) to set parameters for an VTR TS 
at a selected GigE output port. 

Grooming -> Mapping -> Outputs -> right-click on a GigE interface -> select Create VTR 
Transport Stream from the popup menu. 

Figure 97. Create Output VTR Transport Stream - configuration

1. At the Create Output VTR Transport Stream dialog, enter information to define the VTR TS. 
Use guidelines from Table 68 for your entries. 

2. Click Apply Configuration to save and use the configuration. 

The new VTR TS is now displayed at the Outputs panel of the Mapping tab page. 

This transport stream is now ready to accept program setup and/or mapping.
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Parameters listed and described in Table 68 are provided in the Create Outputs Stream screens for 
configuration of single-video transcoded and non-transcoded streams.

Table 68. Create Output Transport Stream - Parameters for AVTX, VTX, VTR, and PIP  

Field Description Default

Port Displays the selected port on which the output transport stream is 
being created. 

Read-only 

Transcoding Note that a valid MPEG-2 or H264 SD or HD license is required to 
enable transcoding. The following transcoding transport streams are 
available:

• AVTX (Audio + Video)

• VTX (Video)

• PIP (Video)

When displayed as checked, transport-level transcoding is enabled for 
an SPTS program in the TS. 

This field is un-checked for VTR transport streams.

Read-only

TS Name (Optional) Alphanumeric string to set name for the output transport 
stream.

Maximum length = 32 characters.

Blank

TS DPI For VTR Transport Streams only: Enables transport level DPI for the 
output transport stream. All programs within this output transport 
stream will be DPI capable. 

A bandwidth based DPI license, and available bandwidth, are 
required.

Un-checked 

Program DPI For VTR Transport Streams only: Enables program level DPI for the 
output transport stream. Only output programs created with DPI 
enabled will be DPI capable. 

A number-based DPI license, and available DPI sessions, are 
required.

Un-checked 

SPTS Check if the output is a single program transport stream (SPTS).

If you are creating a transcoding (AVTX, VTX, PIP) transport stream, 
SPTS is checked and read-only

Checked


Multicast IP

Unicast IP

Set stream as either multicast (check) or unicast (un-check). 

• For multicast, type a valid multicast IP address.

• For unicast, type a unicast IP address, and provide subnet mask 
and ARP settings. 

Checked 
(multicast)

Bitrate (Mbps) Value to set bitrate of the output stream. 

As appropriate for your locale, type a comma or a period symbol to 
designate the decimal point in your entry (see also “Bitrate Entry 
Guidelines” on page 310). 

See “Bitrate Configuration Reference” on page 310 for guidelines.

AVTX= 20
VTX = 20
PIP = 1.2
VTR = 38
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Async Data 
Bitrate (Mbps)

For AVTX, VTX, and PIP transport streams, value in Mbps to set 
maximum bitrate for asynchronous data in this stream. 

The async data bitrate cannot exceed the TS bitrate.

As appropriate for your locale, type a comma or a period symbol to 
designate the decimal point in your entry (see also “Bitrate Entry 
Guidelines” on page 310). 

See “Bitrate Configuration Reference” on page 310 for guidelines.

PIP: 0 (no 
maximum limit; 
equivalent to the 
transport stream 
bitrate)

Automatic 
Video Bitrate

(In Mbps)

Enable (check) or (disable) auto video bitrate assignment. 

• If enabled (checked) the system assigns the video bitrate, with the 
latency marked by a “Perfecting video” message until the bitrate is 
assigned. 

• If disabled (un-checked) enter a value to define video bitrate (See 
“Bitrate Configuration Reference” on page 310, for acceptable 
values).

As appropriate for your locale, type a comma or a period symbol to 
designate the decimal point in your entry (see also “Bitrate Entry 
Guidelines” on page 310). 

AVTX=15.0

VTX=15.0

PIP = 0.3

UDP Port Identifier of the UDP port to use for transmitting data. Blank

Pick TS ID Enables the system to choose a unique number for identification of the 
output transport stream. 

When checked, the entry field is displayed. Enter a value, in decimal 
format, in the range 0 to 65535. 

Display of this field is demonstrated in Figure 98, “Subnet Mask, ARP, 
Mac Address, FEC, and TS ID fields for output TS,” on page 148.

Un-checked 

When checked: 0 

Subnet Mask For unicast configuration only—set the subnet mask of the output 
transport stream. 

Display of this fiFeld is demonstrated in Figure 98, “Subnet Mask, 
ARP, Mac Address, FEC, and TS ID fields for output TS,” on 
page 148.

255.255.255.0 

Network PID Value, in the range 16 to 8175, to define the program ID of transport 
stream packets that contain the network information table. 

8175

When creating a 
DVB output 
transport stream, 
this field defaults 
to 16 and is read 
only.

ARP For unicast configuration only—Enable (check) or disable (un-check) 
ARP for this stream:

• If creating a unicast transport stream on GigE’s 1-8, check this box 
if ARP is to be used for broadcasting the VMG MAC address. 

• If creating a unicast transport stream on 10GigE 1 or 10GigE 2, un-
check this box and enter the MAC address

• Display of this field is demonstrated in Figure 98, “Subnet Mask, 
ARP, Mac Address, FEC, and TS ID fields for output TS,” on 
page 148

enable (checked)

Table 68. Create Output Transport Stream - Parameters for AVTX, VTX, VTR, and PIP (Continued) 

Field Description Default
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TS Type For AVTX, VTX, or PIP, select type of output transport stream to 
create, as either MPEG-2, ATSC, SCTE, or DVB. This setting is not 
applicable to VTR transport streams. 

For TS types ATSC or DVB, refer to “Creating ATSC and DVB Output 
Transport Streams” on page 151 for additional configuration 
parameters.

MPEG-2 

MAC Address Where ARP is not enabled, type the physical MAC address of the 
active NPM. 

Display of this field is demonstrated in Figure 98, “Subnet Mask, ARP, 
Mac Address, FEC, and TS ID fields for output TS,” on page 148

Hidden if ARP 
enabled.

When ARP is un-
checked: 
00:00:00:00:00:00 

Multiple TS Click to access the Select Multiple IP and UDP screen, to create 
multiple transport streams.

Refer to “Creating Multiple Transport Streams” on page 130 for more 
information.

RTP Enable (check) or disable (un-check) Real Time Protocol (RTP) on the 
output transport stream. 

Un-checked 

FEC For transrating transport streams only: Enable (check) or disable (un-
check) Forward Error Correction (FEC) on the output transport stream. 
Checking the FEC option reveals the following fields in which to set 
the height and width of the FEC matrix: 

D: value to define FEC height, in the range 4 to 20. 

L: value to define FEC width, in the range 1 to 20

When checked, an additional four UDP ports will be used when the 
stream is created, to total five UDP ports per FEC-enabled stream. 

Display of REC port configuration fields is demonstrated in Figure 98, 
“Subnet Mask, ARP, Mac Address, FEC, and TS ID fields for output 
TS,” on page 148. Additional guidelines for FEC configuration are 
provided in “Creating FEC-based Output Transport Streams” on 
page 151.

Un-checked



D = 4

L = 1

Redundant 
Output Button

Access the Set Redundant IP Address dialog to set a multicast or 
unicast IP address for supplemental port mirroring. 

See also “Redundant Output” on page 149. 

n/a

Advanced 
Setting Button

For VTR transport stream only: Access advanced settings for the 
selected transport stream. 

See also “Advanced Transport Stream Setting” on page 150. 

n/a

Table 68. Create Output Transport Stream - Parameters for AVTX, VTX, VTR, and PIP (Continued) 

Field Description Default
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Parameters listed and described in Table 69 are provided in the Create Outputs Stream screens for 
configuration of single-video transcoded and non-transcoded streams.

Unicast Addressing for Output Transport Streams

If the output transport stream configuration dialog is set to disable (un-check) multicast, the unicast 
IP address field is then revealed to enable entry of the IP address to be associated with this stream. 
Correspondingly, the subnet mask, ARP and MAC address fields are also revealed (Figure 98). 

Figure 98. Subnet Mask, ARP, Mac Address, FEC, and TS ID fields for output TS

Table 69.  Video Transcoding Parameters - Standard Output Streams

Field Description Default

Input 
Resolution 
Class

 Select HD or SD.

• For SD, additional fields are displayed in which to set video type (as 
either MPEG-2 or H264) and video standard (as either NTSC or 
PAL). 

• HD does not require video type and video standard settings.

• AVTX and 
VTX: HD input, 
HD output, and 
MPEG-2 video

• PIP:
HD input, PIP 
output, and 
H264 video

• VTR (not 
applicable)

Output 
Resolution 
Class

Select HD or SD. 

• For SD: set video type as either MPEG-2 or H264. 

• For HD: set video type as either MPEG-2 or H264.



VMG Element Manager User Guide 149

Release 3.1.3 Creating Output Transport Streams

Redundant Output

The redundant output function supplements the port mirroring established via GigE port configuration, 
and allows you to configure secondary DIP and DMAC (if DIP is unicast) for a specific output 
transport stream. This allows the DIP of the redundant output transport stream to differ from the 
source. 

With the Set Redundant IP Address dialog for either unicast or multicast, you can set up the 
secondary DIP for use with a specific output transport stream.

• Multicast: the DMAC is well-known and derived directly from the DIP. Therefore, when an 
output ts is enabled (assigned to a TCM or VPM on the VMG), its network settings are enacted 
without additional dependencies. 

• Unicast. In this case, wait is necessary during ARP resolution for both primary (if primary is 
unicast) and secondary DIPs before the network settings can be enacted. 

If ARP for the secondary DIP is not resolved, the primary output transport stream will not be 
transmitted (even if ARP for the primary DIP is resolved), and vice versa. 

You can statically configure both the primary and secondary DMAC addresses (if unicast) to avoid 
ARP dependencies during programming of the output transport stream.

Create <type> Transport Stream--> set Multicast or Unicast IP address --> click Redundant Output 
button --> Set Redundant IP Address dialog.

Figure 99. Set Redundant IP Address—Multicast
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Figure 100. Set Redundant IP Address—Unicast

Advanced Transport Stream Setting

This option applies only to VTR transport streams, and provides access to configuration of the MPTS 
H.264 alarm bitrate level. This setting can assist in maintaining video quality for MPEG-2 video 
content in the presence of other content, such as H.264, which bypasses the VMG’s transrater. If the 
H.264 program bandwidth exceeds the configured percentage, an alarm is generated. 

Use the Advanced Transport Stream Setting dialog (Figure 101 and Table 70) to set the H.264 
Alarm Bitrate.

Grooming -> Mapping -> Outputs -> right-click GigE interface -> select Create Output VTR -> 
Create Output VTR Transport Stream screen (un-check the SPTS option) --> click Advanced 
Setting button -> Advanced Transport Stream Setting dialog.

Figure 101. Advanced Transport Stream Setting - MPTS

1. At the Advanced Transport Stream Setting dialog, select a value to define a percentage of 
transport stream bandwidth. 
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2. Click Apply to dismiss this dialog and to return to the Output Transport Stream dialog. 

3. At the Output Transport Stream dialog, click Apply Configuration to save and use this setting.

Creating FEC-based Output Transport Streams

The following guidelines should be considered when creating FEC-based output transport streams: 

• Because FEC coding is used on top of the RTP, when the FEC field is checked, RTP must also be 
checked. 

• The valid height (D) range of the FEC matrix is from 4 to 20. 

• The valid width (L) range of the FEC matrix is from 1 to 20. 

• Each FEC-based output transport stream will use an additional four (4) UDP ports, totalling five 
(5) UDP ports per FEC enabled stream. 

For example, if creating an FEC output transport stream with a multicast IP address of 239.1.1.1, 
which uses UDP port number 500, port numbers 500-504 will be used for the FEC-based stream. 

• For the reason mentioned above, creating multiple transport streams using incrementing UDPs for 
an FEC-based stream is not allowed. 

Creating ATSC and DVB Output Transport Streams

PSIP (Program and System Information Protocol) is a collection of tables operating within the 
terrestrial broadcast Transport Stream (TS) of every digital (and sometimes analog) television. PSIP 
settings are configured as part of the transport stream. PSIP tables are defined as part of the ATSC 
standards. DVB defines Service Information (SI) tables to achieve similar functions.

These tables contain system information and program data:

• System information allows navigation and access of the channels within the DTV transport stream.

• Program data provides necessary information for efficient browsing and event selection.

• Some PSIP tables contain the information to locate digital streams. 

Note: If you are not sure of the PSIP guidelines, there are many good references on the Internet, 
including the ATSC Recommended Practice: Program and System Information Protocol 
Implementation Guidelines for Broadcasters at http://www.atsc.org/standards/. 

For DVB reference, see DVB-SI reference, see http://www.home.agilent.com/upload/
cmc_upload/All/6C06MPEGPAPER1.pdf

Table 70. Advanced Transport Stream Setting

Field Description Default

MPTS H.264 
Alarm Bitrate 
Level (Mbps): 
19.00

Value to define percentage of aggregated transport stream 
bandwidth allowable before generating alarm, as one of the 
following:

0%, 25%, 50%, 75%, 100%

50%

http://www.atsc.org/standards/
http://www.home.agilent.com/upload/cmc_upload/All/6C06MPEGPAPER1.pdf
http://www.home.agilent.com/upload/cmc_upload/All/6C06MPEGPAPER1.pdf
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Creating ATSC Output Transport Streams

Use steps in this section to create a new ATSC output transport stream.

1. From the Outputs panel of the Grooming -> Mapping tab page, right-click the output port on 
which to create the stream and select one of the following options from the popup menu 
(Figure 93):

• Create AVTX Transport Stream

• Create VTX Transport Stream

• Create PIP Transport Stream

• Create VTR Transport Stream

The Create Transport Stream configuration dialog associated with your selection is now 
displayed. 

2. At the output stream configuration dialog, in the TS Type field, select ATSC. 

The lower portion of the screen expands to reveal the ATSC configuration fields shown in 
Figure 102. 

Figure 102. Create ATSC Output Transport Stream

3. Use guidelines from Table 71 to define ATSC parameters for the output transport stream. 

4. Click Apply Configuration to save and use these settings.

PSIP table fields
(see Table 71).
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Table 71. Create ATSC Output Transport Stream Fields 

Field Description Default

EIT PID
  EIT [0-3]

Event Information Table packet identifier (PID) numbers. These can 
be manually set, overriding the PID in the Master Guide Table 
(MGT). 

• Valid range is from 48 to 8175

• EIT 1 - 3 automatically increments by 1, as based on the base 
value entered in EIT 0. 

Blank 

EIT Interval
  EIT [0-3]

Event Information Table intervals. These can be manually set, 
overriding the intervals in the Master Guide Table (MGT).

EIT 0: Valid range from 10 to 500 
EIT 1: Valid range from 1000 to 3000
EIT 2: Valid range from 30000 to 60000
EIT 3: Valid range from 30000 to 60000



EIT 0: 500
EIT 1: 3000
EIT 2: 60000
EIT 3: 60000

MGT Interval The Master Guide Table intervals. The MGT is the highest table in 
the ATSC transport stream table hierarchy. It contains the PIDs of 
other tables so receivers can locate them.

Valid range is from 10 to 150 

150 

CVCT Interval Cable Virtual Channel Table intervals. The CVCT provides 
information about channels, such as channel name, navigation 
identifier, and stream components.

Valid range is from 10 to 400 

400 

STT Source System Time Table source. The STT serves as a reference for time-
of-day functions. Used for setting daylight-savings time indicators 
on the consumer’s set-top box, and synchronizing the concept of 
“now” between the set-top box and the broadcaster.

• Click the Select STT button to select a source. If a groomed input 
transport stream is using an STT, valid options will appear in this 
menu. 

• There must be a valid STT source to be ATSC compliant.

Blank

RRT Source Rating Region Table source. The RRT transmits the program rating 
information. 

• Click the Select RRT button to select a source. If a groomed 
input transport stream is using an RRT, valid options will appear 
in this menu.

• There must be a valid RRT source to be ATSC compliant.

Blank 

Modulation 
Mode

Valid modes are: 

Analog, SCTE 64 QAM, SCTE 256 QAM, ATSC 8 VSB, and ATSC 
16 VSB.

SCTE 256 QAM
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Creating DVB Output Transport Streams

Use steps in this section to create a new DVB output transport stream.

1. From the Outputs panel of the Grooming -> Mapping tab page, right-click the output port on 
which to create the stream, and select one of the following options from the popup menu 
(Figure 93):

• Create AVTX Transport Stream

• Create VTX Transport Stream

• Create PIP Transport Stream

• Create VTR Transport Stream

2. At the output stream configuration dialog, in the TS Type field, select DVB. 

The lower portion of the screen expands to reveal the fields shown in Figure 103.

Figure 103. Create DVB Output Transport Stream   

3. Use guidelines from Table 72 to define DVB parameters for the output transport stream. 

4. Click Apply Configuration to save and use these settings. 
.

Table 72. Create DVB-SI Output Transport Stream Fields 

Field Description Default

Network ID Value, in the range 0 to 65535, to set Network ID of the current 
transport stream.

160

DVB-SI table fields
(See Table 72)
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Modulation 
Mode

Modulation mode to be used for the TS, as either SCTE 64 QAM or 
SCTE 256 QAM.

SCTE 256 QAM

Original 
Network ID

Value, in the range 0 to 65535, to set the Network ID from which this 
stream has originated.

160

NIT Source Specifies whether or not a DVB network information table is to be 
included in the output TS. To place a value for NIT Source, click 
Select NIT, then select an option from the Select NIT Source 
dialog:

• None - No NIT will be generated on the output TS

• [Input GigE TS ID] - Specified source NIT will be included in the 
output TS. 

NOTE: If a NIT is to be included in the output TS, a valid DVB 
stream must be feeding the input, and DVB table processing must 
be enabled on the input TS. Refer also to Table Processing in 
Table 69 on page 148.


Blank

TDT/TOT 
Source

Specifies whether or not DVB time and date, and time offset tables 
will be generated for the output TS. To place a value for TDT/TOT 
Source, click Select TDT/TOT, then select a value from the Select 
TDT/TOT Source dialog:

• None - No DVB time tables will be generated on the output TS.

• Local TOT - The output TS will use the locally configured TOT. 

• [Input GigE TS ID] - Specified source TDT/TOT will be included in 
the output TS.

NOTE: If a TDT/TOT is to be included in the output TS, a valid DVB 
stream must be feeding the input, and DVB table processing must 
be enabled on the input TS. Refer also to Table Processing in 
Table 69 on page 148.

Blank

Table 72. Create DVB-SI Output Transport Stream Fields (Continued)

Field Description Default

Example of NIT 
Source selection 
that includes the 
input TS (GigE 6 
TS), which is a 
DVB stream for 
which DVB table 
processing has 
been enabled. 

Example of TDT/
TOT Source 
selection that 
includes the input 
TS (GigE 6 TS), 
which is a DVB 
stream for which 
DVB table 
processing has 
been enabled. 
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SDT Source Specifies whether or not a service description table will be 
generated for this transport stream, as one of the following:

• N/A - No SDT will be generated for this output TS

• LocalSDT - Local SDT will be generated for this output TS. 

NOTE: if an SDT is to be included in the output TS, a valid DVB stream must 
be feeding the input, and DVB table processing must be enabled on the 
input TS. Refer also to Table Processing in Table 61, “Create Input 
Transport Stream Fields,” on page 129.

LocalSDT

EIT Source Specifies how an Event Information Table (EIT) is generated by the 
VMG, as one of the following:

• Groomed Input is selected, an Event Information Table (EIT) is 
generated based on that which is received from the groomed 
input program of the DVB TS. 

• N/A - No EIT will be generated for this output TS.

Groomed Input

Table 72. Create DVB-SI Output Transport Stream Fields (Continued)

Field Description Default
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Output Programs and Grooming

The VMG supports program-level grooming. The VMG Element Manager provides two methods you 
can use to create new output programs in standard output transport streams, as described in the 
following topics:

• “Manual Program Creation,” next.

• “Using Drag-and-Drop to Create Output Programs” on page 170.

The manual program creation method walks you through the Output Program creation process, 
whereas drag-and-drop program creation automatically sets up an output program on the transport 
stream to which the program was dragged.

Note: The target output transport stream must already exist before performing program level 
grooming. Refer to “Creating Single Video Output Transport Streams” on page 140 and 
“Creating ATSC Output Transport Streams” on page 152 for more information.

Note: Output program creation depends on the type of licenses installed. Refer to “License 
Management” on page 99 for details.

Manual Program Creation

This section contains guidelines for the following manual configurations:

• “Manual configuration for non-transcoded program,” next.

• “Manual setup for transcoded program” on page 159

Manual configuration for non-transcoded program

Use the Create Output Program screen for manual setup of a non-transcoded program. 

From the Outputs panel of the Grooming -> Mapping tab page -> right-click a non-transcoded 
transport stream -> select Create Program from the popup menu -> Create Output Program dialog 
(Figure 104). 

Figure 104. Manual Program Creation-Non transcoded Stream
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1. At the Create Output Program dialog, use guidelines from Table 73 to define the output 
program. 

2. Click Apply to save and use your settings. 

After creating the program, an existing input program can be dragged and dropped over it, which 
will open the Configure Program Mapping dialog (see example in Figure 110 on page 171). 
For more information, see “Managing Standard Output Streams and Programs” on page 184.

Table 73. Grooming - Create Output Program Fields  - Non-transcoded

Field Description Default

Port View the GigE or 10 GigE interface on which the program is 
being created. 

Read-only

IP Address The destination IP address of the transport stream. Read-only

UDP Port UDP port the program uses, based on UDP port of the 
transport stream. 

Read-only

TS ID The program’s transport stream id (name), based on TS ID 
of the transport stream. 

Read-only 

TS Type Type of transport stream, based on TS type specified in the 
creation of the transport stream.

Read-only 

Program Number Number assigned to the program.

Valid range is from 1 to 131072 

1 

Program Name Type alphanumeric string to set program name. 

Maximum length = 32 characters. 

Default format: GigE #-t[unique id]-[Program Number] 

e.g: 

GigE 7-
t47221504-1 

PMT PID ID of the program map table (PMT).

Check this box to input a valid range from 48-8175. 

Un-checked 

Major Channel Number Operator-defined channel number that groups all channels 
to be identified to a particular broadcast corporation. When 
the program’s TS Type is set to ATSC, the value in this field 
may be set from 1 to 999. 

Read-only

Minor Channel Number Operator-defined channel number that identifies a particular 
channel within the Major Channel Number group. When the 
program’s TS Type is set to ATSC, the value in this field may 
be set from 0 to 999. 

Read-only 

Program DPI Enable or disable DPI for the output program. 

• This field is displayed only if the output transport stream 
was enabled for Program-level DPI. 

• A number-based DPI license, and available DPI sessions 
are required. 

• Each program with program-level DPI enabled will use 
one license from the available license pool. To “free up” a 
program DPI license, un-check this box. 

• This box must be un-checked to enable program deletion. 

Un-checked 

SCTE 30 to 35 
Conversion

Used to enable SCTE 30 to SCTE 35 conversion. Un-checked 
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Manual setup for transcoded program

Use the Create Transcoding Output Program dialog to manually establish a transcoded program 
type. This setup is available for VTX or PIP transport streams: it does not apply to AVTX transport 
streams. 

Transcoded programs do not support DPI, Program Substitution, SCTE 30 to 35 conversion, or 
transrating. The fields associated with these options are not visible when creating or grooming 
transcoded programs. 

From the Outputs panel of the Grooming -> Mapping tab page, right-click the VTX or PIP transport 
stream and select Create Program from the popup menu -> Create Transcoding Output Program 
dialog.

The entry fields provided in the Create Transcoding Output Program screen will be pertinent to the 
type of video transcoding already configured for the output GigE port, as one of the following:

• MPEG-2 HD Encoded Video—Transcoded Output Program Configuration (see  page 160).

• MPEG-2 SD Encoded Video—Transcoded Output Program Configuration (see  page 161).

• HD Encoded H.264 Video—Transcoded Output Program Configuration (see  page 162)

• SD Encoded H.264 Video—Transcoded Output Program Configuration (see  page 163).

• PIP Encoded H.264 Video—Transcoded Output Program Configuration (see  page 164).

Program Substitution Enable or disable program substitution for the output 
program. 

• A number-based Program Substitution license, and 
available Program Substitution sessions are required. 

• Each program with Program Substitution enabled will use 
one license from the available license pool. To “free up” a 
program substitution license, un-check this box. 

• When this box is checked, the Program DPI box may not 
be checked at the same time. 

• This box must be un-checked before program deletion. 

• When this box is checked, the Disable PMT update during 
program substitution option becomes visible. 

NOTE: DPI is not supported on a channel substituted 
program. 

Un-checked 

Disable PMT update 
during program 
substitution

When checked, this option will maintain the same PMT table 
version after a substitution event as long as elementary 
stream structures match. This avoids possible set top box 
re-tuning and disruptions.

• This field is only displayed when the Program Substitution 
box is checked; otherwise, this box is hidden.

Hidden

Table 73. Grooming - Create Output Program Fields (Continued) - Non-transcoded

Field Description Default
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MPEG-2 HD Encoded Video—Transcoded Output Program Configuration

For this setup, you should first check to ensure that the VTX TS is configured for MPEG-2 HD 
encoded video. 

1. At the Create or Modify Output Transport Stream dialog, ensure that the Video Transcoding 
section contains the following entries:

2. Use the Create Transcoded Output Program screen from an output VTX TS (Figure 105) to set 
parameters for an HD Encoded MPEG-2 video program. 

Figure 105. Create Transcoding Output Program - MPEG-2, HD Encoding

3. At the Create Transcoding Output Program dialog, use guidelines from the following tables to 
define this output program:

- “Create Transcoding Output Program—Associated TS Parameters” on page 165.

- “Create Transcoding Output Program—PMT/PSIP Parameters” on page 165.

- “Create Transcoding Output Program—Video Parameters” on page 166.

4. Click Apply to save and use these settings. 

For 
VTX 

TS
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MPEG-2 SD Encoded Video—Transcoded Output Program Configuration

For this setup, you should first check to ensure that the VTX TS is configured for MPEG-2 SD 
encoded video. 

1. At the Create or Modify Output Transport Stream dialog, ensure that the Video Transcoding 
section contains the following entries:

2. Use the Create Transcoded Output Program screen from an output VTX TS (Figure 106) to set 
parameters for an SD Encoded MPEG-2 video program. 

Figure 106. Create Transcoding Output Program - MPEG-2, SD Encoding

3. At the Create Transcoding Output Program dialog, use guidelines from the following tables to 
define this output program:

- “Create Transcoding Output Program—Associated TS Parameters” on page 165.

- “Create Transcoding Output Program—PMT/PSIP Parameters” on page 165.

- “Create Transcoding Output Program—Video Parameters” on page 166.

4. Click Apply to save and use these settings. 

For 
VTX 
TS
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HD Encoded H.264 Video—Transcoded Output Program Configuration

For this setup, you should first check to ensure that the PIP or VTX TS is configured for H.264 HD 
encoded video. 

1. At the Create or Modify Output Transport Stream dialog (for VTX or PIP), ensure that the 
Video Transcoding section contains the following entries:

2. Use the Create Transcoded Output Program screen (Figure 107) to set parameters for an HD 
Encoded H.264 video program. 

Figure 107. Create Transcoding Output Program - H.264, HD encoded

3. At the Create Transcoded Output Program dialog, use guidelines from the following tables to 
define this output program:

- “Create Transcoding Output Program—Associated TS Parameters” on page 165.

- “Create Transcoding Output Program—PMT/PSIP Parameters” on page 165.

- “Create Transcoding Output Program—Video Parameters” on page 166.

4. Click Apply to save and use these settings. 

For 
PIP 
TS

For 
VTX 
TS
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SD Encoded H.264 Video—Transcoded Output Program Configuration

For this setup, you should first check to ensure that the PIP or VTX TS is configured for H.264 SD 
encoded video. 

1. At the Create or Modify Output Transport Stream dialog (for VTX or PIP), ensure that the 
Video Transcoding section contains the following entries:

2. Use the Create Transcoded Output Program screen from an output PIP or VTX TS (Figure 108) 
to set parameters for an SD Encoded H.264 video program.

Figure 108. Create Transcoding Output Program - H.264, SD encoded

3. At the Create Transcoded Output Program dialog, use guidelines from the following tables to 
define this output program:

- “Create Transcoding Output Program—Associated TS Parameters” on page 165.

- “Create Transcoding Output Program—PMT/PSIP Parameters” on page 165.

- “Create Transcoding Output Program—Video Parameters” on page 166.

4. Click Apply to save and use these settings. 

For 
PIP 
TS

For 
VTX 
TS
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PIP Encoded H.264 Video—Transcoded Output Program Configuration

Use the Create Transcoded Output Program screen (Figure 109) to set parameters for a PIP 
Encoded H.264 video program. 

Figure 109. Create Transcoding Output Program - H.264, PIP encoded

1. At the Create Transcoded Output Program dialog, use guidelines from the following tables to 
define this output program:

- “Create Transcoding Output Program—Associated TS Parameters” on page 165.

- “Create Transcoding Output Program—PMT/PSIP Parameters” on page 165.

- “Create Transcoding Output Program—Video Parameters” on page 166.

2. Click Apply to save and use these settings. 

For 
PIP 
TS
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Create Transcoding Output Program—Associated TS Parameters

The parameters listed and described in Table 74 are provided in the Create Transcoding Program 
dialog. 

Create Transcoding Output Program—PMT/PSIP Parameters

The parameters listed and described in Table 75 are provided in the Create Transcoding Program 
dialog. 


Table 74. Create Transcoding Output Program Fields—Associated TS Parameters

Field Description Default

Port The GigE or 10 GigE interface on which the program is being 
created. 

Read-only

IP Address The destination IP address of the transport stream. Read-only

UDP Port UDP port the program uses, based on UDP port of the transport 
stream. 

Read-only

TS ID The program’s transport stream id (name), based on TS ID of the 
transport stream. 

Read-only 

TS Type Type of transport stream, based on TS type specified in the 
creation of the transport stream.

Read-only 

TS Bitrate(Mbps) Bitrate for the transport stream, based on TS bitrate specified in 
the creation of the transport stream.

Read-only

Table 75. Create Transcoding Output Program Fields—PMT/PSIP Parameters

Field Description Default

Program Number Number assigned to the program.

Valid range is from 1 to 131072 

1 

Program Name Type an alphanumeric string to set program name. 

Maximum length = 32 characters.

Default format: GigE #-t[unique id]-[Program Number] 

e.g: 

GigE 7-
t47221504-1 

PMT PID ID of the program map table (PMT).

Check this box to input a valid range from 48-8175. 

Un-checked 

Major Channel 
Number

Operator-defined channel number. Used to group all channels that 
are to be identified to a particular broadcast corporation. 

When the program’s TS Type is set to ATSC, the value in this field 
may be set from 1 to 999. 

Read-only

Minor Channel 
Number

Operator-defined channel number. Used to identify a particular 
channel within the Major Channel Number group. 

When the program’s TS Type is set to ATSC, the value in this field 
may be set from 0 to 999. 

Read-only 



VMG Element Manager User Guide 166

Release 3.1.3 Output Programs and Grooming

Create Transcoding Output Program—Video Parameters

The parameters listed and described in Table 74 are provided in the Create Transcoding Program 
dialog. 

Table 76. Create Transcoding Output Program Fields—Video Parameters  

Field Description Default

Video Type Specifies the type of video the program is to be transcoded to. The 
available options are MPEG-2 and H.264 for VTX transport 
streams and H.264 only for PIP transport streams.

MPEG-2

Encoding 
Template

Choose between HD (high definition), SD (standard definition), or 
PIP (picture in picture).

If HD, SD, or PIP is selected, the Video Bit Rate defaults and range 
will change as described below.

PIP is only available if creating a program for a PIP transport 
stream.

HD

PIP

Automatic Video 
Bitrate 

(In Mbps)

Allows automatic bitrate assignment, to maximize bitrate available 
for video streams within the range configured in the output 
transport stream. 

If this box is checked, the system assigns the video bitrate, with the 
latency marked by a “Perfecting video” message until the bitrate is 
assigned. 

Leaving this box un-checked will allow manual video bitrate entry 
according to supported values for Video Type parameters MPEG-2 
HD, MPEG-2 SD, H.264 HD, H.264 SD, and PIP. Refer to “Bitrate 
Configuration Reference” on page 310 for ranges and default 
values. 

Un-checked

Profile

(Video Type = 
H.264 only)

Select either high, main, or baseline to set the video standard to be 
used. Refer to “Video Profile Configuration Reference” on 
page 313 for guidelines. 

Note: Profile is available only when Video Type is set to H.264. 
High is not available for PIP transport streams.

For HD or SD:
High

For PIP: Main

GOP Structure Specifies how the Group of Pictures (GOP) structure is 
determined, as either GOPM or GOPN. 

GOP M—Specifies the spacing of the P frames in the output. The 
higher the value, the lower the data rate.

• MPEG-2 HD or SD, select 1, 2, or 3. 3

• For H.264 HD or SC, select 1, 2, 3, 4, or 8. 

- Note that GOP M 8 is not available if input is 1080i HD. 

4

• For H.264 PIP, select 1 or 4. 4

GOP N — Specifies the number of frames in each GOP. The 
higher the value, the lower the data rate.

• MPEG-2 HD or SD, set value between 1 and 60 and a multiple 
of the GOP M value, else the nearest lower multiple is used. 

15

• H.264 HD or SC, set value between 1 and 240 and a multiple of 
the GOP M value. 
When the GOP M value is set to 4 or 8, the GOP N value is set 
to 32 and is read-only.

32

• H.264 PIP, the value is set to 32 and read-only
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Pre-Processing 
Filters Enable

One, both, or none of the following pre-processing filters may be 
selected: 

MCTF noise reduction — when checked, enables motion 
compensated temporal filtering (MCTF).

Telecine--when checked, indicates whether the source program 
was telecine (television / cinema) processed. The telecine process 
converts a source feed at 24 frames per second (typically a film) to 
a feed at 30 frames per second. When telecine has occurred, 
indicating its occurrence when creating a transcoded output 
program allows for more efficient processing. 

Note: Telecine is only available when the Video Type is set to 
MPEG-2.

Un-checked

Resolution Specifies the type of Horizontal (H) resolution to use for the 
transcoded program. 

• For HD transcoded programs, the following options are 
available: 
Full Res, 1920, 1440, 1280, 960 

HD:

H: Full Res

• For SD programs, the following options are available:
Full D-1, VGA, 3/4 D-1, 2/3 D-1, or 1/2 D-1


H: Full D-1

• For PIP programs, the following horizontal and vertical options 
are available: 
H:1/2D1 X V:1/2D1 (352 x 240 for NTSC; 352 x 288 for PAL)

192 X192, 128 X 96, 96 X 96


192 x 192

AFD Output By default, Active Format Descriptions on the input streams are 
forwarded in the output streams. Check the box to disable the 
forwarding of AFDs.

The AFD Output parameter does not appear when the Encoding 
Template is set to PIP.

For information on AFD, refer to “Active Format Description (AFD)” 
on page 168.

Un-checked

Active Format

(Hidden unless SD 
selected)

Specifies the type of output for HD content transcoded to SD, as 
one of the following options:

• Force 16:9 letterbox — an AFD code of 10 is included in the 
output (16:9 Image: Letterbox in 4:3 frame, Full Frame in 16:9 
frame).

• Force 4:3 centercut — an AFD code of 9 is included in the 
output (4:3 Image: Full Frame in 4:3 frame, Pillarbox in 16:9 
frame).

• Use AFD; 16:9 fallback — the frame format will be determined 
by the Active Format Description in the input program. If the 
AFD is not present, the frame will be forced to 16:9 Letterbox.

• Use AFD; 4:3 fallback — the frame format will be determined by 
the Active Format Description in the input program. If the AFD is 
not present, the frame will be forced to 4:3 Centercut.

The Active Format field only appears when the Encoding Template 
is set to SD.

Force 16:9 
letterbox

Table 76. Create Transcoding Output Program Fields—Video Parameters  (Continued)

Field Description Default



VMG Element Manager User Guide 168

Release 3.1.3 Output Programs and Grooming

Active Format Description (AFD)

MPEG-2 standards define a 4:3 aspect ratio for SD content, 16:9 for HD content. When transcoding 
from HD content to SD size, in general, we must fit 16:9 HD frames inside a 4:3 frame. This can be 
accomplished using two different approaches: 16:9 letter box, where the full 16:9 frame is visible with 
black bars at the top and the bottom of the 4:3 screen, and 4:3 center cut, where the right and left 
portions of the 16:9 frame are cut off and the remainder fills the 4:3 frame.

To aid HD to SD down-scaling, incoming MPEG-2 or H264 video can contain active format 
description (AFD) code that describes the active video region inside the 16:9 display frame. The down-
scaling process then uses this code to downscale only the active region to the SD display region, thus 
maximizing the displayed video area inside the 4:3 display.

With the VMG, you can choose whether to forward the incoming AFD in transcoded output streams. 
You can also determine how to process incoming AFDs:

Aspect Ratio Specifies the ratio of the program’s width to the height. 

• For an HD program, the field is read-only and set to Automatic.

• For an SD program, choose from one of the following options: 
Automatic, 4:3, 16:9.

• For a PIP program, choose from one of the following options: 
Automatic, 4:3, 16:9.

HD and SD:

Automatic

PIP:

4:3

Closed Captioning Specifies the format used for encoding closed captioning on an 
MPEG-2 transcoded program. The options are:

• SCTE 21

• SCTE 20 and SCTE 21

When selecting SCTE 20 and SCTE 21, be sure to reserve 
sufficient bandwidth for both closed captioning streams. Automatic 
Video Bitrate Assignment accounts for the additional bandwidth 
needed for SCTE 20.

The VMG discards user data format as per SCTE 20 in the input. It 
re-formats user data for the input as per SCTE21 to SCTE, and as 
per SCTE 20 when requested. 

The Closed Captioning field only appears when the Video Type is 
set to MPEG-2.

SCTE 21

IDR Interval (in 
Frames)

Specifies the interval between instantaneous decoder refresh 
(IDR) frames.

• For GOP M—1-3 with HD or SD encoding, the IDR interval can 
be input by the user and must be a multiple of the GOP N value. 
Enter 0 if no IDR frames are to be inserted. 

• For GOP M—4, the IDR interval can be set to 96 (the default) or 
0 (no IDR).

• For GOP M—8, the IDR interval is set to 96 and is read-only.

• If PIP is selected for the Encoding Template, no IDR frames are 
inserted and the field does not display. 

The IDR Interval field only appears when the Video Type is set to 
H.264.

96

Table 76. Create Transcoding Output Program Fields—Video Parameters  (Continued)

Field Description Default
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• Follow the AFD while selecting either 16:9 letterbox or 4:3 centercut as fallback if no AFD is 
present

OR

• Ignore any AFD and force the output to either 16:9 letterbox or 4:3 centercut

Table 77 describes how the VMG processes incoming video depending on the incoming AFD and the 
GUI option you select.

Table 77. VMG Handling of AFD Codes Depending on GUI Selection 

AFD code in 
input HD 
video
in decimal 
(binary)

Aspect ratio of 
the “area of 
interest” in 
input HD 
video

Output Based on Active Format GUI Selection

Force 16:9 
letterbox

Force 4:3 
centercut

Use AFD; 16:9 
fallback

Use AFD; 4:3 
fallback

0 (0000) Reserved 16:9 letterbox 
vertically 
centered

4:3 centercut 16:9 letterbox 
vertically 
centered

16:9 letterbox 
vertically 
centered

1 (0001) Reserved: treat 
as full screen 
16:9

16:9 letterbox 
vertically 
centered

4:3 centercut 16:9 letterbox 
vertically 
centered

16:9 letterbox 
vertically 
centered

2 (0010) Full screen box 
16:9 (top)

16:9 letterbox 
vertically 
centered

4:3 centercut 16:9 letterbox 
vertically 
centered

16:9 letterbox 
vertically 
centered

3 (0011) Pillar box 14:9 
(top)

16:9 letterbox 
vertically 
centered

4:3 centercut 14:9 letterbox 
vertically 
centered

14:9 letterbox 
vertically 
centered

4 (0100) Box > 16:9 
(center). Treat 
as full screen.

16:9 letterbox 
vertically 
centered

4:3 centercut 16:9 letterbox 
vertically 
centered

16:9 letterbox 
vertically 
centered

5 (0101) Reserved: treat 
as full screen 
16:9

16:9 letterbox 
vertically 
centered

4:3 centercut Anamorphic 16:9 letterbox 
vertically 
centered

6 (0110) Reserved: treat 
as full screen 
16:9

16:9 letterbox 
vertically 
centered

4:3 centercut Anamorphic 16:9 letterbox 
vertically 
centered

7 (0111) Reserved: treat 
as full screen 
16:9

16:9 letterbox 
vertically 
centered

4:3 centercut Anamorphic 16:9 letterbox 
vertically 
centered

8 (1000) Active format is 
the same as 
the coded 
frame. Full 
screen 16:9

16:9 letterbox 
vertically 
centered

4:3 centercut 16:9 letterbox 
vertically 
centered

16:9 letterbox 
vertically 
centered

9 (1001) Pillar box 4:3 
center cut

16:9 letterbox 
vertically 
centered 
(postage 
stamp)

4:3 centercut Full frame 4:3 
image

Full frame 4:3 
image

10 (1010) Full screen 
16:9 (center)

16:9 letterbox 
vertically 
centered

4:3 centercut 16:9 letterbox 
vertically 
centered

16:9 letterbox 
vertically 
centered



VMG Element Manager User Guide 170

Release 3.1.3 Output Programs and Grooming

Using Drag-and-Drop to Create Output Programs

The VMG Element Manager supports drag-and-drop grooming at the program level and transport 
stream level. Drag-and-drop grooming is performed on the Grooming -> Mapping tab page of the 
VMG Element Manager screen.

Program grooming performs different tasks depending on whether there are any existing programs 
currently associated with the output transport stream (Table 78).

11 (1011) Pillar box 14:9 
(center)

16:9 letterbox 
vertically 
centered

4:3 centercut 14:9 pillar box 14:9 pillar box

12 (1100) Reserved: treat 
as full screen 
16:9

16:9 letterbox 
vertically 
centered

4:3 centercut Anamorphic Anamorphic

13 (1101) Pillar box 4:3 
center cut (with 
shoot and 
protect 14:9 
center)

16:9 letterbox 
vertically 
centered 
(postage 
stamp)

4:3 centercut Full frame 4:3 
image

Full frame 4:3 
image

14 (1110) Full screen 
16:9 (with 
shoot and 
protect 14:9 
center)

16:9 letterbox 
vertically 
centered

4:3 centercut Full screen 
16:9

(14)

Full screen 
16:9

(14)

15 (1111) Full screen 
16:9 (with 
shoot and 
protect 4:3 
center)

16:9 letterbox 
vertically 
centered

4:3 centercut Full frame 4:3 
image

Full frame 4:3 
image

No AFD Treat as full 
screen 16:9

16:9 letterbox 
vertically 
centered

4:3 centercut 16:9 letterbox 
vertically 
centered

4:3 centercut

Table 77. VMG Handling of AFD Codes Depending on GUI Selection (Continued)

AFD code in 
input HD 
video
in decimal 
(binary)

Aspect ratio of 
the “area of 
interest” in 
input HD 
video

Output Based on Active Format GUI Selection

Force 16:9 
letterbox

Force 4:3 
centercut

Use AFD; 16:9 
fallback

Use AFD; 4:3 
fallback

Table 78. Drag-and-Drop Results

When you drag: The grooming behavior:

Program to Transport Stream The program is created in the Transport Stream; the Configure 
Program Mapping screen appears, allowing you to modify the 
program mapping information.

Program to non-transcoded Program Deletes the existing program and replaces it with the dragged 
program.

Program to the TS carrying the 
transcoded Program

Regrooms the program to the new program.
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Grooming Non-Transcoded Programs

Use the Configure Program Mapping dialog (Figure 110) to set grooming parameters for a selected 
program in a non-transcoded transport stream.

From the Inputs panel of the Grooming --> Mapping tab page--> drag input program to Outputs 
panel --> non-transcoded VTR stream --> Configure Program Mapping screen (Figure 110). 

Figure 110. Configure VTR Program Mapping

1. At the Configure VTR Program Mapping dialog, use guidelines from the following tables:

- Table 79, “Grooming—Configure VTR Program Mapping Fields—Source,” on page 172.

- Table 80, “Grooming—Configure VTR Program Mapping Fields—Destination,” on page 172.

- Table 81, “Grooming - Configure VTR Program Mapping Fields—Component PIDs,” on 
page 173.

- Table 82, “Grooming - Configure VTR Program Mapping Fields—Quality of Service,” on 
page 174.

TS-level DPI Program (top); Program-level DPI Program (bottom)
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2. Click Apply Configuration to save and use the settings. After clicking the Apply Configuration 
button the input program is copied to the output transport stream, replacing any existing programs 
if their schedules conflict.

Configure VTR Program Mapping—Source 

The parameters listed in Figure 79 are provided in the Configure VTR Program Mapping dialog 
(Figure 110). 

Configure VTR Program Mapping—Destination

The parameters listed in Figure 80 are provided in the Configure VTR Program Mapping dialog 
(Figure 110). 

Table 79. Grooming—Configure VTR Program Mapping Fields—Source

Field Description Default

Port The input program’s source GigE or 10 GigE interface. Read-only

TS ID The input program’s transport stream id (name). Read-only

Program Number Program number assigned to the input program. Read-only

Program Name Program name assigned to the input program. Read-only

Table 80. Grooming—Configure VTR Program Mapping Fields—Destination 

Field Description Default

Port The output program’s destination GigE interface port. Read-only 

TS ID The program’s transport stream id (name), based on TS ID 
of the transport stream. 

Read-only 

Program Number Number, in the range 1 to 131072, assigned to the output 
program. 

Number of the 
GigE port 

Program Name Type an alphanumeric string to set the program name. 

Maximum length = 32 characters.

Default format: GigE #-t[unique id]-[Program Number] 

e.g: 

GigE 7- 
t47221504-1 

TS Bitrate(Mbps) Displays the bitrate defined for the transport stream. Read-only

TS Type
Displays the transport stream type, as either MPEG-2, 
ATSC, DVB, & SCTE 

Read-only 

Major Channel Number

(appears only when TS 
Type is set to ATSC)

Operator-defined channel number, for grouping of all 
channels to be identified to a particular broadcast 
corporation. When the program’s TS Type is set to ATSC, 
the value in this field may be set from 1 to 999. 

Blank

Minor Channel Number

(appears only when TS 
Type is set to ATSC)

Operator-defined channel number that identifies a particular 
channel within the Major Channel Number group. When the 
program’s TS Type is set to ATSC, the value in this field may 
be set from 0 to 999. 

Blank
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Configure VTR Program Mapping—Component PIDs

The parameters listed in Figure 81 are provided in the Configure VTR Program Mapping dialog 
(Figure 110).

Table 81. Grooming - Configure VTR Program Mapping Fields—Component PIDs 

Field Description Default

Input Type Displays the input program types and associated PIDs. To 
allow stream grooming, un-check the desired input PID 
Types.

Checked 

PID Displays the PID of the associated Input Type. Read-only

Output Type Displays the output program types if a referenced or 
unreferenced PID has been defined. Click this field or click 
Enter PID under Action to create a referenced or 
unreferenced PID.

Blank

PID Displays the output program type’s PID if one has been 
defined as described above. Click this field to open the same 
screen as described above for defining a PID.

Blank

Stay Unreferenced

(Field displays only if 
the input program is a 
Ghost Program)

If the input program is a Ghost Program, the Stay 
Unreferenced option displays in this section.

• Checked = no PAT / PMT generation. Use this option if the 
PIDs in this stream are to remain unreferenced in PSI 
tables. See also “Adding an Unreferenced PID as an 
Elementary Stream” on page 262 for more information.

• Un-checked = the program will become referenced.

Checked 

Synchronize input and 
output program names

Enable (check) or disable (un-check) synchronization of the 
output program names to the input program names. 

Un-checked

Forward SCTE 35 Cue Enable (check) or disable (un-check) forwarding of SCTE 35 
information at input streams.

Un-checked

PMT PID ID of the program map table (PMT). Check to input a valid 
range from 48-8175. 

Un-checked 

SCTE 30 to 35 
Conversion

Enable (check) or disable (un-check) SCTE 30 to SCTE 35 
conversion at output streams.

Un-checked 

Program DPI

(Field displays only if 
the output transport 
stream was enabled for 
Program level DPI)

Enable or disable DPI for the output program. Un-checked 

• Un-check = Each program with program-level DPI enabled 
will use one license from the available license pool. To 
“free up” a program DPI license, un-check this box. 

• Checked = to delete the program, this box must be un-
checked.

NOTE: A number-based DPI license, and available DPI 
sessions are required. 
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Configure VTR Program Mapping—Quality of Service

The parameters listed in Figure 82 are provided in the Configure VTR Program Mapping dialog 
(Figure 110).

Note: Statistical multiplexing with rate shaping: With an MPTS, the instantaneous transrating factor 
for each video stream is determined by ensuring that no overflow or underflow occurs at the 
receiver when the video programs contained in that MPTS are sent at the transport stream 
bitrate.

Program Substitution Enable or disable program substitution for the output 
program. A number-based Program Substitution license, and 
available Program Substitution sessions are required. 

NOTE: DPI is not supported on a channel-substituted 
program. 

Un-checked 

Un-check = Each program with Program Substitution 
enabled will use one license from the available license pool. 

To “free up” a program substitution license, un-check this 
box.

Checked =

• When this box is checked, the Program DPI box may not 
be checked at the same time.

• When this box is checked, the Disable PMT update during 
program substitution option becomes visible. 

• To delete the program, this box must be un-checked.

Disable PMT update 
during program 
substitution

When checked, this option will maintain the same PMT table 
version after a substitution event as long as elementary 
stream structures match. This avoids possible set top box re-
tuning and disruptions.

This field is only displayed when the Program Substitution 
box is checked; otherwise, this box is hidden.

Hidden

Table 82. Grooming - Configure VTR Program Mapping Fields—Quality of Service 

Field Description Default

Service Level Select bit rate adaptation techniques to be applied to MPEG-
2 encoded streams to enhance bandwidth efficiency as one 
of the following:

• Any integer from -8 to +8 

• 0 for average or mid-scale quality

• Bypass Transrater

• Handle as Data

• No Rate-shaping

See also Table 83, “Service Level Configuration Details,” on 
page 175.

0 

Max Video Bitrate 
(Mbps)

Value to define maximum bitrate (in Mbps) for this program. 
Choosing a specific max rate will bypass automatic 
transrating based on priorities. 

Blank 

Table 81. Grooming - Configure VTR Program Mapping Fields—Component PIDs (Continued)

Field Description Default
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QoS Settings for Program Mapping

This section contains information about the quality of service selections (Table 83) for service level 
configuration, which are provided in the VTR Program Mapping screen. This Service Level field 
allows the assignment of transrating priorities and conditions for each program. 

Grooming Transcoded Programs

Use the Configuration Program Mapping dialog for AVTX, VTX, or PIP to set grooming 
parameters for a transcoded program (see also “Click Apply Configuration to save the settings. The 
new program is now displayed in the Outputs panel, in the expanded PIP TS view.” on page 178).

Select and drag an input program to the transcode-enabled output transport stream under which to 
create the output program, to present the Configure Program Mapping dialog for the TS type:

• “Configure AVTX Program Mapping” on page 176.

• “Configure VTX Program Mapping” on page 177.

• “Configure PIP Program Mapping” on page 178.

Table 83. Service Level Configuration Details

QoS Service Level 
Configuration Video Processing

Can DPI be 
performed?

Effect on Video Output 
Bandwidth

Transrating Service 
Level Values

Video elementary stream 
(ES) is processed through the 
transrater.

• -8: highest transrating, 
lowest quality.

• +8: lowest transrating, 
highest quality. 

YES

DPI sessions carry 
same QOS 
settings as 
network.

Transrated output video ES 
requires less bandwidth than 
input video ES.

No Rate-shaping Video ES processing is 
limited through the transrater 
with null packet removal.

• Video quantization level is 
unchanged

YES

DPI sessions carry 
same QOS 
settings as 
network.

Output video ES bandwidth will 
vary depending on level of ES 
null packet removal.

Bypass Transrater Video ES is not processed 
through the transrater. 

• Video can be displayed.

YES

DPI sessions carry 
same QOS 
settings as 
network.

Output video ES uses the same 
bandwidth as input video ES. 

• Cannot use more than the 
bandwidth of output TS.

Handle As Data Video ES is not processed 
through the transrater.

• Video cannot be displayed.

NO Output data ES is treated as 
data and will therefore use the 
same bandwidth as input video 
ES. 

• Cannot use more than the 
bandwidth of output TS. 

• Total bandwidth should not 
exceed 4Mbps per TS.
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Configure AVTX Program Mapping

Use the Configure AVTX Program Mapping screen (Figure 111) to set grooming parameters for a 
specific AVTX transport stream. 

Figure 111. Configure AVTX Program Mapping—Grooming Parameters

1. At the Configure AVTX Program Mapping screen, use guidelines from the following tables to 
define the grooming parameters for this AVTX stream. 

- “Configure AVTX/VTX/PIP Program Mapping—Source” on page 179.

- “Configure AVTX/VTX/PIP Program Mapping—Destination” on page 179.

- “Configure AVTX/VTX/PIP Program Mapping—Component PIDs” on page 180.

- “Configure AVTX/VTX/PIP Program Mapping—Video” on page 180.

- “Configure AVYX/VTX/PIP Program Mapping—Audio” on page 183.

2. Click Apply Configuration to save the settings. The new program is now displayed in the 
Outputs panel, in the expanded AVTX TS view.

Enabled only if a Dolby 
Codec is selected. 
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Configure VTX Program Mapping

Use the Configure AVTX Program Mapping screen (Figure 112) to set grooming parameters for a 
specific VTX transport stream. 

Figure 112. Configure VTX Program Mapping—grooming parameters

1. At the Configure VTX Program Mapping screen, use guidelines from the following tables to 
define the grooming parameters for this VTX stream. 

- “Configure AVTX/VTX/PIP Program Mapping—Source” on page 179.

- “Configure AVTX/VTX/PIP Program Mapping—Destination” on page 179.

- “Configure AVTX/VTX/PIP Program Mapping—Component PIDs” on page 180.

- “Configure AVTX/VTX/PIP Program Mapping—Video” on page 180.

- “Configure AVYX/VTX/PIP Program Mapping—Audio” on page 183.

2. Click Apply Configuration to save the settings. The new program is now displayed in the 
Outputs panel, in the expanded VTX TS view.
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Configure PIP Program Mapping 

Use the Configure PIP Program Mapping screen (Figure 113) to set grooming parameters for a 
specific PIP transport stream. 

Figure 113. Configure PIP Program Mapping—grooming parameters

1. At the Configure PIP Program Mapping screen, use guidelines from the following tables to 
define the grooming parameters for this VTX stream. 

- “Configure AVTX/VTX/PIP Program Mapping—Source” on page 179.

- “Configure AVTX/VTX/PIP Program Mapping—Destination” on page 179.

- “Configure AVTX/VTX/PIP Program Mapping—Component PIDs” on page 180.

- “Configure AVTX/VTX/PIP Program Mapping—Video” on page 180.

- “Configure AVYX/VTX/PIP Program Mapping—Audio” on page 183.

2. Click Apply Configuration to save the settings. The new program is now displayed in the 
Outputs panel, in the expanded PIP TS view.
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Configure AVTX/VTX/PIP Program Mapping—Source

The source parameters listed and described in Figure 84 are provided in the Configure Program 
Mapping dialog for AVTX, VTX, or PIP.

Configure AVTX/VTX/PIP Program Mapping—Destination

The destination parameters listed and described in Table 85 are provided in the Configure Program 
Mapping dialog for AVTX, VTX, or PIP.
.

Table 84. Grooming - Create Configure AVTX/VTX/PIP Program Mapping Fields—Source 

Field Description Default

Port The input program’s source GigE or 10 GigE interface. Read-only

IP:UDP / TS ID The input program’s transport IP address, UDP port, and stream id 
(name). 

Read-only

Program 
Number

Program number assigned to the input program. Read-only

Program Name Program name assigned to the input program. Read-only

Table 85. Grooming - Create Configure AVTX/VTX/PIP Program Mapping Fields—Destination  

Field Description Default

Port The output program’s destination GigE interface port. Read-only 

IP:UDP / TS ID The program’s transport stream IP address and UDP port and id 
(name), based on TS ID of the transport stream. 

Read-only 

Program 
Number

Value, in the range 1-131072, assigned to the output program. Number of the 
GigE port 

Program Name Alphanumeric string to set name assigned to the program. 

Maximum length = 32 characters.

Example: GigE 7- t47221504-1 

Default format: 
GigE #-t[unique 
id]-[Program 
Number] 

TS Bitrate 
(Mbps)

The maximum bitrate for the TS Read-only

TS Type
Displays the transport stream type as either MPEG-2, ATSC, DVB, 
or SCTE 

Read-only 

Major Channel 
Number

(appears only 
when TS Type 
is set to ATSC)

Operator-defined channel number. Used to group all channels that 
are to be identified to a particular broadcast corporation. 

• When the program’s TS Type is set to ATSC, the value in this field 
may be set from 1 to 999. 

Blank

Minor Channel 
Number

(appears only 
when TS Type 
is set to ATSC)

Operator-defined channel number. Used to identify a particular 
channel within the Major Channel Number group.

• When the program’s TS Type is set to ATSC, the value in this field 
may be set from 0 to 999. 

Blank
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Configure AVTX/VTX/PIP Program Mapping—Component PIDs

The component PIDs parameters listed and described in Table 86 are provided in the Configure 
Program Mapping dialog for AVTX, VTX, or PIP.
.

Configure AVTX/VTX/PIP Program Mapping—Video

The video parameters listed and described in Table 87 are provided in the Configure Program 
Mapping dialog for AVTX, VTX, or PIP. 
.

Table 86. Grooming - Create Configure AVTX/VTX/PIP Program Mapping Fields—Component PIDs   

Field Description Default

Input Type Displays the input program types and associated PIDs. To allow 
stream grooming, un-check the desired input PID Types.

Checked 

PID Displays the Input Type’s associated PID. Read-only

Output Type Displays the output program types if a referenced or unreferenced 
PID has been defined. 

If blank, click in this field or click Enter PID under Action to create a 
referenced or unreferenced PID.

Blank

PID Displays the output program type’s PID (if defined as described 
above). 

If blank, click in this field or click Enter PID under Action to create a 
referenced or unreferenced PID.

Blank

Pass-through Specify whether to disallow passthrough (None), or enable AC-3 or 
E-AC-3 (Dolby Digital Plus) passthrough on this output transport 
stream. 

None

Max Audio Set value to define the maximum allowable audio elementary 
streams to be handled in the output. Note that this setting affects 
bitrate allowances on the stream. 

See “Bitrate 
Configuration 
Reference” on 
page 310 for 
comparative 
values.

Max Data Set value to define the maximum allowable data elementary streams 
to be handled in the output. Note that this setting affects bitrate 
allowances on the stream. 

Table 87. Grooming - Create Configure ATVX/VTX/PIP Program Mapping Fields—Video 

Field Description Default

Video Type Specifies the type of video the program is to be transcoded to, as 
either MPEG-2 and H.264.

MPEG-2

Encoding 
Template

Choose between HD (high definition), SD (standard definition), or 
PIP (picture in picture). 

If selecting HD, SD, or PIP the Video Bit Rate defaults and range will 
change as described below.

HD for AVTX and 
VTX TS

PIP for PIP TS
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Automatic Video 
Bitrate 
Assignment 

(In Mbps)

This feature allows automatic bitrate assignment in order to 
maximize the bitrate available for video streams within the range 
configured by the user in the output transport stream. Automatic 
bitrate assignment also takes into account other (non-video) 
elementary streams in the output TS. 

• Checked = the system assigns the video bitrate, with the latency 
marked by a “Perfecting video” message until the bitrate is 
assigned. 

• Un-checked = A low manual video bitrate entry according to the 
supported values for Video Type parameters MPEG-2 HD, MPEG-
2 SD, H.264 HD, H.264 SD, and PIP. As appropriate for your 
locale, type a comma or a period symbol to designate the decimal 
point in your entry (see also “Bitrate Entry Guidelines” on 
page 310). 

Refer to “Bitrate Configuration Reference” on page 310 for ranges 
and default values.

Un-checked

Profile

(Video Type = 
H.264 only)

Select either high, main, or baseline to set the video standard to be 
used. Refer to “Video Profile Configuration Reference” on page 313 
for guidelines. 

Note: Profile is only available when Video Type is set to H.264. High 
is not available for PIP transport streams.

Main

GOP Structure Specifies how the Group of Pictures (GOP) structure is determined 
When the GOP M value is set to 4 or 8, the GOP N value is set to 32 
and is read-only. 

GOP M--Specifies the spacing of the P frames in the output. The 
higher the value, the lower the data rate.

• MPEG-2 HD or SD, select 1, 2, or 3. Default=3

• H.264 HD or SD, select 1, 2, 3, 4, or 8. Default = 4

- Note that GOP M 8 is not available if input is 1080i HD.

• H.264 PIP, select 1 or 4. Default = 4

GOP N — Specifies the number of frames in each GOP. The higher 
the value, the lower the data rate.

• MPEG-2 HD or SD, set value between 1 and 60 and a multiple of 
the GOP M value, else the nearest lower multiple is used. 
Default = 15

• H.264 HD or SD, set value between 1 and 240 and a multiple of 
the GOP M value. Default = 32

• H.264 PIP, the value is set to 32 and read-only

For MPEG-2 HD 
or SD:
GOP M: 3
GOP N: 15

For H.264 HD, SD 
or PIP:
GOP M: 4
GOP N: 32

Table 87. Grooming - Create Configure ATVX/VTX/PIP Program Mapping Fields—Video (Continued)

Field Description Default
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Pre-Processing 
Filters Enable

One, both, or none of the following pre-processing filters may be 
selected: 

MCTF noise reduction — when checked, enables motion 
compensated temporal filtering (MCTF).

Telecine--when checked, indicates whether the source program was 
telecine (television / cinema) processed. The telecine process 
converts a source feed at 24 frames per second (typically a film) to a 
feed at 30 frames per second. When telecine has occurred, 
indicating its occurrence when creating a transcoded output program 
allows for more efficient processing. 

Note: Telecine is only available when the Video Type is set to 
MPEG-2.

Un-checked

Resolution Specifies the type of Horizontal (H) resolution to use for the 
transcoded program. 

• For HD transcoded programs, the following options are available: 
Full Res, 1920, 1440, 1280, 960 

• For SD programs, the following options are available:
Full D-1, VGA, 3/4 D-1, 2/3 D-1, or 1/2 D-1

• For PIP programs, the following horizontal and vertical options are 
available: 
H:1/2D1 X V:1/2D1 (352 x 240 for NTSC; 352 x 288 for PAL)

192 X192, 128 X 96, 96 X 96

HD:

H: Full Res

SD:

H: Full D-1

PIP:

192 X 192

AFD Output By default, Active Format Descriptions on the input streams are 
forwarded in the output streams. Check the box to disable the 
forwarding of AFDs.

The AFD Output parameter does not appear when the Encoding 
Template is set to PIP.

For information on AFD, refer to “Active Format Description (AFD)” 
on page 168.

Un-checked

Active Format

(Hidden unless 
SD selected)

Specifies the type of output for HD content transcoded to SD, as one 
of the following options:

• Force 16:9 letterbox — an AFD code of 10 is included in the output 
(16:9 Image: Letterbox in 4:3 frame, Full Frame in 16:9 frame).

• Force 4:3 centercut — an AFD code of 9 is included in the output 
(4:3 Image: Full Frame in 4:3 frame, Pillarbox in 16:9 frame).

• Use AFD; 16:9 fallback — the frame format will be determined by 
the Active Format Description in the input program. If the AFD is 
not present, the frame will be forced to 16:9 Letterbox.

• Use AFD; 4:3 fallback — the frame format will be determined by 
the Active Format Description in the input program. If the AFD is 
not present, the frame will be forced to 4:3 Centercut.

The Active Format field only appears when the Encoding Template is 
set to SD.

Force 16:9 
letterbox

Table 87. Grooming - Create Configure ATVX/VTX/PIP Program Mapping Fields—Video (Continued)

Field Description Default
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Configure AVYX/VTX/PIP Program Mapping—Audio
.

Aspect Ratio Specifies the ratio of the program’s width to the height. 

• For an HD program, the field is read-only and set to Automatic.

• For an SD program, choose from one of the following options: 
Automatic, 4:3, 16:9.

• For a PIP program, choose from one of the following options: 
Automatic, 4:3, 16:9.

HD and SD:

Automatic

PIP:

4:3

Closed 
Captioning

Specifies the format used for encoding closed captioning on an 
MPEG-2 transcoded program. The options are:

• SCTE 21

• SCTE 20 and SCTE 21

When SCTE 20 and SCTE 21 is selected, be sure to reserve 
sufficient bandwidth for both closed captioning streams. Automatic 
Video Bitrate Assignment accounts for the additional bandwidth 
needed for SCTE 20.

The VMG discards user data format as per SCTE 20 in the input. It 
re-formats user data for the input as per SCTE21 to SCTE, and as 
per SCTE 20 when requested. 

The Closed Captioning field only appears when the Video Type is set 
to MPEG-2.

SCTE 21

IDR Interval (in 
Frames)

Specifies the interval between instantaneous decoder refresh (IDR) 
frames.

• For GOP M=1-3 with HD or SD encoding, the IDR interval can be 
input by the user and must be a multiple of the GOP N value. 
Enter 0 if no IDR frames are to be inserted. 

• For GOP M=4, the IDR interval can be set to 96 (the default) or 0 
(no IDR).

• For GOP M=8, the IDR interval is set to 96 and is read-only.

• If PIP is selected for the Encoding Template, no IDR frames are 
inserted and the field does not display. 

The IDR Interval field only appears when the Video Type is set to 
H.264.

96

Table 88. Grooming - Create Configure ATVX/VTX/PIP Program Mapping Fields—Audio 

Field Description Default

Audio Profile You can define audio profiles that you can quickly apply to a 
Program Mapping.

If this option is checked, enter a name to create a new audio profile 
and then define the audio parameters below. If the option is un-
checked, you can select from a list of existing audio profiles and the 
audio parameters will be automatically filled in and un-editable.

Blank

Audio Codec Defines the codec for the output audio, as one of the following 
options: HE-AAC, HE-AACv2, AAC-LC, MPEG-1 LII, MPEG-2 LII, 
AC-3, E-AC-3 (Dolby Digital Plus).

Note: this audio codec setting is not applicable for VTX. 

AAC LC

Table 87. Grooming - Create Configure ATVX/VTX/PIP Program Mapping Fields—Video (Continued)

Field Description Default
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Note: Transcoded programs do not support DPI, Program Substitution, SCTE 30 to 35 conversion, 
or transrating. The fields associated with these options are not visible or editable when 
creating or grooming transcoded programs.

Managing Standard Output Streams and Programs

You can view, change parameters, or delete output streams and programs from the Grooming Mapping 
tab page, as described in the following sections:

• “Displaying or Modifying Grooming Details,” next.

• “Modifying, Deleting, and Regrooming Output Transport Streams and Programs” on page 189

Displaying or Modifying Grooming Details

• For non-transcoded transport streams and programs, use the Current Program Mapping screen 
to view grooming details.

• For transcoded transport streams, go to the individual programs to modify and view grooming 
details. 

Display Grooming for all Programs in a Non-Transcoded TS

Use the Current Program Mapping screen to view grooming details for a VTR transport stream.

From the Outputs panel of the Grooming -> Mapping screen, right-click at the transport stream and 
select Display Grooming from the popup menu --> Current Program Mapping screen (Figure 114). 

Sampling Rate Value, in kHz, to set the number of audio samples per second. The 
higher the number, the better the sound quality. Choose one of the 
following options: 8 kHz, 11.03 kHz, 12 kHz, 16 kHz, 22.05 kHz, 
24 kHz, 32 kHz, 44.1 kHz, 48 kHz

44.1 kHz

Channels Defines the number of output channels per audio stream, using one 
of the following options: mono, stereo, 5.1 surround

stereo

Audio Bitrate Defines the bitrate for all audio streams within the MBR TS. The 
selectable values depend on your selection of Audio Codec, 
Sampling Rate, and Channels.

128 kbps

Audio Gain Defines the gain on an audio stream level. Audio Gain is applied to 
all audio streams within the MBR TS. If the input program has two or 
more audio PIDs, all audio outputs will have the same gain. 

• Audio Gain ranges from -24 dB to +24 dB and is selectable in 1 dB 
increments.

Note: And Audio Gain of 0 means no gain.

no Gain

Advanced 
Button

Allows access to Dolby Configuration dialogs, as appropriate for the 
Audio Codec specified in the Audio Codec field. 

• Disabled for 
non-Dolby audio 
Codec.

• Enabled for 
Dolby audio 
Codec.

Table 88. Grooming - Create Configure ATVX/VTX/PIP Program Mapping Fields—Audio (Continued)

Field Description Default
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Figure 114. Current Program Mapping—non-transcoded TS

The upper portion of the Current Program Mapping screen contains the table of grooming sessions 
for the selected transport stream (Table 89). 

Information contained in the lower section of the Current Program Mapping screen is derived from 
configuration described in “Grooming Non-Transcoded Programs” on page 171.

Table 89. Grooming - Current Program Mapping - Top Portion 

Field Description Default

Input Port The input program’s GigE or 10 GigE interface. Read-only 

Input TS ID The input program’s transport stream ID. Read-only 

Input Program Program number assigned to the input program. Read-only 

Output Port The output program’s transport GigE or 10 GigE interface port. Read-only 

Output TS ID The output program’s transport stream ID. Read-only 

Output Program Program number assigned to the output program. Read-only 



VMG Element Manager User Guide 186

Release 3.1.3 Managing Standard Output Streams and Programs

Display Grooming for a Single Program in a Non-Transcoded TS

To view grooming details for a single program in a non-transcoded transport stream, access the 
Current Program Mapping screen:

From the Outputs panel of the Grooming -> Mapping screen, right-click on a program in a transport 
stream -> select Display Grooming -> Current Program Mapping screen (Figure 115).

Figure 115. Current Program Mapping—Single Program—Non-transcoded Stream
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Modify Grooming for a Transcoded Program

To modify grooming details for a transcoded program, use the Modify Program Mapping screen. 

From the Outputs panel of the Grooming -> Mapping screen, right-click a transcoded program and 
select Modify Grooming from the popup menu (Figure 116 and Table 90).

Figure 116. Modify Program Mapping—Program in Transcoded Stream

1. At the Modify Program Mapping screen, apply changes, as necessary. 
Guidelines are provided in Table 90. 

2. Click the green Apply Configuration button to save your changes.
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Note: Once you have made valid changes, the Apply Configuration button becomes green, indicating 
you can save those changes.

Table 90. Transcoded Grooming - Modify Program Mapping screen parameters 

Section Field(s) Description Default

Source

Port, 
TS ID, 
Program Number, 
Program Name,

For a description of these fields, see 
“Configure AVTX/VTX/PIP Program 
Mapping—Source” on page 179.

Read-only

Actual Resolution Displays the resolution of the source input 
program before transcoding has occurred. 

Read-only

Destination

Port, 
TS ID, 
Program Number, 
Program Name.
TS Bitrate(Mbps)
TS Type
Major Channel
Minor Channel

For a description of these fields, see 
“Configure AVTX/VTX/PIP Program 
Mapping—Destination” on page 179.

Read-only 
except for 
Program Name

Component PIDs

Input Type
Input PID
Output Type,
Output PID.

For a description of these fields, see 
“Configure AVTX/VTX/PIP Program 
Mapping—Component PIDs” on page 180.

Editable

Synchronize input and 
output program names,
Forward SCTE 35 Cue.
PMT PID

For a description of these fields, see 
“Configure AVTX/VTX/PIP Program 
Mapping—Component PIDs” on page 180.

Editable

Quality of 
Service

Service Level For transcoded programs, transrating 
options are not available. This field will be 
displayed as read-only.

Bypass 
Transrater

Max Video Bitrate 
(Mbps)

 For transcoded programs, transrating 
options are not available.

Blank
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Modifying, Deleting, and Regrooming Output Transport Streams and Programs

Use the menu provided from an individual output transport stream or program to select the Modify, 
Delete, and Regroom function appropriate for the stream. 

Grooming -> Mapping tab page, Outputs panel -> right-click the output transport stream to present 
its popup menu. 

Options available from an output transport stream menu—for VTR, AVTX, VTX, and PIP—are 
identical. Certain options are dependent on the current setup of the transport stream (Table 91). 

Video

Video Type
Encoding Template
Automatic Video Bitrate
Profile
GOP Structure:
GOP M
GOP N
Pre-Processing Filters 
Enable.
Resolution
Actual Resolution
AFD Output
Active Format
Aspect Ratio
Closed Captioning,
IDR Interval

For a description of these fields, see 
“Configure AVTX/VTX/PIP Program 
Mapping—Video” on page 180.

Editable

Actual Video Bitrate Displays the actual video bitrate of the 
transcoded output program.

Read-only

Actual Resolution Displays the resolution at which the system 
has transcoded the MPEG-2 program.

Read-only

Audio
(if AVTX TS)

Audio Profile
Audio Codec
Sampling Rate
Channels
Audio Bitrate
Audio Gain

For a description of these fields, see 
“Configure AVYX/VTX/PIP Program 
Mapping—Audio” on page 183.

Editable

Table 90. Transcoded Grooming - Modify Program Mapping screen parameters (Continued)

Section Field(s) Description Default

Table 91. Output Transport Stream—Popup Menu 

Menu Option Description

Modify Transport Stream Presents the transport stream modification dialog specifically for the selected 
transport stream type.

Note that to modify the name of a non-transcoding program, neither DPI (if 
applicable) nor Program Substitution can be enabled. If either of these 
options is enabled, un-check the relevant box, apply the changes, then 
proceed with modifying the name. 

Delete Transport Stream Deletes the selected transport stream. This option always presents a 
confirmation dialog prior to deleting the TS. 
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Menus and Modification dialogs for standard output streams are described in the following topics:

• “Non-transcoded Output Transport Stream—VTR,” next.

• “Transcoded Output Transport Stream—PIP” on page 192.

• “Transcoded Output Transport Stream—AVTX” on page 193.

• “Transcoded Output Transport Stream—VTX” on page 194

Create Program For PIP and VTX transport streams, this option presents the Create 
Transcoding Output Program dialog. 
For VTR, this option presents the non-transcode Create Output Program 
dialog. 

Delete All Programs Remove all programs associated with the selected transport stream.This 
option always presents a confirmation dialog prior to deleting the programs 
currently under the transport stream.

Display Grooming Go to the Current Program Mapping dialog to view current grooming session 
and other information about the VTR program mapping. 

This option is provided only for VTR transport streams, and is disabled for 
transcoded streams.

Bitrate Monitor Go to the Monitor tab page of the VMG Element Manger screen.

Reset Grooming Reset grooming for transcoded transport streams. This option is not 
available for VTR transport streams. 

The system always issues a confirmation query prior to performing the reset. 

Table 91. Output Transport Stream—Popup Menu 

Menu Option Description
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Non-transcoded Output Transport Stream—VTR

To access management options for a VTR transport stream, use the VTR popup menu:

Grooming -> Mapping tab page, Outputs panel -> right-click the non-transcoded (VTR) output 
transport stream and select an option from the popup menu. 

Use the Modify Output VTR Transport Stream dialog (Figure 117) to change parameters for a 
specific VTR transport stream. 

Figure 117. Modify Output Transport Stream - VTR

1. At the Modify Output VTR Transport Stream dialog, edit any or all of the following fields: TS 
Name, Multicast IP, UDP port, and/or TS bitrate. 

Caution: Modification of any setting (other than the TS name) can result in service interruption.

2. Click the green Apply Configuration button to update and save these settings. 
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Transcoded Output Transport Stream—PIP

To access management options for a PIP transport stream, use the PIP popup menu:

Grooming -> Mapping tab page, Outputs panel -> right-click on a PIP transcoded output transport 
stream and select an option from the popup menu.

To modify current parameters for this stream type, go to the Modify Output PIP Transport Stream 
dialog (Figure 118). 

Figure 118. Modify Output Transport Stream - PIP

1. At the Modify Output PIP Transport Stream dialog, edit any or all of the following fields: TS 
Name, Multicast IP, UDP port, TS bitrate, and/or Input Video Transcoding Input settings. 

Caution: Modification of any setting (other than the TS name) can result in service interruption.

2. Click the green Apply Configuration button to update and save these settings. 
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Transcoded Output Transport Stream—AVTX

To access management options for an AVTX transport stream, use the AVTX popup menu:

Grooming -> Mapping tab page, Outputs panel -> right-click on an AVTX transcoded output 
transport stream and select an option from the popup menu.

To modify current parameters for this stream type, go to the Modify Output AVTX Transport 
Stream dialog (Figure 119). 

Figure 119. Modify Output Transport Stream - AVTX

1. At the Modify Output AVTX Transport Stream dialog, edit any or all of the following fields: TS 
Name, Multicast IP, UDP Port, TS bitrate, Async Data Bitrate, Auto/Video bitrate, and/or the 
Video Transcoding settings. 

Caution: Modification of any setting (other than the TS name) can result in service interruption.

2. Click the green Apply Configuration button to update and save these settings. 
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Transcoded Output Transport Stream—VTX

To access management options for a VTX transport stream, use the VTX popup menu:

Grooming -> Mapping tab page, Outputs panel -> right-click on an VTX transcoded output transport 
stream and select an option from the popup menu.

To modify current parameters for this stream type, go to the Modify Output VTX Transport Stream 
dialog (Figure 120).

Figure 120. Modify Output Transport Stream - VTX - No Audio Transcoding

1. At the Modify Output VTX Transport Stream dialog, edit any or all of the following fields: TS 
Name, Multicast IP, UDP Port, TS bitrate, Async Data Bitrate, Auto/Video bitrate, and/or the 
Video Transcoding settings. 

Caution: Modification of any setting (other than the TS name) can result in service interruption.

2. Click the green Apply Configuration button to update and save these settings. 
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Resetting Grooming—AVTX, VTX, PIP

Use the Reset Grooming option (Figure 121) on an output transport stream currently in service to tear 
down a current configuration and rebuild the transport stream with the identical configuration. 

Figure 121. Reset Grooming—AVTX, VTX, PIP

Note: Because this option interrupts service during the tear down and rebuild process, the system 
queries for confirmation to proceed with the reset (Figure 122). 

Figure 122. Reset Groom Confirmation—AVTX, VTX, PIP

Regrooming—VTX, VTX+PIP, PIP

Regrooming is the process of changing the program mapping configuration by performing a drag-and-
drop grooming operation a second time, replacing all existing program information in the destination 
with the new program information.

Regrooming is not allowed if Program Substitution or DPI is enabled. To regroom a channel 
substituted or DPI-enabled program, modify the program to disable Program Substitution or DPI, 
proceed with regrooming, then modify the program again to re-enable Program Substitution or DPI. 

Regrooming occurs as a result of dragging an input program to an output transport stream that has 
already been groomed. This action rebuilds the grooming at the selected output TS, with the new input 
program, using the identical configuration on the output program and output elementary streams. 

Caution: The new input program must be similar to the current input program that it will replace: it 
must contain the identical number of streams, stream types, and PMT order. 

Prior to dynamically grooming the targeted output transport stream, the VMG Element Manager 
queries for confirmation of the configuration, to ensure that the input configuration matches that of the 
output configuration. The Confirmation dialog (Figure 123) also reminds you that regrooming 
interrupts service. 
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Figure 123. Regroom Confirmation—VTX, VTX+PIP, PIP

Upon completion of the regrooming process, you can view the results in a Modify Program Mapping 
screen for a particular transport stream type. 

Deleting All Output Transport Streams

To delete all output transport streams in a port:

From the Outputs panel of the Grooming -> Mapping screen, right-click the desired port and select 
the Delete All Transport Streams option from the popup menu (Figure 124).

Figure 124. Delete All Output Transport Streams

Select Yes when prompted by the Delete Confirmation screen.

Deleting a Single Transport Stream

To delete a single transport stream and all its associated programs in a port:

Right click on the transport stream and select the Delete Transport Stream option from the popup 
menu.

Select Yes when prompted by the Delete Confirmation screen.

Deleting All Programs in a Transport Streams

To delete all programs in a transport stream (this will delete all corresponding grooming sessions as 
well):

Right click on the transport stream and select the Delete All Programs option from the popup menu.

Select Yes when prompted by the Delete Confirmation screen.
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Figure 125. Output Program Popup Menus—Non-Transcoded and Transcoded

Modify Output Program

The Modify Output Program and Modify Transcoding Output Program screens (Figure 126 and 
Figure 127) allow a name change for the selected program. 

Note: To find out how to modify input program parameters, see “Modify Input Program” on 
page 134.

Figure 126. Modify Output Program Screen—Non-Transcoded

Non-Transcoded Transcoded
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Figure 127. Modify Output Program Screen—Transcoded

Deleting Programs

This function deletes a single program in a transport stream and all corresponding grooming sessions 
for the selected TS. 

Right click on the program to be removed, and select the Delete Program option from the popup 
menu.

Select Yes when prompted by the Delete Confirmation screen.

The deleted program should no longer be visible beneath the TS at the Mapping tab page. 

Deleting Grooming Sessions

Use the Current Program Mapping dialog to select and remove a grooming session for a TS. 

At the Outputs panel of the Mapping screen, right-click the program containing the grooming session 
to be deleted --> select Display Grooming from the popup menu --> Current Program Mapping 
dialog (Figure 128).

1. At the Current Program Mapping dialog, click on the grey row that identifies the grooming 
session you want to delete, then right-click and select Delete from the popup menu. 

The selected row is now removed from the table in this dialog. 

2. Click Refresh. 
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Figure 128. Delete Grooming Session

Viewing Grooming Source

Selecting this option from the program context menu highlights the source input program associated 
with the selected program (Figure 129).

Figure 129. View Grooming Source

Display Grooming

Use the Current Program Mapping dialog, which displays the currently configured grooming 
sessions for the selected non-transcoded program. See “Displaying or Modifying Grooming Details” 
on page 184.

Program Grooming Source Selected
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Transcoded+PIP Transport Streams

This chapter describes the use of the VMG Element Manager to manage the creation and grooming of 
transcoded+PIP transport streams. 

The Grooming -> Mapping tab provides program and transport stream (TS) information.

Note: System configuration must be completed before performing grooming tasks. Refer to 
Chapter 4, “System Configuration” for more information.

Note: The VMG supports input-level program redundancy for transcoded+PIP transport streams. If 
you plan to implement program redundancy, please familiarize yourself with “Program 
Redundancy” on page 253 before performing the procedures in this chapter.

In This Chapter:

• “Overview,” next.

• “Creating Transcoded+PIP Transport Streams” on page 201.

• “Transcoded+PIP TS Program Grooming” on page 208.

• “Managing Transcoded+PIP Transport Streams and Programs” on page 217.

• “Bitrate Monitoring” on page 223.

Overview

In contrast to standard output transport streams, a transcoded+PIP transport stream transcodes a single 
input stream into two output streams:

• A full frame rate, broadcast-resolution main stream, either HD or SD.

• A corresponding PIP stream, defined as a video-only SPTS program consisting of a lower-
resolution H.264 Baseline Profile stream.

Transcoded+PIP transport streams use the VMG’s resources more efficiently than standard output 
transport streams and also simplify the creation of programming that provides PIP services. 
Transcoded+PIP transport streams are single-program transport streams (SPTSs) in which the 
broadcast-resolution and the PIP video start at the same time and share the same input time base. You 
can create two types of Transcoded+PIP transport streams:

• AVTX+PIP—enables the transcoding of both audio and video

• VTX+PIP—enables the transcoding of video

All programs groomed to Transcoded+PIP transport streams are transcoded to H.264 video.
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Table 92 (below) highlights the differences between Transcoded+PIP Transport Streams and Standard 
Output Transport Streams.

Creating Transcoded+PIP Transport Streams

The VMG supports two Transcoded+PIP TS types: MPEG-2 and DVB, for which the VMG supports 
SI table generation. Steps are provided in the following topics:

• “Creating MPEG-2 Transcoded+PIP Transport Streams,” next. 

• “Creating DVB Transcoded+PIP Transport Streams” on page 206.

Color Indicators for Transcoded+PIP TS 

In the Outputs panel, the Transcoded+PIP TS icon is gray when video processing is not active. When 
you groom a program to the Transcoded+PIP TS the icon become green to indicate that the TS is 
active. The two SPTSs appear within the Transcoded+PIP TS—one that is broadcast resolution and the 
other PIP resolution. The Transcoded+PIP TS automatically takes on the name of the Main stream.

In Transcoded+PIP TS-related screens, purple background shading identifies fields that cannot be 
edited. Fields that have white or light blue shading can be edited by first double-clicking on them.

Creating MPEG-2 Transcoded+PIP Transport Streams

Go to the GigE interface on which to create a new MPEG-2 Transcoded+PIP transport stream:

From the Outputs panel of the Grooming -> Mapping tab page, right-click on the output GigE 
interface on which to create the stream to present the popup menu (Figure 130).

Table 92. Differences between Standard Output TS and Transcoded+PIP TS

Feature Standard Output TS Transcoded+PIP TS

Transcoding Both transcoding and non-
transcoding supported

Transcoding only

Transcoding output MPEG-2 or H.264
HD, SD, or PIP stand-alone streams

H.264 only
HD or SD (PIP included 
automatically)

TS Types MPEG-2, SCTE, ATSC, DVB MPEG-2, DVB

SPTS/MPTS Both SPTS and MPTS SPTS only

Digital Program Insertion TS level and Program level No DPI support

Program Creation Manual and Drag-and-Drop 
Grooming

Drag-and-Drop Grooming only
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Figure 130. Output Transport Stream Menu Options

1. At the popup menu, select one of the following options:

• Create AVTX+PIP Transport Stream (to transcode both audio and video)

• Create VTX+PIP Transport Stream (to transcode video only)

The Create Transcoded+PIP Transport Stream screen is now displayed (Figure 131), as 
associated with your selection. 

Figure 131. Create MPEG-2 Transcoded+PIP Transport Stream screen

2. Verify TS Type is set to MPEG-2.

3. Set the parameters for both the Main (broadcast-resolution) and PIP transport streams (Table 93), 
then click Apply to complete this operation.
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Table 93. Create MPEG-2 Transcoded+PIP Transport Stream  

Field Description Default

Port Displays the selected port on which the Transcoded+PIP output 
transport stream is being created. 

Read-only 

TS Type Select a type of Transcoded+PIP output transport stream to create, as 
either MPEG-2 or DVB.

MPEG-2

Index The row entry within the Transcoded+PIP TS creation dialog. Read-only

Type The type of video stream, either Main (full resolution) or PIP. Read-only

Name (Optional) Type alphanumeric string to set name of the output 
transport stream.

Note: The name you give to the Main stream will also become the 
name of the Transcoded+PIP TS.

Blank

TS ID (Optional) The TS ID enables the system to choose a unique number 
for identification of the output transport stream. Valid range is from 0 to 
65535 in decimal format.

Blank

Multicast Enable (check) or disable (un-check) multicast for the output transport 
stream. If enabled, the IP Address must be a valid multicast IP 
address. 

Checked 

IP Address The IP address to which the output stream is routed. 

• If Multicast is checked, this must be a valid multicast IP address.
Valid range is from 224.0.0.1 to 239.255.255.255.

• If Multicast is un-checked, this must be a valid unicast IP address.
Valid range is from 0.0.0.1 to 223.255.255.255.

• Do not assign 10.0.0.1x or 10.0.0.2x to the VMG management 
interface face or Ethernet port because these are reserved for 
internal VMG usage.

Blank

Subnet Mask If Multicast is un-checked, this field is available for input. When Multicast is 
un-checked: 
255.255.255.0 

UDP Port Type a value, in the range 1 - 65535, to specify the UDP port to use for 
transmitting data. 

Blank

Redundant IP 
Address

The alternate IP address to which the output stream can be routed. 
The redundant IP option can be used if port mirroring is enabled on 
the output port. 

• If Multicast is checked, this must be a valid multicast IP address.
Valid range is from 224.0.0.1 to 239.255.255.255.

• If Multicast is un-checked, this must be a valid unicast IP address.
Valid range is from 0.0.0.1 to 223.255.255.255.

• Do not assign 10.0.0.1x or 10.0.0.2x to the VMG management 
interface face or Ethernet port because these are reserved for 
internal VMG usage.

Blank

Redundant 
Subnet Mask

If Multicast is un-checked, this field is available for input. When Multicast is 
un-checked: 
255.255.255.0 
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The new Transcoded+PIP TS is now displayed on the Grooming -> Mapping tab page (as 
demonstrated in Figure 132.

TS Bitrate 
(Mbps)

The bitrate of the output stream.

• For the Main transport stream, the valid range is 0.1 to 38.8 Mbps.

• For the PIP transport stream, the valid range is 0.1 to 1.0 Mbps.

As appropriate for your locale, type a comma or a period symbol to 
designate the decimal point in your entry (see also “Bitrate Entry 
Guidelines” on page 310). 

Main: 18.5

PIP: 1.2

Async Data 
Bitrate (Mbps)

Applicable to the main configuration, value in Mbps to set maximum 
bitrate for asynchronous data in this stream. 

Async data bitrate cannot exceed the TS bitrate. 

As appropriate for your locale, type a comma or a period symbol to 
designate the decimal point in your entry (see also “Bitrate Entry 
Guidelines” on page 310). 

Blank (no 
maximum limit; 
equivalent to 
transport stream 
bitrate)

Automatic 
Video Bitrate

(In Mbps)

Enable (check) or (disable) auto video bitrate assignment. 

• If enabled the system assigns the video bitrate, with the latency 
marked by a “Perfecting video” message until the bitrate is 
assigned. 

• If disabled, use a video bitrate entry according to supported values 
Video Type parameters H.264 HD, H.264 SD, or H.264 PIP. Refer 
to Table , “Bitrate Configuration Reference,” on page 310 for ranges 
and default values. 

Un-checked

Video Bitrate Value, in Mbps, to set maximum video bitrate for the main and the PIP 
in this stream. 

Main: 8.0

PIP: 0.3

Table 94.  Video Transcoding Parameters - Transcoded+PIP Streams

Field Description Default

Input 
Resolution 
Class

 Select HD or SD.

• For SD, set video type (as either MPEG-2 or H264) and video 
standard (as either NTSC or PAL). 

• HD does not require video type and video standard settings.

• AVTX and 
VTX: HD input, 
HD output, and 
MPEG-2 video

• PIP:
HD input, PIP 
output, and 
H264 video

• VTR (not 
applicable)

Output 
Resolution 
Class

Select HD or SD. 

• For SD: set video type as either MPEG-2 or H264. 

• For HD: set video type as either MPEG-2 or H264.

Table 93. Create MPEG-2 Transcoded+PIP Transport Stream  (Continued)

Field Description Default
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Figure 132. Ungroomed MPEG-2 Transcoded+PIP transport stream

Main video stream

PIP video stream

Same name
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Creating DVB Transcoded+PIP Transport Streams

Go to the GigE interface on which to create a new DVB Transcoded+PIP transport stream:

From the Outputs panel of the Grooming -> Mapping tab page, right-click the output GigE inter-face 
on which to create the stream (see Figure 130 on page 202) to present the popup menu. 

1. At the popup menu, select one of the following:

• Create AVTX+PIP Transport Stream (to transcode both audio and video)

• Create VTX+PIP Transport Stream (to transcode video only)

The Create Transcoded+PIP Transport Stream screen is now displayed, as associated with your 
selection (Figure 131 on page 202). 

2. Set TS Type to DVB, to present the TS-specific fields in the screen (Figure 133).

Figure 133. Create DVB Transcoded+PIP Transport Stream

3. Set parameters for both the Main (full-resolution) and PIP transport streams as well as the DVB-
specific parameters (Table 95), then click Apply to complete this operation. (See also Table 93 on 
page 203 for details about other fields in this screen.).

The new Transcoded+PIP TS displays on the Outputs panel of the Grooming -> Mapping tab 
page (Figure 134).

Table 95. Create DVB-SI Output Transport Stream 

Field Description Default

Network ID Input the Network ID of the current transport stream.

Valid range is from 0 to 65535.

160

Modulation 
Mode

Use the pull-down menu to select the modulation mode used for the 
TS. Choice between SCTE 64 QAM and SCTE 256 QAM.

SCTE 256 QAM

Original 
Network ID

Input the Network ID from which this stream has originated.

Valid range is from 0 to 65535.

160

See Table 95, “Create DVB-SI 
Output Transport Stream,” on 
page 206, for description of 
these fields.
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Figure 134. Ungroomed DVB Transcoded+PIP transport stream

NIT Sourcea Specifies whether or not a DVB network information table is to be 
included in the output TS. Click the Select NIT button to select a 
source. Choices are:

None - No NIT will be generated on the output TS

[Input GigE TS ID] - Specified source NIT will be included in the 
output TS.

Blank

TDT/TOT 

Sourceb
Specifies whether or not DVB time and date, and time offset tables 
will be generated for the output TS. Click the Select TDT/TOT 
button to select a source. Choices are:

None - No DVB time tables will be generated on the output TS.

Local TOT - The output TS will use the locally configured TOT as 
described in “Configured GigE Ports in Grooming -> Mapping 
Subtab” on page 71.

[Input GigE TS ID] - Specified source TDT/TOT will be included in 
the output TS.

Blank

SDT Sourcec Specifies whether or not a service description table will be 
generated for this transport stream. Choose an option from the 
pulldown menu:

N/A - No SDT will be generated for this output TS

LocalSDT - Local SDT will be generated for this output TS. 

LocalSDT

EIT Source Specifies how an Event Information Table (EIT) is generated by the 
VMG. Choices are:

Groomed Input is selected, an Event Information Table (EIT) is 
generated based on that which is received from the groomed input 
program of the DVB TS. 

N/A - No EIT will be generated for this output TS.

Groomed Input

a. If a NIT is to be included in the output TS, a valid DVB stream must be feeding the input and DVB table processing must 
be enabled on the input TS (Click here for more information on enabling DVB table processing).

b. If a TDT/TOT is to be included in the output TS, a valid DVB stream must be feeding the input, and DVB table processing 
must be enabled on the input TS (Click here for more information on enabling DVB table processing).

c. If an SDT is to be included in the output TS, a valid DVB stream must be feeding the input, and DVB table processing 
must be enabled on the input TS (Click here for more information on enabling DVB table processing).

Table 95. Create DVB-SI Output Transport Stream 

Field Description Default

Main video stream

PIP video stream

Same name
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Transcoded+PIP TS Program Grooming

Unlike standard OTS creation in which a program can be created both manually and through drag-and-
drop grooming, Transcoded+PIP programs are created through drag-and-drop grooming only. When 
dragging an input program to an Transcoded+PIP TS, the VMG automatically creates one output 
program on each of the main and PIP transport streams, for a maximum of two programs on the 
Transcoded+PIP TS.

Note: The target Transcoded+PIP TS must already exist before performing program level grooming. 
Refer to “Creating MPEG-2 Transcoded+PIP Transport Streams” on page 201 and 
“Creating DVB Transcoded+PIP Transport Streams” on page 206 for more information.

Note: Output program creation depends on the type of licenses installed. Refer to “License 
Management” on page 99 for details.

To groom a program to a Transcoded+PIP TS

To perform program grooming for transcoded+PIP transport streams, you can apply drag-and-drop 
grooming in the Grooming -> Mapping tab page. 

1. Set up the transport stream type, in the output panel of the grooming tab page. 

After setting up an AVTX+PIP TS or VTX+PIP TS in the output panel, drag a program from the 
input panel to the new output stream. (Figure 135). 

Figure 135. Transcoded+PIP TS Program Grooming - Drag and Drop

The program mapping screen associated with AVTX+PIP or VTX+PIP will now display, as shown 
in the following topics:

- “Grooming to AVTX+PIP” on page 209.

- “Grooming to VTX+PIP” on page 210. 

Guidelines for setting parameters are provided in “Program Mapping Parameters for VTX+PIP or 
AVTX+PIP” on page 211.

2. Complete your entries in the configuration screen, then click Apply. 

The groomed program is now displayed in the Transcoded+PIP TS on the Grooming -> Mapping 
tab page (similar to the example shown in Figure 136).

Figure 136. Groomed Transcoded+PIP Transport Stream

Colorization of the Transcoded+PIP TS icon indicates that the stream is actively processing video. 
In addition to modifying the Transcoded+PIP TS, you can now modify the grooming parameters 
(“Modify Transcoded+PIP Grooming” on page 219) and view its grooming source (“View 
Transcoded+PIP Grooming Source” on page 222).
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Grooming to AVTX+PIP

If you groom to an AVTX+PIP TS, the Create AVTX+PIP Program Mapping screen for an HD 
encoded H.264 video program is displayed (Figure 137).

Figure 137. Create AVTX+PIP Program Mapping

Configuration guidelines AVTX_PIP program mapping are provided in “Program Mapping Parameters 
for VTX+PIP or AVTX+PIP” on page 211.

TO BE EXCHANGED

Enabled only if a Dolby 
Codec is selected. 
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Grooming to VTX+PIP 

If you groom to a VTX+PIP TS, the Create VTX+PIP Program Mapping menu for an HD encoded 
H.264 video program is displayed (Figure 138).

Figure 138. Create VTX+PIP Program Mapping

Configuration guidelines VTX_PIP program mapping are provided in “Program Mapping Parameters 
for VTX+PIP or AVTX+PIP” on page 211.

TO BE EXCHANGED
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Program Mapping Parameters for VTX+PIP or AVTX+PIP 

Parameters available in the Create Transcoded+PIP Programming Mapping tab page are 
categorized as follows:

• “Source Parameters,” next.

• “Destination” on page 211

• “Video and Audio Parameters” on page 212

• “Main Components” on page 215

• “PIP Components” on page 216

Note: Transcoded+PIP programs do not support DPI, Program Substitution, SCTE 30 to 35 
conversion, or transrating.

Source Parameters 

The source parameters listed and described in Table 96 are available from the Create 
Transcoded+PIP Programming Mapping tab page.

Destination

The destination parameters listed and described in Table 97 are available from the Create 
Transcoded+PIP Programming Mapping tab page.

Table 96. Grooming —Source Parameters

Field Description Default

Port The input program’s source GigE or 10 GigE interface. Read-only

TS ID The input program’s transport stream ID. Read-only

Program Name Program name assigned to the input program. Read-only

Program Number Program number assigned to the input program. Read-only

Resolution Class Resolution standard, as either SD or HD, assigned to the input 
program. 

Read-only

Table 97. Grooming—Destination Parameters

Field Description Default

Port View output program’s destination GigE interface port. Read-only 

TS Index View the unique ID for each transcoded+pip transport stream. Read-only

TS Name View program’s transport stream name. Read-only 

IP Address:
UDP Port

View IP address and port to which the output stream is routed. Read-only

TS Bitrate View bitrate of the output stream. Read-only

Prog Number Type a value, in the range 1 - 131072, to assign a number to the 
output program. 

1

Prog Name Alphanumeric string to set program name.

• Default format: GigE #-t[unique id]-[Program Number].

For example: 

GigE 7- 
t47221504-1 
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Video and Audio Parameters

The video and audio parameters listed and described in Table 98 are available from the Create 
Transcoded+PIP Programming Mapping tab page.

Table 98. Grooming—Video and Audio Parameters  

Field Description Default

Video Type Only H.264 is available as the video type for Transcoded+PIP 
output transport stream programs.

H.264

Encoding Template Choose between HD (high definition) or SD (standard definition)

• If HD is selected, the video bitrate defaults and range will 
change (see the Automatic Video Bitrate (In Mbps) field).

• If SD is selected, the video bitrate defaults and range will 
change (see the Automatic Video Bitrate (In Mbps) field).

HD for Main.

Read-only for PIP

Profile Select either high, main, or baseline to set the video standard to 
be used. Refer to “Video Profile Configuration Options” on 
page 313 for guidelines. 

Note: Profile is available only when Video Type is set to H.264. 
High is not available for PIP transport streams.

High for the Main 
stream and Main 
for the PIP stream

Automatic Video 
Bitrate

(In Mbps)

Enable (check) or (disable) auto video bitrate assignment.

• If enabled the system assigns the video bitrate, with the latency 
marked by a “Perfecting video” message until the bitrate is 
assigned. 

• If disabled, use a video bitrate entry compliant with supported 
Video Type parameters H.264 HD, H.264 SD, or H.264 PIP. As 
appropriate for your locale, type a comma or a period symbol to 
designate the decimal point in your entry (see also “Bitrate 
Entry Guidelines” on page 310). 

• See Table , “Bitrate Configuration Reference,” on page 310 for 
ranges and default values. 

Un-checked

Resolution Specifies the type of horizontal (H) resolution to use for the 
transcoded program. 

• For HD transcoded programs, the following options are 
available: 
Full Res, 1920, 1440, 1280, 960 

• For SD programs, the following options are available:
Full D-1, VGA, 3/4 D-1, 2/3 D-1, or 1/2 D-1

• For the PIP program, the following horizontal and vertical 
options are available: 
H:1/2D1 X V:1/2D1 (352 x 240 for NTSC; 352 x 288 for PAL), 192 X192, 
128 X 96, 96 X 96

HD:

H: Full Res

SD:

H: Full D-1

PIP:

192 X 192

AFD Output Disable (check) or enable (un-check) forwarding of Active Format 
Descriptions in output streams. This option does not apply to the 
PIP program. 

For information on AFD, refer to “Active Format Description 
(AFD)” on page 168.

Un-checked
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Active Format

(Hidden unless SD 
selected)

Specifies the type of output for HD content transcoded to SD. The 
options are:

• Force 16:9 letterbox — an AFD code of 10 is included in the 
output (16:9 Image: Letterbox in 4:3 frame, Full Frame in 16:9 
frame).

• Force 4:3 centercut — an AFD code of 9 is included in the 
output (4:3 Image: Full Frame in 4:3 frame, Pillarbox in 16:9 
frame).

• Use AFD; 16:9 fallback — the frame format will be determined 
by the Active Format Description in the input program. If the 
AFD is not present, the frame will be forced to 16:9 Letterbox.

• Use AFD; 4:3 fallback — the frame format will be determined by 
the Active Format Description in the input program. If the AFD is 
not present, the frame will be forced to 4:3 Centercut.

The Active Format field only appears when the Encoding 
Template is set to SD.

• This option does not apply to the PIP program.

Force 16:9 
letterbox

Aspect Ratio Specifies the ratio of the program’s width to the height. 

• For an HD program, the field is read-only and set to Automatic.

• For an SD program, choose from one of the following options: 
Automatic, 4:3, 16:9

• For the PIP program, choose from one of the following options: 
Automatic, 4:3, 16:9

HD and SD:

Automatic

PIP:

4:3

GOP M Specifies the spacing of the P frames in the output. The higher the 
value, the lower the data rate. 

• For the Main program, choose one of the following values: 
1, 2, 3, 4, or 8. 

- Note that GOP M 8 is not available if the input is 1080i HD. 

• For the PIP program, choose one of the following values:
1 or 4

4

GOP N Specifies the number of frames in each GOP. The higher the 
value, the lower the data rate. 

• For the Main program, this value must be between 1 and 240 
and a multiple of the GOP M value. 

When the GOP M value is set to 4 or 8, the GOP N value is set 
to 32 and is read-only.

• For the PIP program, this value is set to 32 and read-only.

32

Table 98. Grooming—Video and Audio Parameters  (Continued)

Field Description Default
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IDR Interval (in 
Frames)

Specifies the interval between instantaneous decoder refresh 
(IDR) frames.

• For GOP M=1-3 with HD or SD encoding, the IDR interval can 
be manually entered and must be a multiple of the GOP N 
value. Enter 0 if no IDR frames are to be inserted. 

• For GOP M=4, the IDR interval can be set to 96 (the default) or 
0 (no IDR).

• For GOP M=8, the IDR interval is set to 96 and is read-only.

• For the PIP program, no IDR frames are inserted and this field 
does not display. 

96

Closed Caption 
Type

Currently only CEA 608. CEA 608. 

SCTE 35 Cue Check the Forward box to forward SCTE 35 cues from the input 
program

• This option does not apply to the PIP program. 

Checked

Pre-Processing 
Filters

MCTF noise reduction — when checked, enables motion 
compensated temporal filtering (MCTF). 

• This option does not apply to the PIP program. 

Un-checked

Audio Profile

(AVTX+PIP only)

You can define audio profiles that you can quickly apply to a 
Program Mapping.

If this option is checked, enter a name to create a new audio 
profile and then define the audio parameters below. If the option is 
un-checked, you can select from a list of existing audio profiles 
and the audio parameters will be automatically filled in and un-
editable.

Blank

Audio Codec

(AVTX+PIP only)

Defines the codec for the output audio. Choose one of the 
following options:

• HE AAC, HE AAC v2, AAC-LC, MPEG1 L2, MPEG2 L2, AC-3

AAC LC

Sampling Rate

(AVTX+PIP only)

Defines the number of audio samples per second. The higher the 
number, the better the sound quality. Choose one of the following 
options:

• 8 kHz, 11.03 kHz, 12 kHz, 16 kHz, 22.05 kHz, 24 kHz, 32 kHz, 
44.1 kHz, 48 kHz

48 kHz

Channels

(AVTX+PIP only)

Defines the number of output channels per audio stream as either 
mono, stereo, or 5.1 surround.

stereo

Audio Bitrate

(AVTX+PIP only)

Defines the bitrate for all audio streams within the MBR TS. The 
selectable values depend on your selection of Audio Codec, 
Sampling Rate, and Channels.

128 kbps

Table 98. Grooming—Video and Audio Parameters  (Continued)

Field Description Default
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Main Components

The main components parameters listed and described in Table 99 are available from the Create 
Transcoded+PIP Programming Mapping tab page.

Audio Gain

(AVTX+PIP only)

Defines the gain on an audio stream level. Audio Gain is applied 
to all audio streams within the MBR TS. If the input program has 
two or more audio PIDs, all audio outputs will have the same gain. 

• Audio Gain ranges from -24 dB to +24 dB and is selectable in 1 
dB increments.

Note: And Audio Gain of 0 means no gain.

no Gain

Advanced Button

(AVTX+PIP only)

Allows access to Dolby Configuration dialogs, as appropriate for 
the Audio Codec specified in the Audio Codec field. 

• Disabled for 
non-Dolby 
audio Codec.

• Enabled for 
Dolby audio 
Codec.

Table 99. Grooming—Main Components Parameters  

Field Description Default

Pass-through

(AVTX+PIP only)

Enable or disable AC-3 audio pass-through for the stream. 

If enabled, the AC-3 stream will be passed through to the output 
with your setting for the PID, and transcoded to the output with 
your settings for audio codec. 

None

Start PID

(AVTX+PIP only)

This field is displayed in the Program Mapping screen when AC-3 
is selected for Pass-through. 

Type the PID value to be associated with AC-3. 

Range: 32 - 8175.

Blank

Max Audio Set value to define the maximum allowable audio elementary 
streams to be handled in the output. Note that this setting affects 
bitrate allowances on the stream. 

See “Bitrate 
Configuration 
Reference” on 
page 310 for 
comparative 
values.

Max Data Set value to define the maximum allowable data elementary 
streams to be handled in the output. Note that this setting affects 
bitrate allowances on the stream. 

Groom Check this box to include the specified elementary stream in the 
Main output program.

Checked 

Input Type Displays the input elementary stream types for the input program. Read-only

Input PID Displays the Input Type’s associated PID for the input program. Read-only

TS Index X PID The X refers to the TS Index for the Main transport stream within 
this Transcoded+PIP TS. Here you can set the PIDs for the Main 
transport stream.

Output PID

TS Index X Lang The X refers to the TS Index for the Main transport stream within 
this Transcoded+PIP TS.

For audio streams, this displays the output language of the 
elementary stream.

Read-only

Table 98. Grooming—Video and Audio Parameters  (Continued)

Field Description Default
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PIP Components

The PIP components parameters listed and described in Table 100 are available from the Create 
Transcoded+PIP Programming Mapping tab page.

About Audio Pass-Through

Pass-through configuration can be applied only to MBR, AVTX+PIP, and AVTX grooming. Only one 
input audio stream per groom is allowed when the pass-through option is enabled. This will result in 
output that contains one transcode audio and one pass-though audio. Audio pass-through applies to the 
entire groom; it cannot be applied to individual audio streams. 

1. From the Outputs panel of the Grooming -> Mapping tab page, right-click on a GigE interface 
and choose Create Transport Stream for either MBR, AVTX+PIP, or AVTX to access the Create 
Transport Stream screen for your selection.

2. Provide the following entries in the Create Transport Stream screen:

- Name, TS ID, multicast information, IP Address, UDP, and bitrate.

- Resolution class = HD.

- Click Apply to put the Transport Stream on the Outputs panel. 

3. Drag an input stream over to the new output stream. The Configure Program Mapping screen for 
the your selection is now displayed. 

Note: At the Main Components section of the screen, the Pass-Through field defaults to None. 

4. Select either AC-3 or E-AC-3 (Dolby Digital Plus) from the Pass-Through field, and set a value 
to define the PID at the Start PID field. 

5. Set any other required parameters in the Configure Program Mapping screen, then click Apply 
to complete this grooming operation. 

Table 100. Grooming—PIP Components Parameters

Field Description Default

Groom Indicates that the elementary stream is included in the PIP output 
program.

Read-only 

Input Type Displays the input elementary stream types for the input program. Read-only

Input PID Displays the Input Type’s associated PID for the input program. Read-only

TS Index X PID The X refers to the TS Index for the PIP transport stream within 
this Transcoded+PIP TS. Here you can set the PIDs for the PIP 
transport stream.

Output PID



VMG Element Manager User Guide 217

Release 3.1.3 Managing Transcoded+PIP Transport Streams and Programs

Managing Transcoded+PIP Transport Streams and Programs

Management of Transcoded+PIP transport streams and programs is performed from the Grooming tab 
of the VMG Element Manager screen. 

Modify a Transcoded+PIP Transport Stream

Caution: Modifying a Transcoded+PIP TS will disrupt program output from the VMG for a few 
seconds. The actual duration of the disruption at the set top box end might be several 
seconds.

To modify a Transcoded+PIP transport stream:

1. Go to the Modify AVTX+PIP Transport Stream screen:

From the Outputs panel of the Grooming -> Mapping tab page, right-click a Transcoded+PIP TS, 
and select Modify Transcoded+PIP Transport Stream (Figure 139) to present the Modify 
AVTX+PIP Transport Stream screen (MPEG-2 Figure 139, or DVB Figure 140). 

Figure 139. Transcoded+PIP TS 



VMG Element Manager User Guide 218

Release 3.1.3 Managing Transcoded+PIP Transport Streams and Programs

Figure 140. Modify Transcoded+PIP Transport Stream for DVB Transport Stream

2. At the Modify AVTX+PIP Transport Stream screen, enter changes, then click Apply. 

- The Apply button becomes green when all required fields contain information. 

- The Grooming button also becomes green when all required fields contain information You 
can then go directly to the Program Mapping screen in which to apply grooming parameters 
for this transport stream. 

Note: In the Modify AVTX+PIP Transport Stream screen, purple shading indicates parameters that 
cannot be edited. 

For both MPEG-2 and DVB Transcoded+PIP transport streams, the following parameters can be 
modified (see Table 93 on page 203 for information on these parameters):

• Name

• Multicast

• IP Address

• Subnet Mask (if Multicast is un-selected)

• UDP Port

For DVB Transcoded+PIP transport streams, the following additional parameters can be modified (see 
Table 95 on page 206 for information on these parameters):

• Network ID

• Original Network ID

• NIT Source

• TDT/TOT Source

• SDT Source

• EIT Source

TO BE EXCHANGED
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Deleting a Transcoded+PIP Transport Stream

To delete the transport stream:

1. From the Outputs panel of the Grooming -> Mapping tab page, right-click the desired Trans-
coded+PIP TS and select Delete AVTX+PIP Transport Stream or Delete VTX+PIP Transport 
Stream from the popup menu (see Figure 139 on page 217).

You will be asked if you wish to delete the transport stream.

2. Click Yes.

Modify Transcoded+PIP Grooming

Access the Modify ACTV+PIP Program Mapping screen to modify grooming for an 
Transcoded+PIP transport stream:

From the Outputs panel of the Grooming -> Mapping tab page, right-click on a Transcoded+PIP TS 
and select Modify AVTX+PIP Grooming, or Modify VTX+PIP Grooming, from the popup menu 
(see Figure 139 on page 217) to present the Modify Transcoded+PIP Program Mapping tab page 
(Figure 141).

Figure 141. Modify Transcoded+PIP Program Mapping

All parameters that can be set during initial grooming of an Transcoded+PIP program can also be 
modified. Refer to the following parameter descriptions for guidelines:
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• Table 96, “Grooming —Source Parameters,” on page 211.

• Table 97, “Grooming—Destination Parameters,” on page 211.

• Table 98, “Grooming—Video and Audio Parameters,” on page 212.

• Table 99, “Grooming—Main Components Parameters,” on page 215.

• Table 100, “Grooming—PIP Components Parameters,” on page 216.

Resetting Grooming—AVTX+PIP or VTX+PIP

Use the Reset Grooming option (Figure 142) on an output transport stream to tear down a current 
configuration and rebuild the transport stream with an identical configuration. 

From the Outputs panel of the Grooming -> Mapping tab page, right-click on an AVTX+PIP, 
VTX+PIP, transport stream for the popup menu -> select Reset Grooming.

Figure 142. Reset Grooming—AVTX+PIP. VTX+PIP

Note: This option interrupts service on service associated with transport streams sharing the same 
MBR group ID or audio profile. When selected, a confirmation query (Figure 143) will be 
presented prior to beginning the reset process on the selected transport stream. 

Regrooming—AVTX, AVTX+PIP

Regrooming occurs when you drag an input program to an output transport stream that has already 
been groomed. This action rebuilds the grooming at the selected output TS, with the new input 
program, is both configurations are identical—on the output program and the output elementary 
streams. 

Prior to regrooming the targeted output transport stream, the VMG Element Manager queries for 
confirmation of the configuration, to ensure that the input configuration matches that of the output 
configuration. The Confirmation dialog (Figure 143) also reminds you that regrooming interrupts 
service. 

Confirmation Query for Reset Grooming at 
AVTX+PIP TS.

Confirmation Query for Reset Grooming at
VTX+PIP TS.
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Figure 143. Regroom Confirmation—AVTX+PIP. VTX+PIP

Once this grooming session is completed, you can check the Modify <type> Program Mapping 
screen to view data about the incorporated program. Fields associated with the Output ES (in 
Component PIDs) are editable; all others are read-only, as demonstrated in Figure 144.

Figure 144. Viewing Regrooming Detail

Confirmation Query for Regroom at 
AVTX+PIP TS.

Confirmation Query for Regroom at 
VTX+PIP TS.
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Deleting Transcoded+PIP Grooming

To delete the grooming:

1. From the Outputs panel of the Grooming -> Mapping tab page, right-click the desired Trans-
coded+PIP TS and select Delete AVTX+PIP Grooming or Delete VTX+PIP Grooming from the 
popup menu (see Figure 139 on page 217).

You will be asked if you wish to delete the grooming.

2. Click Yes.

View Transcoded+PIP Grooming Source

To view the grooming source for an Transcoded+PIP program:

1. From the Outputs panel of the Grooming -> Mapping tab page, right-click the desired Trans-
coded+PIP TS carrying the program and select View AVTX+PIP Grooming Source or View 
VTX+PIP Grooming Source from the popup menu (see Figure 139 on page 217).

Selecting this option highlights the source input program associated with the selected 
Transcoded+PIP program.

Figure 145. View Transcoded+PIP Grooming Source

Program Grooming Source Highlighted
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Bitrate Monitoring

Go to the Input-Output Bitrate Monitor screen to view the bitrate graph for an Transcoded+PIP 
program:

From the Outputs panel of the Grooming -> Mapping tab page, right-click a transport stream within 
the Transcoded+PIP TS and select Bitrate Monitor from the popup menu (Figure 146) to present the 
Input-Output Bitrate Monitor screen. See Chapter 16, “Monitoring” for additional information.

Figure 146. Transcoded+PIP Bitrate Monitor

Note: The Bitrate Monitor can only display the real-time bitrate for one transport stream and to one 
VMG Element Manager user at a time. Two transport streams cannot be monitored. 
simultaneously.
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MBR Transport Streams

This chapter describes the use of the VMG Element Manager to manage the creation and grooming of 
MBR (multi-bitrate) transport streams. The Grooming -> Mapping tab provides program and 
transport stream (TS) information.

Note: System configuration must be completed before performing grooming tasks. Refer to 
Chapter 4, “System Configuration” for more information. In addition to the hardware 
requirements, sufficient H.264 SD licenses must be available.

Note: The VMG supports input-level program redundancy for MBR transport streams. If you plan to 
implement program redundancy, please familiarize yourself with “Program Redundancy” on 
page 253 before performing the procedures in this chapter.

Hardware requirements for support of MBR Transport Stream configuration are provided in Table 101.

Streams associated with MBR configurations can be monitored at the bitrate level. See Chapter 16, 
Monitoring on Page 291 for more information. 

In This Chapter:

• “Overview,” next.

• “Creating MBR Transport Streams” on page 226.

• “MBR TS Program Grooming” on page 230.

• “Managing MBR Transport Streams and Programs” on page 238.

Overview

An MBR (multi-bitrate) transport stream enables transcoding of a single input stream (HD or SD in 
either MPEG-2 or H.264 format) into as many as four H.264 SPTSs per grooming operation. More 
than four profiles (outputs) can be configured by performing multiple groom operations reference the 
same group ID. All programs groomed to MBR TSs are transcoded to H.264 video. For each SPTS in 

Table 101. VMG Hardware Requirements for MBR TS Configuration

Hardware Description

TCM One or more must be installed and operational.

AMP One or two must be installed and operational.

Each AMP must be physically connected to its NPM pairing, using guidelines from 
the VMG Hardware Setup Guide for your VMG. The available VMG Hardware 
Setup Guides are listed in “Related Documentation” on page 2.

Each AMP connection must be enabled through the VMG Element Manager. See 
“AMP Connection” on page 69 for instructions.
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an MBR TS, you can independently control the video bitrate, resolution, aspect ratio, profile, and GOP 
structure for a groomed program.

MBR TSs also perform transcoding on the input audio streams, enabling you to control the number of 
audio channels, sampling rate, and audio bitrate for the output programs. You can set up as many as 
54 HD or 108 SD video/audio MBR groups for programs groomed to MBR TSs with up to eight 
profiles (outputs) each. Capacities for redundant and non-redundant VMG systems are listed in 
Table 102 and Table 103.

Transport streams have different characteristics, as based on whether they are MBR streams or 
standard output streams (Table 104). 

Table 102. MBR Transport Stream System Capacities - Redundant System

VMG Model
Input 
Resolution

Maximum Capacities

MBR 
Groups

MBR 
Transport 
Streams

MBR 
Profiles

Stereo Audio 
Transcoding 
streams (AAC-LC)

Qty of Audio 
Transcodings 
per MBR Group

VMG-14a

a. System containing nine active TCMs.

HD/SD

108 108 432 375 mono, or

249 stereo, or

132 surround
2VMG-8b

b. System containing three active TCMs.

36 36 144

VMG-6c

c. System containing one active TCM. 

12 12 48

Table 103. MBR Transport Stream System Capacities - Non-Redundant System

VMG Model
Input 
Resolution

Maximum Capacities

MBR 
Groups

MBR 
Transport 
Streams

MBR 
Profiles

Stereo Audio 
Transcoding 
streams (AAC-LC)

Qty of Audio 
Transcodings 
per MBR Group

VMG-14a

a. System containing 11 active TCMs. 



HD/SD

132 132 528 375 mono, or

249 stereo, or

132 surround
2VMG-8b

b. System containing five active TCMs. 

60 60 240

VMG-6c

c. System containing three active TCMs. 

36 36 144

Table 104. Differences between Standard Output TS and MBR TS  

Feature Standard Output TS MBR TS

Video Transcoding Both transcoding and non-
transcoding supported

Transcoding only

Transcoding output MPEG-2 or H.264
HD, SD, or PIP stand-alone streams

H.264 only
Up to 4 streams of varying resolutions 
(per groom; more supported per 
group ID)

TS Types MPEG-2, SCTE, ATSC, DVB MPEG-2

SPTS/MPTS Both SPTS and MPTS SPTS only
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Note: See also the “Resolution Configuration Reference” on page 309 for resolutions currently 
supported for HD or SD programming.

Inter-VMG IDR Alignment

The VMG enables transcoders to create IDR-aligned output profiles suitable for segmenting and 
adaptive delivery. It also ensures that different transcoders that ingest the same input will have all of 
their outputs be IDR aligned. 

To enable inter-VMG IDR alignment, each VMG must be configured to use identical MBR settings 
and tuning parameters.

Creating MBR Transport Streams

The VMG supports only one MBR TS type: MPEG-2. You can control the HD output for the MBR 
transport stream by setting parameters for up to four individual streams, or use the Full HD Output 
option to consolidate full output into a single MBR transport stream as described in the following 
topics:

• “Configuring Individual MBR Transport Streams,” next.

• “Configuring Full HD MBR Transport Stream” on page 227. 

Use the Create MBR Transport Stream screen (Figure 147 (default) and Figure 148 (Full HD 
Output), and Table 105) to set MBR parameters for the stream.

From the Outputs panel of the Grooming -> Mapping tab page, right-click the output GigE interface 
and select Create MBR Transport Stream. 

Note: In MBR TS screens, purple background shading identifies fields that cannot be edited. Fields 
that have white or light blue shading can be edited by first double-clicking on them.

Configuring Individual MBR Transport Streams

1. At the Create MBR Transport Stream screen (Figure 147), select the number of transport 
streams to be included, and set values for each in the configuration table. See Table 105 for 
configuration guidelines.

2. Enable or disable output SDT, and set Video Transcoding Input Resolution Class as either HD 
or SD. 

- Select HD if the video input you intend to process is High Definition. 

- Select SD if the video input you intend to process is Standard Definition.

Digital Program Insertion TS level and Program level No DPI support

Program Creation Manual and Drag-and-Drop 
Grooming

Drag-and-Drop Grooming only

Table 104. Differences between Standard Output TS and MBR TS  (Continued)

Feature Standard Output TS MBR TS
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Figure 147. Output interface popup menu - Create MBR Transport Stream - Default 

3. Click Apply. The new MBR TS is now displayed on the Grooming -> Mapping tab page 
(Figure 149)

Configuring Full HD MBR Transport Stream

Configuration for Full HD MBR enables one profile, only, per MBR transport stream. 

1. At the Create MBR Transport Stream screen (Figure 148), click to check-mark the Full HD 
Output checkbox. 

The Number of Transport Streams available is now displayed as one only, and only one row is 
provided for entry of the MBR stream parameters. See Table 105 for configuration guidelines.

Note: If you deselect the Full HD Output box, you can replace the missing configuration rows by 
entering a value (maximum four) into Number of Transport Streams field.

Figure 148. Output interface popup menu - Create MBR Transport Stream - Default 
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2. Click Apply. The new MBR TS is now displayed on the Grooming -> Mapping tab page 
(Figure 149).

.

Table 105. Create MBR Transport Stream Fields 

Field Description Default

Port View the selected port on which the MBR output transport stream is 
being created. 

Read-only 

TS Type View the type of MBR output transport stream being created. 

Currently, MPEG-2 is the only option.

Read-only

Number of 
Transport 
Streams

Type a value, in the range 1 - 4, to set the number of single-program 
transport streams (SPTS) to be contained by the MBR TS.

Note: for full HD mode, only 1 TS is allowed. 

4

Output SDT Enable (check) or disable (un-check) SDT passthrough on this MBR 
transport stream.

Un-checked

Index View the individual stream number within the MBR TS. Read-only

Name (Optional) Type an alphanumeric string—up to 32 characters—to set a 
name for the output transport stream. 

Note: The name you give to the first stream will also become the name 
of the MBR TS.

Blank

TS ID (Optional) Type a numeric value, in the range 0 - 65535, to set a 
unique transport identifier. 

Blank

Multicast Enable (check) or disable (un-check) multicast for this output transport 
stream. 

Checked 

IP Address The IP address to which the output stream is routed. 

• If Multicast is checked, this must be a valid multicast IP address.
Valid range is from 224.0.0.1 to 239.255.255.255.

• If Multicast is un-checked, this must be a valid unicast IP address.
Valid range is from 0.0.0.1 to 223.255.255.255.

Blank

Subnet Mask If Multicast is un-checked, this field is available for input. When Multicast is 
un-checked: 
255.255.255.0 

UDP Port The UDP port to use for transmitting data. Valid range is from 1 to 
65535.

Blank

TS Bitrate 
(Mbps)

Set bitrate of the output stream. The valid range is from 0.1 to 
10 Mbps. The sum of all TS bitrates within the MBR group will be 
constrained to 12 Mbps.

As appropriate for your locale, type a comma or a period symbol to 
designate the decimal point in your entry (see also “Bitrate Entry 
Guidelines” on page 310). 

Blank

Input 
Resolution 
Class

Specifies the video input you intend to process, as either HD or SD. HD

Video bitrate Value, in Mbps, to define the maximum bitrate for the video bitrate in 
this transport stream.

Range: 0.1 - 8 Mbps. The total for the four video streams is limited to 
9 Mbps.

Blank
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Figure 149. Example New MPEG-2 MBR transport stream at Mapping tab page. 

The MBR TS icon is gray unless video processing is active, that is, until you groom a program to the 
MBR TS. One to four SPTSs appear within the MBR TS. The MBR TS automatically takes on the 
name of the first SPTS.

Figure 150. Groomed MBR Transport Stream

Table 106.  Video Transcoding Parameters - MBR Streams

Field Description Default

Input 
Resolution 
Class

 Select HD or SD.

• For SD, set video type (as either MPEG-2 or H264) and video 
standard (as either NTSC or PAL). 

• HD does not require video type and video standard settings.

• AVTX and 
VTX: HD input, 
HD output, and 
MPEG-2 video

• PIP:
HD input, PIP 
output, and 
H264 video

• VTR (not 
applicable)

Output 
Resolution 
Class

Select HD or SD. 

• For SD: set video type as either MPEG-2 or H264. 

• For HD: set video type as either MPEG-2 or H264.

Full HD Output 
(checkbox)

Check here if the stream is to be treated as an Full-HD MBR. If so, the 
dialog will provide only one entry row in which to define the Full-HD 
MBR parameters, and the number of transport streams that can be 
groomed to the particular session will be limited to one only. 

An Full-HD MBR transport stream video bitrate is limited to 9 Mbits/
sec, and can support up to four audio and four data PIDs. 

When unchecked, all other sessions (maximum 4) remain unaffected. 

• Unchecked

Same name

Colorization of the MBR TS icon (previously gray) 
indicates that the groomed stream is actively 
processing video. 

• You can modify parameters for the MBR TS (see 
“Modifying an MBR Transport Stream” on 
page 238).

• You can also modify current grooming parameters 
(“Modifying MBR Grooming” on page 241) and 
view its grooming source (“Viewing MBR 
Grooming Source” on page 243). 

• You can modify the MBR program name 
(“Modifying MBR Program” on page 244).
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MBR TS Program Grooming

Unlike standard OTS creation in which a program can be created both manually and through drag-and-
drop grooming, MBR programs are created through drag-and-drop grooming only. When you drag an 
input program to an MBR TS, the VMG automatically creates one output program on each of the 
transport streams, for a maximum of four programs on an MBR TS.

Note: The target MBR TS must already exist before performing program level grooming. Refer to 
“Creating MBR Transport Streams” on page 226 for more information.

Note: MBR TS programs require an H264 Transcoding License. Refer to “License Management” on 
page 99 for details.

Drag-and-drop grooming is performed on the Grooming -> Mapping tab page of the VMG Element 
Manager screen (Figure 151). 

Figure 151. Grooming Configuration

Grooming a Program to an MBR TS

After you associate a selected program to a new MBR transport stream, the Configure MBR Program 
Mapping screen is then presented, which allows you to set the grooming parameters. 

1. Set up the MBR transport stream in the Output panel of the grooming table page. 

2. Drag a program from the Input panel to the new to MBR TS at the Output panel (Figure 152). 

Figure 152. MBR TS Program Grooming - Drag and Drop

The MBR Program Mapping screen will now display (Figure 153 and Figure 154). 
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3. At the MBR Program Mapping screen, set parameters, then click Apply. 

Guidelines applying settings at this screen are provided in “Program Mapping Parameters for 
MBR” on page 231. 

Clicking Apply grooms the new MBR output program, which will now be displayed in the MBR 
TS on the Grooming -> Mapping tab page (similar to the example shown in Figure 150).

4. At the Outputs panel, note that the MBR group ID is now appended to the MBR TS information. 

Program Mapping Parameters for MBR 

The Configure MBR Program Mapping screen complies with the video transcoding setting—as either 
SD (Figure 153), HD (Figure 154), or Full HD Output (Figure 155—defined during creation, as well 
as modification, of the MBR output transport stream. 

The Configure MBR Program Mapping screen contains the sections described in the following 
tables:

• Table 107, “Grooming - Configure MBR Program Mapping, Source and Destination settings,” on 
page 234.

• Table 108, “Grooming - Configure MBR Program Mapping, Output Programs settings,” on 
page 235.

• Table 109, “Grooming - Configure MBR Program Mapping, General settings,” on page 236.

• Table 110, “Grooming - Configure MBR Program Mapping, Audio settings,” on page 237

• Table 111, “Grooming - Configure MBR Program Mapping, Component PID settings,” on 
page 237.

Configure MBR Program Mapping—SD

Use the Configure MBR Program Mapping screen (Figure 153) to define grooming parameters for a 
specified MBR program using resolution class SD. 

1. At the Outputs panel, create or modify an MBR transport stream, and set Video Transcoding for 
SD. 

2. From the Inputs panel of the Grooming -> Mapping tab page, drag a program to the MBR TS on 
the Outputs panel. The Configure MBR Program Mapping screen is now displayed.

3. At the Configure MBR Program Mapping screen, set parameters, then click Apply to dismiss 
the screen.

4. At the Outputs panel, note that the MBR group ID is now appended to the information alongside 
this MBR TS.)
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Figure 153. Configure MBR Program Mapping (SD Resolution Class)

Configure MBR Program Mapping—HD

Use the Configure MBR Program Mapping screen (Figure 154) to define grooming parameters for a 
specified MBR program using resolution class SD. 

1. At the Outputs panel, create or modify an MBR transport stream, and set Video Transcoding for 
HD. 

2. From the Inputs panel of the Grooming -> Mapping tab page, drag a program to the MBR TS on 
the Outputs panel. The Configure MBR Program Mapping screen is now displayed.

3. At the Configure MBR Program Mapping screen, set parameters, then click Apply to dismiss 
the screen.

4. At the Outputs panel, note that the MBR group ID is now appended to the information alongside 
this MBR TS.

TO BE EXCHANGED
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Figure 154. Configure MBR Program Mapping (HD Resolution Class)

Configure MBR Program Mapping—Full HD Output

Use the Configure MBR Program Mapping screen (Figure 155) to define grooming parameters for a 
specified MBR program using resolution class Full HD Output.

Note: Configuration for Full HD MBR enables one profile, only, per MBR transport stream.

1. At the Outputs panel, create or modify an MBR transport stream. Set Video Transcoding for HD 
and check the Full HD Output box. 

2. From the Inputs panel of the Grooming -> Mapping tab page, drag a program to the MBR TS on 
the Outputs panel. The Configure MBR Program Mapping screen is now displayed.

3. At the Configure MBR Program Mapping screen, set parameters, then click Apply to dismiss 
the screen.

4. At the Outputs panel, note that the MBR group ID is now appended to the information alongside 
this MBR TS.
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Figure 155. Configure MBR Program Mapping (Full HD Output Resolution Class)

Note: MBR programs do not support DPI, Program Substitution, SCTE 30 to 35 conversion, or 
transrating.

Table 107. Grooming - Configure MBR Program Mapping, Source and Destination settings  

Section Field Description Default

Source

Port The input program’s source GigE or 10 GigE interface. Read-only

TS ID The input program’s transport stream ID. Read-only

Program Name Program name assigned to the input program. Read-only

Program 
Number

Program number assigned to the input program. Read-only

Forward 
SCTE 35 Cue

Check this box to forward all SCTE 35 Cues from the 
input program

Checked

Resolution 
Class

This field specifies the input resolution class that is 
going to be detected from transport stream.

Read-only

TO BE EXCHANGED
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Destination

Port The output program’s destination GigE interface. Read-only

MBR TS Index A unique system-generated ID for the MBR TS. Read-only

SDT Option Select Passthrough or Generate.

The default setting is dependent on the input setting (as 
configured with Create Output TS). If Output TS is 
enabled (checked, at Create Output TS), and:

• If the input TS has SDT, the SDT option will be Pass-
through.

• If the input does not carry SDT, the SDT option 
setting will be Generate.

If SDT is not enabled for output SDT, the SDT option 
will be None and grayed-out.

See 
description at 
left.

SDT Service 
Name

Alphanumeric entry, up to 64 characters, to identify the 
SDT service for this transport stream.

Default display is dependent on SDT option:

• If SDT option is Generate, this field is blank.

• If SDT option is Passthrough, the field displays the 
SDT service name defined for the corresponding 
input program. 

See 
description at 
left. 

Table 108. Grooming - Configure MBR Program Mapping, Output Programs settings  

Field Description Default

TS Index A unique ID for each transport stream in the MBR TS Read-only 

TS Name The name given to each TS when the MBR TS was created. Read-only 

IP Address:
UDP Port

The IP address and port to which the output stream is routed. Read-only

TS Bitrate The bitrate of the output stream. Read-only

Prog Number Number assigned to the output program. 

Valid range is from 1 to 131072.

1

Prog Name Name assigned to the program.

• Field is alphanumeric.

• Default format: GigE #-t [unique id]-[Program Number].

For example: 

GigE 7- 
t47221504-1 

Video Bitrate
(In Mbps)

Sets the maximum bitrate for the video stream in each program. The Video 
Bitrate can range from 0.1 to 8 Mbps but cannot be set higher than the TS 
Bitrate. The sum of all video bitrates within the MBR group will be 
constrained to 9 Mbps. 

1.5 Mbps

Resolution Specifies the resolution for each transcoded program. The list of possible 
resolutions depends on the Resolution Class, for either HD or SD. 

Values and resolution combinations associated with the resolution classes 
are provided in “Resolution Configuration Reference” on page 309.

640x360 for 
HD

480x368 for 
SD

1920x1080 for 
Full HD

Table 107. Grooming - Configure MBR Program Mapping, Source and Destination settings  (Continued)

Section Field Description Default
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Aspect Ratio Specifies the ratio of the program’s width to the height. Choose from one of 
the following options for each TS:

• Automatic, 4:3, 16:9

Automatic

Profile Select either high, main, or baseline to set the video standard to be used. 
Refer to Table 136, “Video Profile Configuration Options,” on page 313 for 
guidelines. 

Note: The transcoded programs in a single MBR TS can have a mix of 
High and Main for the profile. However, you should not mix Baseline with 
High and Main profiles.

High

Table 109. Grooming - Configure MBR Program Mapping, General settings  

Field Description Default

Video Type Only H.264 is available as the video type for MBR output transport stream 
programs

Read-only

Create MBR 
Group ID

MBR Groups are video/audio profiles that you can quickly apply to an MBR 
Program Mapping.

If this option is checked, enter a name to create a new MBR Group ID and 
then define the video and audio parameters below. If the option is un-
checked, you can select from a list of existing MBR Groups and the video 
and audio parameters will be automatically filled in and un-editable.

Checked

GOP M Specifies the spacing of the P frames in the output. The higher the value, 
the lower the data rate. Choose from one of the following options:

• 1, 2, or 4. 

4

GOP N Specifies the number of frames in each GOP. Choose from one of the 
following options:

• 32 (or 64 in full HD mode)

• 60 (or 120 in full HD mode)

• Optimized GOP length. 

32

IDR Interval 
(in Frames)

Specifies the interval between instantaneous decoder refresh (IDR) 
frames. Choose one of the following options:

• 32 frames, 64 frames, 96 frames, 128 frames, 160 frames, 192 frames, 
224 frames, 256 frames, 288 frames, 320 frames

NOTE: 

If GOP N is set as 60, acceptable settings for IDR Interval are 60, 120, 
180, 240, or 300. 

In full HD mode, settings for IDR intervals are effectively doubled: 64, 128, 
192, 256, 320... 640)

160 frames

3D MCTF 
noise 
reduction

When checked, enables motion compensated temporal filtering (MCTF). Read-only

Regular IDR 
Intervals

Enable (check) or disable IDR frames to occur at regular intervals. Checked

Table 108. Grooming - Configure MBR Program Mapping, Output Programs settings  (Continued)

Field Description Default
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Table 110. Grooming - Configure MBR Program Mapping, Audio settings  

Field Description Default

Audio Codec Defines the codec for the output audio. Choose one of the following 
options:

• For non-Dolby:
HE AAC, HE AAC v2, AAC-LC, MPEG1 L2, MPEG2 L2, AC-3

• For Dolby (These options activate the Advanced button)
E-AC-3 (Dolby Digital Plus),

AAC-LC

Sample Rate Set value, in kHz, to define number of audio samples per second. The 
higher the number, the better the sound quality. Choose one of the 
following options:

• 8 kHz, 11.03 kHz, 12 kHz, 16 kHz, 22.05 kHz, 24 kHz, 32 kHz, 44.1 kHz, 
48 kHz

See 
Table 123, 
“Audio Bitrates 
and Sampling 
Rates,” on 
page 306.

Channels Defines the number of output channels per audio stream. Choose one of 
the following options:

• mono, stereo, 5.1 surround

stereo

Audio Bitrate Defines the bitrate for all audio streams within the MBR TS. The selectable 
values depend on your selection of Audio Codec, Sample Rate, and 
Channels.

See 
Table 123, 
“Audio Bitrates 
and Sampling 
Rates,” on 
page 306.

Audio Gain Defines the gain on an audio stream level. Audio Gain is applied to all 
audio streams within the MBR TS. If the input program has two or more 
audio PIDs, all audio outputs will have the same gain. 

• Audio Gain ranges from -24 dB to +24 dB and is selectable in 1 dB 
increments.

Note: An Audio Gain of 0 means no gain.

no Gain

Advanced 
Button

This button is enabled only if the currently selected Audio Code is one of 
the Dolby codec options. 

When enabled, click to access encoder configuration parameters 
associated with the resolution and codec settings currently in place at the 
MBR Program Mapping screen. 

See also 
Chapter 13, 
“Advanced 
Audio Encoder 
Configuration.”

Table 111. Grooming - Configure MBR Program Mapping, Component PID settings  

Field Description Default

Audio Pass-
Through

This is selectable only if Create MBR Group ID is checked (in the General 
section of this screen). Other fields associated with audio pass-through—
SCTE Video and/or AC-3 audio eng—are also selectable if pass-through is 
enabled. 

Select either None or AC-3. 

None
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Managing MBR Transport Streams and Programs

Use the Grooming tab of the VMG Element Manager screen for management of MBR transport 
streams and programs.

Modifying an MBR Transport Stream

Use the Modify MBR Transport Stream screen (Figure 156) to change settings for a specific MBR 
transport stream. 

Caution: Modifying an MBR TS will disrupt program output from the VMG for a few seconds. The 
actual duration of the disruption at the set top box end might be several seconds.

From the Outputs panel of the Grooming -> Mapping tab page, right-click the MBR TS to be 
modified, and select Modify MBR Transport Stream from the popup menu.

Max Audio Set value to define the maximum allowable audio elementary streams to 
be handled in the output. Note that this setting affects bitrate allowances 
on the stream. 

See “Bitrate 
Configuration 
Reference” on 
page 310 for 
comparative 
values.

Max Data Set value to define the maximum allowable data elementary streams to be 
handled in the output. Note that this setting affects bitrate allowances on 
the stream. 

Start PID This field is displayed in the Program Mapping screen when AC-3 is 
selected for Pass-through. 

Type the PID value to be associated with AC-3. 

Range: 32 - 8175.

Groom Check this box to include the corresponding elementary stream in the 
output program.

Checked

Input Type Displays the input elementary stream types for the input program.

This information is available if an MBR group has been defined or 
modified. 

Read-only

Input PID Displays the Input Type’s associated PID for the input program. Read-only

TS Index X 
PID

The X refers to the TS Index for the SPTS within this MBR TS. Here you 
can set the output PIDs for each SPTS.

Output PID

Table 111. Grooming - Configure MBR Program Mapping, Component PID settings  (Continued)

Field Description Default
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Figure 156. Modify MBR Transport Stream

1. At the Modify MBR Transport Stream screen, enter changes in the editable fields.

For both MBR transport streams, the name, IP address, and UDP port of each SPTS can be 
modified (see Table 105 on page 228 for information on these parameters).

2. Click one of the buttons:

- If the Apply button is green, you can click Apply to save and use changes shown in the screen. 
If the Apply button is grey, click Grooming to go to the Modify MBR Program Mapping 
screen. 

At the Modify MBR Program Mapping screen, check and/or modify settings on this screen, 
then click Accept to return to the Modify MBR Transport Stream screen (on which the 
Apply button should now be green). 

- Click Cancel to abort this MBR modification session. 

Resetting Grooming—MBR

Use the Reset Grooming option (Figure 157) on an output transport stream to tear down a current 
configuration and rebuild the transport stream with the identical configuration. 
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Figure 157. Reset Grooming—MBR

Note: This option interrupts service during the tear down and rebuild process. When selected, a 
confirmation query will be presented prior to beginning the reset process on the selected 
transport stream. 

Regrooming—MBR

To regroom an MBR ts, drag an input program to an MBR output transport stream that has already 
been groomed. This action rebuilds the MBR grooming at the selected output TS, with the new input 
program, using the identical configuration on the output program and output elementary streams. 

Prior to dynamically grooming the targeted output transport stream, the VMG Element Manager 
queries for confirmation of the configuration, to ensure that the input configuration matches that of the 
output configuration. The Confirmation dialog (Figure 158) also reminds you that regrooming 
interrupts service. 

Figure 158. Reset Groom Confirmation—MBR

Clicking Yes results in display of the MBR Program Mapping screen, where you can apply and/or 
verify settings for this transport stream. 
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• If the MBR group contains more than one MBR transport stream, you will be guided to the MBR 
Program Mapping screen associated with the first MBR transport stream of the MBR group. 

• If you apply changes to the MBR transport stream program mapping, then (as depending on the 
changes you make) you may also need to make changes to the remaining MBR transport streams 
in the group. 

Upon completion of the regrooming process, you can view the results in a Modify <TS type> 
Program Mapping screen. 

Deleting an MBR Transport Stream

Use the Delete MBR Transport Stream function to remove an MBR transport stream from a 
specified interface. 

From the Outputs panel of the Grooming -> Mapping tab page, right-click an MBR TS and select 
Delete MBR Transport Stream from the popup menu.

1. At the Delete Confirmation dialog (Figure 159), click Yes.

Figure 159. Delete MBR Transport Stream

2. At the Outputs panel, check to ensure that the deleted MBR TS is no longer displayed.

Modifying MBR Grooming

Use the Modify MBR Program Mapping screen (Figure 160) to adjust grooming parameters for a 
specified MBR program. 

From the Outputs panel of the Grooming -> Mapping tab page, right-click an MBR TS and select 
Modify MBR Grooming from the popup menu.
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Figure 160. Modify MBR Program Mapping (SDT Enabled)

The configuration fields provided in this screen are identical to those originally configuration for this 
MBR program mapping. 

• To change MBR parameters in this screen, use guidelines provided in Table 107 on page 234. 

• Values and resolution combinations associated with the resolution classes are provided in 
“Resolution Configuration Reference” on page 309.
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Deleting MBR Grooming

Use the Delete MBR Grooming function to remove grooming from a specified MBR TS. 

1. From the Outputs panel of the Grooming -> Mapping tab page, right-click the MBR TS and 
select Delete MBR Grooming from the popup menu (see Figure 156 on page 239).

2. At the Delete Confirmation dialog (Figure 161), click Yes.

Figure 161. Delete MBR Grooming

Viewing MBR Grooming Source

To view the grooming source for an MBR program:

1. From the Outputs panel of the Grooming -> Mapping tab page, right-click an MBR TS carrying 
the program, and select View MBR Grooming Source from the popup menu.

2. Look at the highlighted row now displayed in the Inputs column (Figure 162). This is the source 
input program associated with the selected MBR TS output.

Figure 162. View MBR Grooming Source

Program Grooming Source is Highlighted at the 
Inputs panel. 
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Modifying MBR Program

Note: For MBR programs, Modify Program, Delete Program, Manage Elementary Streams, View 
Grooming Source, and Display Grooming menu options are not available. (Figure 163).

Figure 163. MBR Program Popup Menu
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Advanced Grooming Applications

This chapter describes the use of the VMG Element Manager to perform advanced grooming 
applications. The Grooming -> Mapping tab provides program and transport stream (TS) 
information.

Additionally, audio codec configuration tools you can use with MBR Program Mapping are also 
described in this chapter. 

Note: System configuration must be completed before performing grooming tasks. Refer to 
Chapter 4, “System Configuration” for more information.

In This Chapter:

• “Advanced Audio Encoder Configuration,” next.

• “Program Redundancy” on page 253.

• “Elementary Stream/PID Management” on page 258.
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Advanced Audio Encoder Configuration

Configuration parameters for Dolby Codec are provided from the MBR Program Mapping screen, as 
based on your selection for audio encoding:

• “AC-3 Encode Configuration,” next.

• “E-AC-3 (Dolby Digital Plus) Encode Configuration” on page 249.

AC-3 Encode Configuration

The AC-3 audio encoding configurations for MBR Program Mapping are described in the following 
topics:

• “AC-3 Channel—5.1 Surround,” next.

• “AC-3 Channel—Mono” on page 247.

• “AC-3 Channel—Stereo” on page 248.

AC-3 Channel—5.1 Surround 

To configure an AC-3 audio codec with 5.1 Surround encoding in an MBR program groom, use the 
Advanced Parameters: AC-3-CH_5_1 Encode dialog (Figure 164).

Drag input program to output MBR transport stream -> at Configure MBR Program Mapping 
screen, select AC-3 at Audio Codec field, and 5.1 Surround at Channels field -> click Advanced 
button. 

Figure 164. AC-3 (5.1 Surround Channel) Configuration

See Table 112, “Advanced Audio Encoder Settings,” on page 252 for available options and default 
values. 
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AC-3 Channel—Mono

To configure an AC-3 audio codec with Mono encoding in an MBR program groom, use the 
Advanced Parameters: AC-3-MONO Encoder dialog (Figure 165).

Drag input program to output MBR transport stream -> at Configure MBR Program Mapping 
screen, select AC-3 at Audio Codec field, and Mono at Channels field -> click Advanced button. 

Figure 165. AC-3 (Mono Channel) Configuration

See Table 112, “Advanced Audio Encoder Settings,” on page 252 for available options and default 
values. 
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AC-3 Channel—Stereo

To configure an AC-3 audio codec with Stereo encoding in an MBR program groom, use the 
Advanced Parameters: AC-3-STEREO Encoder dialog (Figure 166).

Drag input program to output MBR transport stream -> at Configure MBR Program Mapping 
screen, select AC-3 at Audio Codec field, and Stereo at Channels field -> click Advanced button. 

Figure 166. AC-3 (Stereo Channel) Configuration

See Table 112, “Advanced Audio Encoder Settings,” on page 252 for available options and default 
values. 
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E-AC-3 (Dolby Digital Plus) Encode Configuration

The E-AC-3 (Dolby Digital Plus) audio encoding configurations for MBR Program Mapping are 
described in the following topics:

• “E-AC-3 (Dolby Digital Plus) Channel—5.1 Surround,” next.

• “E-AC-3 (Dolby Digital Plus) Channel—Mono” on page 250.

• “E-AC-3 (Dolby Digital Plus) Channel—Stereo” on page 251.

E-AC-3 (Dolby Digital Plus) Channel—5.1 Surround

To configure an E-AC-3 (Dolby Digital Plus) audio codec with 5.1 Surround encoding in an MBR 
program groom, use the Advanced Parameters: AC-3-CH_5_1 Encoder dialog (Figure 167).

Drag input program to output MBR transport stream -> at Configure MBR Program Mapping 
screen, select AC-3 at Audio Codec field, and 5.1 Surround at Channels field -> click Advanced 
button.

Figure 167. E-AC-3 (Dolby Digital Plus) (5.1 Surround Channel) Configuration

See Table 112, “Advanced Audio Encoder Settings,” on page 252 for available options and default 
values. 
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E-AC-3 (Dolby Digital Plus) Channel—Mono

To configure an E-AC-3 (Dolby Digital Plus) audio codec with Mono encoding in an MBR program 
groom, use the Advanced Parameters: AC-3-MONO Encoder dialog (Figure 168).

Drag input program to output MBR transport stream -> at Configure MBR Program Mapping 
screen, select AC-3 at Audio Codec field, and Mono at Channels field -> click Advanced button.

See Table 112, “Advanced Audio Encoder Settings,” on page 252 for available options and default 
values. 

Figure 168. E-AC-3 (Dolby Digital Plus) (Mono Channel) Configuration
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E-AC-3 (Dolby Digital Plus) Channel—Stereo

To configure an E-AC-3 (Dolby Digital Plus) audio codec with Stereo encoding in an MBR program 
groom, use the Advanced Parameters: AC-3-STEREO Encoder dialog (Figure 169).

Drag input program to output MBR transport stream -> at Configure MBR Program Mapping 
screen, select AC-3 at Audio Codec field, and Stereo at Channels field -> click Advanced button.

See Table 112, “Advanced Audio Encoder Settings,” on page 252 for available options and default 
values. 

Figure 169. E-AC-3 (Dolby Digital Plus) (Stereo Channel) Configuration
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Table 112. Advanced Audio Encoder Settings

Field Description Default

Bitstream mode

• For AC-3 and/or E-AC-3 
(Dolby Digital Plus).

Applicable to mono, stereo, and 5.1 surround channels.

Select an option:

• 0 - main audio service: complete main (CM)

• 1 - main audio service: music and effects (ME)

• 2 - associated audio service: visually impaired (VI)

• 3 - associated audio service: hearing impaired (HI)

• 4 - associated audio service: dialogue (D)

• 5 - associated audio service: commentary (C)

• 6 - associated audio service: emergency (E)

• 7 - associated audio service: voice over (VO)

0

Dialog normalization

• For any audio codec type.

Applicable to mono, stereo, and 5.1 surround.

• Select a value from the range 0 dB (passthrough) and -1 dB 
(loudest) to -31 dB (least loud). 

27

DRC Line mode profile 

• For AC-3 and/or E-AC-3 
(Dolby Digital Plus).

Applicable to mono, stereo, and 5.1 surround 

Select an option:

• 0 - No compression

• 1 - Film standard compression

• 2 - Film light compression

• 3 - Music standard compression

• 4 - Music light compression

• 5 - Speech compression

1

DRC RF mode profile

• For AC-3 and/or E-AC-3 
(Dolby Digital Plus).

Applicable to mono, stereo, and 5.1 surround.

Select an option:

• 0 - No compression

• 1 - Film standard compression

• 2 - Film light compression

• 3 - Music standard compression

• 4 - Music light compression

• 5 - Speech compression

1

DRC Line mode profile 2

• For AC-3 and/or E-AC-3 
(Dolby Digital Plus). 

Applicable to mono, stereo, and 5.1 surround.

Select an option:

• 0 - No compression

• 1 - Film standard compression

• 2 - Film light compression

• 3 - Music standard compression

• 4 - Music light compression

• 5 - Speech compression

1
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Program Redundancy

The VMG supports per-input program redundancy. In a program redundancy configuration, a switch to 
backup occurs when:

• Missing MPTS/SPTS streams are identified by checking the PAT.

• Missing program streams are identified by checking the PMT.

The VMG allows you to designate any input service as a “standby program” with the exception of the 
same service. The VMG returns back to the primary program from the standby program when the 
primary program recovers from the interruption. 

The backup program can be another program on the same GigE port or it can be on a different GigE 
port in the same chassis, as long as the ports are in the same grooming group. 

The health of the standby program will be checked before failover, and the VMG will not perform the 
switch if the standby is degraded.

DRC RF mode profile 2

• For AC-3 and/or E-AC-3 
(Dolby Digital Plus). 

Applicable to mono, stereo, and 5.1 surround.

Select an option:

• 0 - No compression

• 1 - Film standard compression

• 2 - Film light compression

• 3 - Music standard compression

• 4 - Music light compression

• 5 - Speech compression

1

LFE enabled

• For AC-3 and/or E-AC-3 
(Dolby Digital Plus). 

Applicable for 5.1 surround configuration only:

• Select either ON or OFF. 

Default=

• Off, non 3/2 mode

• On, 3/2 mode

Depends on 
3/2 mode.

Surround phase shift enabled

• For any audio codec type.

Applicable for 5.1 surround configuration only, to disable or enable 
90-degree phase shift to surround channels.

• Select either ON or OFF. 

OFF

Surround attenuation enabled

• For any audio codec type.

Applicable for 5.1 surround configuration only, to disable or enable 3 
dB attenuation to surround channels.

• Select either ON or OFF.

OFF

Table 112. Advanced Audio Encoder Settings

Field Description Default
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Program Redundancy Best Practices and Considerations

The following considerations should be taken into account when configuring input program 
redundancy.

• Input-level program redundancy can be modified as long as there are no grooming sessions 
associated with the input program.

• The primary and backup video types must be the same. For example, an H.264 program cannot be 
used to backup an MPEG-2 program and vice versa.

• Both primary and backup programs must be in the same grooming group. For example, a primary 
program in the 8x1 GigE grooming group may not use as its backup a program from the 1x10 
GigE grooming group.

• NPM switchover has the same effect as a system reboot on program redundancy; if the backup 
program has been used as an input source for a grooming session, the backup will revert back to 
primary after an NPM switchover.

• Program redundancy is not applicable for ghost programs. A ghost program cannot be used as a 
backup program, and a backup program cannot be configured for a ghost program. 

Program Redundancy Operation Modes

The VMG supports two Program Redundancy modes (Table 113):

• Automatic recovery from the backup program to the primary program.

• Manual selection when the recovery process should occur.

Configuring Program Redundancy

You can configure program redundancy on a per-input program level basis. Groomed programs using 
channel substitution will be fully redundant.

Note: When configuring redundancy at the input level, the selected program must not yet be groomed 
to an output.

Use the Input Program Redundancy Configuration screen (Figure 170) to set define program 
redundancy settings. 

From the Inputs panel of the Grooming -> Mapping tab page, right-click on the program to back up, 
and select Config Program Redundancy from the popup menu. 

Table 113. Program Redundancy Modes of Operation

Category  Primary to Backup Backup to Primary

Automatic Failover to 
Backup Program / 
Automatic Recovery to 
Primary Program

Automatic failover operation is 
based on detection of a missing 
PAT/PMT (after approximately 7 
seconds).

Automatic recovery operation is based on 
PAT/PMT detection (after approximately 7 
seconds).

Automatic Failover to 
Backup Program / Manual 
Recovery to Primary 
Program

Automatic failover operation is 
based on detection of a missing 
PAT/PMT (after approximately 7 
seconds).

Manual recovery operation is based on 
the user selecting when a single program 
or all programs should be recovered to 
their respective primary programs.
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Figure 170. Input Program Redundancy Configuration screen

1. At the Input Program Redundancy Configuration screen, enable (check) Specified Program 
Backup (at top of screen).

2. Locate and select the program that is to be the backup for the input program.

3. At Selected Program Redundancy Mode, click to select either Automatic Failover / Automatic 
Recovery or Automatic Failover / Manual Recovery.

Figure 170 shows an example of program redundancy in which the backup is selected as GigE 5, 
Transport Stream ID 0, Program Number 0, and Program Name of Backup_Program1.

4. Click Apply to create the redundancy configuration.

After you configure redundancy for a program, the Grooming -> Mapping tab page shows that 
redundancy has been configured for the program and whether the primary program is active 
(Figure 171) or the backup program is active (Figure 172).

Figure 171. Program Redundancy Indicator — Primary Programs Active

“P” indicates the primary 
program is active.
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Figure 172. Program Redundancy Indicator — Backup Programs Active

Modifying Input-level Program Redundancy

Use the following steps to change the program used for backup, or to change the redundancy mode: 

1. Repeat the steps from “Configuring Program Redundancy” on page 254, and select a different 
backup program and/or change the Selected Program Redundancy Mode.

2. Click Apply at the Input Program Redundancy Configuration screen when you have 
completed your configuration. 

Deleting Input-level Program Redundancy

Use the following steps to remove a program redundancy setting:

1. Open the Input Program Redundancy Configuration screen.

2. Deselect the Specified Program Backup option.

3. Click Apply.

Manual Recovery Procedure

If you configure program redundancy for a program to have manual recovery, you must manually 
switch from the backup input program to the primary input program after the primary input program is 
restored. 

Recovering Individual Programs

Use the following steps to perform a manual recovery for program redundancy operation on individual 
programs: 

1. From the Inputs panel of the Grooming -> Mapping tab page, right-click the primary program 
for which the backup program is still active and select Switch Backup to Primary Program from 
the popup menu (Figure 173). 

“B” indicates the backup 
program is active.
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Figure 173. Program Redundancy - Manual Recovery

2. At the confirmation dialog (Figure 174), click Yes. 

Figure 174. Switch Input Program Redundancy Confirmation

Recovering All Programs

Use the following steps to perform a manual recovery for program redundancy operation on all 
programs: 

1. From the VMG Element Manager main menu, select Maintenance -> Program Redundancy 
Switch to Primary.

2. At the Regroom confirmation dialog (Figure 175), click Apply.

Figure 175. Confirm Recovery of All Programs

Backup program is still active.
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Elementary Stream/PID Management

The VMG provides the ability to manage input and output elementary streams for purposes of PID 
management. You can create new elementary streams, reorder existing streams, create unreferenced 
PIDs, and perform referenced and unreferenced PID mapping. The following sections provide 
instructions on elementary stream management.

Creating an Output Elementary Stream

Use the Manage Element Streams screen (Figure 176) to add a new elementary stream to a standard 
output program. The streams displayed in this screen will vary, as associated with the contents for the 
selected program.

From the Outputs panel of the Grooming -> Mapping tab page, right-click on the program to which 
you want to add an elementary stream and right, and select Manage Elementary Streams from the 
popup menu. 

Figure 176. Manage Elementary Streams

1. At the Manage Elementary Streams screen, click Add ES. 

A new elementary stream entry will now display below the last stream. 

By default, the new stream is an AC-3 Audio stream. See Figure 177 for an example.

Note: The ES Type, Stream Type, and PID fields in the Manage Elementary Streams screen can 
only be modified when the word “New” appears next to the entry in the Stream Order column. 
Once you click Apply to save changes, you will not be able to modify any of these parameters 
for this particular stream without deleting the stream and adding it again.
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Figure 177. Manage Elementary Stream - New

2. Modify the ES Type, Stream Type, and PID by clicking or double-clicking on each field under 
the respective column. (See Table 114 for details.)

For ES Type, a drop down box will be displayed with applicable choices:

Figure 178. Elementary Stream Types

For Stream Type, depending on the ES Type, either a drop down box will appear with applicable 
choices (Figure 179), or the Audio Selection screen is presented (Figure 180):

Figure 179. Stream Types

Stream Order must
display New” in 
order to modify the
stream.
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Figure 180. Audio Selection Screen for Elementary Streams

For the PID column, double-clicking the field will render it editable and you can type in the new 
PID:

Figure 181. Manage Elementary Stream - PID

3. Click Apply when you are done modifying the elementary stream to save all changes. The new 
stream will be displayed in the Outputs panel of the Grooming -> Mapping tab page.

Table 114 provides a description of the fields from the Manage Elementary Stream menu.

Table 114. Manage Elementary Streams menu 

Field Description

Stream Order Read-only. Displays the order of the stream in the program mapping table 
(PMT).

Grooming Status Read-only. Displays whether or not the stream is currently groomed.

ES Type Read-only if changes have been saved (i.e., Apply has been clicked).

If the changes to the stream have not yet been applied, clicking this field will 
open a drop down menu with the following options from which to choose:

Audio, Data, or Video.

Edit PID field.
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Reordering an Output Elementary Stream

You can reorder an elementary stream to change the order of the stream in the PMT. (If, for example, 
you wish to change the order a stream is placed in the PMT when sent to the end-user’s STB.)

1. Highlight the stream you want to reorder (Figure 182).

Figure 182. Reordering an Elementary Stream

Stream Type Read-only if changes have been saved (i.e., Apply has been clicked).

If the changes to the stream have not yet been applied, and depending on 
the selection from ES Type, clicking this field will open various options:

• For Audio Stream Type: Set an audio code type and language from the 
Audio Selection screen. Audio code options are MPEG-1 Audio, MPEG-
2 Audio, AC-3 Audio (0x6), AC-3 Audio (0x81), AAC Audio (0x0f), HE-
AAC Audio (0x11). Currently supported languages are listed in “Audio 
input elementary stream language options” on page 313.

• For Data Stream Type: Set a value from the selection range (5 to 255) with 
6 as either Teletext or Subtitle. 

• For Video Stream Type: Select either MPEG2, H.264, or SCTE.

PID Read-only if changes have been saved (i.e., Apply has been clicked).

If the changes to the stream have not yet been applied, double-clicking this 
field allows you to modify the PID associated with the new elementary 
stream.

Reserved Read-only. If the stream is a reserved PID, Yes will appear; if the stream is 
not a reserved PID, nothing will appear in this column.

• Anytime an elementary stream is manually created as described in 
“Creating an Output Elementary Stream,” above, the PID will automatically 
be Reserved. For more information on Reserved PIDs, see “Reserved 
PIDs” on page 264.

Table 114. Manage Elementary Streams menu (Continued)

Field Description
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2. Click Up or Down as required to put the stream in its desired place.

3. When you are done, click Apply.

Creating an Input Elementary Stream

To create an Input Elementary Stream, you must first create a ghost program within the desired input 
transport stream. Once the ghost program has been created, the Add Elementary Stream option from 
the popup menu will become selectable. For details on creating ghost programs, refer to “Creating 
Ghost Programs” on page 132. For details on creating input elementary streams, follow the steps in the 
section, “Adding an Unreferenced PID as an Elementary Stream” on page 262.

Elementary Stream Remapping

You can create a reserved PID or select any specific PID from existing output PIDs, while performing 
grooming in the Configure Program Mapping screen, as an outgoing PID.

You have the flexibility of selecting any PID value for an outgoing PID. When you select from an 
existing PID then it should be of the same ES Type and language (for audio) as the corresponding 
Input ES. If there is no exact match then you cannot select that existing output PID.

You cannot create a Reserved PID for Video if there is an existing video PID in the output program on 
which you are grooming.

Adding an Unreferenced PID as an Elementary Stream

You can add an unreferenced PID to an input transport stream. This allows you to manage 
unreferenced PID inputs for various applications in the VMG output. Unreferenced PID streams are 
MPEG-2 elementary streams that are encapsulated in the MPEG-2 SPTS or MPTS whose PIDs are not 
referenced in any PSI (PAT and PMT) tables. These unreferenced PID streams may be purposely 
inserted for some special control and applications; they could also result from the stream originator's 
error. 

Unreferenced PIDs can come from the program inputs from GigE or 10xGigE interfaces. In some 
applications, these unreferenced PIDs need to be routed to the appropriate output ports as pass-
through, or with or without the PIDs being remapped. In other cases, these unreferenced PIDs need to 
be dropped, either because such unreferenced PIDs are not needed or the streams are corrupted. 

To add an unreferenced PID as an Elementary Stream:

1. From the Inputs panel of the Grooming -> Mapping subtab, select to ghost program to which 
you want to add an unreferenced PID.

2. Right-click the Ghost Program, and choose Add Elementary Stream (Figure 183).
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Figure 183. Add Elementary Stream popup menu

Figure 184. Add Elementary Stream screen

3. From the pull-down menus, select the Stream Category, Stream Type, and PID.

Table 115 describes the options available from the Inputs panel of the Add Elementary Stream 
screen:

4. Click Apply. The new PID appears (Figure 185).

Table 115. Input Add Elementary Stream screen

Field Description Default

TS Name of the selected transport stream Read-only

Program Name of the selected program Read-only

Stream Category Clicking this field will open a drop down menu 
with the following options from which to 
choose:

Audio, Data, or Video.

Audio

Stream Typea

a. Stream Type Video is not supported when creating an Elementary Stream for a ghost program.

Depending on the selection from Stream Type, 
clicking this field will open various options:

• If Stream Type is Audio -- A new screen will 
open allowing you to choose Audio Type of: 
MPEG1, MPEG2, AC-3 (0x6) or AC-3 
(0x81), or AAC (0x0f).

• If Stream Type is Data -> A drop down box 
will appear with a type range from 5 to 255. 

MPEG1 Audio

PID (32...8175) Type a PID value for this ES.

Range = 32 - 8175

Blank
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Figure 185. New Unreferenced PID

Reserved PIDs

Reserved PIDs allow you to create PIDs under output programs which will maintain PID values and 
ES Type and Subtype across reboots and regrooming even when the PID is not groomed. These types 
of output elementary streams are called reserved PIDs. An example of when it is useful to reserve PIDs 
would be a set top box expecting to receive a specific PID. 

The Manage Elementary Streams screen can be used to add the ES and to specify its PID and 
subtype, as well as the language for the audio ES. The subtype of the reserved video stream will be 
overwritten by the input Video Subtype but the PID value will be maintained. You can delete any 
reserved ES if it is not groomed from the Grooming -> Mapping screen by right-clicking the ES, and 
choosing Delete.

Note: When specifying PID values from the Outputs panel of the Grooming -> Mapping screen, the 
values must be unique.

There are two ways to create reserved PIDs: via output elementary stream creation or via grooming.

Reserved PIDs via Output ES Creation

To create a reserved PID via output ES:

Create a new output elementary stream as described in the section, “Creating an Output Elementary 
Stream” on page 258.

Ensure that the PID value is unique to the transport stream for the program under which you are 
creating the new elementary stream. 

Reserved PIDs via Grooming

To create a reserved PID via grooming:

1. Use the drag-and-drop grooming feature as described in “Using Drag-and-Drop to Create Output 
Programs” on page 170 to drag an input program to an output transport stream.

The Configure Program Mapping tab page (Figure 195) for the selected stream type is 
presented.
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Figure 186. Configure Program Mapping - Reserved PID

2. Bring up the Add Elementary Stream dialog by using either of the following actions from the 
Component PIDs section:

- Go to the Action column and click Enter PID in the row containing the PID to be changed.

or

- Click in the blank space in the Output Type column or the PID column. 

3. At the Add Elementary Stream dialog, type a PID value from 32 to 8175 that will be reserved for 
this stream.

4. Click Apply.

The new reserved PID is now displayed in the Component PIDs portion of the Configure 
Program Mapping tab page (Figure 187).

Figure 187. Configure Program Mapping - New PID value
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5. Click Apply Configuration to groom the new program with reserved PID.

The Grooming -> Mapping tab page will look similar to that shown in Figure 188.

Figure 188. Grooming -> Mapping tab page- Reserved PID 

Reserved PID 
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Elementary Stream Ghost PID Management

Ghost Programs and PIDs are extra input and output streams not referenced in a Program Association 
Table (PAT). The VMG allows you to manage elementary stream (ES) Ghost PIDs in three ways:

• Unreferenced PID Pass Through. The PID output is unreferenced in the Program Mapping Table 
(PMT) and there is no mapping to any other program or transport stream table. Typical 
applications are Data PID transport and grooming.

• Unreferenced PID Mapping. This has no reference in the PMT, but is mapped as a table entry in 
the PAT at the transport stream level. This is used in various EPG applications.

• Referenced PID Mapping. The PID output is referenced as a PMT entry. A typical application 
might be to associate electronic program guide (EPG) data with one or more programs. 

Unreferenced PIDs streams are those MPEG-2 streams encapsulated in the MPEG-2 SPTS or MPTS 
but their PIDs are not referenced in any PSI (PAT and PMT) tables. These unreferenced PID streams 
may be purposely inserted for some special control and applications; they could also result from the 
stream originator's error. 

Unreferenced PIDs can come from the program inputs from GigE or 10GigE interfaces. In some 
applications, these unreferenced PIDs need to be routed to the appropriate output GigE ports as pass-
through without or with PIDs remapping. In other cases, these unreferenced PIDs need to be dropped, 
either because such unreferenced PIDs are not needed or the streams are corrupted.

The VMG allows you to add and drop the unreferenced PIDs in its inputs from both GigE and 10GigE 
ports.

The VMG can groom the unreferenced PIDs from the inputs to the appropriate output transport stream 
(SPTS or MPTS) with or without PID remapping using the GUI configuration for the unreferenced 
PIDs.

Unreferenced PIDs associated with program inputs are usually known in advance, so they can be 
configured through the GUI for pass-through or drop. The GUI enables the user-configurable 
remapping as an output PID for the input unreferenced PID; the output PID can also be referenced in 
the output TS when necessary through GUI configuration. 

User-configured unreferenced PID streams are routed based on grooming and grooming group rules.

The VMG ensures there are no conflicts between unreferenced PIDs and the referenced PIDs in its 
output MPTS or SPTS. If there are unreferenced PIDs causing conflict in the output MPTS or SPTS, 
then the groomed unreferenced PID causing the conflict is dropped. This could happen when an 
unreferenced PID is not allowed to be remapped for output.
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Unreferenced PID Pass Through

To add an unreferenced PID:

1. Start by creating a ghost program as described in “Creating Ghost Programs” on page 132. See 
Figure 189.

Figure 189. Ghost Programs With Unreferenced PID.

2. Map the unreferenced PID to an output by dragging and dropping the ghost program from the 
input GigE port to the output transport stream. 

The Configure Mapping screen appears (Figure 190).

Figure 190. Ghost Program Dragged and Dropped to Output TS

3. Note the PID number of the component PID, in this case 117. You will need this when you want to 
create a referenced PID mapping.

4. Be sure that the Stay Unreferenced box is checked, and click Apply Configuration.

The ghost program and its data transport stream with a PID of 117 appears on both the input and output 
(Figure 191) showing the stream has been passed through.
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Figure 191. Ghost Program Passed Through

Unreferenced PID Mapping

1. Start with a screen, as shown in Figure 192.

Figure 192. Starting Unreferenced PID Mapping

2. Drag the Ghost Program from the input of Figure 192 and drop it on the transport stream you just 
created. The Configure Program Mapping screen (Figure 193) now appears.
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Figure 193. Configure Program Mapping screen - Unreferenced

3. Be sure that the Stay Unreferenced box is checked.

4. In the Component PIDs portion of the screen, click the empty space to the right of the row of the 
stream. The Add Elementary Stream screen of Figure 194 appears.

Figure 194. Add Elementary Stream screen

5. Enter the new reserved PID number, (in this case, 118, the same PID number as shown in 
Figure 193) and click Apply. 

6. Click Apply Configuration in the Configure Program Mapping screen. The unreferenced PID 
is mapped.
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Referenced PID Mapping

Input Ghost ES PIDs can be groomed by the VMG and referenced as ES PIDs in a program in the 
output TS as long as the PID value is unique within the output TS. 

Figure 195 shows the starting screen with the unreferenced PID input mapped into a Ghost Program on 
the input.

Figure 195. Starting screen for Referenced PID Mapping

To map a referenced PID to a program:

1. Drag the Ghost Program from the input of Figure 195 and drop it on the transport stream. The 
Configure Program Mapping screen (Figure 196) appears.

Figure 196. Mapping the Referenced PID

2. Be sure that the Stay Unreferenced box is un-checked.

3. Click Apply Configuration. The Mapping tab page (Figure ) shows the mapped PID in both 
programs from the input and the output.
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Mapped Referenced PID
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CHAPTER 14

Module Redundancy

This chapter discusses the redundancy features offered by the VMG Network Processor Module 
(NPM), Video Processor Module (VPM), and the Transcoding Module (TCM).

In This Chapter:

• “NPM Status and Health,” next.

• “NPM Redundancy” on page 274.

• “VPM and TCM Status and Health” on page 275.

• “VPM and TCM Redundancy” on page 276.

• “AMP Status and Health” on page 278.

• “AMP Redundancy” on page 278.

NPM Status and Health

The LEDs on the front panel of the NPM card indicate its current status and health. This information is 
also displayed in the chassis view of the VMG Element Manager. Refer to “Chassis Tab” on page 25 
for details. Table 116 describes the NPM front panel LEDs.

Table 116. NPM Front Panel LED Description 

LED Name Color/Condition Description

Hot Swap Blue NPM is not ready for hot-swap

Flashing Blue Transition between the hot-swap not ready state to ready state, 
and ready state to not ready state.

Off NPM is ready for hot-swap

Chassis Status Red Chassis interface fault

Green NPM payload powered and out of reset

FPGA Config Red FPGA configuration in progress

Green FPGA configuration is done

Fault Red Fault

Green In normal operation

Backup Red Standby

Green In operation
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NPM Redundancy

In order to take advantage of the VMG’s redundancy features, two NPMs must be installed and 
properly configured as well as a virtual IP address assigned to the VMG system. The NPM provides 
video and data service filtering/switching/routing to and from all other cards in the chassis, and 
supports 1:1 card redundancy. In this redundancy configuration, one NPM is designated as the primary 
(active) card and the other NPM as the backup (standby) card. During normal use, the standby NPM is 
in warm-standby mode and ready to become active if either the active NPM encounters a failure or a 
user initiates a manual switchover. In warm-standby redundancy mode all traffic flows simultaneously 
into both NPMs in the chassis; however, only the active NPM is processing the data.

High Availability

During system boot, if two NPMs are available they negotiate their roles within the redundant system. 
One becomes active and the other goes into standby mode. The criteria used to determine this are:

• Configuration database validity.

• Health of NPM software and hardware.

• The cards’ previous active/standby role.

• The cards’ physical location within the VMG chassis.

After the active NPM is determined, applications on that card take control of the system and start 
configuring the hardware based on its persistent configuration data. The active NPM takes control over 
all network interfaces for video streams, and its physical Ethernet interface becomes active.

The switch between active and standby roles in an NPM redundancy environment is seamless.

The standby NPM continues to keep in sync with the persistent data storage controlled by the active 
database.

Fast Failover Switch

The NPM Fast Failover switch mechanism allows for seamless transition in the event of a redundancy 
switch. When a card failure or user initiated switch-over occurs, the standby NPM will detect the 
failure using a missed heartbeat mechanism. The standby NPM will claim all the MUXs from the 
failed NPM while the MUX software automatically re-initializes itself and wipes out configuration 
from the failed NPM. 

System Failure

Certain system failure conditions exist that trigger a failover. Some active NPM failure conditions are: 

• An unplanned reset of the active NPM.

• Removal of the active NPM:

- Partial card removal using the ejector handles (allowing the hot-swap procedure to complete).

- Abrupt card removal (without allowing the hot-swap procedure to complete).

Note: For more information about the NPM ejector handles, refer to Chapter 3, Physical 
Installation, Inserting Modules section, in the VMG Hardware Setup Guide.
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User-Initiated

When a user-initiated switch-over occurs, all applications on the active NPM are asked to free their 
resources. This action triggers checkpoints to sync the persistent configuration from the active 
database to the standby database. Once the user initiated switch-over is accepted, configuration 
changes are no longer allowed and are not saved.

After the flushing procedure is complete, the active NPM relinquishes control of the system and 
reboots, allowing the standby NPM to take control and go into an active state. All video streams, client 
connections (GUI, etc.), and connections with ad servers will temporarily go down during the 
transition.

Refer to “NPM Redundancy Switch” on page 106 for more information on user initiated switch over.

Configuring NPM Redundancy

1. Make sure the same physical setup, including applicable wiring and network connection, exists for 
both NPM cards. 

2. Setup a Virtual IP Address in the VMG Element Manager Global Configuration -> Management 
Interface tab (see “Management Interface Tab” on page 44 for more information).

3. If using the VMG with an ad server, setup a Virtual MAC Address in the VMG Element Manager 
Global Configuration -> Grooming Group tab (see “Grooming Group tab” on page 46).

VPM and TCM Status and Health

Note: The VPM is not supported in Release 3.1.x. Please refer to the associated Release Notes for 
additional information

The LEDs on the front panel of the VPM and TCM cards indicate their current status and health. This 
information is also displayed in the chassis view of the VMG Element Manager. Refer to “Chassis 
Tab” on page 25 for details. Table 117 describes the VPM and TCM front panel LEDs.

Table 117. VPM/TCM front panel LEDs 

LED Name Color/Condition Description

Hot Swap Blue VPM//TCM is not ready for hot-swap.

Flashing Blue VPM/TCM is making transition from hot-swap not ready to ready 
state, and ready state to not ready state.

Off VPM/TCM is ready for hot-swap.

Status Red Chassis interface fault.

Green Payload up.

Config Red FPGA configuration in progress.

Green FPGA configuration completed.

Fault Red Fault.

Green Normal Operation.

Backup Red Standby.

Green In operation.
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VPM and TCM Redundancy

Note: The VPM is not supported in Release 3.1.x. Please refer to the associated Release Notes for 
additional information

The VMG offers N+M VPM and TCM redundancy, where N is the number of cards in the system and 
M is the number of redundancy cards available for the following cards and functions: 

• VPM:Grooming, statistical multiplexing, transrating, and digital ad insertion.

• TCM:Grooming and transcoding.

Note: VPM uses load balancing for redundancy, whereas TCM uses first-fill provisioning.

Unlike N+1 redundancy, N+M redundancy allows an operator to utilize all the VPM or TCM cards in 
the VMG system for video processing and transcoding, thus sharing the load and the probability of a 
malfunction equally between the VPMs or TCMs instead of dedicating one or multiple cards operating 
in standby mode to provide redundancy. This N+M redundancy scheme requires VPM or TCM 
capacity to be over-provisioned (i.e., you allow for more capacity than is operationally needed to allow 
a successful failover) so that video streams from a failed VPM card(s) can be redistributed across 
remaining functional VPM or TCM cards without running out of processing capacity on those 
modules.

Note: A VPM card cannot provide redundancy for a TCM card and vice versa. 

Functionality

When the system detects a failed VPM or TCM card, the redundancy algorithm will automatically 
perform intelligent redistribution of output transport stream video processing across all available 
sources. 

Failover

With N+M redundancy, if one VPM or TCM card fails, video processing resources will be 
redistributed to any other available VPM or TCM card(s) until the failed card can be replaced. It is not 
necessary to replace the same card in the same slot. VPM or TCM cards can be easily added with no 
service interruption, or removed from the system with minimal service interruption.

Failover conditions consist of online insertion and removal of a card or a hardware or software failure.

Oversubscription Indication

Depending on available resources, any number of card failures can be reallocated to any number of 
available cards. The Chassis view of the VMG Element Manager displays color-coded and text 
indications of current bandwidth percentage use in order for the user to better gauge at what point 
oversubscription may occur, and when additional VPMs might be necessary. Figure 197 shows the 
Chassis view with the VPM redundancy status highlighted at the bottom:
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Figure 197. Chassis tab - VPM Redundancy

For complete descriptions of the VPM Redundancy properties and values, see Table 10, “Chassis Tab - 
System Information  - Management IP,” on page 28 and Table 17, “Chassis Tab - Card Information,” 
on page 31.

Additionally, if VPM or TCM resource allocation fails, the undistributed (oversubscribed) program’s 
icon will remain black and white (indicating no video processing is taking place) in the Outputs panel 
of the Grooming -> Mapping subtab of the VMG Element Manager. 

Configuring VPM and TCM Redundancy

VPM and TCM redundancy occurs automatically in the VMG system. No additional configuration is 
necessary. 

Bandwidth 
utilization indicator
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AMP Status and Health

The LEDs on the front panel of the AMP card indicates its current status and health. This information 
is also displayed in the chassis view of the VMG Element Manager. Refer to “Chassis Tab” on page 25 
for details. Table 118 describes the AMP front panel LEDs.

AMP Redundancy

Each AMP module is paired with an NPM module and follows the same failover behavior as the NPM. 
In the VMG-6 and VMG-8, the AMP in slot 3 is paired with the NPM in slot 1 to form one group, and 
the AMP in slot 4 is paired with the NPM in slot 2 to form another group. In the VMG-14, the AMP in 
slot 6 is paired with the NPM in slot 7 to form one group, and the AMP in slot 9 is paired with the 
NPM in slot 8 to form another group.

Functionality

Whichever NPM is active, it’s paired AMP is active also. In each NPM/AMP group, the NPM is the 
master. NPM switchover triggers AMP switchover; also, AMP switchover triggers NPM switchover. 

Note: If you have active grooming of programs on standard OTSs and Transcoded+PIP TS, AMP 
failover will cause video interruption of these programs due to NPM switchover.

You can trigger NPM/AMP failover through the GUI, but only when both the NPM and AMP are in a 
fully redundant configuration (that is, two NPMs and two AMPs). However, NPM auto-failover will 
trigger AMP switchover even if only one AMP is installed. If programs are configured on standard 
OTSs and Transcoded+PIP TS, video on those programs will be restored after NPM failover. However, 
MBR TS programs will not be restored if there is no working AMP paired with the new active NPM.

Table 118. AMP Front Panel LEDs 

LED Name Color/Condition Description

OOS (Out of 
Service)

Red System out of service

Off System normal

Health Solid green AMP firmware is active, payload enabled

Flashing green AMP firmware is active, payload disabled

Off AMP firmware is inactive

Hot Swap Solid blue AMP board is inactive and ready to be swapped

Flashing blue AMP board is activating/deactivating and unsafe to swap

Off AMP board is active and unsafe to swap
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Figure 198. Chassis tab - AMP Redundancy

For complete descriptions of the AMP Redundancy properties and values, see Table 10, “Chassis Tab - 
System Information  - Management IP,” on page 28 and Table 17, “Chassis Tab - Card Information,” 
on page 31.

Configuring AMP Redundancy

AMP redundancy happens automatically in the VMG system. No additional configuration is 
necessary. 
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Digital Program Insertion (DPI) and 
Program Substitution

Digital Program Insertion (DPI) is used for the insertion of ads or other types of television content in 
the digital domain. DPI commonly involves splicing MPEG-2 or H.264 video streams in order to 
perform the substitution. The VMG is fully compliant with SCTE 30 and SCTE 35 DPI standards.

Program Substitution is used for the insertion of secondary, long format video content into a primary 
video stream. Program Substitution commonly involves splicing MPEG-2 or H.264 video streams in 
order to perform the substitution. 

Note: An NTP server must be used with the VMG when performing DPI with a schedule referencing 
an absolute time base to ensure time synchronization. The NTP server must be up and running 
prior to booting up the VMG.

Note: The VPM is not supported in Release 3.1.0. Please refer to the 3.1.0 Release Notes for 
additional information. 

Note: DPI and Program Substitution capability are dependent on the type of licenses installed. Refer 
to “License Management” on page 99 for details.

Note: DPI and Program Substitution are not available for transcoded programs, including 
Transcoded+PIP programs.

In This Chapter:

• “Digital Program Insertion,” next.

• “Configuring DPI Programs” on page 282.

• “Connecting an Ad Server to the VMG” on page 285.

• “Program Substitution” on page 285.

• “SCTE 30 to SCTE 35 Conversion” on page 288.

• “SCTE 35 Cue Message Forwarding” on page 290.

Digital Program Insertion

The VMG performs DPI splicing by opening a session and inserting digital ads into a primary 
programming channel or a group of channels. For example, inserting locally-generated advertisements 
into network distributed programming. The information about when to splice and what to insert are 
communicated to the VMG using SCTE 30 and SCTE 35 messages.
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SCTE 30 splicing messages provide a standardized method for communication between ad servers and 
splicers, such as the VMG. The VMG performs ad splicing when it receives splicing messages and ads 
from the ad server.

SCTE 35 cueing messages provide the signaling that allows splicing of transport streams for digital 
program and ad insertion. These cueing messages provide the VMG with the precise timing 
information needed to coordinate with the ad server for splicing a primary video feed.

SCTE 35 cue message forwarding and SCTE 30 to SCTE 35 message conversion are configurable 
through the VMG Element Manager.

The VMG is capable of real-time splicing of un-encrypted MPEG-2 input streams into another un-
encrypted MPEG-2 input stream, or real-time splicing of un-encrypted H.264 input video streams into 
another un-encrypted H.264 input stream. This can be performed in real-time at any I or P frame in an 
MPEG-2 stream, or any pre-conditioned IDR frame in an H.264 stream. The VMG also supports 
simultaneous ad insertions for both SD and HD MPEG-2 and H.264 video programs, as well as 
insertion of back-to-back ads. Multiple ad zones can also be defined.

Network and ad stream language mapping is supported by the VMG. If the network feed contains both 
English and Spanish audio, and the ad content also includes both English and Spanish audio, then the 
English ad content audio is spliced to the English network feed audio stream and the Spanish ad 
content audio is spliced to the Spanish network feed audio stream. However, if the ad content only 
contains English audio, then the English ad content audio is spliced to the English feed only.

The VMG is also capable of performing rate-shaping on inserted MPEG-2 video ad channels.

Seamless splicing of H.264 video network feeds with ad streams follow the DVS714r3 and SCTE 128 
standards. DVS714r3 covers video coding constraints, and SCTE 128 deals with video system and 
transport constraints. SCTE 128 describes the transmission of advanced video coding (AVC) coded 
digital video in MPEG transport streams. Figure 199 shows how the VMG interacts in a DPI 
environment.
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Figure 199. VMG in DPI Environment

Configuring DPI Programs

There are two types of DPI program configurations available: Transport Stream DPI and Program-
level DPI. 

Transport Stream DPI provides the ability to configure DPI programs on an entire transport stream 
and requires the use of a Bandwidth-based DPI license. For every DPI-enabled transport stream, the 
license manager will deduct from available bandwidth based on the amount of DPI bandwidth 
purchased under the license and total bitrate of the transport stream.

Program-level DPI provides the ability to configure DPI at the program level; in lieu of using a 
bandwidth-based license, Program-level DPI will deduct one number-based license for every DPI-
enabled program. 

Configuring DPI Programs - Transport Stream Level

1. Verify a proper DPI Bandwidth-based license exists in the License Manager and the appropriate 
amount of bandwidth is available on the transport stream. 

See “License Management” on page 99 for details. 

2. From the Outputs panel of the VMG Element Manager Grooming -> Mapping tab page, right-
click the desired GigE or 10GigE interface for which to enable bandwidth-based DPI 
programming and select Create Transport Stream (Figure 96 on page 143).

3. Un-check the Transcoding box at the top right of the Create Output Transport Stream dialog.

4. Check the TS DPI box.

5. Enter other necessary information for the transport stream, such as Destination IP and UDP Port.

6. Select Apply Configuration.
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7. Under the transport stream that is now enabled for TS level DPI, create or groom a new program 
by following the applicable steps in “Output Programs and Grooming” on page 157.

Note: When creating DPI-based programs (either on the transport level or the program level) the 
name assigned to the program must exactly match the name configured on the ad server.

8. Select Apply to create the new program or Apply Configuration to groom the new program.

Configuring DPI Programs - Program Level

1. Verify a proper DPI number-based license exists in the License Manager. See “License Manage-
ment” on page 99 for details. 

2. If modifying an existing program: from the Outputs panel of the VMG Element Manager 
Grooming -> Mapping tab page, right-click the desired program under the transport stream for 
which to enable DPI and select Modify Program (Figure 126 on page 197).

or

3. If creating a new program, follow the applicable steps in “Output Programs and Grooming” on 
page 157.

Note: When creating DPI-based programs (either on the transport level or the program level) the 
name assigned to the program must exactly match the name configured on the ad server.

4. Check the Program DPI box in the relevant Create / Modify Output Program or Configure 
Program Mapping dialog.

5. Select Apply or Apply Configuration.

Note: DPI is not supported on a channel substituted program; therefore, DPI and Program 
Substitution cannot be checked at the same time when configuring on the program level. 

The VMG Element Manager displays DPI-based programs in the Grooming -> Mapping tab page as a 
different program icon. When DPI is configured and active on a program, a program icon will be 
displayed with an arrow inside as seen in Figure 200. (For a complete description of icons available in 
the Mapping tab page, see Table 57 on page 122.)
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Figure 200. DPI-based Program Icon

Active DPI Program

Active non-DPI Program
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Connecting an Ad Server to the VMG

Figure 201 shows how an ad server is connected to the VMG through the management interface only. 
This is the most general method; however, other connection methods may be possible.

Figure 201. Connecting an Ad Server to the VMG

Program Substitution

Program substitution is a form of digital program insertion (DPI) that offers the ability to splice 
secondary, long-format video content into a primary video stream. Long format content, which is 
typically 30 to 60 minute programming segments, differs from short format content which is used for 
regional spot advertisements. 

The VMG is capable of real-time splicing of unencrypted MPEG-2 input streams into another 
unencrypted MPEG-2 input stream, or real-time splicing of unencrypted H.264 input video streams 
into another unencrypted H.264 input stream for Program Substitution. 

Program substitution is particularly important for some operators in meeting National programming 
content rules which often limit the amount of International programming that is allowed. For example, 
a Canadian channel airing a U.S. music video network from 10 a.m. to 6 p.m. may be required to 
switch to local programming during the prime time evening hours. This capability is equally important 
for channels that play long-form infomercials or home shopping programs during the early morning 
hours, but need to switch to their regular programming for the remainder of the day. Figure 202 shows 
how the VMG interacts in a Program Substitution environment.
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Figure 202. VMG in Program Substitution Environment

The implementation for program substitution is similar to that of DPI. Instead of using an ad server to 
splice an MPEG-2 input video stream into another MPEG-2 input video stream or an H.264 input 
video stream into another H.264 input video stream, a Program Substitution scheduling server is used 
as the controller that communicates with the VMG based on the SCTE 30 standard. Figure 203 shows 
Program Substitution implemented on a VMG system.

Figure 203. Program Substitution Flow, with Scheduling Server

Configuring Program Substitution

1. Verify the proper Program Substitution number-based license exists in the License Manager. See 
“License Management” on page 99 for details. 

2. If modifying an existing program: from the Outputs panel of the VMG Element Manager’s 
Grooming -> Mapping tab page, right-click the desired program under the transport stream for 
which to enable a channel substituted program and select Modify Program (Figure 126 on 
page 197).

or

3. If creating a new program, follow the applicable steps in “Output Programs and Grooming” on 
page 157.

Over GigE InputsOver GigE Inputs
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Configuring DPI at the Program Level

1. Verify a proper DPI number-based license exists in the License Manager. See “License Manage-
ment” on page 99 for details. 

2. If modifying an existing program: from the Outputs panel of the VMG Element Manager 
Grooming -> Mapping tab page, right-click the desired program under the transport stream for 
which to enable a DPI and select Modify Program (Figure 126 on page 197).

or

3. If creating a new program, follow the applicable steps in “Output Programs and Grooming” on 
page 157.

Note: When creating channel substituted programs, the name assigned to the program must exactly 
match the name configured on the program substitution scheduling server.

4. Check the Program Substitution box in the relevant Create / Modify Output Program or 
Configure Program Mapping screen.

When checked, the Disable PMT update during program substitution option becomes visible. 
This option maintains the same PMT table version after a substitution event, as long as elementary 
stream structures match. This avoids possible set top box re-tuning and disruptions. 

5. Select Apply or Apply Configuration.

Note: Program Substitution is not supported on a DPI-enabled transport stream or program; 
therefore, DPI and Program Substitution cannot be checked at the same time when 
configuring on the program level, nor can a channel substituted program be created under a 
DPI-enabled transport stream.

The VMG Element Manager displays channel substituted programs in the Grooming -> Mapping tab 
page as a different program icon. When Program Substitution is configured and active on a program, a 
program icon will be displayed one on top of the other as seen in Figure 200. (For a complete 
description of icons available in the Mapping tab page, see Table 57 on page 122.)



VMG Element Manager User Guide 288

Release 3.1.3 SCTE 30 to SCTE 35 Conversion

Figure 204. Channel Substituted Program Icon

SCTE 30 to SCTE 35 Conversion

The VMG is capable of receiving SCTE 30 splice messages from an ad server and converting them 
into SCTE 35 ‘cue-tone’ messages at the program level. This allows DPI to be performed at the 
regional hub. 

Figure 205. SCTE 30 to SCTE 35 Conversion

Active Channel 
Substituted Program

Active non-Channel 
Substituted Program
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To enable SCTE conversion:

1. Launch the VMG Element Manager and log in as the Administrator.

2. Create or modify a new output program as described in “Output Programs and Grooming” on 
page 157 and “Modifying and Deleting Input Transport Streams and Programs” on page 133.

- If creating a program manually, the Create Output Program dialog opens (Figure 206).

- If using the drag-and-drop program creation method the Configure Program Mapping screen 
opens (Figure 207).

Figure 206. Enable SCTE 30 to SCTE 35 Conversion (Manual Program Creation)

Figure 207. Enable SCTE 30 to SCTE 35 Conversion (Drag-and-Drop Program Creation)

3. Check the SCTE 30 to 35 Conversion box, and apply other settings in the screen, as required. 
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Note: If enabling SCTE 30 to 35 Conversion, neither DPI nor Program Substitution should be 
enabled.

4. Click Apply Configuration.

Note: Once enabled, the transport stream will only perform conversions. No splicing is performed.

SCTE 35 Cue Message Forwarding

The VMG is capable of forwarding SCTE 35 cue messages on an input program to a groomed output 
program. 

Use the Configure Program Mapping screen (Figure 208) to enable SCTE 35 message forwarding:

1. Launch the VMG Element Manager and log in as the Administrator.

2. Create or modify a new output program as described in “Using Drag-and-Drop to Create Output 
Programs” on page 170 (only the drag-and-drop program creation or modification method is 
available for enabling this field). 

Figure 208. Enable SCTE 35 Message Forwarding

3. Check the Forward SCTE 35 Cue box, and apply other settings, as required. 

4. Click Apply Configuration.
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Monitoring

The VMG Element Manager provides various methods you can use to view and control displays of 
error counts on input and output transport streams and elementary streams. 

In This Chapter:

• “Bitrate Monitoring—MBR Transport Streams,” next.

• “Monitoring Input-Output Transport Streams” on page 292

• “Viewing Elementary Stream Traffic Details” on page 293

• “Displaying Error Statistics” on page 298.

• “Additional Monitoring Operations” on page 301.

Bitrate Monitoring—MBR Transport Streams

To monitor the bitrate for an MBR program:

From the Outputs panel of the Grooming -> Mapping tab page, right-click on a transport stream 
within the MBR TS and select Bitrate Monitor from the popup menu (Figure 209).

Figure 209. MBR Bitrate Monitor

The VMG Element Manager opens the Input-Output Bitrate Monitor to display the input and output 
bitrates for the selected transport stream. 

Note: The Bitrate Monitor can only display the real-time bitrate for one transport stream and to one 
VMG Element Manager user at a time. Two transport streams cannot be simultaneously 
monitored.
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Monitoring Input-Output Transport Streams

To view monitoring detail for a transport stream, go to the Input-Output Bitrate Monitor tab page 
(Figure 210). 

From the VMG Element Manager tabs, click the Monitor tab. 

or

From the Outputs panel of the Grooming tab page, right-click a transport stream to monitor, and 
select Bitrate Monitor from the popup menu. 

About the Bitrate Monitor Graph

Note: The Bitrate Monitor can only display the real-time bitrate for one transport stream and to one 
VMG Element Manager user at a time. Two transport streams cannot be simultaneously 
monitored.

To adjust the view on display, use the selectors across the top of the screen to select the port, transport 
stream, and legend information. 

Figure 210. Bitrate Monitor Components

The input and output bitrates are shown in a bar graph by program number in the middle portion of the 
screen. At the bottom portion of the screen a program’s percentage of the total output bitrate is 
displayed.

Use the Start/Stop button at the lower right of the screen to activate or halt display of the real-time 
monitoring display. 
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Viewing Elementary Stream Traffic Details

Use tools in the Monitor tab’s ES Error / Traffic Monitor tab page (Figure 211) to define the 
individual input or output elementary streams and the monitoring parameters to be displayed as real-
time graph, as described in the following topics:

• “Displaying Input ES Performance Graphs” on page 293.

• “Displaying Output ES Performance Graphs” on page 296. 

Figure 211. Traffic Monitor Graph Components

Displaying Input ES Performance Graphs

Use the Select an Input ES dialog (Figure 212) to select an audio or video input elementary stream 
and to define the monitoring information to be reported about a selected stream.

Starting at the VMG Element Manager, Monitor tab -> ES Error/Traffic Monitor tab page, click 
Select Input ES.

1. At the Select Input ES dialog, click on an audio or video ES. The OK button at the bottom of the 
screen should now be green. 

2. Click the OK button to access parameters to chart audio ES or video ES performance. 


Hover on the tab label to reveal 
details (in yellow block) about the 
TS associated with the graph. 

Tabs that identify and provide access to 
each graph that you create.

Access to dialogs in which to select ESs and various 
types of error counters for your graphing.

Access to the error counter selector. You 
can change the settings at any time. 

Display of the currently configured error 
counters, and legend, for the graph in view.
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Figure 212. Select an Input ES

Input Video ES

Use the steps in this section to create a real-time graph that displays performance information about a 
selected input video ES.

1. At the Select an Input ES dialog, select the video ES to be monitored, and click the green OK 
button to present the Select Errors for Video dialog (Figure 213). 

Figure 213. Set Monitoring Parameters for Input Video ES
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2. At the Select Errors for Video dialog, click to check-mark the video monitoring options to be 
used, then click Apply to present the Input Video graph (Figure 214).

Figure 214. Generating a Performance Graph—Input ES Video

Input Audio ES

Use the steps in this section to create a real-time graph that displays performance information about a 
selected input audio ES.

1. At the Select an Input ES dialog, select the audio ES to be monitored, and click the green OK 
button to present the Select Errors for Audio dialog (Figure 215). 

Figure 215. Setting Parameters for Input ES Performance Monitoring
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2. At the Select Errors for Audio dialog, click to check-mark the audio monitoring options to be 
used, then click Apply to present the Input Audio graph (Figure 216).

Figure 216. Generating a Performance Graph—Input ES Audio

Displaying Output ES Performance Graphs

Use the Select an Output ES dialog to select an output elementary stream and to define the 
monitoring information to be reported about the selected stream. 

At the VMG Element Manager, Monitor tab -> ES Error/Traffic Monitor tab page, click Select 
Output ES. 

Figure 217. Select an Input ES
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Output ES Audio 

Use the steps in this section to create a real-time graph that displays performance information about a 
selected output audio ES.

1. At the Select an Input ES dialog, expand a program and click the audio ES to be monitored. 
The OK button, at the bottom of the screen, should now be green (Figure 218). 

2. Click the green OK button to present the Select Errors for Audio dialog. 

3. At the Select Errors for Audio dialog, click to check-mark the monitoring options to be used, 
then click Apply. 

Output ES Video 

Use the steps in this section to create a real-time graph that displays performance information about a 
selected output video ES.

1. At the Select an Input ES dialog, click the video ES to be monitored. 
The OK button, at the bottom of the screen, should now be green (Figure 218).

2. Click the green OK button to present the Select Errors for Video dialog. 

3. At the Select Errors for Video dialog, click to check-mark the monitoring options to be used, then 
click Apply. 

Figure 218. Setting Parameters for Output ES Performance Monitoring
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Displaying Error Statistics

You can view error statistics reported by the VMG, as described in the following topics:

• “Audio Elementary Stream Statistics,” in next section. 

• “Video Elementary Stream Statistics” on page 299.

Audio Elementary Stream Statistics

This section describes how to access statistics for input and output audio elementary streams. 

Input Errors

Use the Display Input Audio ES Error Statistics dialog (Figure 219) to view the errors reported by 
the VMG for a selected input audio elementary stream. 

At the VMG Element Manager, Grooming tab -> Mapping tab page, Inputs column -> right-click on 
an audio ES, and select Display Error Statistics from the popup menu. 

Figure 219. Display Input Audio ES Error Statistics

Output Errors

Use the Display Output Audio ES Statistics dialog to view the errors reported by the VMG for a 
selected output audio elementary stream. 

At the VMG Element Manager, Grooming tab -> Mapping tab page, Outputs column -> right-click 
on an audio ES, and select Display ES Statistics from the popup menu. 
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Figure 220. Display Output Audio ES Error Statistics 

Video Elementary Stream Statistics

This section describes how to access statistics for input and output video elementary streams. 

Input Video Statistics

Use the Display Input Video ES Error Statistics dialog (Figure 221) to view various types of error 
counts associated with the selected video elementary stream. 

At the VMG Element Manager, Grooming tab --> Mapping tab page, Inputs column -> right-click on 
a video ES, and select Display Error Statistics from the popup menu. 

Figure 221. Display Input Video ES Error Statistics
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Output Video Statistics

Use the Display Output Video ES Statistics dialog (Figure 222) and to view the errors reported by the 
VMG for a selected output audio elementary stream. 

At the VMG Element Manager, Grooming tab --> Mapping tab page, Outputs column --> right-click 
on an audio ES, and select Display ES Statistics from the popup menu. 

Figure 222. Display Output Video ES Errors

Table 119. Audio Error Counters 

Field Description

Type This setting controls how the audio errors are to be reported: 

Select either cumulative or Instantaneous:

• Cumulative: View number of audio errors, as accumulated since new grooming 
associated with the transport stream.

• Instantaneous: View number of audio errors, as a delta value resultant of the 
previous poll and the current poll (polling occurs every 30 seconds).

CC Errors Number of continuity counter errors reported on the audio stream.

Packets Dropped Number of discarded packet errors reported on the audio stream.

Audio Underflows Number of underflow errors reported on the audio stream. 

Audio Loss Number of audio loss errors reported on the input audio elementary streams.

Audio Underflow Number of audio underflow errors reported on the input audio elementary stream. 

Input TS Missing 
Count

Number of occurrences of PAT timeout (for 2 seconds) on an input audio transport 
stream. 
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.

Additional Monitoring Operations

Additional monitoring operations are available directly from a graph in view, via the popup menu 
(Figure 223 and Table 121). 

At the VMG Element Manager, Monitor tab -> ES Error/Traffic Monitor tab page -> graph view, 
right-click on the graph to present the popup options. 

Table 120. Video Error Counters

Field Description

Type This setting controls how the video errors are to be reported: 

Select either cumulative or Instantaneous:

• Cumulative: View counts of video errors, as accumulated since new grooming 
associated with the transport stream.

• Instantaneous: View number of audio errors, as a delta value resultant of the 
previous poll and the current poll (polling occurs every 30 seconds).

DTS Jumps Number of DTS jumps reported on the video stream.

PCR Resets Number of program clock reference errors reported on the video transport stream. 

Video Underflows Number of video underflow errors reported on the video stream.

Video Loss Number of Video Loss errors reported on the output video stream.

Decoder Errors Number of decoder errors reported on the video stream.

CC Errors Number of continuity counter errors reported on the video stream. 

Frames Lost Number of frames reported as lost on the video stream.

Packets Lost Number of packets reported as lost on the video stream.

TEI Errors Number of transport error indicator instances on the video stream.

Packets Dropped Count of packets dropped from the video elementary stream.

Input TS Missing 
Count

Count of input transport streams missing.

PCR Errors Count of program clock errors.
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Figure 223. Graph Page Options:

Table 121. Monitoring Page Options  

Popup Menu 
Option Description

Copy Make a copy of the image currently in view. You can paste the image into any 
documentation platform. 

Save Image as... Preserve the image currently in view, as a graphic file in a specified location. This option 
presents the Save dialog, which allows you to specify the location and name for the 
(.png) image file.

Save data as... Preserve details associated with the image currently in view, as a spreadsheet file (.csv) 
to a specified location. this option presents the Save dialog, which allows you to specify 
the location and name for the (.csv) file. 

Print... Send the image from your computer to the currently configured default printer, to obtain 
hardcopy of the graphic on display. 

Zoom in... • Both Axes: 

• Domain Axis:

• Range Axis:

Zoom out...

Auto range...
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Troubleshooting

If you are experiencing problems with your VMG, please contact RGB Customer Support. Prior to 
doing so, you should gather as much information as possible about the problem so that you can 
provide a comprehensive description of the situation to RGB Customer Support.

In This Chapter:

• “LED Indicators,” next.

• “Event Log Analysis” on page 303.

• “Software Upgrade” on page 303.

• “Contacting RGB Customer Support” on page 304.

LED Indicators

The LED indicators on the VMG should be your first line of inquiry if any VMG component is not 
performing correctly.

The LED indicators are fully described in the VMG Hardware Setup Guide that accompanies your 
VMG-6, VMG-8, or VMG-14 chassis. 

Event Log Analysis

If asked to do so by customer support, access the event log. You will be instructed on this procedure 
by the customer support engineer.

Software Upgrade

Use the VMG Element Manager to upgrade any software image of the VMG. 

See “Reboot the VMG to enable activation of the restored database. Refer to “System Reboot” on 
page 103” on page 94 for details about upgrading software.

See the Video Processing Gateway Software Upgrade Guide for upgrade procedures.
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Contacting RGB Customer Support

Note: For BNP products or software purchased through other distribution partners, please contact 
their customer service for product support.

Before you contact Customer Support, have the following information handy:

• A clear description of the problem.

• Steps to reproduce the problem, if applicable.

• Serial number of the VMG, as shown in the System Type screen. 

From the Chassis tab page, System Information -> Chassis section; double-click or right-click 
System Type -> System Type screen. 

Figure 224. System Type screen

Customers who purchased their product directly from RGB Networks, or have purchased extended 
product support directly from RGB Networks should contact customer support via one of the methods 
listed in Table 122. 

Table 122. Contacting Customer Support

Method Details

Phone +1 (877) RGB-NETW (877-742- 6389) or +1 (408) 701-2800

Customer Portal http://support.rgbnetworks.com

Email support@rgbnetworks.com

http://support.rgbnetworks.com
mailto://support@rgbnetworks.com
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Searching the RGB Customer Portal

To search the RGB Customer Portal for a specific document or solution, proceed as follows:

1. Log in to the RGB Customer Portal site (http://support.rgbnetworks.com).

Figure 225. RGB Customer Portal home page

2. From the RGB Customer Portal home page, click on the Knowledge Base tab:

Figure 226. Customer Portal home page - Direct and Reseller

3. From the Knowledge Base home page, enter the desired search term in the Search box and tap the 
[Enter] key:

Figure 227. Knowledge Base search - Direct and Reseller

Direct Customers - RGB Customer Portal home Resellers - RGB Customer Portal home

Direct Customers - Knowledge Base search Resellers - Knowledge Base search

http://support.rgbnetworks.com
http://support.rgbnetworks.com
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APPENDIX A

Configuration Reference

This appendix contains tables of supported sampling and bit rates for channels. 

In This Appendix:

•  “Audio Configuration Reference,”

• “Resolution Configuration Reference” on page 309

• “Locales and Decimal Entries” on page 310.

• “Dolby Dynamic Range Scale Entry Guidelines” on page 313

• “Video Profile Configuration Reference” on page 314.

• “Language Descriptor Settings” on page 314

Audio Configuration Reference

Table 123. Audio Bitrates and Sampling Rates

Audio
Codec

Default 
Sample 
Rate (kHz)

Default 
Channels

Default 
Bitrate 
(Kbps)

HE-AAC 44.1 Stereo 80 

HE-AACv2 44.1 Stereo 40 

AAC-LC 44.1 Stereo 128 

MPEG-1 LII 48 Stereo 192 

MPEG-2 LII 24 Stereo 128 

AC-3 48 Stereo 192 

Table 124. AAC HE Audio Configuration Reference  

Sampling 
Rate
(kHz) Channel

Bit Rates

10 12 14 16 20 24 28 32 40 48 56 64 80 96 11
2

12
8

16
0

19
2

22
4

25
6

16 mono(1) x x x x x x x x x

stereo(2) x x x x x x x x

surround(6) x x x x x x x

22.05 mono(1) x x x x x x x x x x

stereo(2) x x x x x x x x x

surround(6) x x x x x x x x

24 mono(1) x x x x x x x x x x

stereo(2) x x x x x x x x x

surround(6) x x x x x x x x

32 mono(1) x x x x x x x x

stereo(2) x x x x x x x x

surround(6) x x x x x x
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44.1 mono(1) x x x x x x x x x

stereo(2) x x x x x x x

surround(6) x x x x x x x

48 mono(1) x x x x x x x x x

stereo(2) x x x x x x x

surround(6) x x x x x x x

Table 125. AAC HEv2 Audio Configuration Reference

Sampling 
Rate
(kHz) Channel

Bit Rates
10 12 14 16 20 24 28 32 40 48 56 64

16 stereo(2) x x x x x x x x x

22.05 stereo(2) x x x x x x x x x x

24 stereo(2) x x x x x x x x x x

32 stereo(2) x x x x x x x x

44.1 stereo(2) x x x x x x x x x

48 stereo(2) x x x x x x x x x

Table 126. AAC LC Audio Configuration Reference  

Sampling 
Rate
(kHz) Channel

Bit Rates

6 7 8 10 12 14 16 20 24 28 32 40 48 56 64 80 96 11
2

12
8

16
0

19
2

22
4

25
6

32
0

38
4

44
8

51
2

8 mono(1) x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x x x x x x x

11.03 mono(1) x x x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x x x x x x x x x

12 mono(1) x x x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x x x x x x x x x

16 mono(1) x x x x x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x x x x x x x x x x x

surround(6 x x x x x x x x x x

22.05 mono(1) x x x x x x x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x x x x x x x x x x x x x

surround(6 x x x x x x x x x x x x

24 mono(1) x x x x x x x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x x x x x x x x x x x x x

surround(6 x x x x x x x x x x x x

32 mono(1) x x x x x x x x x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x x x x x x x x x x x x x x

surround(6 x x x x x x x x x x

44.1 mono(1) x x x x x x x x x x x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x x x x x x x x x x x x x x x x x

surround(6 x x x x x x x x x x x x

48 mono(1) x x x x x x x x x x x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x x x x x x x x x x x x x x x x x

surround(6 x x x x x x x x x x x

Table 124. AAC HE Audio Configuration Reference  (Continued)

Sampling 
Rate
(kHz) Channel

Bit Rates

10 12 14 16 20 24 28 32 40 48 56 64 80 96 11
2

12
8

16
0

19
2

22
4

25
6
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Table 127. MPEG-1 LII

Sampling 
Rate
(kHz) Channel

Bit Rates

32 48 64 80 96 11
2

12
8

16
0

19
2

22
4

25
6

32
0

38
4

32 mono(1) x x x x x x x x x

stereo(2) x x x x x x x x x x

44.1 mono(1) x x x x x x x x x

stereo(2) x x x x x x x x x x

48 mono(1) x x x x x x x x x

stereo(2) x x x x x x x x x x

Table 128. MPEG-2 LII  

Sampling 
Rate
(kHz) Channel

Bit Rates

8 16 24 32 40 48 56 64 80 96 11
2

12
8

14
4

16
0

16 mono(1) x x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x x x x

22.05 mono(1) x x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x x x x

24 mono(1) x x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x x x x

Table 129. Encode AC-3  

Sampling 
Rate
(kHz) Channel 56 64 80 96 11

2

12
8

16
0

19
2

22
4

25
6

32
0

38
4

44
8

51
2

32 mono(1) x x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x

5.1surround(6) x x x x x x

44.1 mono(10 x x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x

5.1surround(6) x x x x x x

48 mono(1) x x x x x x x x x x x x x x

stereo(2) x x x x x x x x x x x

5.1surround(6) x x x x x x
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Resolution Configuration Reference

The resolutions currently supported for HD, full HD, or SD programming are listed in Table 130 and 
Table 131. 

Resolutions can be combined as shown in Table 133:

Table 130. HD Input Resolution Class

Yellow (high) 1280x720, 1024x576, 960x720, 960x540

Blue (medium) 864x486, 848x480, 768x432, 640x480

Red (low)
640x360, 624x352, 512x288, 480x368, 480x320, 480x272, 416x240, 352x240, 320x240, 
320x180, 320x176, 192x192, 128x96, 96x96

Table 131. SD Input Resolution Class

Yellow (high)
1024x576

Blue (medium) 768x432, 720x576, 720x480, 640x480

Red (low)
640x360, 624x352, 512x288, 480x368, 480x320, 480x272, 448x336, 416x240, 400x360, 
400x224, 352x288, 352x240, 320x240, 320x180, 320x176, 192x192, 128x96, 96x96

Table 132. Full HD Input Resolution Class

Green 1920x1080, 1280x720

Table 133. Resolution Combinations for SD, HD, and Full HD

HD SD Full HD

• 1 Yellow + 1 Blue + 2 Red.

• 1 Yellow + 3 Red.

• 2 Blue + 2 Red.

• 1 Blue + 3 Red.

• 4 Red.

• 2 Blue + 2 Red.

• 1 Blue + 3 Red.

• 4 Red.

• 1 green
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Locales and Decimal Entries

The VMG Element Manager will accept and display decimal values as commonly displayed for the 
language (and country) selected as the Format in the Region and Language menu from the control 
panel of Windows 7. In addition, either a period or a comma will be accepted during input of fields 
allowing a fractional value but will be displayed based on the Format defined by the selected language 
(and country).

Bitrate Configuration Reference

An automatic bitrate assignment can maximize the bitrate available for video streams within the 
configured range in the output transport stream. Automatic bitrate assignment also takes into account 
other (non-video) elementary streams in the output TS. 

Note: For VTX+PIP streams, the VTX component is limited by the VTX/H.264 limits, and the PIP 
component is limited by the PIP/H.264 component. 
For AVTX+PIP streams, the AVTX component is limited by the AVTX/H.264 limits, and the 
PIP component is limited by the PIP/H.264 component.

Guidelines for bitrate entries are provided in the following topics:

• “Bitrate Entry Guidelines,” next. 

• “Bitrate Tables” on page 312.

Table 134. VMG Element Manager screens/values supporting localization

Input Display Screens Effect

x x TS bitrate for several Create, Modify, and 
Configure screens

Rounded to nearest bit per second.

x x Video ES bitrate for several Create 
Modify, and Configure screens.

Rounded to the nearest bit per second.

x x Audio sample rates for several Create 
Modify and Configure screens.

Rounded to nearest bit per second.

x x Dynamic range scale low for Dolby global 
configuration. 

Rounded to nearest tenth. 

x x Dynamic range scale high for Dolby 
global configuration

Rounded to nearest tenth. 

x Transrating bandwidth license (Mbps) at 
License Manager, for purchased, used, 
and available 

Display only.

x DPI Bandwidth License (Mbps) at 
License Manager, for purchased, used, 
and available 

Display only.

x Input-Output Bitrate Monitor, and Input 
Program Total Bitrate and TS Total Bitrate 
labels on graph bars. 

Display only. 

x Input-Output Bitrate Monitor and Input 
Program Total Bitrate and TS Total Bitrate 
labels at bottom of screen. 

Display only. 
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Bitrate Entry Guidelines

The type of decimal mark symbol displayed and/or entered at the VMG Element Manager—to express 
a TS bitrate value—is dependent on the locale settings of the client computer logged in to VMG 
Element Manager. This symbol is either a comma (,) or a period (.) character, and it is used to 
designate the beginning of the fractional portion of the value entered to define a TS bitrate. For 
example, in Spain this value is written as 18,5 Mbps.

Figure 228. Sample TS Bitrate Entry—Using Comma Marks 

The VMG Element Manager rounds out and displays your bitrate entries as follows: 

• For comma (,) decimal mark entries:
If your entry extends beyond the 6th place, it is automatically rounded out to the nearest millionth, 
and the comma mark is displayed in the result. For example, an entry of 0,1234568 will be 
rounded up to display 0,123457.

If you enter a period in place of the comma, the period will be converted to a comma and 
interpreted as a fractional value. For example, an entry of 4.5 will be converted and displayed as 
4,5. 

• For period (.) decimal mark entries:
If your entry extends beyond the 6th place, it is automatically rounded out to the nearest millionth, 
and the period mark is displayed in the result.

For example, an entry of 0.1234568 will be rounded up to display 0.123457. 

If you enter a comma in place of the period, the comma will be converted to a period and 
interpreted as a fractional value. For example, an entry of 4,5 will be converted and displayed as 
4.5. 

When the entered values are again displayed on another logged client, any fractional values will be 
displayed with the decimal mark symbol appropriate to the locale settings of that client computer.
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Bitrate Tables
I

. 

Table 135. AVTX/VTX Transcode Bitrates

Input 
Resolution 
Class

Output

Resolution 
Class Type

Max TS
TS Bitrate 
Range (Mbps)

Max V ES
Video ES 
Bitrate Range 
(Mbps) Audios

HD HD MPEG2 8 - 20 8 - 15 2

HD HD MPEG2 8 - 14 8 - 12 4

HD SD MPEG2 1 - 20 1 - 7 2

HD SD MPEG2 1 - 14 1 - 7 4

HD HD H.264 2 - 18.5 2 - 15 2

HD HD H.264 2 - 11 2 - 9 4

HD SD H.264 0.5 - 18.5 0.5 - 7 2

HD SD H.264 0.5 - 11 0.5 - 7 4

SD SD MPEG2 1 - 5 1 - 4 2

SD SD H.264 1 - 4.5 1 - 3 2

HD PIP H.264 0.1 - 1.2 0.1 - 1.0 0

SD PIP H.264 0.1 - 0.5 0.1 - 0.3 0

Table 136. MBR Transcode Bitrates

Input 
Resolution 
Class

Output

Resolution 
Class Type Profiles Sum of TS Sum of V ES Audios

HD Full HD H.264 1 13 9 8

HD or SD Not Full HD H.264 4 13 9 2

HD or SD Not Full HD H.264 2 13 9 4

HD or SD Not Full HD H.264 1 13 9 8
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Dolby Dynamic Range Scale Entry Guidelines

The type of decimal mark symbol displayed and/or entered at the VMG Element Manager—to express 
a Dolby Dynamic Range value—is dependent on the locale settings of the client computer logged in to 
VMG Element Manager. This symbol is either a comma (,) or a period (.) character, and it is used to 
designate the beginning of the fractional portion of the value entered to define Dolby Dynamic Range. 
For example, in Spain this value is written as 18,5 Mbps.

Figure 229. Sample Dolby Dynamic Range Values—Using Comma Marks 

The VMG Element Manager rounds out and displays your Dynamic Range Scale entries as follows: 

• For comma decimal mark entries:
If your entry extends beyond the 1st place, it is automatically rounded out to the nearest tenth, and 
the comma mark is displayed in the result. For example, an entry of 0,18 will be rounded up to 
display 0,2.

If you enter a period in place of the comma, the period will be converted to a comma and 
interpreted as a fractional value. For example, an entry of 0.5 will be converted and displayed as 
0,5. 

• For period decimal mark entries:
If your entry extends beyond the 1st place, it is automatically rounded out to the nearest tenth, and 
the period mark is displayed in the result. For example, an entry of 0.18 will be rounded up to 
display 0.2. 

If you enter a comma in place of the period, the comma will be converted to a period and 
interpreted as a fractional value. For example, an entry of 0,5 will be converted and displayed as 
0.5. 
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Video Profile Configuration Reference

Configuration for video profile applies to grooming with H.264, which sets the video standard to be 
used for specific classes of applications. Use guidelines in Table 137 when selecting a Profile option. 

Language Descriptor Settings

Use the Modify Language Descriptor dialog, from a selected input audio elementary stream to 
specify one of the following languages (Figure 138):

Table 137. Video Profile Configuration Options  

Option Description

High For broadcast and disc storage applications, particularly for high-definition television 
applications. Allows 8x8 transform size. For high-definition video where each video frame is 
large, the option to encode with a larger coding block allows the encoder to further improve 
coding efficiency. A high-end encoder can send out different scaling matrices based on the video 
content, which tends to offer a better subjective visual quality.

Main For standard definition digital TV broadcasts that use the MPEG-4 formats including broadcasts 
as defined in the DVB standard. Allows B-slices and interlaced coding mode (MBAFF and 
PAFF). Also, it allows CABAC for entropy coding. It offers much better coding efficiency over the 
baseline profile. Therefore, most broadcast video is encoded at least with Main profile.

Baseline for low-cost applications that require additional data loss robustness. Baseline is normally used 
in some video conferencing and mobile applications. Offers very basic coding tools. It can only 
encode progressive video and use I or P slices. Also, it allows CAVLC for entropy coding, a 
simpler but less efficient than CABAC. Many H.246 decoders running on PCs and mobile 
devices can only decode H.246 video encoded in the Baseline profile.

Table 138. Audio input elementary stream language options

Language codes and Languages

ara-Arabic est-Estonian isl-Icelandic nld-dutch spa-Spanish

bel-Belarusian fin-Finnish ita-Italian nor-Norwegian sqi-Albanian

bul-Bulgarian fra-French jpn-Japanese pol-Polish srp-Serbian

cat-Catalan gle-Irish kor-Korean por-Portuguese swe-Swedish

ces-Czech heb-Hebrew lav-Latvian ron-Romanian tha-Thai

dan-Danish hin-Hindi lit-Lithuanian rus-Russian tur-Turkish

deu-German hrv-Croatian mkd-Macedonian slk-Slovak ukr-Ukranian

ell-Greek hun-Hungarian mit-Maltese slv-Slovenian zho-Chinese

eng-English ind-Indonesian msa-Malay
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VMG Alarms and Events 

This appendix is a reference for alarms and events supported by the VMG. 

• Alarms are triggered directly by the VMG, and not by external sources. 

• Events are triggered by both the VMG and external devices.

In This Appendix:

• “General VMG Alarm and Event Categories,” next.

• “VMG Alarm and Event Model” on page 315.

• “VMG Alarm and Event Severity Levels” on page 315.

• “VMG Hardware Alarms” on page 316.

• “Interface and Port (IF_PORT) Alarms” on page 318.

• Specific alarms and events—per category—as listed in Table 138. 

General VMG Alarm and Event Categories

The alarms and events categories used by the VMG are listed in Table 138.

Table 138. VMG General Alarm and Event Categories 

Category Description Reference

SYS Alarms and events related to the VMG 
hardware, 

NTP service, and system shutdown.

“VMG Hardware Alarms” on page 316

“VMG Hardware Events” on page 319

IF_PORT Alarms and events related to the VMG ports 
and interfaces. 

“Interface and Port (IF_PORT) Alarms” on 
page 318 and 

“Interface and Port (IF_PORT) Events” on 
page 325

MPEG Events related to video processing. “Video Processing (MPEG) Events” on page 327

DPI Events related to ad insertion. “Ad Insertion (DPI) Events” on page 340

GRM Events related to video grooming. “Grooming (GRM) Events” on page 341

LIC Events related to licensing for video 
operations.

“Licensing (LIC) Events” on page 343

CFG Events related to configuration “Configuration (CFG) Events” on page 344

ELM Events related to Event and Alarm 
management.

“Event/Alarm Manager (ELM) Events” on 
page 344

AAA Security events for Authentication, 
Authorization, and Accounting operations.

“Security (AAA) Events” on page 345

PGSUB Events related to program substitution. See also “Program Substitution (PgSub) Events” 
on page 347
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VMG Alarm and Event Model

Alarms represent persistent error conditions due to faults in the VMG. Events are used to signify the 
start of a fault condition and raise an alarm. After a fault condition is resolved, another event is used to 
signify the end of the fault condition and clear the alarm. Alarms are cleared only by resolving the fault 
condition, not by an operator performing an administrative action. An alarm can be acknowledged by 
an operator allowing them to indicate that an alarm is known. The VMG records the acknowledgement 
of the alarm and performs no further processing on it.

Alarms and events are identified by area (or category) and type. Some alarms and events also include 
an instance parameter used to differentiate between identical components in the system. For example, 
the Fan_Not_Present event includes an instance parameter that indicates which fan in the system the 
alarm or event refers to. Other alarms and events include parameters that are simply used to provide 
specific information about the alarm or event.

VMG Alarm and Event Severity Levels

Severity levels reported by the VMG, for alarms and events, as listed in Table 139.

Table 139. VMG alarm and event severity levels 

Severity Description

Critical A severe, service-affecting condition has occurred and immediate corrective action is 
imperative.

Major Hardware or software conditions that indicate a serious disruption of service, or the 
malfunctioning or failure of important hardware or software. Requires immediate attention 
and response to restore or maintain system functionality.

Minor For issues that do not have a serious effect on service to customers or are not essential to 
the operation of the system.

Info To raise attention to a condition that could possibly be an impending problem, or to notify 
the customer of an event that improves operation.
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VMG Hardware Alarms

CARD_FAILURE  
Card in main slot <SlotNum> has failed.

Explanation: The card in the specified slot has failed. No services are available
Severity:  CRITICAL

Recommended Action(s): Replace the card in the affected slot.

CARD_NOT_PRESENT  
No card in slot <slot#>with slot admin status <AdminStatus>.

Explanation: A card that is administratively enabled is not present. 
Severity:  CRITICAL
Recommended Action(s): Check that the card is present and working in the specific slot. If 

not, insert a working card. If the slot is meant to be empty, set the admin status 
of the slot to Disabled.

CARD_OPER_DOWN  
Card in main slot<SlotNum> is operationally down.

Explanation: A card that is administratively enabled is operationally down.
Severity:  CRITICAL
Recommended Action(s): (1) Verify the card in the specified slot has cables connected from 

enabled ports to active devices. (2) Verify that persistent storage (flash) has not 
been corrupted and it contains valid copies of kernel and application code, and 
configuration data. 

CARD_OVERHEAT  
Card in main slot <slot#> Current temp=<CurrentTemp#> exceeded 
threshold temp <ThresholdTemp#)>

Explanation: Card temperature exceeds the threshold.
Severity:  CRITICAL
Recommended Action(s): (1) Check ambient temperature. (2) Check air flow.

CARD_TYPE_MISMATCH  
Card in main slot <SlotNum> does not match configured type. 
Actual type is <Actual CardType>. Configured type is 
<ConfiguredCardType>.

Explanation: The card in the specified slot does not match the preconfigured card type. 
Severity:  MAJOR
Recommended Action(s): Either replace the card in the specified slot with the proper card 

type, or change the configuration of the specified slot to match the currently 
installed card type. 
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CFG_OUT_OF_SYNC  
The configuration on standby NPM are out of sync.

Explanation: The configuration on standby NPM is out of sync.
Severity:  CRITICAL
Recommended Action(s): Check the configuration at both NPMs. 

CHASSIS_OVERHEAT  
Chassis has overheated. Current temp=<CurrentTemp#> exceeded 
threshold temp=<Threshold Temp#)>

Explanation: VMG chassis temperature exceeds the threshold.
Severity:  CRITICAL
Recommended Action(s): (1) Check ambient temperature. (2) Check air flow. (3) Remove 

unused components. 

CHASSIS_TEMP  
Cooling state of chassis is <CoolingState>

Explanation: Chassis cooling state is ‘cooling state.’
Severity:  OTHER
Recommended Action(s): N/A

CHASSIS_TEMP_CRITICAL  
Cooling state of chassis is Critical.

Explanation: Alarm status of chassis cooling state is critical.
Severity:  CRITICAL
Recommended Action(s): Telnet from active NPM into 10.0.1.15 or 10.0.2.15 (depending on 

active NPM slot) and execute the command 'clia shelf -v cs' to get list 
of sensors in critical state.

CHASSIS_TEMP_MAJOR  
Cooling state of chassis is Major.

Explanation: Alarm status of chassis cooling state is major. 
Severity:  MAJOR
Recommended Action(s): Telnet from active NPM into 10.0.1.15 or 10.0.2.15 (depending on 

active NPM slot) and execute the command 'clia shelf -v cs' to get list of sensor 
in critical state.

CHASSIS_TEMP_MINOR  
Cooling state of chassis is Minor.

Explanation: Alarm status of chassis cooling state is minor. 
Severity:  MINOR
Recommended Action(s): Telnet from active NPM into 10.0.1.15 or 10.0.2.15 (depending on 

active NPM slot) and execute the command 'clia shelf -v cs' to get list of sensor 
in critical state.
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FAN_NOT_PRESENT  
No fan (or fan tray) present in slot <SlotNum>.

Explanation: The specified slot does not contain a fan or fan tray. 
Severity:  CRITICAL
Recommended Action(s): Install a fan or fan tray in the specified slot. 

POWER_SUPPLY_NOT_PRESENT  
No power supply <PEMType> present in slot <slot#>

Explanation: A power supply (power entry module: PEM) is not present.
Severity:  CRITICAL
Recommended Action(s): Install a power supply in the specified slot. 

POWERSUPPLY_NOT_PRESENT  
No power supply (PEM) present in slot <SlotNum>.

Explanation: A power supply (power entry module: PEM) is not present in the specified slot.
Severity:  CRITICAL
Recommended Action(s): Install a power entry module in the specified slot. 

SHELFMGR_NOT_PRESENT  
No shelf manager in slot <SlotNum>.

Explanation: A shelf manager is not present in the specified slot.
Severity:  CRITICAL
Recommended Action(s): Install a shelf manager in the specified slot. 

SYS_NOT_REDUNDANT  
System not redundant.

Explanation: The system does not currently support redundancy.
Severity:  CRITICAL
Recommended Action(s): Install two working NPMs in the VMG chassis and ensure they 

are configured for redundancy. 

Interface and Port (IF_PORT) Alarms 

CFG_PORT_MIRROR_DISABLE  
Config change: <p n="PortType"/> port <p n="PortNum"/> is 
mirror-to disabled

Explanation: A port mirror is changed to disabled. 
Severity:  INFO
Recommended Action(s): N/A
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CFG_PORT_MIRROR_ENABLE  
Config change: <p n="PortType"/> port <p n="PortNum"/> is 
mirror-to enabled

Explanation: A port mirror is changed to enabled. 
Severity:  INFO
Recommended Action(s): N/A

PORT_OPER_DOWN  
<PortType> port <PortNum> is operationally down with admin 
status <AdminStatus>

Explanation: A port that is administratively enabled is operationally down.
Severity:  MAJOR
Recommended Action(s): Verify the specified port has a cable connected to an active device. 

VMG Hardware Events

ACT_CARD_RESET  
Action: Card in main slot <SlotNum> reset.

Explanation: The specified card has been reset. 
Severity:  INFO
Recommended Action(s): N/A

ACT_SET_TIME  
Action: current time set to <CurrentTime>.

Explanation: The current time has been reset by a VMG Element Manager operator. 
Severity:  INFO
Recommended Action(s): N/A

ACT_SWO_STARTED  
Action: A switchover has started due to <SwitchoverReason>.

Explanation: A switchover has begun.
Severity:  MAJOR
Recommended Action(s): N/A

ACT_SYSTEM_REBOOT  
Action: System rebooted.

Explanation: The system was rebooted.
Severity:  INFO
Recommended Action(s): N/A
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ACT_SYSTEM_SHUTDOWN  
Action: System shutdown.

Explanation: The system was shut down.
Severity:  INFO
Recommended Action(s): N/A

CARD_FAILURE  
Card in main slot <SlotNum> has failed.

Explanation: The card in the specified slot has failed. No services are available
Severity:  CRITICAL
Recommended Action(s): Replace the card in the specified slot. 

CARD_NOT_PRESENT  
No card present in slot <SlotNum> with slot admin status 
<AdminStatus>.

Explanation: An administratively enabled card is not present in the specified slot. 
Severity:  CRITICAL
Recommended Action(s): Insert a working card in the specified slot. If the slot is meant to be 

empty, set the admin stats of the slot to disabled. 

CARD_OPER_DOWN  
Card in main slot <SlotNum> is operationally down.

Explanation: A card is operationally down in the specified slot.
Severity:  INFO
Recommended Action(s): N/A

CARD_OPER_UP  
Card in main slot <SlotNum> is operationally up.

Explanation: Status of the specified card is operationally up. 
Severity:  INFO
Recommended Action(s): N/A

CARD_PRESENT  
Card present in main slot <SlotNum>.

Explanation: A card is present in the specified slot.
Severity:  INFO
Recommended Action(s): N/A

CARD_RESET_DL_DOWN  
Action: Card in main slot <SlotNum> reset due to internal (DL) 
error.

Explanation: The card in the specified slot has been reset, due to an internal (DL) error. 
This event is reported to the trap server.

Severity:  MAJOR
Recommended Action(s): N/A
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CARD_RESET_FAILED  
Reset of card in main slot <SlotNum> failed.

Explanation: A reset operation on the specified card has failed. 
Severity:  CRITICAL
Recommended Action(s): Replace the specified card. 

CARD_RESET_PPC_LOST  
Action: Card in main slot <SlotNum> reset due to loss of PPC 
heartbeat.

Explanation: The card in the specified slot has been reset, due to loss of PPC heartbeat.
This event is reported to the trap server. 

Severity:  MAJOR
Recommended Action(s): N/A

CARD_RESET_SUCCEEDED  
Reset of card in main slot <SlotNum> succeeded.

Explanation: A reset operation on the specified card was successful.
Severity:  INFO
Recommended Action(s): N/A

CARD_TYPE_MISMATCH  
Card in main slot <SlotNum> does not match configured type. 
Actual type is <ActualCardType>. Configured type is 
<ConfiguredCard Type>.

Explanation: The card in the specified slot does not match the pre-configured card type. 
Severity:  MAJOR
Recommended Action(s): Either replace the card in the specified slot with the proper card 

type, or change the configuration of the specified slot to match the currently 
installed card type. 

CFG_CARD_ADMIN_DISABLED
Config change: Card in main slot <SlotNum> admin disabled.

Explanation: Configuration change: the card in the specified slot was administratively 
disabled. 

Severity:  INFO
Recommended Action(s): N/A

CFG_CARD_ADMIN_ENABLED
Config change: Card in main slot <SlotNum> admin enabled.

Explanation: Configuration change: the card in the specified slot was administratively 
enabled. 

Severity:  INFO
Recommended Action(s): N/A
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CFG_NTP_IPADDR  
Config changed: IP address for NTP server.

Explanation: Configuration change: the IP address for an NTP server has been changed. 
Severity:  INFO
Recommended Action(s): N/A

CFG_SWO_ENABLED  
Config change: System switchover is enabled.

Explanation: Configuration change: system switchover is now enabled.
Severity:  INFO
Recommended Action(s): N/A

CFG_SWO_INHIBITED  
Config change: System switchover is inhibited.

Explanation: Configuration change: system switchover is inhibited.
Severity:  INFO
Recommended Action(s): N/A

CFG_Timezone  
Config changed: Time zone is now <TimeZone>.

Explanation: Configuration change: the system time zone has been changed. 
Severity:  INFO
Recommended Action(s): N/A

CHASSIS_TEMP_CRITICAL  
Cooling state of chassis is Critical.

Explanation: Status of the chassis temperature is now critical severity.
Severity:  CRITICAL
Recommended Action(s): N/A

CHASSIS_TEMP_MAJOR  
Cooling state of chassis is Major

Explanation: Status of the chassis temperature is now major severity. 
Severity:  MAJOR
Recommended Action(s): N/A

CHASSIS_TEMP_MINOR  
Cooling state of chassis is Minor

Explanation: Status of the chassis temperature is now minor severity. 
Severity:  MINOR
Recommended Action(s): N/A
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FAN_NOT_PRESENT  
No fan (or fan tray) present in slot <SlotNum>.

Explanation: The specified slot does not contain a fan or fan tray.
Severity:  CRITICAL
Recommended Action(s): Install a fan or fan tray in the specified slot. 

FAN_PRESENT  
Fan (or fan tray) present in slot <SlotNum>.

Explanation: A fan or fan tray is present in the specified slot. 
Severity:  INFO
Recommended Action(s): N/A

NPM_ACTIVE  
NPM card in slot <SlotNum> is now active.

Explanation: The NPM in the specified slot is now in active state.
Severity:  INFO
Recommended Action(s): N/A

NPM_STANDBY  
NPM card in slot <SlotNum> is now standby.

Explanation: The NPM in the specified slot is now in standby state. 
Severity:  INFO
Recommended Action(s): N/A

POWERSUPPLY_NOT_PRESENT  
No power supply (PEM) present in slot <SlotNum>.

Explanation: A power entry module (PEM) is not present in the specified slot.
This event applies only to the VMG-14.

Severity:  CRITICAL
Recommended Action(s): Install a PEM in the specified slot of the VMG-14. 

POWERSUPPLY_NOT_PRESENT  
No power supply <PEMType> present in slot <SlotNum>.

Explanation: Power supply is not present in the VMG.
Severity:  CRITICAL
Recommended Action(s): Verify hardware. 

POWERSUPPLY_PRESENT  
Power supply (PEM) present in slot <SlotNum>.

Explanation: A PEM is present in the specified slot. 
Severity:  INFO
Recommended Action(s): N/A
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SHELFMGR_NOT_PRESENT  
No shelf manager present in slot <SlotNum>.

Explanation: A shelf manager is not present in the specified slot.
Severity:  CRITICAL
Recommended Action(s): Install a shelf manager in the specified slot. 

SHELFMGR_PRESENT  
Shelf manager present in slot <SlotNum>.

Explanation: A shelf manager is present in the specified slot. 
Severity:  INFO
Recommended Action(s): N/A

SWO_FAILED  
Switchover failed.

Explanation: The switchover operation failed.
Severity:  CRITICAL
Recommended Action(s): Reboot the system.

SWO_SUCCEEDED  
Switchover completed successfully and NPM in slot <SlotNum> is 
active.

Explanation: The switchover operation has succeeded. 
Severity:  INFO
Recommended Action(s): N/A

SYS_FULLY_REDUNDANT  
System is fully redundant.

Explanation: The system is fully redundant: two NPMs are installed and operational. One 
NPM is active, and the other is in standby mode. 

Severity:  INFO
Recommended Action(s): N/A

SYS_NOT_REDUNDANT  
System not redundant.

Explanation: The system is not currently supporting NPM redundancy, and redundancy was 
expected. 

Severity:  CRITICAL
Recommended Action(s): Install two working NPMs in the VMG chassis, and ensure they 

are configured for redundancy. 
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Interface and Port (IF_PORT) Events

CFG_DATA_PORT  
Config changed: Auto negotiation on <PortType> port <PortNum> 
changed to <auto_neg>.

Explanation: Configuration change: the auto negotiation settings for the specified port has 
changed. 

Severity:  INFO
Recommended Action(s): N/A

CFG_GROOM_GRP  
Config changed: Port Group Gige 1-Gige 8 is admin 
<AdminState1>; Port group 10 Gige 1 is admin <AdminState2>;Port 
group 10 Gige 2 is admin <AdminState3>.

Explanation: Configuration change: A modification has occurred on the grooming group. 
Severity:  INFO
Recommended Action(s): N/A

CFG_IF  
Configuration changed for interface on <PortType> <IfId>.

Explanation: Configuration change: the configuration of the specified interface has been 
modified. 

Severity:  INFO
Recommended Action(s): N/A

CFG_IF_ADD  Interface created on <PortType> <IfId>.

Explanation: Configuration change: the specified interface was created. 
Severity:  INFO
Recommended Action(s): N/A

CFG_IF_DEL  Interface deleted on <PortType> <IfId>.

Explanation: Configuration change: the specified interface was deleted. 
Severity:  INFO
Recommended Action(s): N/A

CFG_MGMT_IF  
Config change: Mgmt interface to IP address <ipAddr>, net mask 
<netMask>, and gateway <defGway>.

Explanation: Configuration change: changes were made to the specified management 
interface. 

Severity:  INFO
Recommended Action(s): N/A
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CFG_PORT_ADMIN_DISABLED  
Config change: <PortType> port <PortNum> is admin disabled.

Explanation: Configuration change: the administrative status of the specified port was 
disabled. 

Severity:  INFO
Recommended Action(s): N/A

CFG_PORT_ADMIN_ENABLED  
Config changed: <PortType> port <PortNum> is admin enabled.

Explanation: Configuration change: the administrative status of the specified port was 
enabled. 

Severity:  INFO
Recommended Action(s): N/A

IF_OPER_DOWN  
Interface on <PortType> <IfId> is operationally down.

Explanation: The status of the specified interface is operationally down. The status of an 
interface matches that of the port on which it is configured. 

Severity:  INFO
Recommended Action(s): change the status of the port on which the specified interface is 

configured. 

IF_OPER_UP  
Interface on <PortType> <IfId> is operationally up.

Explanation: The status of the specified interface is operationally up. 
Severity:  INFO
Recommended Action(s): N/A

PORT_OPER_DOWN  
<PortType> port <PortNum> with admin status <AdminStatus> is 
operationally down.

Explanation: The status of the specified port is operationally down.
Severity:  INFO
Recommended Action(s): Verify there is a cable connected from the specified port to an 

active network device. 

PORT_OPER_UP  
<PortType> port <PortNum> is operationally up.

Explanation: The status of the specified port is operationally up.
Severity:  INFO
Recommended Action(s): N/A
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Video Processing (MPEG) Events

CFG_InEs  
InEs modified: TS <InTsIdx><InTsIp><InTsUdp> PG 
<InPgIdx><InPgName><InPgNum> ES <InEsIdx> Pid <InEsPid>.

Explanation: An input elementary stream was modified.
Severity:  INFO
Recommended Action(s): N/A

CFG_InEs_ADD  
InEs created: TS <InTsIdx><InTsIp><InTsUdp> PG 
<InPgIdx><InPgName><InPgNum>.

Explanation: An input elementary stream was created.
Severity:  INFO
Recommended Action(s): N/A

CFG_InEs_DEL  
InES deleted: TS <InTsIdx><InTsIp><InTsUdp> PG 
<InPgIdx><InPgName><InPgNum> ES <InEsIdx> Pid <InEsPid>.

Explanation: An input elementary stream was deleted.
Severity:  INFO
Recommended Action(s): N/A

CFG_InPgm  
InPg modified: TS <InTsIdx><InTsIp><InTsUdp> PG 
<InPgIdx><InPgName><InPgNum>

Explanation: An input program was modified.
Severity:  INFO
Recommended Action(s): N/A

CFG_InPgm_ADD  
InPg created: TS <InTsIdx><InTsIp><InTsUdp> PG 
<InPgIdx><InPgName><InPgNum>

Explanation: A ghost input program was created.
Severity:  INFO
Recommended Action(s): N/A

CFG_INPgm_DEL  
InPg deleted: TS <InTsIdx><InTsIp><InTsUdp> PG 
<InPgIdx><InPgName><InPgNum>.

Explanation: An input program was deleted.
Severity:  INFO
Recommended Action(s): N/A
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CFG_InTS  
InTS modified: Index <InTsIdx> Port <PortNum> IP <IP> UDP 
<UDP>.

Explanation: An input transport stream was modified.
Severity:  INFO
Recommended Action(s): N/A

CFG_InTS_ADD  
InTS created: Index <InTsIdx> Port <PortNum> IP <IP> UDP <UDP>,

Explanation: An input transport stream was created.
Severity:  INFO
Recommended Action(s): N/A

CFG_InTS_DEL  
InTS deleted: Index <InTsIdx> Port<PortNum> IP <IP> UDP <UDP>.

Explanation: An input transport stream was deleted. 
Severity:  INFO
Recommended Action(s): N/A

CFG_OutEs  
OutEs modified: TS <OutTsIdx><OutTsIp><OutTsUdp> PG 
<OutPgIdx><OutPg Name><OutPgNum> ES <OutEsIdx> Pid <OutEsPid>.

Explanation: An output ES was modified.
Severity:  INFO
Recommended Action(s): N/A

CFG_OutEs_ADD  
OutEs created: TS <OutTsIdx><OutTsIp><OutTsUdp> PG 
<OutPgIdx><OutPg Name><OutPgNum> ES <OutEsIdx> Pid <OutEsPid>.

Explanation: An output ES was created.
Severity:  INFO
Recommended Action(s): N/A

CFG_OutEs_DEL  
OutEs deleted: TS <OutTsIdx><OutTsIp><OutTsUdp> PG 
<PutPgIdx><OutPg Name><OutPgNum> ES <OutEsIdx> Pid <OutEsPid>.

Explanation: An output ES was deleted.
Severity:  INFO
Recommended Action(s): N/A
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CFG_OutPgm  
OutPg modified: TS <OutTsIdx> PG <OutPgIdx> Name <Name> Num 
<Num>.

Explanation: An output program was modified.
Severity:  INFO
Recommended Action(s): N/A

CFG_OutPgm_Add  
OutPg created: TS <OutTsIdx> PG <OutPgIdx> Name <Name> Num 
<Num>.

Explanation: An output program was created.
Severity:  INFO
Recommended Action(s): N/A

CFG_OutPgm_DEL  
OutPg deleted: TS <OutTsIdx> PG <OutPgIdx> Name <Name> Num <Num>.

Explanation: An output program was deleted.
Severity:  INFO
Recommended Action(s): N/A

CFG_OutTS_ADD  
OutTS created: Index <OutTsIdx> Port <PortNum> IP <IP> UDP <UDP>.

Explanation: An output transport stream was created.
Severity:  INFO
Recommended Action(s): N/A

CFG_OutTS_DEL  
OutTS deleted: Index <OutTsIdx> Port <PortNum> IP <IP> UDP <UDP>.

Explanation: An output transport stream was deleted.
Severity:  INFO
Recommended Action(s): N/A

CFG_OutTS_MODIFY 
OutTS modified: Index<OutTsIdx> Port<PortNum> IP <IP> UDP <UDP>.

Explanation: An output transport stream was modified.
Severity:  INFO
Recommended Action(s): Verify output TS. 

In_TS_NIT_Miss_clear  
InTs (Gige <port>, <ipAddr>/<udp>) NIT recovered.

Explanation: The DVB Network Information Table was recovered for the input transport 
stream. 

Severity:  INFO
Recommended Action(s): N/A
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In_TS_NIT_Miss_Set  
InTs (Gige <port>, <ipAddr>/<udp>) NIT missing.

Explanation: The DVB Network Information Table timed out for the input transport stream.
Severity:  INFO
Recommended Action(s): N/A

In_TS_SDT_Miss_Clear  
InTs (Gige <port>, <ipAddr>/<udp>) SDT recovered.

Explanation: DVB Service Description Table recovered for the input transport stream. 
Severity:  INFO
Recommended Action(s): N/A

In_TS_SDT_Miss_Set  
InTS (Gige <port>, <ipAddr><udp>) SDT missing.

Explanation: DVB Service Description Table timed out for the input transport stream.
Severity:  INFO
Recommended Action(s): Source issue. Analyze the upstream stream. 

Input_Audio_Loss  
InTs: Audio underflow TS <InTsIdx> Port <PortNum> IP <IP> UDP 
<UDP> Pid <APID>.

Explanation: Audio underflow was detected for the specified input. This message identifies 
when a video elementary stream has detected no bitrate or packets on a defined 
PID. 
This event is report to the trap server. 

Severity:  MINOR
Recommended Action(s): Verify the TS.

Input_Mismatch  
The input <"reason" > <"state" > the configuration of the 
output_Ts at Port <PortNum"> IP <"IP"> UDP <"UDP"> 

Explanation: Input video mismatch with the configuration. 
Severity:  MAJOR
Recommended Action(s): Verify configuration

Input_TS_Missing  
InTS: Missing <state> TS <InTsIdx> Port <PortNum> IP <IP> UDP 
<UDP>.

Explanation: A transport stream was missing for the specified input. This message identifies 
when a video elementary stream has detected no bitrate or packets on a defined 
PID. 
This event is reported to the trap server. 

Severity:  MAJOR
Recommended Action(s): Verify the TS. 
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Input_Video_Encrypted  
InTS: Video encrypted, no transrating possible slot <Slot> port 
<Port> IP <IP> UDP <UDP> Prog <PROG>.

Explanation: The input video appears encrypted. Transrating is not possible.
Severity:  INFO
Recommended Action(s): Contact RGB Customer Support.

Input_Video_Loss  
InTs: Video underflow TS <InTsIdx> Port <PortNum> IP <IP> UDP 
<UDP> Pid <VPID>.

Explanation: Video underflow was detected for the specified input. This message identifies 
when a video elementary stream has detected no bitrate or packets on a defined 
PID. 

Severity:  MINOR
Recommended Action(s): Verify the TS. 

Out_TS_TDT_Miss_Clear  
OutTS (Gige <port>, <ipAddr>/<udp>) NIT source recovered.

Explanation: DVB Network Information Table recovered for the output transport stream. 
Severity:  INFO
Recommended Action(s): N/A

Out_TS_TDT_Miss_Clear  
OutTs (Gige <port>, <ipAddr><udp>) TDT source recovered.

Explanation: DVB Time and Date Table source recovered for the output transport stream.
Severity:  INFO
Recommended Action(s): N/A

Out_TS_TDT_Miss_Set  
OutTs (Gige <port>, <ipAddr>/<udp>) TDT source missing.

Explanation: DVB Time and Date Table source timed out for the output transport stamp.
Severity:  INFO
Recommended Action(s): N/A

Out_TS_TOT_Miss_Clear  
OutTS (Gige <port>, <ipAddr>/<udp>) TOT source recovered.

Explanation: DVB Time Offset Table source recovered for the output transport stream.
Severity:  INFO
Recommended Action(s): N/A

Out_TS_TOT_Miss_Set  
OutTS (Gige <port>, <ipAddr><udp>) TOT source missing.

Explanation: DVB Time Offset Table source timed out for the output transport stream.
Severity:  INFO
Recommended Action(s): N/A
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Out_TS-NIT_Miss_Set  
OutTS (Gige <port>, <ipAddr>/<udp>) NIT source missing.

Explanation: DVB Network Information Table timed out for the output transport stream.
Severity:  INFO
Recommended Action(s): N/A

Output_IDR_Error  
Port (<port#>, OTS<O/P TS IP>, <O/P TS Port>, Prog nos <O/P 
Prog#>, ES Pid <ES PID>, has IDRjump: <IDR Gap error counter>

Explanation: The packet drop error of the TMUX is over the threshold. The counter is 
provided. 

Severity:  MAJOR
Recommended Action(s): N/A

OUTPUT_ES_ERROR  
Port (<port#>, OTS<O/P TS IP>, <O/P TS Port>, Prog nos <O/P 
Prog#>, ES Pid <ES PID>, has Resplice DTSjump:<DTS jump error 
counter>

Explanation: Reported on the input transport stream because the output ES groomed from this 
input has DTS jump errors, due to input ES errors. 
This event is reported to the trap server. 

Severity:  MAJOR
Recommended Action(s): N/A

Output_ES_ERROR  
Port (<port#>, OTS<O/P TS IP>, <O/P TS Port>, Prog nos <O/P 
Prog#>, ES Pid <ES PID>, has PCRrst:<PCR reset error counter>

Explanation: Reported to signal the Timing module reset (PCR reset) error caused by certain 
errors in the input program. The counter is provided. 
This event is reported to the trap server. 

Severity:  MAJOR
Recommended Action(s): N/A

OUTPUT_RESPLICE  
Port (<port#>, OTS<O/P TS IP>, <O/P TS Port>, Prog nos <O/P 
Prog#>, ES Pid <ES PID>, has Resplice PCR:<PCR error counter>

Explanation: Reported on the input transport stream because the output ES groomed from this 
input has PCR errors, due to input errors. 
This event is reported to the trap server. 

Severity:  MAJOR
Recommended Action(s): N/A
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OUTPUT_RESPLICE  
Port (<port#>, OTS<O/P TS IP>, <O/P TS Port>, Prog nos <O/P 
Prog#>, ES Pid <ES PID>, has Resplice UndR:<Underflow error 
counter>

Explanation: Reported to signal the underflow error of the output program is over the 
threshold. The counter is provided. 

Severity:  MAJOR
Recommended Action(s): N/A
Recommended Action(s): 

OutTS_oversub_cir  
TS <TsIdx> Port <PortNum> IP <IP> <UDP> oversubscription CLEAR.

Explanation: The output transport stream bitrate oversubscription ends. 
Severity:  MAJOR
Recommended Action(s): Contact RGB Customer Support.

outTS_oversub_set  
TS <TsIdx> Port <PortNum> IP <IP> UDP <UDP> oversubscription 
SET (bitrate is <bitrate> kbps).

Explanation: The output transport stream bitrate exceeds the configured threshold value. 
Severity:  MAJOR
Recommended Action(s): N/A

PGRED_FAILOVER2BKUP_FAIL  
Input Program (Gige<port>, <ipAddr>/<udp>, <pgNum>) failed to 
switchover to backup

Explanation: The event is venerated when primary input program is missing/timed out and 
the configured backup program is not available.
This event is reported to the trap server. 

Severity:  INFO
Recommended Action(s): N/A

V6_AUDIO_CC_ERROR  
V6 Session:<Session ID>, Output:<Transport name> Audio stream 
detected <PARM3> MPEG2TS continuity error(s) in last 60 
seconds.

Explanation: This event is reported every 60 seconds when continuity errors are detected in 
the audio stream. This signifies that the input has issues, and the user should 
ensure the input signal is clean. 

Severity:  INFO
Recommended Action(s): N/A
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V6_AUDIO_DECODE_FAILED  
V6 Session:<Session ID>, Output:<Transport name> Audio decode 
failed for <PARAM3> frame(s) in last 60 seconds

Explanation: The event is reported every 60 seconds when audio frames cannot be decoded. 
This signifies that the input has issues and the user should ensure that the input 
signal is clean. 

Severity:  INFO
Recommended Action(s): N/A

V6_AV_DISCARD_PACKET  
V6 Session:<Session ID>, Output:<Transport name> Audio/Video 
discard <number of packets discarded> packet(s) in last 60 
seconds

Explanation: This event is reported every 60 seconds when an extra packet is received 
unexpectedly. This signifies that the input has a possible extra PID and the user 
should make sure the input port is not use by other SPTS. This can also happens 
if the SPTS has a lot of extra PIDs not used for transcoding.

Severity:  INFO
Recommended Action(s): N/A

V6_FAIL_DETECT  
V6 event Session: <Session ID>, Detection failed.

Explanation: This event occurs when adding a session fails because the session cannot be 
detected.

Severity:  INFO
Recommended Action(s): N/A

V6_FAIL_INPUT_SETUP  
V6 event Session: <Session ID>, Input <Input address> cannot be 
created.

Explanation: This event occurs when adding a session fails because the input stream cannot 
be created (possible socket creation error).

Severity:  INFO
Recommended Action(s): N/A

V6_FAIL_NOT_SUPPORTED  
V6 event Session: <Session ID>, The codec or attributes that 
prevents the session for being added is not supported

Explanation: This event occurs when adding a session fails because the session codec or other 
attribute is not supported.

Severity:  INFO
Recommended Action(s): N/A
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V6_FAIL_OTHER  
V6 event Session: <Session ID>, <Failure Reason>

Explanation: This event occurs when adding a session fails because of reasons not explicitly 
defined. 

Severity:  INFO
Recommended Action(s): N/A

V6_FAIL_OUTPU_SETUP  
V6 event Session: <Session ID>, Output: <Output address> cannot 
be created.

Explanation: This event occurs when adding a session fails because the output stream cannot 
be created (possible socket creation error). 

Severity:  INFO
Recommended Action(s): N/A

V6_LONG_TIME_GAP  
V6 Session: <Session ID>, Output: <Transport name> Audio decode 
detected <number of gaps detected> long time gap(s) (>200ms) in 
last 60 seconds

Explanation: This event is reported every 60 seconds when long time gaps (>200 ms) are 
detected in the audio stream. 

Severity:  INFO
Recommended Action(s): N/A

V6_OUTPU_MISMATCH  
V6 event Output warning: <warning cause>, Session: <Session_ID> 
Step: <Step number>, Output: <output file>

Explanation: This event reports a problem in the generation of an output (file output only). 
Severity:  INFO
Recommended Action(s): N/A

V6_OUTPU_PACKET_ERROR  
V6 Session:<Session ID>, Output:<Transport name> Audio/Video 
unable to output <Number of packets that could not be sent out> 
packet(s) in last 60 seconds

Explanation: This event is reported every 60 seconds when AV packets can't be decoded. This 
signifies that the input has issues and the user should make sure the input signal 
is clean.

Severity:  INFO
Recommended Action(s): N/A
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V6_OUTQUEUE_10PERCENT  
V6 event Queue for session: <Session ID>, Output: <Transport 
name> has reached 10% full.

Explanation: This event occurs when the input queue to ffmpeg reaches 10% full (3.3 million 
bytes).

Severity:  INFO
Recommended Action(s): N/A

V6_OUTQUEUE 50PERCENT  
V6 event Queue for session: <Session ID>, Output: <Transport 
name> has reached 50% full.

Explanation: This event occurs when the input queue to ffmpeg reaches 50% full (16.5 
million bytes).

Severity:  MAJOR
Recommended Action(s): N/A

V6_OUTQUEUE 90PERCENT  
V6 event Queue for session: <Session ID>, Output: <Transport 
name> has reached 90% full. Sever progressing delay. User 
experience degraded. Workload reduction required for proper 
operation. 

Explanation: This event occurs when the input queue to ffmpeg reaches 90% full (29.7 
million bytes).

Severity:  CRITICAL
Recommended Action(s): N/A

V6_PCR_GREATER_DTS  
V6 Session:<Session ID> Output:<Transport name> Audio stream 
detected <number of errors detected> PCR>DTS error(s) in last 
60 seconds

Explanation: The event is reported every 60 seconds when PCR is bigger than DTS. This 
typical of poorly muxed input streams that suffer disruption or a jump. 

Severity:  INFO
Recommended Action(s): N/A

V6_RCSTART_NOT_FOUND  
V6 event Unable to find /etc/rcstart file… could not startup.

Explanation: This Task Manager event indicates that the /etc/rcstart file was not found 
(probably due to an installation problem). 

Severity:  CRITICAL
Recommended Action(s): N/A
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V6_SESMGR_STP_COMPLETED  
V6 event Completed <workflowName+Step number>, Session: 
<session ID+Workorder ID>, Output: <output file>, Transcoder: 
<Transcoder in-use>, Execution time: <execution time>.

Explanation: This event reports the completion of a session step.
Severity:  INFO
Recommended Action(s): N/A

V6_SESMGR_STEP_FAILURE  
V6 event Failed <WorkflowName+Step number>, Session: <Session 
ID+WorkOrder ID>, Output: <Output file>, Transcoder: 
<Transcoder that failed (error: error_code).

Explanation: This event reports a session step failure. 
Severity:  INFO
Recommended Action(s): N/A

V6_SESMGR_STEP_START  
V6 event Started <workflowName+Step number>, Session: <session 
ID>, Work Order: <workorder ID>, Output: <output file>, 
Transcode: <Transcoder in-use>.

Explanation: This event reports a session step starting.
Severity:  INFO
Recommended Action(s): N/A

V6_SESMGR_WO_RESULT  
V6 event Completed <workorder ID>, Session:<session ID>, 
Workflow: <workflow name>, Input: <input file>, Result: 
<result+ execution time>

Explanation: This event signals the completion (successful or not) of a work order. 
Severity:  INFO
Recommended Action(s): N/A

V6_SESMGR_WO_START  
V6 event Started <workorder ID>, Session: <session ID>, 
Workflow: <workflow name>, Input: <input file>

Explanation: This event signals the start of a work order. 
Severity:  INFO
Recommended Action(s): N/A
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V6_SHORT_TIME_GAP  
V6 Session: <Session ID>, Output:<Transport name> Audio decode 
detected <number of gaps detected> short time gap(s) (<200ms) 
in last 60 seconds.

Explanation: This event is reported every 60 seconds when short time gaps (<200ms) are 
detected in the audio stream.

Severity:  INFO
Recommended Action(s): N/A

V6_STREAM_FPS_TOO_LOW  
V6 event Session: <Session ID>, Output: <Transport name>, is 
not transcoding real-time actual fps: <Actual FPS> / target 
fps: <Target FPS>.

Explanation: This event occurs when the input queue to Mpeg2TsDmx reaches 90% full (29.7 
million bytes). 

Severity:  INFO
Recommended Action(s): N/A

V6_TASK_COMM_FAILURE  
V6 event Internal communication problem.

Explanation: This event is reported by any task if it detects problems with inter-task 
communication. 

Severity:  CRITICAL
Recommended Action(s): N/A

V6_TASK_FAILED 
V6 event The tasks have failed.

Explanation: This Task Manager event indicates that a particular task has failed. 
Severity:  CRITICAL
Recommended Action(s): N/A

V6_TASK_OUT_OF_MEMORY  
V6 event Out of memory, exiting

Explanation: This event is reported by any task that runs out of memory.
Severity:  CRITICAL
Recommended Action(s): N/A

V6_TASK_RUNNING  
V6 event The task <param1> is running.

Explanation: This Task Manager event indicates that a particular task is now running. 
Severity:  INFO
Recommended Action(s): N/A
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V6_TASK_STARTED  
V6 event The task <param1> was requested to start.

Explanation: This Task Manager event indicates that a particular task has started, by request. 
Severity:  INFO
Recommended Action(s): N/A

V6_TASK_STOPPED  
V6 event The task has stopped.

Explanation: This Task Manager event indicates that a particular task has stopped by request. 
Severity:  INFO
Recommended Action(s): N/A

V6_TASK_STOPPING  
V6 event The task <param1> was requested to stop.

Explanation: This Task Manager event indicates that a particular task has been requested to 
stop but that there is no guarantee that it will stop. This is different from the 
force-stop request. 

Severity:  INFO
Recommended Action(s): N/A

V6_TASK_SYS_UP  
V6 event All tasks started successfully.

Explanation: This Task Manager event indicates that the system has started successfully.
Severity:  INFO
Recommended Action(s): N/A

V6_WRITE_FRAME_FAILED  
V6 Session:<Session ID>, Output:<Transport name> Audio/Video 
unable to write <Number of packets that could not be written> 
frame(s) in last 60 seconds

Explanation: This event is reported every 60 seconds when AV packets cannot be sent out. 
This signifies that the input has issues and the user should ensure the input 
signal is clean. 

Severity:  INFO
Recommended Action(s): N/A

Video_Loss  
Temporary video loss in Ts: <InTsIdx> Port <PortNum> IP <IP> 
UDP <UPD> Pid<VPID>.

Explanation: Video underflow was detected for the specified input. 
This even is reported to the trap server. 

Severity:  MINOR
Recommended Action(s): Verify the TS. 
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Ad Insertion (DPI) Events

Ad_Service_Acc_Denied  
DPI request for program <Name>, which is not DPI enabled.

Explanation: The service name in the DPI request is not DPI-enabled. 
SCTE 103. 

Severity:  MAJOR
Recommended Action(s): Contact RGB Customer Support, and provide the SCTE number. 

Ad_Service_Invalid  
Invalid or unknown program name <Name>.

Explanation: The service name specified in the DPI request is invalid or not found. 
SCTE 102.

Severity:  MAJOR
Recommended Action(s): Contact RGB Customer Support and provide the SCTE number. 

Ad_Video_underflow  
Ad content underflow for program <Name>.

Explanation: Ad content arrived late or not at all for the specified input. 
SCTE 110.

Severity:  MAJOR
Recommended Action(s): Contact RGB Customer Support, and provide the SCTE number. 

Cue_Tone_Invalid  
Invalid Cue tone received for program <Name>.

Explanation: The cue tone received is invalid for the specified input. 
SCTE 117

Severity:  MINOR
Recommended Action(s): Contact RGB Customer Support, and provide the SCTE number. 

SCTE30_Msg_Invalid  
Invalid SCTE 30 message rcvd for Program <Name>.

Explanation: The SCTE 30 message received is invalid for the specified service. 
SCTE 121.

Severity:  MINOR
Recommended Action(s): Contact RGB Customer Support, and provide the SCTE number. 
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Grooming (GRM) Events

PGRED_FAILOVER_TO_BCKUP  
Grooming session (Gige <port>, ipAddr>/<udp>, <pgNum>) failed 
over to backup.

Explanation: A grooming session has failed over to the backup program. 
This event is reported to the trap server. 

Severity:  MAJOR
Recommended Action(s): N/A

CFG_Grm_ADD  
Grooming session <GIdx> ITs<InTslp>/IPg<InPgNum>OTs<OutTsIp>/
<OutTsUdp>OPg<OutPgNum>/<OutPgName> added.

Explanation: A grooming session was created.
Severity:  INFO
Recommended Action(s): N/A

CFG_Grm_DEL  
Grooming session <GIdx> OTs <OutTsIp>/<OutTsUdp> OPg 
<OutPgNum>/<OutPgName> deleted.

Explanation: A grooming session was deleted.
Severity:  INFO
Recommended Action(s): N/A

PG_RED_RECOVER_TO_PRIM  
Grooming session (Gige< port>, <ipAddr>/<udp>, <pgNum>) 
recovered to primary.

Explanation: A grooming session has recovered to the primary program.
Severity:  INFO
Recommended Action(s): N/A

PGRED_FAILOVR2BKUP_FAIL  
Grooming session (Gige <port>. <ipAddr>/ <udp>, <pgNum> 
failover to backup failed.

Explanation: A grooming session failover to backup program has failed.
This event is reported to the trap server. 

Severity:  CRITICAL
Recommended Action(s): N/A

PGRED_FAILOVER_TO_BCKUP  
Grooming session (Gige<port), <ipAddr>/<udp>, <pgNum>) failover 
to backup failed. 

Explanation: A grooming session failover to backup program has failed.
Severity:  MAJOR
Recommended Action(s): N/A
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PGRED_FAILOVR2BKUP_FAIL  
Grooming session (Gige<port>, <ipAddr>/<udp>, <pgNum>) failover 
to backup failed. 

Explanation: A grooming session failover to backup program has failed.
Severity:  CRITICAL
Recommended Action(s): N/A

PG_RED_RECOVER_TO_PRIM  
Grooming session (Gige<port>), <ipAddr>/<udp>, <pgNum>) 
recovered to primary. 

Explanation: A grooming session recovers to the primary program. 
This event is reported to the trap server. 

Severity:  MINOR
Recommended Action(s): N/A

PGRED_GLB_SWITCH_TO_PRIM  
All grooming sessions using back up input source have been 
switched to primary.

Explanation: The user has manually switched all grooming session, using backup-to-primary.
Severity:  INFO
Recommended Action(s): N/A

PGRED_MANSWTCH_TO_BCKUP  
Grooming session (Gige <Port>, <ipAddr>/<udp>,<pgNum>) switched 
to backup.

Explanation: The user has manually switched to a backup program. 
Severity:  INFO
Recommended Action(s): N/A

PGRED_MANSWTCH_TO_PRIM  
Grooming session (Gige <Port>, OTs <ipAddr>/<udp>/<pgNum>) 
switched to primary.

Explanation: The user has manually switched to primary program.
Severity:  INFO
Recommended Action(s): N/A

XCODE_Resolution_CHG  
XC Sess ITS(GigE <port>,<ipAddr>,<pgNum> In Res <ires>) OTS 
(GigE<oport>,<oipSddr>,<opgNum> Out Res<ores>)

Explanation: A resolution change in a transcoding session has occurred.
Severity:  INFO
Recommended Action(s): N/A
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Licensing (LIC) Events

CFG_LicKey  
Config change: LicType “<LICTYPE>” added.

Explanation: A new license key was configured.
Severity:  INFO
Recommended Action(s): N/A

Del_LiKey  
Config Change: Lic Type <LICTYPE> deleted.

Explanation: An existing license key has been deleted.
Severity:  INFO
Recommended Action(s): Verify the TS. 

InTS_ADD_Fail  
ITS create Failed: <InTsIndex>/<Port Num>/<IP>/<UDP>. No base 
license present.

Explanation: An input transport stream creation was rejected, due to licensing restrictions.
Severity:  INFO
Recommended Action(s): Contact RGB Customer Support. 

LiKey_CFG_FAIL  
CDEL_LicKeyonfig failed: LicType “<LICTYPE>” configuration 
failed.

Explanation: Configuration failed for a new license key.
Severity:  MINOR
Recommended Action(s): Contact RGB Customer Support.

LiKey_Error  
Configuration replay failed: Check licensing.

Explanation: Video configuration not applied. Check licensing.
Severity:  MAJOR
Recommended Action(s): Contract RGB Customer Support.

OutPgm_ADD_Fail  
OPg OP FailedTS: <OutTsIndex>/<PortNum>/<IP>/<UDP> 
<OutPgIndex>/<Num>/<LICTYPE>.

Explanation: An output program creation was rejected, due to licensing restrictions.
Severity:  INFO
Recommended Action(s): Contract RGB Customer Support. 
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OutTS_ADD_Fail 
OTS op Failed: <OutTsIndex>/<PortNum>/<IP>/<UDP><LICTYPE> 
unavailable.

Explanation: An output transport stream creation was rejected, due to licensing restrictions. 
Severity:  INFO
Recommended Action(s): Contact RGB Customer Support. 

Configuration (CFG) Events

CHASSIS_TYPE_MISMATCH  
On system boot, found config DB for chassis type <DB_CHASSIS>, 
but current chassis is <CURR_CHASSIS>.

Explanation: The configuration database lists a different type of chassis than the one currently 
in use.

Severity:  MAJOR
Recommended Action(s): N/A

Event/Alarm Manager (ELM) Events

CFG_ELM_global  
Config changed: global.

Explanation: The configuration of the Event and Alarm Manager has been changed. 
Severity:  INFO
Recommended Action(s): N/A

CFG_SYSLOG_global  
Config changed: global.

Explanation: The configuration of the Syslog server has changed. 
Severity:  INFO
Recommended Action(s): N/A

CFG_SYSLOG_svr  
Config change: syslog server.

Explanation: The configuration of the Syslog server has changed.
Severity:  INFO
Recommended Action(s): N/A
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Security (AAA) Events

CFG_GLOBAL_MOD  
One of more global attributes have been changed.

Explanation: Configuration change: one or more AAA global configuration attributes were 
changed. 

Severity:  INFO
Recommended Action(s): N/A

CFG_SERVER_ADD  
AAA server <serverIndex> added to the configuration.

Explanation: Configuration change: the specified AAA server was added to the configuration
Severity:  INFO
Recommended Action(s): N/A

CFG_SERVER_DEL_AAA 
Server <serverIndex> deleted from the configuration.

Explanation: Configuration change: the specified AAA server was deleted from the 
configuration. 

Severity:  INFO
Recommended Action(s): N/A

CFG_SERVER_MOD  
Configuration of AAA server <serverIndex> modified.

Explanation: Configuration change: the configuration of the specified AAA server was 
changed. 

Severity:  INFO
Recommended Action(s): N/A

CFG_USER_ADD  
User <userName> added to the configuration.

Explanation: Configuration change: the specified user was added to the configuration.
Severity:  INFO
Recommended Action(s): N/A

CFG_USER_DEL  
User <userName> deleted from the configuration.

Explanation: Configuration change: the specified user was deleted from the configuration.
Severity:  INFO
Recommended Action(s): N/A
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CFG_USER_MOD  
Configuration of user <userName> modified.

Explanation: Configuration change: the configuration of the specified user was changed.
Severity:  INFO
Recommended Action(s): N/A

NO_SERVER_RESPONSE  
No response from AAA server <serverIndex> at address 
<serverIPaddr>: <serverPort>.

Explanation: There was no response received from the specified AAA server on an 
authentication request. 

Severity:  MAJOR
Recommended Action(s): (1) Verify AAA server IP address (2) Verify connectivity exists 

between the VMG and the AAA server. 

User_Authen_Failed
or
Login_Failed  User login authentication failed for <username>.

Explanation: Login authentication failed for the specified username. 
Severity:  MINOR
Recommended Action(s): N/A

User_Authen_Succeed
or
Login  
User Authentication succeeded for <username>.

Explanation: Login authentication succeeded for the specified username.
Severity:  INFO
Recommended Action(s): N/A

User_Logout
or
Logout 
User <username> logged out.

Explanation: The specified user has logged out.
Severity:  INFO
Recommended Action(s): N/A
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Program Substitution (PgSub) Events

PgSub_Fail
O/p Pg Name <OPNAME> program substitution failed. SCTE 30 Err 
<ERR>.

Explanation: The program substitution failed.
Severity:  MAJOR
Recommended Action(s): SCTE code reference needed.

PgSub_NoPMTChange
O/P(TS info), I/P(TS info)

Explanation: A program substitution event occurred with no update to the outgoing PMT 
table. 

Severity:  INFO
Recommended Action(s): N/A

PgSub_OK
O/P (<oGePort>, <oTsIp>, <oTsUdp>, <oPgNum>) I/P (iGePort>, 
<iTsIp>/<iTsUdp>,<iPgNum>).

Explanation: The program was successfully substituted. 
Severity:  INFO
Recommended Action(s): N/A

PgSub_Service_AccDenied
Program substitution request received for program <Prog>, which 
is not program substitution enabled.

Explanation: The service name in the PgSub request is not PgSub enabled.
Severity:  MAJOR
Recommended Action(s): Contact RGB Customer Support.

PgSub_Service_Invalid
Invalid or unknown program name <Prog> in Program substitution 
request.

Explanation: The service name in the PgSub request is invalid or not present. 
Severity:  MAJOR
Recommended Action(s): Create the program name to match the SCTE 30 configured name 

for the init-request. 
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This glossary describes some of the terminology used in this document.

Numeric

3DES—Triple Data Encryption Standard
A mode of DES that encrypts data three times. Three 64-bit keys are used, for an overall key length of 
192 bits.

A

AAA—Authentication, Authorization, and Accounting
The services provided by a security protocol. Examples of security protocols are RADIUS and 
TACACS+.

AC—Access Criteria

ACG—Access Control Generator

AES—Advanced Encryption Standard
AES is a privacy transform for IPSec and Internet Key Exchange, and is replacing the Data Encryption 
Standard (DES). AES offers a larger key size and a variable key length.

AFD—Active Format Description

AMP—Application Media Processor
The VMG module that performs audio transcoding.

ANSI—American National Standards Institute

API—Application Programming Interface
A set of functions, procedures, methods, classes or protocols that an operating system, library or service 
provides to support requests made by computer programs.

AR—Analog Regenerator

ARP—Address Resolution Protocol
ARP broadcasts a packet containing the IP address that the sender specifies to all hosts attached to an 
Ethernet connection. When the target recognizes that the IP address is its own, it s a response. 

ATSC—Advanced Television Systems Committee
ATSC is working to coordinate television standards among different communications media. ATSC is 
also developing digital television implementation strategies.

AVTX—Audio/Video Transcode
A transport stream that enables both audio and video transcoding.
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B

Bandwidth
The maximum amount of data that a transmission device is capable of carrying.

C

CA—Conditional Access
An encryption/decryption management method by which a broadcaster controls a subscriber's access to 
services.

CAS—Conditional Access Systems
Systems that ensure broadcast service is accessible only to those entitled to access, usually by 
scrambling or encrypting the service.

CAT—Conditional Access Table
One of the 4 tables in PSI. The CAT provides conditional access to the transport streams.

CBC—Cipher Block Chaining
A DES mode.

CBR—Constant Bit Rate
Constant bit rate encoding ensures that the rate at which a codec's output is consumed is constant. 
Because it is the maximum bitrate that matters, CBR is useful for streaming multimedia content on 
limited capacity channels. See also VBR.

CCA—Circuit Card Assembly

CML
An optical signaling method.

Codec
A program or device used for compressing/decompressing or encoding/decoding data and signals.

CPU—Central Processing Unit

CSA—Common Scrambling Algorithm

CVCT—Cable Virtual Channel Table

CW—Control Word
Part of DVB simulcrypt.

CWG—Control Word Generator
Part of DVB simulcrypt.
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D

DAVIC
Digital Audio Visual Council

DCCT—Directed Channel Change Table
One of the 9 tables in the ATCS PSIP. The DCCT instructs the receiver to change channels based on 
viewer preferences, demographics or geographical location. This table works with a DCCSDT in the set 
top box. 

DCCSCT—Directed Channel Change Selected Code Table
One of the 9 tables in the ATSC PSIP. The DCCSCT allows updating some DCC table information data 
in receivers equipped to handle updates.

DES—Data Encryption Standard
DES specifies a FIPS approved cryptographic algorithm as required by FIPS 140-1. Encrypting data 
converts it to an unintelligible form called cipher. The cryptographic security of the data depends on the 
security provided for the key used to encipher and decipher the data. Data can be recovered from cipher 
only by using exactly the same key used to encipher it.

DET—Data Event Table
One of the 9 tables in the ATSC PSIP. The DET announces the data portion of a video/audio/data event 
when the data event does not match the exact duration of an video/audio event.

DHCP—Dynamic Host Configuration Protocol
A protocol used by networked devices on an IP network. DHCP allows these devices to join a network 
with little to no configuration required.

DHEI—Digital Headend Expansion Interface

DM—Dense Modulator

DOCSIS—Data Over Cable Service Interface Specifications
Now known as CableLabs Certified Cable Modems. DOCSIS specifies modulation schemes and the 
protocol for exchanging bidirectional signals over cable. 

DPI—Digital Program Insertion
The digital splicing of one MPEG program (typically a commercial) into another based on digital cues 
within the MPEG transport stream.

DSP—Digital Signal Processing

DVB—Digital Video Broadcast
A European set of defined transmission standards for digital broadcasting systems.

DVB SI—DVB Simulcrypt

DWDM—Dense Wavelength Division Multiplexing
A fiber-optic transmission technique using light wavelengths to transmit data parallel-by-bit or serial-
by-character.
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E

EAS—Emergency Alert System
An operational structure for national and local emergency alerts used by broadcast, cable, and wireless 
cable.

EBP—Encoder Boundary Point
Data that is inserted into audio or video elementary streams intended for use in adaptive streaming 
applications.

ECB—Electronic Code Book
A DES mode

ECM—Entitlement Control Messages

ECMG—Entitlement Control Messages Generator

EDS—Extended Data Services

EIA—Electronic Industries Alliance

EIT—Event Information Table
One of the 9 tables in the ATCS PSIP. EITs are associated with a specific virtual channel in the VCT, 
contain event information, and point to the location of extended text in the ETT.

Elementary Stream
An individual MPEG data stream, such as a video stream, audio stream, or data stream that is 
encapsulated in a transport stream.

EM—Element Manager
The graphical user interface for the VMG.

EMM—Entitlement Management Message
A packet containing the information necessary to decrypt the picture.

EMMG—Entitlement Management Message Generator
The component of the conditional access headend that delivers entitlements to the multiplexers. 

EOD—Everything-On-Demand

ERM—Encrypter Resource Manager

Ethernet
A frame based local area network technology. Specified in the IEEE 802.3 family of standards.

ETT—Extended Text Table
One of the 9 tables in the ATCS PSIP. ETTs carry longer text messages than EITs for describing events 
and virtual channels.
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F

FCC—Federal Communications Commission
The agency that regulates communications services, including cable television, that originate in the 
United States.

FEC—Forward Error Correction
Also referred to as channel coding, FEC is a technique used for controlling errors in data transmission 
over unreliable or noisy communication channels

FFT—Fast Fourier Transform

FPGA—Field Programmable Gate Array
An array of logic gates that can be hardware-programmed to fulfill user-specified tasks.

FTP—File Transfer Protocol
A network protocol used to transfer data from one computer to another through a network.

FTTP—Fiber to the Premise

FVOD—Free-Video-On-Demand

G

GBP /GBP-2
Gigabit Ethernet Processor module.

GigE—Gigabit Ethernet
Technology for transmitting Ethernet frames at data transfer rates of 1 Gigabit (1,000 megabits) per 
second.

Grooming
The process of creating customized channel lineups.

GUI—Graphical User Interface
A type of user interface that allows people to interact with electronic devices.

H

H.264
A block oriented motion-compensation based codec. It is equivalent to the MPEG-4 Part 10 standard.

HD—High Definition
High-resolution digital television combined with Dolby Digital surround sound (AC-3).

Headend
A regional distribution point in a television system.
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HFC—Hybrid Fiber/Coax
A distribution system combining fiber and coax cable. An HFC system is used to distribute CATV 
signals into a neighborhood. 

I

ICMP—Internet Control Message Protocol
A networking protocol.

IEEE—Institute of Electrical and Electronics Engineers
An international non-profit professional organization that develops a wide array of standards related to 
electricity.

IF
A high-rate signal

IFFT—Inverse Fast Fourier Transform

IGMP—Internet Group Management Protocol
IP hosts use IGMP to register dynamic multicast group membership. Connected routers discover the 
group members using the same protocol.

IMPB—IP-MAC-Port Binding
A configuration that binds a source IP address with an associated MAC address and port number.

IP—Internet Protocol
The network layer for the TCP/IP (Internet Protocol) Suite. It is a connectionless, best-effort packet 
switching protocol.

IP Address
A numerical identifier used by computers and devices on an IP network.

IPMI—Intelligent Platform Management Interface
An open standards specification that defines interfaces which enable system administrators to monitor, 
manage, diagnose, and recover systems.

IPTV—Internet Protocol Television
A system where digital television is delivered to a network infrastructure using Internet Protocol 
through a broadband connection. Often, IPTV is delivered in conjunction with Video on Demand and 
other Internet services, such as web access and Voice over IP.

IRD—Integrated Receiver Decoder

IRT—Integrated Receiver Transcoder

ITU—International Telecommunication Union
An international organization through which governments and the private sector coordinate global 
telecommunications networks and devices.



VMG Element Manager User Guide 354

Release 3.1.3

J

JRE—Java Runtime Environment
JRE is made up of the Java virtual machine, the Java platform core classes, and supporting files.

L

LAN—Local Area Network
A type of computer network that spans a small physical area such as a home, office, or school.

LED—Light Emitting Diode
A semiconductor diode that emits light when current passes through it. LEDs are used as indicators.

M

MBR TS—Multi-bitrate Transport Stream
An MBR TS enables you to transcode a single input stream into four SPTSs. 

MGT—Master Guide Table
One of the 9 tables in the ATCS PSIP. MGT provides program-identification (PID) locations so a 
receiver can find the other tables, and informs the receiver of changes or table updates.

MIB—Management Information Base
MIB defines the variables needed by the SNMP protocol to monitor and control elements in a network. 

MID
Mid-plane.

MOD
Modulator and Up-Converter

MOD
Movies-On-Demand

MPE—Multi-Protocol Encapsulation

MPEG—Moving Pictures Experts Group
A joint standards working group of ISO/IEC that develops video and audio encoding standards.

MPEG-2
A transport, audio, and video standard for compression and storage of broadcast quality television.

MPEG-4
A graphics and video compression algorithm standard based on MPEG-1, MPEG-2, and other related 
technologies.

MPTS—Multi-Program Transport Stream
A transport stream that contains multiple programs.

MRM—Multiplex Resources Manager
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Multiplexing
The process of combining several different signals onto a single communication channel for 
transmission.

MUX—Multiplexer
A device that combines multiple data sources into a single data stream for transmission. Some MUX’s 
can demultiplexes the single data stream into its composite forms.

N

NEBS—Network Equipment Building System

NIST—National Institute of Standard and Technology

NIT—Network Information Table
One of the four tables in PSI. The NIT provides information about transport streams and multiplexes.

NMP—Network Management Protocol
A Network Management System

NPM—Network Processor Module
The VMG module that performs network related processing.

NSA—National Security Agency

NTP—Network Time Protocol
A TCP protocol that ensures accurate local time-keeping with reference to radio and atomic clocks, and 
can synchronize distributed clocks within milliseconds.

NTSC—National Television System Committee
Committee that defined the current standard for analog color television in North America, as well as the 
name for the standard. The format is 525 lines in 4MHx of video bandwidth.

O

OIF
A standards body

OOB—Out-Of-Band

OTN
An Optical Transport Network

OTS
Output Transport Stream
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P

PAT—Program Association Table
One of the 4 tables in PSI. The PAT lists the programs available in a transport stream.

PCR—Program Clock Reference

PDG—Private Data Generator

PEM—Power Entry Module

PHY
Physical link layer

PID—Packet Identifier
Part of the transport stream packet header used to identify tables, elementary streams, and programs.

PIP—Picture in Picture

PLL—Phase-Locked Loop
Part of the clock generator

PMT—Program Map Table
One of the 4 tables in PSI. The PMT contains information about MPEG-2 programs.

POD—Point-Of-Deployment

Program
A collection of audio, video, tables, and elementary streams carried on a channel.

PSI—Program Specific Information
A collection of four tables as part of an MPEG-2 or MPEG-4 transport stream. These four tables 
include:

• Conditional Access Table (CAT)

• Network Information Table (NIT)

• Program Association Table (PAT)

• Program Map Table (PMT)
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PSIP—Program and System Information Protocol
A collection of nine tables that allow the DTV transport stream to provide information about a station's 
services and programming. These nine tables include:

• Master Guide Table (MGT)

• System Time Table (STT)

• Virtual Channel Table (VCT)

• Rating Region Table (RRT)

• Event Information Table (EIT)

• Extended Text Table (ETT)

• Data Event Table (DET)

• Directed Channel Change Table (DCCT)

• DCC Selected Code Change Table (DCCSDT)

PSIG—PSI/SI Generator

Q

QAM—Quadrature Amplitude Modulation
This is the modulation technique used in systems carrying digital video.

QoS—Quality of Service
Guarantees network bandwidth and availability for applications.

R

RADIUS—Remote Authentication Dial In User Service
A networking protocol that provides centralized AAA services.

Redundancy
A method of providing a backup for critical system components to ensure uninterruptible service in the 
event of a failure. High availability and reliability.

RF—Radio Frequency
Television signals are modulated onto RF signals and are then demodulated by the television tuner.

RRT—Regional Ratings Table
One of the 9 tables in the ATCS PSIP.

RTP—Real Time Protocol
RTP provides services such as payload type identification, sequence numbering, time-stamping, and 
delivery monitoring to real-time applications.

RTC—Real Time Clock

RTM—Rear Transition Module

RU—Rack Unit
A common increment of equipment space height. The height of 1 RU is 1.75 inches. 
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S

SCR
DVB CSA scrambler

SCS—Simulcrypt Synchronizer

SCTE—Society of Cable Telecommunications Engineers
An organization that develops training for cable television installers and engineers and standards for the 
cable industry. 

SD—Standard Definition
Television systems that have a resolution that meets standards but not considered either enhanced 
definition or high definition.

SDT—Service Description Table
A table ID that indicates the MPEG-2 SI packet type.

SerDes
Serializer/deserializer

SFP—Small Form Factor Pluggable
An optical interface that is used in network switches for Fibre Channel, Gigabit Ethernet and 
InfiniBand.

SCM—Shelf Control Manager
Manager of the chassis population and infrastructure.

SHO—Super Head-end Office
The central distribution point in a television system. Main office.

SMF—Single Mode Fiber
An optical fiber designed to carry only a single ray of light.

SNMP—Simple Network Management Protocol
A protocol used to monitor and control network devices, and to manage configurations, statistics 
collection, performance, and security.

SPTS—Single Program Transport Stream.
A transport stream that contains only one program.

SRM—System/Session Resource Manager

Status Bar
Located at the bottom of an application window and displays system status information.

STT—System Time Table
One of the 9 tables in the ATCS PSIP. Allows a broadcaster to present time indicators to the consumer, 
ensuring that the time is synchronized.
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SVOD—Subscription-Video-on-Demand
A Video-on-Demand service offered by subscription, providing viewers with access to select programs 
from the libraries of featured cable networks.

T

TACACS+—Terminal Access Controller Access-Control System Plus
A networking protocol that provides centralized AAA services.

TBR—Time Base Recovery

TCM—Transcoding Module
The VMG module that performs transcoding.

TCP—Transmission Control Protocol
A connection oriented transport protocol in the Internet (TCP/IP) protocol suite.

TFTP—Trivial File Transfer Protocol
A simple form of the File Transfer Protocol (FTP). TFTP uses UDP and is often used by servers to boot 
diskless workstations, X-terminals, and routers.

Transcoding
The process of converting one digitally encoded format to another, such as MPEG-2 to H.264 or vice 
versa.

Transrating
Transrating, or rate shaping, is the process of changing the bitrate of a video stream for the purposes of 
improving bandwidth and system efficiency.

TS—Transport Stream
One or more multiplexed MPEG-2 or MPEG-4 programs and related data.

TSA—Transfer Switch Adapter
RF redundant switching/routing

TVCT—Terrestrial Virtual Channel Table

U

UDP—User Datagram Protocol
A connectionless transport protocol in the TCP/IP (Internet) protocol suite that runs over the IP network 
protocol. UDP provides a direct way to send information over an IP network. It is used primarily for 
broadcasting messages over a network.

V

VBI—Vertical Blanking Interval
A portion of a television signal that carries non-audio/video data, such as closed-caption text. 
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VBR—Variable Bit Rate
VBR streams vary in bandwidth over time.

VCT—Virtual Channel Table
One of the 9 tables in the ATCS PSIP. The VCT contains a list of all the channels that are or will be 
online, along with their channel name and number. This table contains the set of data that enables a 
receiver to tune and locate the service being broadcast.

VHO—Video Hub Office
The regional distribution point in a television system. Satellite office that receives video from SHO.

VIA—Video Intelligence Architecture
An FPGA based modular architecture developed by RGB.

VMG-6—Video Multiprocessing Gateway, 6-slot chassis

VMG-8—Video Multiprocessing Gateway, 8-slot chassis

VMG-14—Video Multiprocessing Gateway, 14-slot chassis

VOD—Video On Demand
A system that allow users to watch video content over a network as part of an interactive television 
system, either by streaming or by download.

VPM—Video Processor Module
The VMG card that performs video related processing.

VSO—Video Serving Office
The local distribution point in a television system. Central office that receives video from VHO.

VTR—Video Transrating
A transport stream that enables only video transrating.

VTX—Video Transcode
A transport stream that enables only video transcoding.

W

WAN—Wide Area Network
A type of computer network that spans a large geographic area such as a state or country.

WM9
Windows Media 9
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X

XFI
Serial GbE optical interface

XFP—10 Gigabit Small Form Factor Pluggable
10 Gigabit Small Form Factor Pluggable (SFP). The XFP is a pluggable, hot-swappable optical 
interface for 10 Gigabit SONET/SDH, Fibre Channel, Gigabit Ethernet, and other applications. XFP 
modules are optical transceivers, typically 1310nm or 1550nm. Optical XFPs include digital 
diagnostics.
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.dll files 87
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Table 11. MPEG1 L2 308

A
A6 group ID 76
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AAC HE Audio 306
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AC-3 Encode 308
ACT_CARD_RESET 319
active format 167, 182, 213
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ad server

connecting 285
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Ad_Service_Acc_Denied 340
Ad_Service_Invalid 340
Ad_Video_underflow 340
AFD output 182
alarms

active
paging 110

list of 316–??
alarms and events

categories 314
list of 314
severity levels 315

AMP 5
redundancy 278

AMP redundancy 278
Append new configuration to existing TS database 40, 

74
Application Media Processor 5
aspect ratio 78, 168, 183, 213, 236
ATSC transport streams 152

audio
bit rate 79
channels 79
codec 79
gain 80
pass-through 80
sampling rate 79
start pid 80

audio pass-through 215, 216

B
backup

input port
program redundancy 83

input table processing
program redundancy 83

bit rate 174
Bulk configuration

directories 87
using templates 87

bulk configuration 39

C
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CARD_FAILURE 316, 320
CARD_NOT_PRESENT 316, 320
CARD_OPER_DOWN 316, 320
CARD_OPER_UP 320
CARD_OVERHEAT 316
CARD_PRESENT 320
CARD_RESET_DL_DOWN 320
CARD_RESET_FAILED 321
CARD_RESET_PPC_LOST 321
CARD_RESET_SUCCEEDED 321
CARD_TYPE_MISMATCH 316, 321
CFG_CARD_ADMIN_DISABLED 321
CFG_CARD_ADMIN_ENABLED 321
CFG_DATA_PORT 325
CFG_ELM_global 344
CFG_GLOBAL_MOD 345
CFG_Grm_ADD 341
CFG_Grm_DEL 341
CFG_GROOM_GRP 325
CFG_IF 325
CFG_IF_ADD 325
CFG_IF_DEL 325
CFG_InEs 327
CFG_InEs_ADD 327
CFG_InEs_DEL 327
CFG_InPgm 327
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CFG_InPgm_ADD 327
CFG_INPgm_DEL 327
CFG_InTS 328
CFG_InTS_ADD 328
CFG_InTS_DEL 328
CFG_LicKey 343
CFG_MGMT_IF 325
CFG_NTP_IPADDR 322
CFG_OutEs 328
CFG_OutEs_ADD 328
CFG_OutEs_DEL 328
CFG_OUT_OF_SYNC 317
CFG_OutPgm 329
CFG_OutPgm_Add 329
CFG_OutPgm_DEL 329
CFG_OutTS_ADD 329
CFG_OutTS_DEL 329
CFG_OutTS_MODIFY 329
CFG_PORT_ADMIN_DISABLED 326
CFG_PORT_ADMIN_ENABLED 326
CFG_PORT_MIRROR_DISABLE 318
CFG_PORT_MIRROR_ENABLE 319
CFG_SERVER_ADD 345
CFG_SERVER_DEL_AAA 345
CFG_SERVER_MOD 345
CFG_SWO_ENABLED 322
CFG_SWO_INHIBITED 322
CFG_SYSLOG_global 344
CFG_SYSLOG_svr 344
CFG_Timezone 322
CFG_USER_ADD 345
CFG_USER_DEL 345
CFG_USER_MOD 346
chassis

card information 31
port information 33
system information 28, 29, 30
view, Element Manager tab 25

CHASSIS_OVERHEAT 317
CHASSIS_TEMP 317
CHASSIS_TEMP_CRITICAL 317, 322
CHASSIS_TEMP_MAJOR 317, 322
CHASSIS_TEMP_MINOR 317, 322
CHASSIS_TYPE_MISMATCH 344
Clear the TS database 40, 74
closed captioning 168, 183
configuration

AAA
global 55
servers 57

chassis, viewing 25
menu, Element Manager 39
NTP 41
ports, GbE 63
redundancy switch 49
system, global 41
user authentication 53
virtual IP address 45

connecting
ad server 285

constant bitrate 10
creating

output programs, drag and drop 208, 230
transport streams, input 128
transport streams, multiple 130
transport streams, output

ATSC 152
DVB 154
MPEG-2 140, 201, 206

cue messages
forwarding 290

Cue_Tone_Invalid 340
Customer Support

Contacting 304

D
database

backup 15
restore 15

database backup 15, 91
database restore 15, 91
deleting

AAA servers 60
programs 136, 198
transport streams 133, 189

Del_LiKey 343
digital program insertion (DPI) 12, 280, 291

program substitution 285
drag and drop grooming 208, 230
DST 107
DVB 206
DVB transport streams 154, 206
DVS714r3 281

E
edit AAA servers 58
Element Manager 303
Element manager

log in 20
Element Stream 258
Encoder Boundary Point (EBP) 50, 51
events

history
paging 112
viewing 111

list of 319

F
failover, system 274
FAN_NOT_PRESENT 318, 323
FAN_PRESENT 323
FEC 127
first audio PID 78
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forward error correction
Pro-MPEG CoP#3 127

forward SCTE35 cue 79
forwarding SCTE 35 cue messages 290
full HD MBR transport stream, configuration 227
full HD output 226
full HD output, MBR program mapping 233

G
Ghost programs

Creating 132
Gigabit Ethernet (GbE)

port configuration 63
global configuration 41

grooming group 47
grooming group combinations 48
system 42
virtual IP 45

gop m 79
gop n 79
GOP structure 166, 181, 213, 236
grooming 9, 157

drag and drop 208, 230
group combinations 48
groups 46
modifying 133, 189
viewing

source 199
grooming group 253

H
H.264 280, 281
hardware revision number 33
HDR Parameter Insertion 51
high availability 274

I
IDR Interval 168, 183
IDR interval 214, 236
idr interval 79
IF_OPER_DOWN 326
IF_OPER_UP 326
input

port 76
program redundancy 83

program number 76
program redundancy 83

resolution class 76
source IP 76

program redundancy 83
table processing 81
TS name 76

input transport streams
creating 128

Input_Audio_Loss 330

Input_Mismatch 330
Input_TS_Missing 330
Input_Video_Encrypted 331
Input_Video_Loss 331
InTS_ADD_Fail 343
In_TS_NIT_Miss_clear 329
In_TS_NIT_Miss_Set 330
In_TS_SDT_Miss_Clear 330
In_TS_SDT_Miss_Set 330

J
Java 18
Java Web Start

clearing cache 37
JRE 18

L
LEDs 303
library files 87
license management

license keys 102
license types 16, 99

LiKey_CFG_FAIL 343
LiKey_Error 343
local user accounts 56
Login 346
Login_Failed 346
Logout 346

M
management interface 44
manufacturer date 33
manufacturer name 33
MBR 224
mbr group id 76, 79
mcast IP 76

program redundancy 83
menus

software upgrade 303
VMG Element Manager 23

modifying
AAA servers 57
GbE port configuration 63
grooming 133, 189
system configuration 39
transport streams and programs 133, 189

monitoring and management 15
MPEG-2 140, 201, 280, 281
MPEG2 L2 308
MPEG-2 transport streams 140, 201
multi-bitrate transport streams 224
multicast 129
multiplexing, statistical 10
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N
N+M redundancy 7, 276
N+M VPM redundancy 276
Network Processing Modules 5
Network Processor Module (NPM)

GbE port configuration 63
grooming groups 46
redundancy 273
redundancy switch 49, 106

Network Time Protocol (NTP)
server setup 41

NO_SERVER_RESPONSE 346
NPM 5

redundancy 275
NPM_ACTIVE 323
NPM_STANDBY 323

O
OutPgm_ADD_Fail 343
output

sdt 81
output programs

drag and drop grooming 208, 230
grooming 157

output transport streams, creating 140, 152, 154, 201, 206
multiple 130

OUTPUT_ES_ERROR 332
Output_ES_ERROR 332
Output_ES_Error 332
Output_IDR_Error 332
OUTPUT_RESPLICE 332, 333
OutTS_ADD_Fail 344
Out_TS-NIT_Miss_Set 332
OutTS_oversub_cir 333
outTS_oversub_set 333
Out_TS_TDT_Miss_Clear 331
Out_TS_TDT_Miss_Set 331
Out_TS_TOT_Miss_Clear 331
Out_TS_TOT_Miss_Set 331
oversubscription

VPM 276

P
part name 33
part number 33
PGRED_FAILOVER2BKUP_FAIL 333
PGRED_FAILOVER_TO_BCKUP 341
PGRED_FAILOVR2BKUP_FAIL 341, 342
PGRED_GLB_SWITCH_TO_PRIM 342
PGRED_MANSWTCH_TO_BCKUP 342
PGRED_MANSWTCH_TO_PRIM 342
PG_RED_RECOVER_TO_PRIM 341, 342
PgSub_Fail 347
PgSub_NoPMTChange 347
PgSub_OK 347
PgSub_Service_AccDenied 347

PgSub_Service_Invalid 347
port information, viewing 33
port mirroring 14
PORT_OPER_DOWN 319, 326
PORT_OPER_UP 326
POWER_SUPPLY_NOT_PRESENT 318
POWERSUPPLY_NOT_PRESENT 318, 323
POWERSUPPLY_PRESENT 323
program

name 77
number 77

Program and System Information Protocol (PSIP) 9
Program Grooming

transcoded+PIP TS 208, 230
program redundancy 14, 252

best practices 254
input program redundancy 125
input-level

deleting 256
modifying 256

manual recovery 256
Program Substitution 12
program substitution 285

scheduling server 287
program-level DPI 282
programs

deleting 136, 198
drag and drop grooming 208, 230
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